# CONTENTS

<table>
<thead>
<tr>
<th>Guide Overview</th>
<th>Description of this guide............................................................ xi</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>What’s new in this guide .................................................................... xiii</td>
</tr>
</tbody>
</table>

1. Getting Started with MicroStrategy Desktop

<table>
<thead>
<tr>
<th>Introduction</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>About MicroStrategy Desktop .......... 2</td>
<td></td>
</tr>
<tr>
<td>Installing MicroStrategy Desktop .................................................. 4</td>
<td></td>
</tr>
<tr>
<td>Upgrading and updating MicroStrategy Desktop ...................................... 6</td>
<td></td>
</tr>
<tr>
<td>Installing MicroStrategy Desktop with an automatic (silent) installation .............................................. 11</td>
<td></td>
</tr>
<tr>
<td>Opening MicroStrategy Desktop ............................................................. 16</td>
<td></td>
</tr>
<tr>
<td>Building your first dashboard .......................................................... 17</td>
<td></td>
</tr>
<tr>
<td>Opening a new, blank dashboard .................. 18</td>
<td></td>
</tr>
<tr>
<td>Importing your data from a file .................................................. 19</td>
<td></td>
</tr>
<tr>
<td>Creating a visualization .................. 24</td>
<td></td>
</tr>
<tr>
<td>Formatting your visualization .................. 31</td>
<td></td>
</tr>
<tr>
<td>Adding filters to your dashboard .................. 34</td>
<td></td>
</tr>
<tr>
<td>Allowing a visualization to update the data displayed in another visualization .............................................. 38</td>
<td></td>
</tr>
<tr>
<td>Analyzing your data .................. 41</td>
<td></td>
</tr>
<tr>
<td>Saving your dashboard .................. 47</td>
<td></td>
</tr>
<tr>
<td>Sharing your results .................. 48</td>
<td></td>
</tr>
<tr>
<td>Understanding how MicroStrategy works with and stores data .................. 49</td>
<td></td>
</tr>
<tr>
<td>Providing business context to data: Attributes .................. 50</td>
<td></td>
</tr>
<tr>
<td>Calculating data: Metrics .................. 52</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Introduction</td>
<td>55</td>
</tr>
<tr>
<td>Best practices: Importing data into MicroStrategy Desktop</td>
<td>59</td>
</tr>
<tr>
<td>Importing data from a file</td>
<td>62</td>
</tr>
<tr>
<td>Importing data by scraping a web page (public data)</td>
<td>65</td>
</tr>
<tr>
<td>Importing data from a database by building a SQL query</td>
<td>67</td>
</tr>
<tr>
<td>- Creating and managing filters to determine which data to import from a database</td>
<td>75</td>
</tr>
<tr>
<td>- Defining joins between columns in database tables</td>
<td>78</td>
</tr>
<tr>
<td>Importing data from a database by picking relational tables</td>
<td>80</td>
</tr>
<tr>
<td>Importing custom data by typing or pasting values</td>
<td>83</td>
</tr>
<tr>
<td>Importing data from a BI tool</td>
<td>85</td>
</tr>
<tr>
<td>- Obtaining the URL for the query</td>
<td>86</td>
</tr>
<tr>
<td>- Importing data from a BI source into Desktop</td>
<td>89</td>
</tr>
<tr>
<td>Importing data from a Dropbox file</td>
<td>91</td>
</tr>
<tr>
<td>Importing data from Facebook</td>
<td>93</td>
</tr>
<tr>
<td>Importing data from Google Analytics</td>
<td>96</td>
</tr>
<tr>
<td>Importing data from Google BigQuery</td>
<td>99</td>
</tr>
<tr>
<td>- Combining data in tables with joins in Google BigQuery</td>
<td>102</td>
</tr>
<tr>
<td>Importing data from a file stored on Google Drive</td>
<td>105</td>
</tr>
<tr>
<td>Importing data from a Salesforce report</td>
<td>107</td>
</tr>
<tr>
<td>Importing data from a sample file</td>
<td>109</td>
</tr>
<tr>
<td>Importing data from Twitter</td>
<td>110</td>
</tr>
<tr>
<td>Importing data from Hadoop</td>
<td>112</td>
</tr>
<tr>
<td>Importing data from a database by typing a query</td>
<td>113</td>
</tr>
<tr>
<td>- Customizing your SQL query while importing data from Google BigQuery or Hadoop</td>
<td>117</td>
</tr>
<tr>
<td>Suggesting a data source for data import</td>
<td>120</td>
</tr>
<tr>
<td>Previewing your data and specifying data import options</td>
<td>121</td>
</tr>
<tr>
<td>Improving performance: Partitioning large datasets and creating search indexes</td>
<td>127</td>
</tr>
<tr>
<td>Refining your data quality before importing</td>
<td>129</td>
</tr>
<tr>
<td>Preparing your data to display on maps: Geo roles</td>
<td>135</td>
</tr>
<tr>
<td>Defining relationships between attributes</td>
<td>138</td>
</tr>
<tr>
<td>Editing imported data</td>
<td>140</td>
</tr>
<tr>
<td>Refreshing and updating your imported data:</td>
<td></td>
</tr>
<tr>
<td>Republishing datasets</td>
<td>141</td>
</tr>
</tbody>
</table>
3. Creating Dashboards and Visualizations

- **Introduction** .............................................................. 145
- Creating a dashboard .................................................... 146
- Managing data in a dashboard ........................................ 151
  - Adding, replacing, and removing datasets in a dashboard .. 152
  - Selecting which datasets determine the dashboard’s available values ......................................................... 158
  - Selecting how a dataset accesses its data: Direct data access vs. in-memory .................................................. 160
  - Modifying, renaming, showing, and hiding dataset objects in a dashboard .................................................. 162
- Formatting a dashboard .................................................. 167
  - Selecting the display theme for a dashboard................. 167
  - Creating color palettes to customize display themes........ 169
  - Defining default fonts and colors for the objects in the dashboard ...................................................................... 173
- Saving and exporting a dashboard .................................... 175
  - Saving a dashboard..................................................... 175
  - Exporting a dashboard .................................................. 176
  - Exporting a visualization ............................................... 178
- Displaying a visual representation of your data: Visualizations................................................................. 179
  - Creating a Graph visualization ...................................... 181
    - Creating area, bar, or line graphs ................................ 192
    - Creating a bubble or scatter graph ................................ 196
    - Creating a graph with graph markers displayed in a grid layout ................................................................. 200
    - Creating a graph with pies or rings ................................ 202
    - Creating a combination graph ....................................... 209
    - Creating a dual-axis graph ............................................ 215
  - Creating a Grid visualization ........................................... 220
  - Creating a Heat Map visualization .................................. 223
  - Creating an ESRI Map visualization ................................. 227
    - Creating an ESRI Map visualization that displays map markers ................................................................. 228
    - Creating an ESRI Map visualization that displays a density map ............................................................... 233
    - Creating an ESRI Map visualization that displays areas ................................................................. 239
  - Creating a Network visualization .................................... 243
    - Changing the type of visualization displayed .................. 246
    - Duplicating visualizations ........................................... 247
    - Moving visualizations .................................................. 248
## 6. Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages

**Introduction** .......................................................................................... 369

- Layering and organizing data for filtering ........................................... 372
  - Adding, modifying, and deleting sheets ........................................ 374
  - Adding, modifying, and deleting pages ...................................... 376

- Creating filters for a sheet of data ......................................................... 378
  - Creating an attribute filter for a sheet .......................................... 381
  - Creating a metric filter for a sheet .............................................. 384

- Creating a metric filter that ranks the values of an attribute .............. 389

- Applying filter changes individually or all at once .......................... 394

- Filtering the attribute values displayed in an filter for a sheet ........ 395

- Creating a filter for the data on a visualization ................................. 402
  - Filtering the objects displayed in a filter for a visualization .. 407
  - Creating a filter on the data in a visualization or another filter ........ 409

- Using a visualization to filter the data displayed in another visualization ............................................................. 413

## 7. Analyzing Data in Dashboards

**Introduction** .......................................................................................... 419

- Running and viewing a dashboard .................................................... 420
  - Viewing dashboards in Presentation Mode .................................. 422

- Analyzing data in a visualization ........................................................ 424
  - Analyzing data in a graph ............................................................ 427
  - Analyzing data in a grid ............................................................... 434
  - Analyzing data in a heat map ........................................................ 438
  - Analyzing data in a map ............................................................... 441
  - Analyzing data in a Network visualization .................................. 445

- Examining the underlying data in a visualization .............................. 449

- Filtering data in a dashboard ............................................................. 451
  - Filtering data in a sheet ............................................................... 453
Filtering data in a visualization ............................................. 460
Selecting data in one visualization to update the data
displayed in another ............................................................. 464

8. Connecting to a Server to Access Data and Dashboards

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>469</td>
</tr>
<tr>
<td>Connecting a server to MicroStrategy Desktop</td>
<td>470</td>
</tr>
<tr>
<td>User privileges for Desktop</td>
<td>472</td>
</tr>
<tr>
<td>Saving a dashboard onto a MicroStrategy server</td>
<td>474</td>
</tr>
<tr>
<td>Opening a dashboard saved on a server</td>
<td>477</td>
</tr>
<tr>
<td>Selecting the authentication mode</td>
<td>480</td>
</tr>
<tr>
<td>Importing a dataset from a server</td>
<td>481</td>
</tr>
<tr>
<td>Using data from a project on a server</td>
<td>483</td>
</tr>
</tbody>
</table>

9. Connecting to a Data Source to Import Data

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>487</td>
</tr>
<tr>
<td>Creating a data source connection to a relational data source</td>
<td>488</td>
</tr>
<tr>
<td>Creating a DSN</td>
<td>492</td>
</tr>
<tr>
<td>Creating a DSNLess database connection that supports a third-party driver</td>
<td>494</td>
</tr>
<tr>
<td>Managing database connections</td>
<td>496</td>
</tr>
<tr>
<td>Configuring OAuth parameters for a data source</td>
<td>498</td>
</tr>
</tbody>
</table>

A. System Requirements

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>501</td>
</tr>
<tr>
<td>Software requirements</td>
<td>501</td>
</tr>
<tr>
<td>Hardware requirements and recommendations</td>
<td>503</td>
</tr>
<tr>
<td>Data source and ODBC driver support</td>
<td>504</td>
</tr>
</tbody>
</table>

B. Configuration Requirements for Data Sources

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>513</td>
</tr>
<tr>
<td>DB2 iSeries</td>
<td>514</td>
</tr>
<tr>
<td>DB2 Wire</td>
<td>515</td>
</tr>
<tr>
<td>DB2 z/OS</td>
<td>516</td>
</tr>
<tr>
<td>Greenplum</td>
<td>517</td>
</tr>
<tr>
<td>Hive</td>
<td>519</td>
</tr>
<tr>
<td>Impala</td>
<td>519</td>
</tr>
<tr>
<td>Infobright</td>
<td>520</td>
</tr>
<tr>
<td>Informix Wire</td>
<td>521</td>
</tr>
<tr>
<td>Informix XPS</td>
<td>522</td>
</tr>
</tbody>
</table>
Microsoft Access ................................................................. 523
MySQL ................................................................................. 523
Oracle .................................................................................. 524
PostgreSQL ........................................................................... 526
Salesforce ............................................................................ 526
SQL Server ........................................................................... 527
Sybase ASE .......................................................................... 528
Web services ......................................................................... 529

C. Interfaces for Data Import, Dashboard Creation, and Preferences

Introduction .............................................................................. 531
Interfaces for importing data .................................................. 531
  Select Import Options dialog box ....................................... 533
  Preview page ....................................................................... 534
  All Objects View page ....................................................... 536
  Parse Your Data page ....................................................... 538
  Wrangle Your Data page ................................................... 540
  Valid date and time forms for wrangling your data............. 541
  Create Multiform Attribute dialog box ............................... 542
  Geo Attribute dialog box ................................................... 544
  Expression dialog box ....................................................... 545
  New Condition dialog box .................................................. 545
  Link Attributes Editor ....................................................... 547
  Function Arguments dialog box ......................................... 547
Interfaces for creating dashboards .......................................... 548
  Dashboard Editor ............................................................... 549
  Dashboard Editor: Dashboard Datasets panel .................... 551
  Dashboard Editor: Filter panel .......................................... 555
  Dashboard Editor: Editor panel ......................................... 557
  Dashboard Editor: Graph .................................................. 560
  Dashboard Editor: Grid ..................................................... 562
  Dashboard Editor: Heat Map ............................................. 563
  Dashboard Editor: ESRI Map ............................................. 565
  Dashboard Editor: Network ............................................... 567
  Dashboard Editor: Visualization Gallery ............................ 568
  Attribute Editor ............................................................... 570
  Dashboard Properties dialog box ...................................... 572
  Filtering Options dialog box ............................................. 572
  Replace Objects dialog box .............................................. 574
Interfaces for formatting dashboard objects ........................................... 575
  Dashboard Editor: Graph: Properties................................................. 576
  Dashboard Editor: Grid: Properties.................................................. 590
  Dashboard Editor: Heat Map: Properties........................................... 595
  Dashboard Editor: ESRI Map: Properties........................................... 599
  Dashboard Editor: Network: Properties............................................. 601
  More Options dialog box................................................................. 604
  Advanced Sort Editor................................................................... 607
  Thresholds Editor.......................................................................... 608
  Advanced Thresholds Editor............................................................. 610
  Show Data dialog box.................................................................... 611
  Dashboard Editor: HTML container properties............................... 612
  Dashboard Editor: Image properties............................................... 612
  Dashboard Editor: Filter properties................................................. 613
  Dashboard Editor: Text properties.................................................... 616
  Preferences dialog box................................................................... 618
    Specifying the display language preferences................................... 618
    Selecting the network proxy.......................................................... 619

Additional Resources

  Introduction....................................................................................... 621
  Discussion Forum............................................................................. 621
  Resources......................................................................................... 622
  Documentation................................................................................ 622

Version Information and Legal Notices

  User Guide......................................................................................... 631

Index.................................................................................................... 635
GUIDE OVERVIEW

Description of this guide

The *MicroStrategy Desktop User Guide* describes the steps for a business analyst to execute and analyze a dashboard in MicroStrategy Desktop. It provides the information necessary for a business analyst to import data from a data source, and use that data to create and modify dashboards.

This guide is organized into the following sections:

- *Chapter 1, Getting Started with MicroStrategy Desktop* introduces MicroStrategy Desktop. It describes how MicroStrategy works with and stores the data you import. It also provides steps to create your first dashboard.

- *Chapter 2, Importing Data into MicroStrategy Desktop* describes how to import data into MicroStrategy Desktop, for use in creating dashboards.

- *Chapter 3, Creating Dashboards and Visualizations* describes how to create and format a dashboard, and add visual representations of the data (called visualizations) to the dashboard to make your data easier to interpret. It also describes how to layer and organize the data into multiple pages and sheets, and customize which information to display. It explains tasks such as opening, saving, and exporting dashboards.
• *Chapter 4, Adding Text, Images, and Web Content* describes how to add objects to display data in different ways, label or describe data, display Web content, and manipulate the data to customize which information to display.

• *Chapter 5, Creating New Attributes, Metrics, and Groups* describes how to create new attributes and metrics based on existing objects, to present your data in different ways. It also includes steps to group multiple attribute elements into a single item.

• *Chapter 7, Analyzing Data in Dashboards* describes common methods you can use to better understand and present the data that appears in a dashboard.

• *Chapter 8, Connecting to a Server to Access Data and Dashboards* describes how to connect to a MicroStrategy server. The connection allows you to share dashboards with other users by uploading and downloading to the server.

• *Chapter 9, Connecting to a Data Source to Import Data* describes how to establish communication between MicroStrategy Desktop and your data source, for importing data from a database. The database connection enables MicroStrategy Desktop to retrieve data from your data source.

• *Appendix A, System Requirements* lists software and hardware requirements to support MicroStrategy Desktop. It also lists the data source types and ODBC drivers that are certified or supported for Desktop.

• *Appendix B, Configuration Requirements for Data Sources* provides the configuration information required to connect to data sources.

• *Appendix C, Interfaces for Data Import, Dashboard Creation, and Preferences* explains the dialog boxes and other interfaces you can use to import data, create and format visualizations, and so on.

• *Additional Resources* provides information about the MicroStrategy Desktop Discussion Forum, where you can ask questions and exchange information with other Desktop users. It also introduces the reporting capabilities of the full MicroStrategy product suite with a list of MicroStrategy user manuals.
What’s new in this guide

Desktop 10.0

- For updates to the software requirements of MicroStrategy Desktop, see *Software requirements, page 501*.
- MicroStrategy Desktop is available for the Apple operating system.

Installation

- You can automatically (or silently) uninstall, repair, or upgrade Desktop. For steps, see *Installing MicroStrategy Desktop with an automatic (silent) installation, page 11*.

Importing data

- You can import data from:
  - Reports and queries in a BI tool
  - A database by picking relational tables
  - Data values typed or pasted into MicroStrategy Desktop
  - A Dropbox file
  - Facebook
  - Google Analytics
  - Google BigQuery
  - A file stored on Google Drive
  - A Hadoop Distributed File System
  - A MicroStrategy server
  - A Salesforce report
  - A sample file provided by MicroStrategy
  - Twitter
  - Data from a web page by scraping the page
A MicroStrategy server by opening a dashboard stored on the server, importing a dataset stored on the server, or using data from a project on the server

For a complete list of all the available data sources and steps to import data, see Importing Data into MicroStrategy Desktop, page 55.

- You can import .tsv and .prn files. For steps to import data from a file, see Importing data from a file, page 62.

- When you import data, you can use data columns as attribute forms to define a new, multiform attribute, if your data contains different attribute forms of the same attribute saved in separate data columns. For more details and steps to define multiform attributes, see Previewing your data and specifying data import options, page 121.

- You can explore your imported data to evaluate its quality and usability. You can then prepare your data to improve its quality before you import it into MicroStrategy Desktop. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on. This process is also referred to as data wrangling. For a complete list of the available actions and steps to refine your data, see Refining your data quality before importing, page 129.

- You can improve performance by partitioning a very large dataset and creating search indexes for attributes. For reasons to use partitioning and search indexes, as well as steps to create them, see Improving performance: Partitioning large datasets and creating search indexes, page 127.

**Visualizations**

- Improved Graph visualizations include more graph options, including:
  - The ability to drag and drop dataset objects directly onto the graph area to add them to the graph
  - More flexible dual-axis and combination graphs
  - Trend lines and reference lines
  - Graphing on "non-traditional" axes: the right vertical axis and top horizontal axis

For steps to create Graph visualizations, and examples, see Creating a Graph visualization, page 181.
• You can select the color to display each attribute value in a Graph or Heat Map visualization. For example, you can choose to display data for Electronics as red. If a bar graph is used, the bar riser for Electronics is displayed in red. If a pie chart is used, the pie slice for Electronics is red.

When you change the display color for an attribute value, other graphs and heat maps will use the same color to display the value. All the graphs and heat maps must color the graph items based on the same attribute. For example, a dashboard contains a bar graph and a heat map, both showing data colored by geographical region. An area graph displays data colored by product category. If you select dark green for the Southeast region's bar riser in the graph, the rectangle for Southeast is colored dark green in the heat map. Since the area graph is colored by category, the region's color does not apply to the area graph.

For steps, see Formatting a Graph visualization, page 283 and Formatting a Heat Map visualization, page 296.

• You can determine whether to show or hide null values in a Grid visualization. For steps, see Formatting a Grid visualization, page 293.

• The ESRI Map visualization allows you to display map markers, a density map, or colored map areas on a map. For steps to create ESRI Map visualizations, and examples, see Creating an ESRI Map visualization that displays map markers, page 228, Creating an ESRI Map visualization that displays a density map, page 233, and Creating an ESRI Map visualization that displays areas, page 239.

• Formatting Mode allows you to quickly select and format items in a visualization. For steps, see Using Formatting Mode for visualizations, page 267.

• You can drag and drop objects directly on all visualizations except maps. For background information on visualizations, see Displaying a visual representation of your data: Visualizations, page 179.

• You can create multiple thresholds on the same visualization, including thresholds with multiple conditions that can be based on attributes as well as metrics. For steps, see Adding or removing a threshold in a visualization, page 273.

• You can apply threshold formatting to a metric's values, its subtotals, or both values and subtotals. For steps, see Adding or removing a threshold in a visualization, page 273.
Adding content to dashboards

- You can display images, such as a corporate logo or photo, in your dashboard. For steps to add an image, see *Adding an image, page 312.*

- You can display real-time information from the web, directly in your dashboard, by adding HTML containers. An HTML container displays the contents of a web page or content formatted in HTML. For steps to add an HTML container, see *Adding web content, page 314.*

- You can filter or restrict the data displayed in a visualization, by creating a filter. For example, a user can choose to display data only for selected call coverage regions. You can update the items available in a visualization filter, by creating a filter on the visualization filter. For example, a user can choose a year from one filter. This updates a second filter, which displays quarters only from the chosen year. The user can then display data for a specific year and quarter. For steps to create a filter, see *Creating a filter for the data on a visualization, page 402.*

- You can create a new attribute in your dashboard, based on dataset objects that already included in the dashboard. For a complete description of derived attributes, including examples, and steps to create a derived attribute, see *Creating an attribute based on existing objects: Derived attributes, page 344.*

- You can group attribute elements into a single element, or combine elements with a calculation to create a new element. These elements are displayed on visualizations. For a complete description of groups, including examples, and steps to create them, see *Grouping attribute values in a dashboard, page 349.*

- The new Derived Metric Editor gives you added functionality when creating derived metrics based on metrics already in the dashboard. For example, you can change the level that a derived metric is calculated at. It also helps guide you the process of creating a derived metric. For steps to create derived metrics, see *Creating a metric based on existing objects: Derived metrics, page 318.*

Working with datasets and dataset objects

- You can quickly replace one or multiple datasets in a dashboard, then determine how to replace or remove references to dataset objects from the original dataset. For steps, see *Adding, replacing, and removing datasets in a dashboard, page 152.*
• You can show and hide dataset objects in the Datasets panel. For steps, see *Modifying, renaming, showing, and hiding dataset objects in a dashboard, page 162.*

**Formatting a dashboard**

• You can choose from the Light or Dark display themes to quickly change the overall look and feel of your dashboard. Each display theme contains color palettes for more variety and customization options. A color palette applies to the objects, such as a graph’s bar risers or heat map’s rectangles, displayed in all the visualizations in the dashboard. For steps and examples, see *Formatting a dashboard, page 167.*

**Analyzing data**

• You can select the "only" option in a filter to quickly view data for only one item in the filter. For steps, see *Filtering data in a dashboard, page 451.*

**Analytics Desktop 9.4.1.6**

• For updates to the software requirements of Desktop, see *Software requirements, page 501.*

**Analytics Desktop 9.4.1.5**

• You can create a silent, or automated, installation which is called from a script and executed without user interaction. Silent installations are useful if you do not want users to run the installation themselves. For steps, see *Installing MicroStrategy Desktop with an automatic (silent) installation, page 11.*

• Additional data source support is included in the list of data sources; see *Data source and ODBC driver support, page 504.*
GETTING STARTED WITH MICROSTRATEGY DESKTOP

Introduction

MicroStrategy Desktop provides instant access to your data to create interactive dashboards to display and explore your business data. Using simple, interactive visualizations and pre-defined, presentation-quality formatting, you can quickly display your data in a visually-striking, interactive dashboard, creating data-driven stories in a short time. This data discovery tool empowers you to analyze and understand your data, and easily share those insights with others.

This section provides an overview of MicroStrategy Desktop. It explains how to begin working with MicroStrategy, by installing or upgrading the tool. Next, you are introduced to the features available in MicroStrategy Desktop, with steps to build your first dashboard. For details, see the following:

• *About MicroStrategy Desktop, page 2*
• *Installing MicroStrategy Desktop, page 4*
• *Opening MicroStrategy Desktop, page 16*
• *Building your first dashboard, page 17*
• *Understanding how MicroStrategy works with and stores data, page 49*
About MicroStrategy Desktop

You can quickly create a customized, interactive dashboard and use it to explore your business data with MicroStrategy Desktop. You can explore and analyze data on your own, with minimal technical support—even if this is your first time analyzing data with a visual data discovery tool. MicroStrategy Desktop is a client application, and it allows you to import data from many different sources, including local files, databases, a Google drive, Facebook, and more.

After you import data, you can add visual representations of the data (called visualizations) to make the data easier to interpret, and perform manipulations on the data to customize the information that is included in the dashboard. You can print the dashboard and export it as a PDF file or an image file.

MicroStrategy Desktop allows you to streamline the tasks that are required to create a polished dashboard using the data that you import. For example, you can:

• Quickly add, rearrange, or remove data from a visualization in a dashboard.

• Create additional visualizations to display the data in multiple ways, then easily modify, move, and size visualizations in the dashboard.

• Automatically change how your data is displayed based on the values of your data, by adding thresholds to a dashboard.
- Customize the information that is displayed by adding filters to a dashboard.
- Easily group data in the dashboard, enabling you to switch between and explore subsets of the data.
- Add labels, background information, a description, instructions for the dashboard, and so on by adding text to the dashboard.
- Add images to the dashboard. For example, you can add a corporate logo or photo.
- Display real-time information from the web, directly in your dashboard, by adding HTML containers. An HTML container displays the contents of a web page or content formatted in HTML.

The image below shows a Heat Map visualization in the same dashboard, which displays the data using colored rectangles of different sizes and colors depending on the revenue and profit data for each Call Center. You can format the colors used to display the rectangles, delete rectangles from the display, and change how the size and position of the rectangles is calculated.

For an introduction to the features available in MicroStrategy Desktop, see *Building your first dashboard, page 17*. This section provides steps to import data from a file, create a dashboard with a Heat Map visualization, analyze and manipulate data on the visualization, and share your results with colleagues.
Related topics

- For an introduction to the features available in MicroStrategy Desktop, see Building your first dashboard, page 17.
- For an overview of how to import your data into Desktop, see Importing Data into MicroStrategy Desktop, page 55.
- For steps to create a dashboard, see Creating a dashboard, page 146.
- For descriptions of the types of visualizations that can be added to a dashboard, see Displaying a visual representation of your data: Visualizations, page 179.

Installing MicroStrategy Desktop

MicroStrategy Desktop provides a lightweight installation that shortens the setup time required to quickly create polished, interactive dashboards to display and explore your business data.

Follow the steps below to install MicroStrategy Desktop on a Windows machine. For a Mac, download the MicroStrategy Desktop app from the Apple App Store.

You can create a silent, or automated, installation which is called from a script and executed without user interaction. Silent installations are useful if you do not want users to run the installation themselves or if you want to install the software in bulk to many users. You can also automatically uninstall, repair, and upgrade Desktop. For steps, see Installing MicroStrategy Desktop with an automatic (silent) installation, page 11.

To upgrade an existing installation, see Upgrading and updating MicroStrategy Desktop, page 6.

Prerequisites

- Review the software and hardware requirements, provided in Software requirements, page 501 and Hardware requirements and recommendations, page 503 respectively.
- You must have a Desktop license to install Desktop.
• You must have the following permissions and privileges to install Desktop:
  □ You must log on to the machine using a domain account with Windows administrative privileges for the domain or target machine.
  □ You must have write permissions in the installation directory to complete the installation.

• MicroStrategy Desktop cannot concurrently be installed on a machine that has other MicroStrategy products installed, with the exception of MicroStrategy Office.

---

**To install MicroStrategy Desktop on Windows**

1. Log on to the machine where you are installing MicroStrategy Desktop.
2. Exit all Windows applications before beginning the installation process.
3. Navigate to the download site for MicroStrategy Desktop and download the MicroStrategy Desktop installation files.
4. Locate and run the MicroStrategyDesktop-Version.exe file, where Version is the version number of MicroStrategy Desktop to be installed. For example, to install the 32-bit version of Desktop, run MicroStrategyDesktop-32bit.exe.

   You may have to extract the downloaded files to locate the MicroStrategy-Version.exe file. When extracting the files, ensure that the extraction software maintains the folder structure of the compressed files. Most extraction software maintains the folder structure by default, but if you use WinRAR, ensure that you select the Extract full paths option.

   You may see a message asking if you want to allow the MicroStrategyDesktop.exe program to make changes to the computer. Click **Yes** to permit your machine to open the MicroStrategy Desktop installation file.

   The Welcome page opens.

5. Review the welcome information and click **Next**. The License Agreement page opens.
6 Read the license agreement, and accept the agreement by selecting the check box. If you do not accept the agreement, you cannot install MicroStrategy Desktop.

7 The default location where the MicroStrategy Desktop will be installed is displayed. You can change this if you want to install MicroStrategy Desktop in a different location. Click Change, browse to the location to install MicroStrategy Desktop, and click OK.

8 Click Start to begin the installation of MicroStrategy Desktop. The Progress page opens, which displays the progress of the installation. Once the installation is complete, the Successful Installation page opens.

9 If you want to open MicroStrategy Desktop immediately, select the Launch MicroStrategy Desktop check box.

10 Click Finish.

Related topics

- Opening MicroStrategy Desktop, page 16
- Software requirements, page 501
- Hardware requirements and recommendations, page 503
- Upgrading and updating MicroStrategy Desktop, page 6
- About MicroStrategy Desktop, page 2
- Building your first dashboard, page 17

Upgrading and updating MicroStrategy Desktop

To take advantage of new features and functionality, you can upgrade to the latest version of Desktop.

When you upgrade Desktop from version 9.4.x, you can choose whether or not to save your existing dashboards:

- If you choose to save them, your existing dashboards in Desktop’s My Dashboards folder are moved to C:\Users\UserName\Documents\MicroStrategy\My Dashboards. The existing folder structure is maintained. Note that this process can take some time, depending on the
number of dashboards you have. The dashboards can be opened in the new version of Desktop.

- If you do not save them, your existing dashboards in Desktop’s My Dashboards folder are overwritten during the upgrade.

By default, Desktop automatically checks for updates and notifies you to install an update when it is available. You can also prevent Desktop from automatically checking for updates.

For steps to upgrade and update Desktop, see the following sections:

- To upgrade your version of Desktop on a Windows machine, page 7
- To upgrade your version of Desktop on a Mac machine, page 9
- To prevent Desktop from automatically checking for updates, page 10
- To allow Desktop to automatically check for updates, page 10

**Prerequisites**

- The steps below assume that you have an earlier version of Desktop installed on your computer.
- The computer on which you are upgrading Desktop must be connected to the Internet.
- Review the software and hardware requirements, provided in Software requirements, page 501 and Hardware requirements and recommendations, page 503 respectively.
- You must have the following permissions and privileges to upgrade Desktop:
  - You must log on to the machine using a domain account with Windows administrative privileges for the domain or target machine.
  - You must have write permissions in the installation directory to complete the upgrade.

---

**To upgrade your version of Desktop on a Windows machine**

1. Log on to the machine where you are upgrading Desktop.
2. To open Desktop, double-click the MicroStrategy Desktop icon.
3 If you are working with Desktop, save any work in progress:
   • If you are modifying a dashboard, save the dashboard.
   • If you are importing data, finish importing the data and save the dashboard.

4 On a Windows machine, from the File menu of a dashboard, select Preferences. The Preferences dialog box opens.

5 Click the General tab.

6 Click Check for Updates Now. The MicroStrategy Desktop Update dialog box opens.
   • If the message indicates that your Desktop is the most up-to-date version, click Close to return to the Preferences dialog box.
   • If a newer Desktop version is available, a notification message is displayed. Click Update and continue with these steps.

7 If you have made changes to the current dashboard, you are asked whether or not you want to save the changes.

8 Desktop closes, and the upgrade begins.
   • You may see a message asking if you want to allow the MicroStrategyAnalyticsDesktop.exe program to make changes to the computer. Click Yes to permit your machine to open the Desktop installation file.
   • The InstallShield Wizard opens and prepares the update process. When it is complete, the License Agreement page opens.

9 Read the license agreement, and accept the agreement by selecting the check box. If you do not accept the agreement, you cannot upgrade Desktop.
   Once you have accepted the license agreement, click Next.

10 Do one of the following:
   • To keep your existing dashboards to use them in the updated Desktop, click Yes. Your existing dashboards in Desktop’s My Dashboards folder are moved to C:\Users\UserName\Documents\MicroStrategy\My Dashboards. Note that this process can take some time, depending on the number of dashboards you have.
   • To remove your existing dashboards, click No.
11 The Setup Status page opens, which displays the progress of the dashboard copy (if selected) and the installation. Once the installation is complete, the Successful Installation page opens. Click Finish.

To upgrade your version of Desktop on a Mac machine

1 Log on to the machine where you are upgrading Desktop.

2 To open Desktop, double-click the MicroStrategy Desktop icon.

3 If you are working with Desktop, save any work in progress:
   - If you are modifying a dashboard, save the dashboard.
   - If you are importing data, finish importing the data and save the dashboard.

4 On a Mac machine, from the Desktop menu of a dashboard, select Preferences. The Preferences dialog box opens.

5 Click the General tab.

6 Click Check for Updates Now. The MicroStrategy Desktop Update dialog box opens.
   - If the message indicates that your Desktop is the most up-to-date version, click Close to return to the Preferences dialog box.
   - If a newer Desktop version is available, a notification message is displayed. Click Update and continue with these steps.

7 If you have made changes to the current dashboard, you are asked whether or not you want to save the changes.

8 Desktop closes, and the App Store Update panel is displayed. Click Update. The installer file, MicroStrategy Desktop.pkg, is downloaded.

9 Open the installer file. The License Agreement page opens.

10 Read the license agreement, and accept the agreement by selecting the check box. If you do not accept the agreement, you cannot upgrade Desktop.
   Once you have accepted the license agreement, click Next.
11 Do one of the following:

• To keep your existing dashboards to use them in the updated Desktop, click Yes. Your existing dashboards in Desktop’s My Dashboards folder are moved to C:\Users\UserName\Documents\MicroStrategy\My Dashboards. Note that this process can take some time, depending on the number of dashboards you have.

• To remove your existing dashboards, click No.

12 The Setup Status page opens, which displays the progress of the dashboard copy (if selected) and the installation. Once the installation is complete, the Successful Installation page opens. Click Finish.

To prevent Desktop from automatically checking for updates

1 Do one of the following:

• On a Windows machine, from the File menu of a dashboard, select Preferences.

• On a Mac machine, from the Desktop menu of a dashboard, select Preferences.

The Preferences dialog box opens.

2 Click General.

3 Clear the Check for Updates Automatically check box.

   If you clear Check for Updates Automatically while an update file is being downloaded, the update file will finish downloading, but you will not be prompted to install the update. This update file is downloaded to improve performance in the future if you decide to check for updates.

4 Click OK to return to Desktop.

To allow Desktop to automatically check for updates

1 Do one of the following:

• On a Windows machine, from the File menu of a dashboard, select Preferences.
• On a Mac machine, from the Desktop menu of a dashboard, select Preferences.

The Preferences dialog box opens.

2 Click General.

3 Select the Check for Updates Automatically check box.

When an update is available, a notification message is displayed. For steps to install an update, see To upgrade your version of Desktop on a Windows machine, page 7.

4 Click OK to return to Desktop.

Related topics
• Providing business context to data: Attributes, page 50
• Calculating data: Metrics, page 52
• Software requirements, page 501
• Hardware requirements and recommendations, page 503
• Installing MicroStrategy Desktop, page 4
• Importing Data into MicroStrategy Desktop, page 55

Installing MicroStrategy Desktop with an automatic (silent) installation

On a Windows machine, you can create a silent, or automated, installation which is called from a script and executed without user interaction. Silent installations are useful if you do not want users to run the installation themselves, or if you want to install the software in bulk to many users. You can also automatically uninstall, repair, and upgrade Desktop.

The automatic installation is controlled by the response.ini file. You can create a response.ini file in any text editor and save the file as response.ini in the desired folder. The response.ini file specifies all the selections you want to make during the installation in the MicroStrategy Desktop Installation Wizard. You can either run it with all the MicroStrategy
Desktop Installation Wizard options that are pre-selected, or run it without having to use the wizard at all.

You must save the `response.ini` file as ANSI encoding.

**The response.ini file**

The following table describes the parameters and options for the all the sections, such as Installer, Initial Paths, and so on in the `response.ini` file. It is followed by a sample `response.ini` file for your reference.

The options are case sensitive, therefore they must be entered as indicated in the tables below.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Installer]</td>
<td>Section that begins the installation.</td>
</tr>
<tr>
<td>HideAllDialogs=</td>
<td><code>TRUE</code> or <code>FALSE</code>. Indicates whether the installation uses all default values. <code>FALSE</code> displays all the dialog boxes and you must browse using the Next buttons. The default is <code>FALSE</code>.</td>
</tr>
<tr>
<td>CreateShortcuts=</td>
<td><code>TRUE</code> or <code>FALSE</code>. <code>TRUE</code> creates shortcuts on the Windows Start menu and desktop. The default is <code>TRUE</code>.</td>
</tr>
<tr>
<td>CheckForUpdate=</td>
<td><code>TRUE</code> or <code>FALSE</code>. Indicates whether Desktop automatically checks for updates. <code>TRUE</code> allows the automatic check, which notifies you to install an update when it is available. <code>FALSE</code> prevents the automatic check, so that no external requests are made. The default is <code>TRUE</code>.</td>
</tr>
<tr>
<td>[InitialPaths]</td>
<td>Section for specifying the path for Desktop.</td>
</tr>
<tr>
<td>MicroStrategyDesktop=</td>
<td>Location where Desktop will be installed. If left empty, it takes the default location of:</td>
</tr>
<tr>
<td></td>
<td>• 32-bit Windows environments: <code>C:\Program Files\MicroStrategy\MicroStrategy Desktop</code></td>
</tr>
<tr>
<td></td>
<td>• 64-bit Windows environments: <code>C:\Program Files (x86)\MicroStrategy\MicroStrategy Desktop</code></td>
</tr>
<tr>
<td>[Welcome]</td>
<td>Section for configuring the Welcome dialog box.</td>
</tr>
<tr>
<td>RemoveAll=</td>
<td><code>TRUE</code> or <code>FALSE</code>. The default is <code>FALSE</code>.</td>
</tr>
<tr>
<td></td>
<td>• To uninstall Desktop, use <code>TRUE</code>.</td>
</tr>
<tr>
<td></td>
<td>• To install, repair, or upgrade Desktop, use <code>FALSE</code>.</td>
</tr>
<tr>
<td>[Finish]</td>
<td>Section that specifies the Desktop Installation Wizard Complete dialog box.</td>
</tr>
<tr>
<td>LaunchDesktopAfterInstall=</td>
<td><code>TRUE</code> or <code>FALSE</code>. <code>TRUE</code> opens Desktop after the installation is complete. The default is <code>TRUE</code>.</td>
</tr>
</tbody>
</table>
Sample response.ini file

[Installer]
HideAllDialogs=TRUE
CreateShortcuts=TRUE
CheckForUpdate=TRUE

[InitialPaths]
MicroStrategyDesktop=c:\Program Files (x86)\MicroStrategy\MicroStrategyDesktop

[Welcome]
RemoveAll=FALSE

[Finish]
LaunchDesktopAfterInstall=TRUE

Result codes for the setup.log file

When you run the silent install, you can specify the location and name of the setup.log file, using the -f1 parameter. The log file contains result codes which show whether the silent install completed successfully. The possible result codes are described below:

<table>
<thead>
<tr>
<th>Result Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Success</td>
</tr>
<tr>
<td>-1</td>
<td>General error</td>
</tr>
<tr>
<td>-2</td>
<td>Invalid mode</td>
</tr>
<tr>
<td>-4</td>
<td>Insufficient memory available</td>
</tr>
<tr>
<td>-5</td>
<td>File does not exist</td>
</tr>
<tr>
<td>-6</td>
<td>Cannot write to the response file</td>
</tr>
<tr>
<td>-7</td>
<td>Cannot write to the log file</td>
</tr>
<tr>
<td>-8</td>
<td>Invalid path to the InstallShield silent response file</td>
</tr>
</tbody>
</table>
You can use the steps listed below to silently uninstall, repair, or upgrade Desktop. To uninstall Desktop, the `response.ini` file must contain the following option:

`RemoveAll=TRUE`

### Prerequisites

- Review the software and hardware requirements, provided in *Software requirements, page 501* and *Hardware requirements and recommendations, page 503* respectively.

- You must have the following permissions and privileges to install MicroStrategy Desktop:
  - You must log on to the machine using a domain account with Windows administrative privileges for the domain or target machine.
  - You must have write permissions in the installation directory to complete the installation.

- MicroStrategy Desktop cannot concurrently be installed on a machine that has other MicroStrategy products installed, with the exception of MicroStrategy Office.

- The `response.ini` file must be set up and available to the machine where you are installing MicroStrategy Desktop.

### To automatically install MicroStrategy Desktop on Windows

1. Log on to the machine where you are installing MicroStrategy Desktop.
2 Exit all Windows applications before beginning the installation process.

3 From the Windows Start menu, select **Programs**, then select **Accessories**, and then right-click **Command Prompt** and select **Run as Administrator**. The User Account Control dialog box opens.

The steps to open a Windows command prompt with administrator privileges may be different depending on your version of Windows.

4 Click **Yes** to open the command prompt with administrator privileges. The command prompt is displayed.

5 Run the silent install with the **response.ini** file by typing the following command:

```
INSTALL_PATH\MicroStrategyDesktop_10.0.0.exe
--Responsefile="C:\response.ini" -s -f1"C:\setup.log"
```

- The `-s` parameter indicates that the installation is to be completely silent. If the `-s` parameter is not included in the command, then an interface is displayed during the installation that shows the progress of the installation.

- If the setup program cannot proceed, it terminates and the silent installation is ended. Some examples of reasons for termination are an invalid value for an installation requirement or MicroStrategy Desktop is currently running. You can review any errors in the log file specified in the `-f1` parameter. For a list of the result codes, see **Result codes for the setup.log file, page 13**.

6 After the installation is complete, you can check the result of the installation process. If the silent installation is successful, the resulting code value is zero (**ResultCode=0**) in the **setup.log** file. This is the only indication of the installation being completed if the installation is completely silent and a restart of the machine is not required.

You can review the **MicroStrategyDesktopInstall.log** file, located in the MicroStrategy Desktop installation folder, for complete log information.

**Related topics**

- **Opening MicroStrategy Desktop, page 16**
- **Software requirements, page 501**
Opening MicroStrategy Desktop

You can open MicroStrategy Desktop by doing any of the following:

- To open MicroStrategy Desktop with an empty dashboard, double-click the MicroStrategy Desktop icon. The Getting Started page is displayed, with dashboard samples, tutorial videos, and links to information, such as the discussion forum and online help. To create a new dashboard in Desktop, click Get Started. If a message displays about accessing Getting Started and Quick Tips, click OK to close the message.
  - To skip the Getting Started page the next time that you open Desktop, on the Getting Started page, select the Don’t Show This Again check box. To display the Getting Started page once you are in Desktop, from the Help menu, select Getting Started.
- To display a saved dashboard in Desktop, double-click its .mstr file.
- To create a new dashboard with data imported from an Excel file or a comma-separated value (CSV) file, right-click the file on a Windows machine and select Open with MicroStrategy Desktop. MicroStrategy Desktop opens on the Data Import Preview page. For a description of the Preview page, see Preview page, page 534.

You can open multiple instances of Desktop at the same time on a Windows machine, allowing you to view different dashboards.

The first time that you open Desktop, you are presented with tips to guide you through the process of creating a dashboard. To begin creating your dashboard, click Hide Quick Tips. To display the tips again, from the Help menu, select Quick Tips.

- If you are new to MicroStrategy and creating dashboards, see Building your first dashboard, page 17 for an introduction to the features available in MicroStrategy Desktop. This section provides steps to import data from a file, create a dashboard with a Heat Map visualization, analyze and manipulate data on the visualization, and share your results with colleagues.
• For steps to create dashboards with the full range of MicroStrategy Desktop features, begin by *Importing Data into MicroStrategy Desktop, page 55*, then see *Creating Dashboards and Visualizations, page 145*.

**Related topics**

• *Installing MicroStrategy Desktop, page 4*
• *About MicroStrategy Desktop, page 2*

---

**Building your first dashboard**

This section introduces you to the features available in MicroStrategy Desktop. It provides steps to import data from a file, create a dashboard with a Heat Map visualization, analyze and manipulate data on the visualization, and share your results with colleagues.

This section is for business analysts who are new to MicroStrategy and creating dashboards.

MicroStrategy Desktop includes a wide range of features beyond those covered here as you create your first dashboard. Throughout the section, you will find suggestions to expand your experience of MicroStrategy Desktop beyond the scope of your first dashboard.

At a high level, building your first dashboard consists of the following steps:

1. **Open a blank dashboard.** For steps, see *Opening a new, blank dashboard, page 18*.

2. **Import your data from a file on your computer or network.** For steps, see *Importing your data from a file, page 19*.

3. **Create a Heat Map visualization with your imported data.** For steps, see *Creating a visualization, page 24*.

4. **Format your Heat Map visualization.** For steps, see *Formatting your visualization, page 31*.

5. **Create a filter to limit the data that is displayed on your dashboard.** For steps, see *Adding filters to your dashboard, page 34*. 
6 Add a second visualization to your dashboard. Create a different type of filter that allows the selections that you make in one visualization to automatically update the data displayed in another visualization. For steps, see *Allowing a visualization to update the data displayed in another visualization, page 38.*

7 Analyze your data by filtering and drilling. For steps, see *Analyzing your data, page 41.*

8 Save your dashboard. For steps, see *Saving your dashboard, page 47.*

9 Share your insights with colleagues by exporting your dashboard. For steps, see *Sharing your results, page 48.*

---

**Opening a new, blank dashboard**

A dashboard is an interactive, presentation-quality display that you can create to explore your business data. You begin by opening a new, blank dashboard, as described below.

---

**To open a new, blank dashboard**

1 Double-click the **MicroStrategy Desktop** icon. The Getting Started page is displayed, with dashboard examples, tutorial videos, and links to information.

   - To skip the Getting Started page the next time that you open Desktop, on the Tutorial Videos window, select the **Don’t Show This Again** check box.

2 To create a new dashboard in MicroStrategy Desktop, click **Get Started**.

You explore your data by adding visualizations, or visual representations of your data, to the dashboard. Before you can create a visualization, you must import your data, as described in *Importing your data from a file, page 19.*

The first time that you open MicroStrategy Desktop, a message is displayed to remind you that you can access the Getting Started page or quick tips from the Help menu. Click **OK** to exit the message and begin creating your dashboard. (The quick tips help guide you through the process of creating a dashboard.)
Beyond your first dashboard: Do more with MicroStrategy Desktop

- For other ways to open Desktop, see *Opening MicroStrategy Desktop, page 16.*

Importing your data from a file

You can import and report on personalized data from various data sources. You can then immediately build dashboards without having to “model” your data source.

This section provides steps to import an Excel (.xls or .xlsx), text, or comma-separated values (CSV) file from your computer. You can also import data from additional data sources, such as a database or custom database query (a Freeform query). For a list of the available data sources, and steps to import data, see *Importing Data into MicroStrategy Desktop, page 55.*

Prerequisites

- The following procedure assumes that you have created a new, blank dashboard. For steps, see *Opening a new, blank dashboard, page 18.*

- Since you will be creating a Heat Map visualization in the next section, your imported data must contain one to two attributes, such as Region or Category, and two metrics, such as Profit or Revenue. For background information and examples of attributes and metrics, see *Providing business context to data: Attributes, page 50* and *Calculating data: Metrics, page 52.*

- The steps below assume that you have your data in a simple tabular layout in an Excel, CSV, or text file.

- Depending on the type of file that you are importing, ensure that the file meets the following requirements:
  - For Excel files:
    - Leave cells of data empty to represent NULL values rather than using the text NULL.
    - Determine whether the data for a column is numeric or textual. If a column contains any non-numeric value in its cells, use a text data type. If all values in the column are numeric, a numeric data type can be used.
– Multiple worksheets can be included in the file, but only one worksheet can be uploaded at a time.

– The first worksheet for the file cannot be empty.

– Avoid leaving more than 20 empty rows between column headers and data on the worksheet, so that you will see an accurate preview of your data.

- For CSV files:
  – Leave cells of data empty to represent NULL values rather than using the text NULL.
  – Determine whether the data for a column is numeric or textual. If a column contains any non-numeric value in its cells, use a text data type. If all values in the column are numeric, a numeric data type can be used.
  – Use commas to separate values. No other characters, such as tabs or semicolons, should be used to separate values in the file.
  – The file must use either UTF-8 or UTF-16 encoding.

– Multiple worksheets can be included in the file, but only one worksheet can be uploaded at a time.

– The first worksheet for the file cannot be empty.

– Avoid leaving more than 20 empty rows between column headers and data on the worksheet, so that you will see an accurate preview of your data.

- For text files:
  – Leave cells of data empty to represent NULL values rather than using the text NULL.
  – Determine whether the data for a column is numeric or textual. If a column contains any non-numeric value in its cells, use a text data type. If all values in the column are numeric, a numeric data type can be used.
  – Use commas to separate values. No other characters, such as tabs or semicolons, should be used to separate values in the file.
  – The file must use either UTF-8 or UTF-16 encoding.
To import and save data from a file

1. In the blank dashboard that you created in *Opening a new, blank dashboard, page 18*, click the Add Data icon in the toolbar, and select External Data. The Connect to Your Data page opens.

2. Click File From Disk. The Upload Your Files page opens.

3. Click Choose Files. The Open dialog box is displayed.

4. Navigate to and select a file to import, then click Open. You can select multiple files.

5. Click Prepare Data.

6. If the file is an Excel workbook with more than one worksheet of data, the Select Worksheets dialog box opens. From the list of worksheets, select the check box for the worksheet to import data from. Click Select.

7. The Preview page opens, displaying a preview of the data that will be imported.

8. Hover your cursor over the table that you added, click the menu icon, and select Parse. The Parse Your Data page opens.

9. By default, MicroStrategy Desktop assumes that your data is stored in a simple tabular layout, with each column in the table containing a separate attribute or metric. You can also choose to import data stored in a cross-tabbed layout. These steps assume that you have your data in a simple tabular layout.

   To import data from a simple tabular layout:
   
   a. Select Tabular.
   
   b. By default, MicroStrategy Desktop uses the first row of data as headers for the imported data columns. These column headers are then displayed as the names of the metrics and attributes that you define:

   - **Metrics**: A metric is a business measure or key performance indicator, such as Revenue, Profit, Employee Headcount, Probability of Purchase, and so on.
• **Attributes**: An attribute is a business concept, such as Product, Employee, Month, and so on. Attributes provide a context for metrics.

If the data in the imported file does not include column headers for the data columns, you can specify the column headers manually by doing the following:

a  Select the **Insert new column headers** check box. A default column header is automatically inserted for each data column.

b  To specify a name for a column header, hover the cursor over the column header and click the arrow icon in the top right. Select **Rename**, then type a name for the header in the field and press ENTER.

10 Click **Apply** (at the bottom of the page) to return to the Preview page.

**Define a data column**

11 You can define a data column as a business concept (an attribute, which is shown with this icon: ◆) or a business measure (a metric, which is shown with this icon: 🌐). To change a data column, hover the cursor over the column, then click the arrow icon, and select one of the following:

•  To define the data column as an attribute, point to **Convert to Attribute**.

•  To define the data column as a metric, select **Convert to Metric**.

12 These steps assume that your attributes will have data types automatically assigned by MicroStrategy Desktop. MicroStrategy also offers more detailed options, such as assigning attributes with the Date data type so that you can create analyses over time. If you want to display your data on a map-based visualization, you can assign a geo role to an attribute. For background information about defining your data in more specific detail, see *Previewing your data and specifying data import options, page 121.*

13 To avoid including a data column in the imported data, hover the cursor over the column, click the arrow icon, and select **Do Not Import**.

14 To rename a data column, hover the cursor over the column, click the arrow icon, and select **Rename**. Type a name in the field and press ENTER. The names of data columns are displayed as the names of attributes and metrics.
15 Repeat the appropriate steps above, starting at Define a data column, page 22, for each data column that you want to define.

**Import your data**

16 Click Finish. The data is imported into your dashboard, and is displayed in the Datasets panel.

Next, you add a visualization to your dashboard. For steps, see Creating a visualization, page 24.

**Beyond your first dashboard: Do more with MicroStrategy Desktop**

- For background information about attributes and metrics, see Understanding how MicroStrategy works with and stores data, page 49.

- You can import data from other data sources. For example, you can import data from a database, by writing your own SQL script to choose the data to import from a database, or from your Google account. For a complete list of data sources and steps, see Importing Data into MicroStrategy Desktop, page 55.

- When you import data, MicroStrategy automatically attempts to determine if your data contains geographical information, such as city or country names. You can use this information to display data on map-based visualizations. For background information and steps, see Preparing your data to display on maps: Geo roles, page 135.

- Each column in a table is imported as a separate attribute. If your data contains different attribute forms of the same attribute saved in separate columns, you can create a multiform attribute to combine the forms into a single attribute. An attribute form provides additional descriptive information about a business attribute. For background information on attribute forms, see Providing business context to data: Attributes, page 50. For steps to create a multiform attribute, see Previewing your data and specifying data import options, page 121.

- You can explore your data to evaluate its quality and usability, and then refine your data to improve its quality before you import it into MicroStrategy Desktop. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on. For steps, see Refining your data quality before importing, page 129.
Creating a visualization

A dashboard is an interactive, presentation-quality display that you can create to explore your business data. You explore your data by adding visualizations, or visual representations of your data, to the dashboard. See the following sections:

- For an overview of the MicroStrategy Desktop workspace and how you use it to build a dashboard, see *Understanding the MicroStrategy Desktop workspace, page 25*.

- For steps to add a Heat Map visualization to your dashboard, see *Creating a Heat Map visualization, page 27*. 
Understanding the MicroStrategy Desktop workspace

At a high level, you create a dashboard by dragging and dropping data. The image below shows a dashboard with a Graph visualization, a Grid visualization, and descriptive text:

The Datasets panel on the far left displays all the data in your dataset. In the example above, the name of the dataset is Hawaiian Airlines Data. When you import your data into Desktop, MicroStrategy automatically determines whether each column of data is a metric or an attribute, as follows:

- **Metrics**: Metrics are business measures or key performance indicators, such as Number of Flights and Delay. Numerical data is usually a metric. Metrics are displayed with this icon: 📈.
• **Attributes**: Attributes are business concepts that provide context for metrics. Examples of attributes include Month and Destination Airport. Attributes are displayed with this icon: ◆.

For background information about attributes and metrics, see *Understanding how MicroStrategy works with and stores data, page 49*.

Visualizations and other objects such as images and text are displayed in the center of the interface. In the example above, a bar graph shows Month, which is an attribute, and Number of Flights, which is a metric. The bar risers are colored by Average (Delay (min)), which is another metric. In addition, this dashboard also contains a grid and two text fields, which provide descriptions of the visualizations.

The Editor panel shows which attributes and metrics have been added to the selected visualization. This section of the interface is where you control what data is displayed on a visualization, and where the data is displayed. In this example, Month is displayed on the vertical axis and Number of Flights on the horizontal axis.

To create a visualization, you drag and drop attributes and metrics from the Datasets panel to the Editor panel or onto the visualization. For example, you can add the On Time % metric to the graph by dragging it from the Datasets panel and dropping it in the Editor panel. You can add the Month attribute to the grid, by dragging it from the Datasets panel and dropping it onto the grid.

To quickly change the visualization used to display your data, click the icon of another visualization type in the Visualization Gallery, which is displayed at the far right of the interface. To view data requirements to display a specific visualization, hover your cursor over the icon in the Visualization Gallery.

The tabs on the bottom of the interface represent the different sheets in the dashboard. Each sheet is a layer of data, with its own filtering criteria.

The Filter panel allows you to limit the data that is displayed on the sheet by filtering data. You filter data by dragging and dropping attributes and metrics from the Datasets panel to the Filter panel. You can also filter specific visualizations, using stand-alone filters. Steps to filter data are covered in *Adding filters to your dashboard, page 34*.

**Selecting a visualization: The Heat Map**

A visualization is a visual representation of the data in a dashboard. Because understanding a business takes more than a single perspective,
MicroStrategy offers a library of interchangeable visualizations to provide multiple ways for you to view and interact with your data. You can add visualizations to a dashboard, choose the visualization that makes the most sense for your data and your goals, and quickly duplicate or switch visualizations to get a different view in seconds.

A single dashboard can contain many visualizations, each containing information from a different set of data. Rendering even very complex business analyses in easy-to-understand visualizations means more people can gain insight from them.

A Heat Map visualization is superb for identifying performance patterns. Attention is drawn instantly to color-coded results, and it is easy to understand the impact of multiple business performance indicators at a glance.

This section explains how to create and analyze a Heat Map visualization. For examples of the other visualizations available in MicroStrategy Desktop, and steps to create them, see Displaying a visual representation of your data: Visualizations, page 179.

Creating a Heat Map visualization

A Heat Map visualization is a combination of nested, colored rectangles, each representing an attribute value, or element. In the heat map below, one attribute is Region, and its values are the different regions in the data, such as Central, Mid-Atlantic, Southwest, and so on. You can add a heat map to a dashboard to quickly grasp the state and impact of a large number of
variables at one time. Heat maps are often used in the financial services industry to review the status of a portfolio.

The rectangles contain a wide variety and many shadings of colors, which emphasize the contribution of the various components. In a heat map:

- The size of each rectangle represents its relative weight. In the example above, revenue determines the size of the rectangles. The Revenue metric has been placed in the Size By area on the Editor panel.

- The color of each rectangle represents its relative value. For example, in the image above, larger profit values are green and smaller values are red. The Profit metric has been placed in the Color By area on the Editor panel. The legend, which is hidden in the image, provides the range of values for each color.

- The large areas, such as the 2012 Q4 area of rectangles in the image above, represent different groups of data. The Quarter attribute has been placed in the Grouping area on the Editor panel.
• The small rectangles, such as Central and Mid-Atlantic in the image above, represent individual attribute values. The Region attribute has been placed below the Quarter attribute in the Grouping area on the Editor panel.

Prerequisite

• A heat map requires one to two attributes, such as Region or Category, and two metrics, such as Profit or Revenue. For background information and examples of attributes and metrics, see Providing business context to data: Attributes, page 50 and Calculating data: Metrics, page 52.

To create a Heat Map visualization on a dashboard using your imported data

1 In the dashboard that you created in Opening a new, blank dashboard, page 18, click the Insert Visualization icon on the toolbar. A blank visualization is added to the dashboard.

2 On the Visualization Gallery, click the Heat Map icon.

If the Visualization Gallery is not displayed, click View in the toolbar, then select Visualization Gallery.

3 If the Datasets panel is not displayed, from the View menu, select Dataset Panel.

If you did not import data into the dashboard, the Dataset Panel is empty. You must add data to the dashboard before you can create a visualization. For steps, see Importing your data from a file, page 19.

4 If the Editor panel is not displayed, from the View menu, select Editor Panel.

5 To display the values of an attribute in the visualization, from the Datasets panel, click and drag the attribute to the Grouping area of the Editor panel. In the example above, the heat map is grouped by the Customer Region attribute. A rectangle for each region is displayed in the heat map.

You can drag additional attributes to the Grouping area to group the rectangles in the heat map in a larger area. For example, in the example image above, the Quarter attribute contains the value 2014 Q4 and the Customer Region attribute contains the values Central and Mid-Atlantic.
If Customer Region is placed above Quarter in the Grouping area, an area called Central is displayed in the heat map, with the rectangles 2014 Q4 and 2014 Q3 inside. You can add additional attributes to further group the rectangles in the heat map.

6 Click and drag the metric that determines the size of each rectangle from the Datasets panel to the Size By area. In the visualization, rectangles for large metric values are displayed as larger than rectangles for small metric values. In the example image above, the rectangles are sized by the Revenue metric.

7 The rectangles can be colored automatically based on the value of a metric or based on the values in an attribute. Click and drag the attribute or metric from the Datasets panel to the Color By area. In the example above, the rectangles are colored by the Profit metric.

8 To remove data from the visualization, in the Editor panel, hover the cursor over the name of the object to remove, then click X.

Next, you format your heat map, to change how it displays. For example, you can determine whether a legend, metric values, and labels are displayed. For steps, see Formatting your visualization, page 31.

Beyond your first dashboard: Do more with MicroStrategy Desktop

• MicroStrategy Desktop contains a library of visualizations that provide multiple ways for you to view and interact with your data. For descriptions of the available visualizations and steps to create them, see Displaying a visual representation of your data: Visualizations, page 179.

• You can add more than one visualization to your dashboard.

• You can easily swap visualizations to gain a new perspective on your data. For steps, see Changing the type of visualization displayed, page 246.

• You can display data from multiple datasets on the same visualization. When you import a new dataset into a dashboard, MicroStrategy automatically links attributes in the new dataset to attributes that already exist in the dashboard. You can also link or unlink attributes manually. For details about using multiple datasets in a visualization, see Creating visualizations using data from multiple datasets, page 252.

• You can view the underlying attribute and metric data in a visualization. You can sort or copy this data, create a new Grid visualization using the data in the grid, save the data as a comma-separated values (CSV) file,
and so on. For steps, see *Examining the underlying data in a visualization, page 449.*

- You can add other objects to the dashboard:
  - Text, which can serve as a label for your data or provide background information, a description, or instructions for the dashboard. For steps and examples, see *Adding text, page 307.*
  - Images, such as a corporate logo or photograph. For steps and examples, see *Adding an image, page 312.*
  - Web content, which displays real-time information from the web directly in your dashboard. Web content includes the contents of a web page, such as a stock ticker running in real time or today’s weather forecast, and content formatted in HTML, such as a web-based chat client. For steps and examples, see *Adding web content, page 314.*

- You can create new attributes and metrics based on existing objects, to present your data in different ways:
  - You can create new metrics based on the existing dataset objects on a dashboard. For example, you can subtract the values of one metric from the values of another metrics, such as Revenue - Cost. These new metrics are called derived metrics. For examples and steps, see *Creating a metric based on existing objects: Derived metrics, page 318.*
  - You can create new attributes based on dataset objects that already included in the dashboard. For example, you can combine the geographical region attribute with the state attribute to produce a result like Chicago, Illinois. These new attributes are called derived attributes. For examples and steps, see *Creating an attribute based on existing objects: Derived attributes, page 344.*
  - You can customize your data by grouping multiple attribute values into a single item (called a derived element). For steps and examples, see *Grouping attribute values in a dashboard, page 349.*

**Formatting your visualization**

Once you have added a visualization to a dashboard, you can format the visualization. For example, you can determine the number format in which
to display numeric values, display or hide the visualization’s title bar, apply banding to values in a grid, and so on.

Each type of visualization provides distinct formatting options to enhance your ability to view and read the data. This section assumes that you are formatting a heat map. For information about formatting other types of visualizations, see Formatting visualizations, page 264.

You can format several aspects of a heat map. The following procedure includes steps to determine how rectangles in the visualization are sized and positioned; the position of the header; and whether to show or hide labels, metric values, and the legend.

The following steps do not include all the available formatting options for a heat map; for a full list, see Formatting a Heat Map visualization, page 296. For example, you can format all the text in the heat map, or you can format the headers, labels, legend, and title separately; you can select the background color of the title, the heat map, and the headers.

To format a heat map

1 In the dashboard that you created in Opening a new, blank dashboard, page 18, click the heat map that you added in Creating a visualization, page 24.

2 In the drop-down list at the top of the Properties panel, select Data Exploration.

   • If the Properties panel is not displayed, from the View menu, select Properties.

3 To determine how the heat map’s rectangles are sized and positioned, select one of the following options under Layout:

   • To size the rectangles in the Heat Map visualization to make them as easy to read as possible, select Keep readability, not element order (default).

   • To size and position the rectangles to make them as easy to read as possible, while still attempting to display them in the same order in which they appear in the visualization’s Editor panel, select Balance readability and element order.
To position the rectangles in the Heat Map visualization in the same order in which they appear in the visualization’s Editor panel, select **Keep element order, not readability**.

To determine where the rectangles’ headers are displayed, select one of the following **Headers** options:

- To display the header in the middle of the rectangle, select **In Center** (default).
- To display the header at the top of the rectangle, select **On Top**.

You can choose whether to label each rectangle with the name of the attribute value that it represents. From the **Labels** drop-down list, select one of the following options:

- To show the rectangle labels, select **On** (default).
- To hide the rectangle labels, select **Off**.
- To display the rectangle labels with the size of each label reflecting the size of the rectangle, select **Proportional**. Rectangles that contain large values will be displayed with larger labels than rectangles that contain small values.

You can choose whether to display the metric values for each rectangle in the heat map. For example, you add Region, Profit, and Revenue to the heat map. The heat map displays rectangles for each geographical region. You can select the **Show Metric Values** check box to display the profit and revenue data for the Mid-Atlantic region in the Mid-Atlantic rectangle, the profit and revenue data for the Northeast region in the Northeast rectangle, and so on. Do one of the following:

- To show the metric values, select the **Show Metric Values** check box.
- To hide the metric values, clear the **Show Metric Values** check box (default).

In the drop-down list at the top of the Properties panel, select **Legend**.

You can choose whether to display a legend in the visualization. From the Do one of the following:

- To show the legend, select the **Show Legend** check box (default).
- To hide the legend, clear the **Show Legend** check box.

Next, you add filters to restrict the data displayed in your visualization. For steps, see *Adding filters to your dashboard, page 34*. 
Beyond your first dashboard: Do more with MicroStrategy Desktop

- If you place a metric in the **Color By** area of a heat map, you can change the colors that are applied to the rectangles. This color formatting is automatically applied when the values of a metric fulfill a specific condition, and is called a threshold. For steps to change colors, and to specify the conditions for which colors are applied, see *Adding or removing a threshold in a visualization, page 273.*

- You can apply formatting to numeric values in a visualization. For steps, see *Formatting numeric values in a visualization, page 271.*

- You can add depth to your dashboard by organizing your data in multiple layers. This is useful if you have a large amount of data that you want to analyze and filter in different ways, using many different visualizations. For steps, see *Layering and organizing data for filtering, page 372.*

- Each type of visualization can be formatted in distinct ways. For background information and steps, see *Formatting visualizations, page 264.*

Adding filters to your dashboard

An intuitive filter panel makes it easy to screen data to see only the information that you need. You can filter data based on the values of any attribute or metric to change your view and better understand your data. Simple check boxes, sliders, and radio buttons make filters easy to use, and the impact of your selections is instantly visible.

The filter panel limits the data that is displayed in the visualizations and text on the current sheet. Each sheet in the dashboard is represented by a tab at the bottom of the interface. Each sheet is a layer of data, with its own filtering criteria. Using sheets and filters allows you to create different views of data, using different visualizations and filters.

For example, the graphs shown below are filtered to display only the South, Southeast, and Southwest customer regions. The filter, shown on the left,
displays the available regions and allows you to change what is displayed on the graphs.

You can create the following types of filters:

- You can filter data based on an attribute’s values. For example, a dashboard displays sales data for several different product categories, from 2009 to 2012. You can filter the data in the dashboard to only display sales data for books and movies in 2012. For steps, see To add an attribute filter, page 36.

- You can filter data based on a metric’s values or rank. For example, you can display data only for stores with profit values greater than $100,000 or for the top five most profitable stores. For steps, see To add a metric filter, page 36.

Add a few filters to your dashboard to see this functionality in action.
To add an attribute filter

1 In the dashboard that you created in Opening a new, blank dashboard, page 18, if the Datasets panel is not displayed, from the View menu, select Dataset Panel.

2 If the Filter panel is not displayed, from the View menu, select Filter Panel.

3 From the Datasets panel, click the attribute to use to filter data, and drag it onto the Filter panel. The filter is added to the Filter panel and is automatically named for the selected attribute.

   You can select and add more than one attribute to the Filter panel at a time. Press CTRL and click each attribute to add.

4 By default, the attribute values are displayed in the Filter panel with check boxes. To change how the values are displayed, hover the cursor over the name of the filter that you just added, click the arrow icon, point to Display Style, then select the style to use to display the filter. For example, the Check Boxes style allows multiple selections, while Search Box is useful for a long list of items and Slider is effective for browsing data in a graph.

5 As you select attribute values in the Filter panel, data for the selections is displayed in the visualizations and text on the sheet. You can choose to display data for all values except the selected values. To do this, hover the cursor over the name of the filter that you just added, click the arrow icon and select Exclude.

To add a metric filter

1 In the dashboard that you created in Opening a new, blank dashboard, page 18, if the Datasets panel is not displayed, from the View menu, select Dataset Panel.

2 If the Filter panel is not displayed, from the View menu, select Filter Panel.

3 From the Datasets panel, click the metric to use to filter data, and drag it onto the Filter panel. The filter is added to the Filter panel and is automatically given the name of the selected metric.
4 By default, the metric values are filtered, rather than its rank, and the values are displayed on a slider. Do one of the following:

- To filter the metric values by comparing them to a specific value, rather than choosing them from a slider, hover the cursor over the name of the filter that you just added, then click the arrow icon, point to **Display Style**, and select **Qualification**. A drop-down list of comparison operators is displayed in the Filter panel.

- To filter on the metric’s rank instead of values, complete the following steps:
  
a. Hover the cursor over the name of the filter that you just added, then click the arrow icon, and select **Qualify on Rank**. A drop-down list of operators, such as Highest and Lowest, is displayed above the slider.

   b. To compare the metric’s rank to a specific value, hover the cursor over the name of the filter that you just added, then click the arrow icon, point to **Display Style**, and select **Qualification**. A drop-down list of comparison operators is displayed in the Filter panel.

For steps to use the filter to update the data displayed on the sheet, see *Filtering data in your dashboard, page 41*.

Next, you create a different type of filter that allows you to select the values in one visualization to automatically update the data displayed in another visualization. For steps, see *Allowing a visualization to update the data displayed in another visualization, page 38*.

**Beyond your first dashboard: Do more with MicroStrategy Desktop**

- You can create a metric filter that ranks the values of an attribute. A metric filter calculates the metric for the attributes in the sheet’s visualizations. If a grid contains geographical region and state data, the metrics are calculated for each state, not each region. If you create a metric filter to display the top five profit values, the profit values are calculated for each state. If you want to display the top five most profitable regions, you can create a metric filter that ranks the values of an attribute. For steps, see *Creating a metric filter that ranks the values of an attribute, page 389*.

- As you make choices in the Filter panel, data in the sheet is updated automatically. The data is updated again when you make another change. You can change this behavior so that you control when the update occurs. When filter changes are applied all at once, the Filter panel displays Reset.
and Apply buttons. After you make choices in the Filter panel, click Apply to update the data on the sheet. For steps, see *Applying filter changes individually or all at once, page 394*.

- If you have created multiple attribute filters on a sheet, you can determine whether or not the selections that you make in one attribute filter affect the choices displayed for other attribute filters. You can allow selections made in attribute filters to affect which items are displayed for other attribute filters displayed below them in the Filter panel. You can also specify which attribute filters are affected by selections made in another attribute filter. This allows certain filters to be unaffected by selections made in other filters, and allows an attribute filter to filter a filter placed above it in the Filter panel. For steps, see *Filtering the attribute values displayed in an filter for a sheet, page 395*.

- You can create a filter for the data on a specific visualization, instead of filtering all the data on the current sheet. For steps, see *Creating a filter for the data on a visualization, page 402*.

### Allowing a visualization to update the data displayed in another visualization

Once you have added multiple visualizations to a dashboard, you can filter, drill on, or select values in one visualization (the source) to automatically update the data displayed in another visualization (the target). The steps below show you how to add another visualization and then create a filter that causes your interactions with one visualization to automatically update another visualization.

You can:

- Filter data in the source visualization to update the data displayed in one or more target visualizations. For example, the source visualization contains a list of product categories. When you filter data in the source to include only data for the Movies category, the data in the target is automatically updated to display only data for Movies. Filtering data in the target does not affect the data displayed in the source. You can:
  
  - Filter data in the source to display only data for selected values
  - Filter data in the source to display all data except the data for selected values
  - Undo filtering in the source
For steps to filter a visualization, see *Filtering data in a visualization, page 460*.

- Drill on data in the source visualization to update the data displayed in one or more target visualizations. Drilling allows you to explore data at additional levels of detail beyond what is immediately visible in the visualization. For example, the source visualization contains a list of product categories. When you drill from Category to Subcategory in the source, the target will be updated to display data at the Subcategory level. You can undo drilling to return to the original display. Drilling on data in the target does not affect the data displayed in the source.

For steps to drill on a visualization, see *Analyzing data in a visualization, page 424*.

- Restrict the data displayed in one or more targets by selecting values in the source. For example, if the target displays revenue data across several months and you select January in the source, the data in the target is automatically updated to display revenue data for January only.

- Highlight the data displayed in one or more targets by selecting values in the source. For example, if the target is a heat map displaying delayed flights for several airports and you select BWI in the source, the rectangles for BWI will be highlighted in the heat map.

---

**To add a visualization to your dashboard**

You must add another visualization to your dashboard, because a dashboard must contain at least two visualizations to allow the values in one visualization to filter the values displayed in another visualization. You have already created a heat map (see *Creating a visualization, page 24*) that you will use as the source visualization. Now, create a grid to use as the target visualization for your filter.

1. In the dashboard that you created in *Opening a new, blank dashboard, page 18*, on the toolbar, click the **Insert Visualization** icon. A blank visualization is added to the dashboard.

2. On the Visualization Gallery, click the **Grid** icon.
   - If the Visualization Gallery is not displayed, click **View** in the toolbar, then select **Visualization Gallery**.

3. If the Datasets panel is not displayed, from the **View** menu, select **Dataset panel**.
4 If the Editor panel is not displayed, from the View menu, select Editor Panel.

5 Add data to the grid, by clicking and dragging objects from the Dataset panel to the Editor panel, as described below:
   • To add an attribute to the rows, drag the attribute to the Rows area.
   • To add an attribute to the columns, drag the attribute to the Columns area.
   • To add a metric to the grid, drag the metric to the Metrics area.
   • When you add a metric to the grid, the Metric Names object, an attribute created by MicroStrategy Desktop, is automatically added to the Editor panel. To change whether the metrics are displayed on the rows or columns of the grid, drag and drop the Metric Names object to the Rows or Columns area.

---

To enable a visualization to update the data displayed in another visualization

1 Use the heat map as the source visualization. (You select items in the source to update the data in the target.) Click the arrow icon in the top right of the heat map, then select Use as Filter. The Filtering Options dialog box opens.

2 Under Use VizualizationName to filter the following targets, where VizualizationName is the name of the source visualization, select the check box next to the grid to use as the target.

3 You can either filter or highlight data in the target by selecting values in the source visualization. Select one of the following from the drop-down list next to Data on selection:
   • To filter the data in the target by selecting values in the source, select Filter. Only the values selected in the source are displayed in the target.
   • To highlight the data in the target by selecting values in the source, select Highlight. The target still displays all the values; the values selected in the source are highlighted in the target.

4 If you selected Filter, you can clear your selections in the source visualization and display the data for all values at the same time in any target visualizations. For example, if the source is a grid that allows you to select regions to filter data in the target, you can click the Region header.
to display data for all regions at the same time in the target. Do one of the following:

- To allow clearing your selections in the source, select the **Allow users to clear all selections** check box.
- To disable clearing selections, clear the **Allow users to clear all selections** check box.

5 Click **OK** to apply your changes.

Next, you analyze your data in the heat map. For steps, see *Analyzing your data, page 41.*

**Analyzing your data**

You can analyze data by manipulating the information in a visualization in multiple ways. For example, you can sort, drill, choose to display or hide data for specific values in a visualization, and so on. You can customize your view of the data, update it, and display it instantly. This section will focus on filtering and drilling.

**Filtering data in your dashboard**

You can simultaneously filter all the data displayed in a sheet, to view only the information that you require. A sheet is a layer of data, with its own filtering criteria. Each sheet is represented by a tab at the bottom of the dashboard. When you select values in a filter, the data is updated in all the visualizations and also in any dataset objects displayed in text fields on the sheet. (A dataset object is an attribute or metric from a dataset.) Data is not updated on other sheets in the dashboard.

For example, the Filter panel shown in the example below filters the data on both visualizations. The filter on the Customer Region attribute changes which customer regions are displayed in the heat map and grid. In this
example, only three regions are selected and are therefore the only regions displayed in the visualizations.

You can filter data based on:

- The values of an attribute: You can filter data based on a list of attribute values, as in the example above.

- The values of a metric: You can filter data based on a metric’s values. In the example above, the Revenue metric has been added to the Filter panel, but no selections have been made. The revenue values are displayed along a slider, so that you can choose values to compare metric values to. For example, you can move the slider’s beginning point to $2 million, to filter out any revenue values below that. The Northwest region, which has a revenue of $1,140,415, would no longer be displayed on the heat map or grid.

- The ranking of a metric: You can filter data based on the rank of a metric. For example, you can display the top five most profitable regions.

To filter data in your dashboard

Use the steps in the following table to filter your dashboard.
Prerequisites

- The steps below assume that your dashboard includes at least one filter on the sheet. A sheet filter is displayed on the Filter panel and filters the data for all the visualizations and text fields on a single sheet. For steps to create filters on a dashboard, see *Adding filters to your dashboard, page 34.*

- If the Filter panel is not displayed in the dashboard, from the View menu, select Filter panel.

<table>
<thead>
<tr>
<th>Filter Example</th>
<th>Steps to Use the Filter</th>
</tr>
</thead>
</table>
| If your filter looks similar to the following example, you can select attribute values from the list. | 1 In the Filter panel, locate the filter that contains the attribute to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.  
2 Select each value to display, or select All to choose all of the values at once.  
• If a search box is displayed, you can narrow the list of attribute values displayed as choices in the filter. Type a value in the search box to update the list of results.  
• If you are selecting items in a filter displayed using the Check Boxes style, you can clear all choices and select a single value. Hover the cursor over the value and click Only. |
| ![Filter Example](image1.png) | |
| If your filter looks similar to the following example, you can search for attribute values. | 1 In the Filter panel, locate the filter that contains the attribute to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.  
2 In the search field, type the name, or part of the name, of the attribute value to find.  
3 From the list of results, select the name of the attribute value. The value is added to the list of values included in the filter.  
4 Repeat the steps above to add additional values to the filter.  
5 To remove a value from the filter, click X next to the value to remove. |
| ![Filter Example](image2.png) | |
### Filter Example

<table>
<thead>
<tr>
<th>Filter Example</th>
<th>Steps to Use the Filter</th>
</tr>
</thead>
</table>
| If your filter looks similar to the following example, you can type a date range. | 1 In the Filter panel, locate the filter that contains the date attribute to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.  
2 In the From field, type the beginning date of the date range or select it from the calendar by clicking the Calendar icon.  
3 In the To field, type the end date of the date range or select it from the calendar by clicking the Calendar icon. |
| ![Date Filter](image) | |
| If your filter looks similar to the following example, you can compare metric values or ranks to a selected number. | 1 In the Filter panel, locate the filter that contains the metric to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.  
2 From the drop-down list, select the operator, such as Greater than or Less than, to use to compare data. If the operators include Highest and Lowest, you are comparing the metric rank rather than value.  
3 In the box, type the value to use to filter data, then press ENTER. |
| ![Revenue Filter](image) | 1500 |
| If your filter looks similar to the following example, you can choose metric values or ranks from a slider. | 1 In the Filter panel, locate the filter that contains the metric to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.  
2 If the filter contains a drop-down list of operators, you are filtering on rank. Select the operator, such as Highest or Lowest.  
3 Do one of the following:  
• To filter the metric values by selecting a general range, click and drag the endpoints of the slider to cover the range of values to display. The selected value range is automatically highlighted in blue.  
• To filter the metric values by typing a specific range of values, hover your cursor over the endpoint of a slider. A dialog box is displayed. Type the value to use as the new endpoint of the value range, then press ENTER. |
| ![Revenue Slider](image) | |
To clear filter selections

1. To clear all filter selections for a single filter, and display all the data for the filtered object, in the Filter panel, hover the cursor over the filter, then click the arrow icon displayed next to the filter name, and select **Clear Selections**. All the selections in the filter are cleared and all data for the attribute or metric that the filter is based on is displayed.

2. To clear all selections for all filters on the sheet, hover the cursor over the Filter panel, then click the arrow icon displayed in the top right of the panel, and select **Clear All Selections**. All the selections in the Filter panel are cleared and all data is displayed.

Filtering and drilling on data in a Heat Map visualization

You can filter and drill on data in a single visualization, without affecting the data displayed in any other visualization. Drilling allows you to examine your data at different levels of detail. For example, if you are examining sales data at a regional level, you can choose to drill down to view the same data at the level of individual franchise locations.

In *Allowing a visualization to update the data displayed in another visualization, page 38*, you allowed changes in the heat map to update the data displayed in the grid. These changes include filtering, drilling on, or selecting values. As you follow the steps below to filter, drill, and select values in the heat map, note the changes made in the grid.

Each type of visualization provides different options for manipulating and exploring data in the visualization. This section assumes that you are analyzing data in a heat map. For information about analyzing data in other types of visualizations, see *Analyzing data in a visualization, page 424*.

To drill on or filter data in a heat map

1. In the dashboard that you created in *Opening a new, blank dashboard, page 18*, select one or more rectangles in the heat map to either filter or drill on, by doing one of the following:
   - To select an individual rectangle, click the rectangle in the heat map.
• To select multiple rectangles, press **CTRL**, then click each rectangle to work with.

• To select all the rectangles in a lasso shape, click and drag over an area of the heat map to choose all the rectangles in the area.

2  Do one of the following, depending on whether you want to filter the heat map or drill on the selected rectangles:

• To filter the heat map to view only the selected rectangles and remove all other rectangles from the heat map, select **Keep Only**.

• To filter the heat map to view all rectangles in the heat map except the selected rectangles, select **Exclude**.

• To drill to an object, right-click the selected rectangle, point to **Drill**, and then select the attribute to drill to. For example, to drill to the data at the Category level, select **Drill** and then **Category**. Only the selected rectangles are displayed, and the drill-to attribute that you selected is used to group rectangles in the heat map.

---

**To undo filtering and drilling on data in a heat map**

1  Click the filter icon in the heat map’s title bar. If the title bar is not displayed, hover the cursor over the top left of the heat map to display the filter icon.

2  Choose from the following:

• To remove all filtering and drilling from the heat map at once, select **Clear All**. All filtering and drilling are removed, and are no longer used to filter data in the heat map.

• To remove a single drill or filter, select the drill or filter to remove. The deleted action is no longer used on the heat map.

Next, save your dashboard. For steps, see *Saving your dashboard, page 47*.

---

**Beyond your first dashboard: Do more with MicroStrategy Desktop**

• When you make a change in a filter, data is updated automatically by default. The data is updated again when you make another change. You can change this behavior so that you control when the update occurs. When filter changes are applied all at once instead of individually, an **Apply** button is displayed in the Filter panel. You click the button to
update the data after you make all your changes to the filter. For steps, see *Applying filter changes individually or all at once, page 394.*

- You can interact with the data in each type of visualization in different ways. For information about analyzing data in other types of visualizations, see *Analyzing data in a visualization, page 424.*

- You can create a filter for the data on a specific visualization, instead of filtering all the data on the current sheet. Visualization filters can filter on metric values or ranks, as well as attribute values. For steps, see *Creating a filter for the data on a visualization, page 402.*

**Saving your dashboard**

You can make changes to a dashboard, then save it for easy access at a later date. The entire dashboard, including visualizations, filters, and so on, as well as the associated datasets, is saved as a .mstr file.

---

**To save your dashboard**

1. In the dashboard that you created in *Opening a new, blank dashboard, page 18,* click the Save icon on the toolbar. The Save As dialog box opens.

2. Browse to the folder to save the dashboard in.

3. Type a name and description for the dashboard in the **Name** and **Description** fields.

4. Click OK to save the dashboard. If a dashboard with the same name already exists in the folder, a Confirm Overwrite message is displayed. Click Yes to overwrite the existing dashboard.

Next, you can share your dashboard with others. For steps, see *Sharing your results, page 48.*

**Beyond your first dashboard: Do more with MicroStrategy Desktop**

- After you save a dashboard, you can quickly open it in Desktop by double-clicking its .mstr file. For more ways to open Desktop, see *Opening MicroStrategy Desktop, page 16.*
• You can use the .mstr file to share the dashboard with other users. You can also upload the dashboard from MicroStrategy Desktop to MicroStrategy Web. Other users can open the file in their own environments, then modify the imported dashboard. For steps to upload a dashboard, see Saving a dashboard onto a MicroStrategy server, page 474.

Sharing your results

Once you have created a dashboard, it is easy to share the results of your analysis with your colleagues, by exporting the dashboard.

Exporting a dashboard enables you view and interact with the results outside of Analytics Desktop. For example, you can view the dashboard results in a PDF file within Adobe Reader.

You can export a dashboard to the following formats:

• **Image**: Export the visible portion of the dashboard as an image. The image is saved as a PNG file.

• **PDF file**: Export the dashboard as a PDF.

You can also save the dashboard as a MicroStrategy file, and then share the dashboard and its data with other MicroStrategy users. For steps to save a dashboard, see Saving your dashboard, page 47.

**Prerequisite**

• Save the dashboard before you export it. For steps, see Saving a dashboard, page 175.

---

**To export a dashboard**

1 In the dashboard that you created in Opening a new, blank dashboard, page 18, from the File menu, point to Export and select one of the following:

• To export the dashboard as a PDF file, select PDF.

• To export the dashboard as an image, select Image.

The Save As dialog box opens.
2 Navigate to the location to save the file, then specify a name for the file in the **File Name** field. Click **Save**. The file is saved.

**Beyond your first dashboard: Do more with MicroStrategy Desktop**

- You can export an individual visualization. For steps, see *Exporting a visualization, page 178*.

---

**Understanding how MicroStrategy works with and stores data**

All dashboards have specific business objects placed on them. These objects determine how your data is imported from your data source, how calculations are performed on that data, and how the results are displayed when each dashboard is run.

Objects used on dashboards include such things as:

- **Attributes**: An attribute is a business concept, such as Product, Employee, Month, and so on. Attributes provide a context for metrics, which are business measures. Attributes are based on the data in your data source, and are created when you import data. An attribute on a dashboard serves as a label for a group of metrics. For a more detailed description and examples of attributes, see *Providing business context to data: Attributes, page 50*.

- **Metrics**: A metric is a business measure or key performance indicator, such as Revenue, Profit, Employee Headcount, or Probability of Purchase. From a practical perspective, metrics are the calculations performed on data stored in your database, the results of which are displayed on a dashboard. A metric on a dashboard shows a list of values that are used for analytical calculations. For a more detailed description and examples of metrics, see *Calculating data: Metrics, page 52*.

When you import data into MicroStrategy Desktop, the dataset is stored with the dashboard. A dataset enables you to dynamically manipulate the data that appears on a dashboard, without having to import a new dataset. For example, you can move attributes or metrics on and off a visualization, create new metrics based on the metrics in your dataset, and so on. You can perform the following manipulations on the data in a dashboard without importing a new dataset:
• Display data on the fly: Dynamic aggregation. See *Adding, replacing, and removing data from visualizations*, page 251.

• Filter data on the fly: Filters. See *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages*, page 369

• Create metrics on the fly: Derived metrics. See *Creating a metric based on existing objects: Derived metrics*, page 318.

• Create attributes on the fly: Derived attributes. See *Creating an attribute based on existing objects: Derived attributes*, page 344.

• Combine data from multiple attribute values into a single item: Group. See *Grouping attribute values in a dashboard*, page 349.

Different data source types can access data directly or from memory. Direct data access means that Desktop connects to the data source. If the in-memory data access is used, Desktop retrieves the dataset results from the data sources and stores them in memory. For example, a connected MicroStrategy server can only directly access data, while relational databases can use either method. For a complete list of the available data source types, see *Importing Data into MicroStrategy Desktop*, page 55. For more details about the difference between data access modes, and steps to change how a dataset accesses data, see *Selecting how a dataset accesses its data: Direct data access vs. in-memory*, page 160.

**Providing business context to data: Attributes**

Attributes are the business concepts that are reflected in the data in your data source. Attributes provide a context in which to report on and analyze business facts or calculations.

For example, consider the sales figures of your company. If you were informed that your company had sales of $100,000, you can gather little useful information. To make the sales figure meaningful, you would need to know more about the source of that sales figure, such as:

• A time frame for the sales
• Who and how many people contributed to the sales total
• What products were sold from which departments
• The scope of the sale, such as national, regional, local, or a single store
Attributes provide context for your data to help answer the type of questions listed above. In this example, attributes such as Month, Year, Department, or Region can provide the analytical depth necessary to understand your company sales figures. An attribute on a dashboard serves as a label for a group of metrics.

Attributes are also used to answer business questions about your data at varying levels of detail. For example, a Day attribute allows you to see sales data summarized at the day level, and a Month attribute allows you to see the same sales data summarized at the month level.

Attributes are comprised of attribute elements. An attribute element is a value of an attribute. For example, the attribute City includes the attribute elements New York and Dallas; January, February, and March are elements of the attribute Month.

Attribute forms are additional descriptive information about a business attribute. Most attributes only have the forms ID and Description. But an attribute can have many other forms. For example, the attribute Customer has the forms First Name, Last Name, Address, Email Address, and so on. A form is a descriptive category for any data that your organization saves about any of its attributes.

Attributes are created when you import data into MicroStrategy Desktop. For steps to import data and designate data as attributes, see *Importing Data into MicroStrategy Desktop, page 55*. Attributes are displayed with this icon on the Datasets panel and Editor panel: 🌈.

You can also create new attributes that are based on the attributes in your dataset while you are viewing a dashboard. For example, you can create a Year derived attribute from a Date attribute that is in the format of MMDDYYYY. For steps to create derived attributes, see *Creating an attribute based on existing objects: Derived attributes, page 344*.

You can group data from multiple attribute values into a single item, called a derived element. You can combine attribute values that have been selected from a list or a visualization into a single derived element. You can also combine data from attribute values and derived elements into a calculation that defines a single derived element. For a more detailed description of these types of derived elements, and steps to create them, see *Grouping attribute values in a dashboard, page 349*.

**Related topics**

- *Calculating data: Metrics, page 52*
Metrics are MicroStrategy objects that represent business measures and key performance indicators. From a practical perspective, metrics are the calculations that are performed on data stored in your data source, the results of which are displayed on a dashboard. Metrics are similar to formulas in spreadsheet software.

Metric calculations can show information at simple levels as well as at complex levels of analysis: displaying sales trends, growth patterns, percent-to-total contributions, profit analysis, and so on. Questions such as “What were the sales for the Eastern Region during the fourth quarter?” and “How many employees received a bonus greater than $5000 in the last 3 years?” can easily be answered by metrics.

Specifically, metrics define the analytical calculations to be performed against data that is stored in the data source. A metric is made up of data source facts and the mathematical operations to be performed on those facts, so that meaningful business analysis can be performed on the results. A metric on a dashboard shows a list of values that are used for analytical calculations.

Metrics are displayed with this icon:  

Metrics are created when you import data into MicroStrategy Desktop. You can also create new metrics that are based on the metrics in your dataset while you are viewing a dashboard. For example, you can create a Profit metric from the values of other metrics, such as Revenue - Cost. For steps to import data and designate data as metrics, see Importing Data into MicroStrategy Desktop, page 55. For steps to create new metrics based on the metrics in your dataset, see Creating a metric based on existing objects: Derived metrics, page 318.

Related topics

- Providing business context to data: Attributes, page 50
- Importing Data into MicroStrategy Desktop, page 55
• Creating a metric based on existing objects: Derived metrics, page 318
Introduction

You import data directly into MicroStrategy Desktop, for use in creating dashboards. You can import data from many different data sources, such as an Excel file or a database, or by using the results of a custom database query.

A dataset is a set of data that can be displayed in a dashboard. In Desktop, datasets provide the data to be displayed in a dashboard, in objects such as visualizations, filters, text fields, and so on. You can import data into a new dataset or add the data to an existing dataset. You can select multiple tables to create a single, multi-table dataset.

You can combine different types of data sources in a single dataset. For example, you can import an Excel spreadsheet and then import a table from a relational database, and combine them into a single dataset.

Data sources can access data directly or from memory. Direct data access means that Desktop connects to the data source. If the in-memory data access is used, Desktop retrieves the dataset results from the data sources and stores them in memory. For more details about the difference, and steps to change how a dataset accesses data, see Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160.
For steps to import data from a specific data source, see the appropriate topic below:

<table>
<thead>
<tr>
<th>To Import Data from...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A file in a selected folder, URL, or file URI scheme</td>
<td>Importing data from a file, page 62</td>
</tr>
</tbody>
</table>
| A web page by scraping the page | Importing data by scraping a web page (public data), page 65  
Extracting data from a web page is also known as scraping a web page. |
<p>| An Excel file or a comma-separated value (CSV) file | To quickly import this data, right-click the file and selecting Open with MicroStrategy Desktop. MicroStrategy Desktop opens on the Data Import Preview page. For steps to preview your data, see Previewing your data and specifying data import options, page 121. |
| A database by: | |
| • Picking relational tables | • Importing data from a database by picking relational tables, page 80 |
| • Building a SQL query | • Importing data from a database by building a SQL query, page 67 |
| • Typing a custom database query | • Importing data from a database by typing a query, page 113 |
| Hadoop by: | |
| • Picking relational tables | • Importing data from a database by picking relational tables, page 80 |
| • Building a SQL query | • Importing data from a database by building a SQL query, page 67 |
| • Typing a custom database query | • Importing data from a database by typing a query, page 113 |
| A Salesforce report | Importing data from a Salesforce report, page 107 |
| Google Analytics | Importing data from Google Analytics, page 96 |
| Google BigQuery by: | |
| • Picking relational tables | • Importing data from Google BigQuery, page 99 |
| • Building a SQL query | • Importing data from a database by building a SQL query, page 67 |
| • Typing a custom database query | • Importing data from a database by typing a query, page 113 |</p>
<table>
<thead>
<tr>
<th>To Import Data from...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Google drive</td>
<td>Importing data from a file stored on Google Drive, page 105</td>
</tr>
<tr>
<td>A file stored on Dropbox</td>
<td>Importing data from a Dropbox file, page 91</td>
</tr>
<tr>
<td>The clipboard or a file by copying them, or by typing values</td>
<td>Importing custom data by typing or pasting values, page 83</td>
</tr>
<tr>
<td>Reports and queries in BI tools</td>
<td>Importing data from a BI tool, page 85</td>
</tr>
<tr>
<td>Facebook</td>
<td>Importing data from Facebook, page 93</td>
</tr>
<tr>
<td>Twitter</td>
<td>Importing data from Twitter, page 110</td>
</tr>
<tr>
<td>A sample file provided by MicroStrategy</td>
<td>Importing data from a sample file, page 109</td>
</tr>
<tr>
<td>A MicroStrategy server by:</td>
<td></td>
</tr>
<tr>
<td>• Opening a dashboard stored on the server</td>
<td>• Opening a dashboard saved on a server, page 477</td>
</tr>
<tr>
<td>• Importing a dataset stored on the server</td>
<td>• Importing a dataset from a server, page 481</td>
</tr>
<tr>
<td>• Using data from a project on the server</td>
<td>• Using data from a project on a server, page 483</td>
</tr>
</tbody>
</table>

If the data source that you want to use is not available, you can suggest it as a possible future addition to MicroStrategy Desktop. For steps, see *Suggesting a data source for data import, page 120*.

After you select the data from a data source other than a MicroStrategy server, you can modify and refine the data, as described below, before
importing the data. Data and dashboards imported from a MicroStrategy server do not need to be modified or refined.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview and modify your data, using the Preview page, by:</td>
<td>Previewing your data and specifying data import options, page 121</td>
</tr>
<tr>
<td>• Selecting the worksheet of data to import, if you are importing the data from an Excel workbook with more than one worksheet</td>
<td></td>
</tr>
<tr>
<td>• Adding more data from the same data source or a different one</td>
<td></td>
</tr>
<tr>
<td>• Designating columns of data as attributes or metrics</td>
<td></td>
</tr>
<tr>
<td>• Choosing whether to import your data in a tabular or cross-tabbed layout (for data that is imported from a source other than a database)</td>
<td></td>
</tr>
<tr>
<td>• Inserting column headers into the data, if the file does not provide them (for data that is imported from a source other than a database)</td>
<td></td>
</tr>
<tr>
<td>• Using data columns as attribute forms to define a new, multiform attribute, if your data contains different attribute forms of the same attribute saved in separate data columns</td>
<td></td>
</tr>
<tr>
<td>Wrangle the data.</td>
<td>Refining your data quality before importing, page 129</td>
</tr>
<tr>
<td>Explore your data to evaluate its quality and usability, and then prepare your data to improve its quality.</td>
<td></td>
</tr>
<tr>
<td>Prepare your data to be displayed on a map.</td>
<td>Preparing your data to display on maps: Geo roles, page 135</td>
</tr>
<tr>
<td>Assign geo roles to each data column that contains geographical data. Geo roles indicate that a data column contains geographical information, making it easier to display geographical data on mapping visualizations.</td>
<td></td>
</tr>
<tr>
<td>Improve performance by partitioning a very large dataset and creating search indexes for attributes.</td>
<td>Improving performance: Partitioning large datasets and creating search indexes, page 127</td>
</tr>
<tr>
<td>If you add multiple datasets to a dashboard, you must link the attributes that are shared in common across multiple datasets. Linking the common attributes allows the data in one dataset to relate to the data in other datasets.</td>
<td>Linking data shared across multiple datasets, page 259</td>
</tr>
</tbody>
</table>

After you import data into MicroStrategy Desktop, the dataset is saved in MicroStrategy Desktop’s memory. You can update your saved datasets. For steps, see the appropriate topic below:

- To make changes to your data, such as adding new data columns or changing data types, see *Editing imported data, page 140.*
To update a dataset, by overwriting the existing data or adding to it, see *Refreshing and updating your imported data: Republishing datasets, page 141*.

**Related topics**

- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*
- *Previewing your data and specifying data import options, page 121*
- *Refining your data quality before importing, page 129*
- *Preparing your data to display on maps: Geo roles, page 135*

## Best practices: Importing data into MicroStrategy Desktop

Consider the following best practices before importing data:

- *Importing data from a file, page 59*
- *Importing data from a database, page 61*
- *Updating imported data with new data, page 61*

### Importing data from a file

- If you are importing data from a file that contains cross-tabbed data, be sure to appropriately highlight and specify the cells that contain your metric data, attribute element data, and the names of metric headers, as described in *Importing data from a file, page 62*.

- You can import data from files on your computer or a shared location using a Windows file path. Specifying the location of your file as a Windows file path allows you to easily update your imported data, without having to manually upload the file each time you update it. You can import data from a file:

  - On your computer, using the format `File:///Path/FileName`, where *Path* is the file path in which the file is located and *FileName* is the name of the file.
• In a shared location, using the format File://ComputerName/Path/FileName, where ComputerName is the name of the machine on which the file is located, Path is the file path in which the file is located, and FileName is the name of the file.

• You can import data from http, https, and ftp URLs. Basic authentication is supported during the import process for https and ftp URLs. To support basic authentication, the user name and password must be included as part of the URL. You can include port information in URLs. Question marks in URLs are not supported.

• Depending on the type of file that you are importing, ensure that the file meets the following requirements:
  
  □ For Excel files:
    – Leave cells of data empty to represent NULL values rather than using the text NULL.
    – Determine whether the data for a column is numeric or textual. If a column contains any non-numeric value in its cells, use a text data type. If all values in the column are numeric, a numeric data type can be used.
    – Multiple worksheets can be included in the file, but only one worksheet can be uploaded at a time.
    – Avoid leaving more than 20 empty rows between column headers and data on the worksheet, so that you will see an accurate preview of your data.

  □ For CSV and text files:
    – Leave cells of data empty to represent NULL values rather than using the text NULL.
    – Determine whether the data for a column is numeric or textual. If a column contains any non-numeric value in its cells, use a text data type. If all values in the column are numeric, a numeric data type can be used.
    – Use commas to separate values.
    – The file must use UTF-8, UTF-16, or UTF-32 encoding.
    – Multiple worksheets in a single file can be uploaded at the same time.
Avoid leaving more than 20 empty rows between column headers and data on the worksheet, so that you will see an accurate preview of your data.

**Importing data from a database**

- If you connect to your data source by creating DSNs using the Microsoft ODBC Data Source Administrator, create system DSNs so that MicroStrategy interfaces will recognize them. DSNs are used to establish communication between MicroStrategy Desktop and your database, for data sources that require a DSN to connect, as described in *Creating a data source connection to a relational data source, page 488*. For steps to create a DSN, see *Managing database connections, page 496*.

- When importing data by typing a Freeform query, if you type a multi-pass SQL statement, the data returned will be from the last SELECT pass that you typed in your Freeform script.

- When importing data by typing a Freeform query, ensure that the column names in your source database do not contain spaces or special characters other than underscore (_).

**Updating imported data with new data**

- When you replace your imported data with new data, consider maintaining the same data structure as your original data. Ensure that the names of columns have not changed from the names in the original dataset, so that columns in the new dataset can be accurately matched to attributes and metrics in the original dataset. If columns are missing in the new data, these columns will no longer appear in the updated dataset, and will not be available for displaying on dashboards.

  If the data structure remains the same, MicroStrategy Desktop automatically resaves the new data.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Importing data from a file, page 62*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*
Importing data from a file

You can import data from a file, such as an Excel spreadsheet or a text file, directly into MicroStrategy Desktop to create a dashboard. You can import data from files in a selected folder, URL, or file URI scheme.

Prerequisites

- The following file types can be used to import data:
  - .xls
  - .xlsx
  - .txt
  - .csv
  - .tsv
  - .prn
- You can upload files using a URL link, which imports data from a file using an http, https, or ftp URL. Anonymous authentication (and basic authentication, for https and ftp URLs) is supported during the import process. To support basic authentication, the user name and password must be included as part of the URL. You can include port information in URLs. Question marks in URLs are not supported.
- You can upload files by specifying the location of your file as a file URI scheme. This allows you to easily update your imported data, without having to manually upload the file each time that you update it. You can import data from a file on your computer or in a shared location. Because the file URI scheme is not supported on Apple computers, this option is not available if you are running MicroStrategy Desktop on an Apple machine.
- For text files and CSV files, MicroStrategy Desktop uses English (United States) localization settings to import data. For example, a comma is used as the separator symbol for every three digits.
• For Excel files, MicroStrategy Desktop uses the localization settings specified in the MicroStrategy User Preferences. For steps to specify locale and internationalization settings, see *Specifying the display language preferences, page 618.*

• Password-protected or compressed files (such as .zip files) cannot be used to upload data.

---

**To import data from a file**

1 Open a dashboard by choosing from the following:

   • To create a new, blank dashboard, from the **File** menu in MicroStrategy Desktop, select **New.**

   • To add data to an existing dashboard, from the **File** menu in MicroStrategy Desktop, select **Open.** Navigate to and select the dashboard to run.

2 Do one of the following:

   • To import data into a new dataset, from the toolbar, click the **Add Data** icon, and then select **External Data.** The Connect to Your Data page opens.

   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select **Edit Dataset.** The Preview page opens. Click **Add a New Table.** The Connect to Your Data page opens.

   **Select the data source**

3 Choose one of the following:

   • To import data from a file on your computer or network, click **File From Disk.** The Upload Your Files page opens. Do one of the following:

     □ To drag and drop a file, drag the file onto the interface. You can drag and drop multiple files.

     □ To browse for a file, click **Choose Files.** The Open dialog box is displayed. Navigate to and select a file to import, then click **Open.** You can select multiple files.
• To import data from a file using a URL link or file URI scheme, click **File From URL.** The Upload Your Files page opens. Choose one of the following:

  □ To browse a network path, perform the following steps:

    a Click **Network Browser.**
    b Type the network path in the field, then click **Enter.** The files in the network path are displayed in the Object Name list on the left.
    c Click and drag the files to be imported into the list on the right.

  □ To manually enter the URL or file URI scheme, type the URL or URI in the field, in one of the following formats, and click **Add.** You can add multiple files.

    - `http://Host/Path/FileName`
    - `https://User:Password@Host/Path/FileName`
    - `ftp://User:Password@Host/Path/FileName`
    - `ftp://User:Password@Host:Port/Path/FileName`
    - `File:///Path/FileName`
    - `File://ComputerName/Path/FileName`

    Where `Host` is the host, `Path` is the file path in which the file is located, `FileName` is the name of the file, `Port` is the port number, `User` and `Password` are the username and password that are required to access the file, and `ComputerName` is the name of the machine on which the file is located.

    The File syntax is unavailable if you are running MicroStrategy Desktop on an Apple machine, because the file URI scheme is not supported on Apple computers.

4 If you want to preview and modify your data before importing, click **Prepare Data.** A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see *Previewing your data and specifying data import options, page 121.*

5 Click **Finish.** The selected data is imported into your dashboard as a dataset.
• For steps to work with datasets on a dashboard, see Managing data in a dashboard, page 151.

• For steps to create a dashboard, see Creating a dashboard, page 146.

Related topics

• Importing Data into MicroStrategy Desktop, page 55
• Best practices: Importing data into MicroStrategy Desktop, page 59
• Creating a dashboard, page 146

Importing data by scraping a web page (public data)

You can import data by extracting data from, or scraping, a web page. The imported data is HTML tables in web pages. You can use web scraping to provide online price comparison, identify changes in a website, monitor weather data, and so on.

If you know the web page that you want to import, you can provide its URL. If you have not identified a specific web page, or want to research a topic, you can search Wikipedia for a topic, and from the results, choose the HTML tables in the web pages to import.

Prerequisite

• Read Best practices: Importing data into MicroStrategy Desktop, page 59.

To import data by scraping a web page (public data)

1. Open a dashboard by choosing from the following:

   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
• To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2 Do one of the following:

• To import data into a new dataset, from the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.

• To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

**Select the data source**

3 Click Public Data. The Public Data page opens.

**Select the data to import**

4 Do one of the following:

• To search for data, type the text to search for in the field. For example, you can type "list of states" or "weather forecast". A list of HTML tables that meet the search criteria is displayed.

• To import data from a specific web page, type or copy its URL into the field. The HTML tables in the web page are added to the list.

5 To preview a table, hover your cursor over its row in the list.

6 To view a table, click its link displayed in the Source column.

7 Select the check box in front of each table to import. To import all the tables, click the check box in front of Source.

8 If you want to preview and modify your data before importing, click Prepare Data. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see **Previewing your data and specifying data import options, page 121**.

9 Click Finish. The selected data is imported into your dashboard as a dataset.
For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.

For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*

---

**Importing data from a database by building a SQL query**

You can import data from a database, Google BigQuery, or Hadoop directly into MicroStrategy Desktop, for use in creating dashboards. An intuitive visual interface makes it easy to build the SQL query that imports your data by dragging and dropping tables, selecting columns, defining joins, and specifying filter conditions.

By default, as you select the data to import, MicroStrategy automatically generates the SQL query that is required to select your data from the database. You can choose to customize how your data is imported by changing the SQL query displayed in the Editor panel, just as you would when importing data using a Freeform script (a custom database query). For steps to change the SQL query used to select data from a database, see *Customizing the SQL query used when importing data, page 74*.

You can write your own database queries, called SQL scripts, to retrieve data from a data source. For background information and steps, see *Importing data from a database by typing a query, page 113*.

You can use joins, expressions, aggregations, and filters to define the data to import. Follow the steps below to create joins, expressions, aggregations, and filters.
**Prerequisites**

- Read *Best practices: Importing data into MicroStrategy Desktop, page 59*.
- Importing data from a database requires a connection to a data source. You can create the connection before you begin importing or during the import process. For steps to create a data source connection, see *Creating a data source connection to a relational data source, page 488*.
- If you are importing from Google BigQuery:
  - You must activate the Google BigQuery API on the project’s Google account and enable billing for the project. For steps, refer to the BigQuery documentation.
  - You must configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source, page 498*. You will need the Client ID and Client Secret that Google BigQuery provides when MicroStrategy Desktop is configured as a remote access application.
  - Google BigQuery restricts the amount of data you can import at one time. If your project contains a large amount of data, consider adding filters to your query to retrieve only the data you need. For the most up-to-date data restrictions, see [https://developers.google.com/bigquery/quota-policy#queries](https://developers.google.com/bigquery/quota-policy#queries).
- You can use these steps to access the Salesforce database on a Windows machine. To access Salesforce on a Mac, see *Importing data from a Salesforce report, page 107*.

---

**To import data from a database by building a SQL query**

1. Open a dashboard by choosing from the following:
   - To create a new, blank dashboard, from the **File** menu in MicroStrategy Desktop, select **New**.
   - To add data to an existing dashboard, from the **File** menu in MicroStrategy Desktop, select **Open**. Navigate to and select the dashboard to run.
2  Do one of the following:

- To import data into a new dataset, from the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.

- To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

**Select the data source**

3  Do one of the following:

- To import data from Hadoop, click Hadoop.

- To import data from a specific database in Hadoop, hover your cursor over Hadoop, click List of Databases, and select a database.

  If you select Pig, the Import from Tables page opens, so that you can type a custom database query to import a table. For steps, see *Customizing your SQL query while importing data from Google BigQuery or Hadoop, page 117*.

- To import data from Google BigQuery, complete the following steps:
  a  Click Google BigQuery.
  b  If you are not logged into your Google account, sign in using your Google username and password.
  c  If a message is displayed asking you to allow MicroStrategy to access your Google BigQuery data, select Allow Access.

- To select a specific database, hover your cursor over Database, and select a database from the list of databases.

- To import data from any available data source connection, click Database.

The Select Import Options dialog box opens.

4  Select Build a Query and click Next. The Import from Tables page opens. If you selected a database, only the data source connections that correspond to the selected database are displayed. If you did not select a database, all available data source connections are displayed.
Build a SQL query

5 From the Data Sources panel on the left, select the name of the data source connection that contains the data to import. A list of the database tables in the selected data source is displayed in the Available Tables panel.

You can create a new connection to a data source while importing your data. For steps to create a new data source connection, see Creating a data source connection to a relational data source, page 488.

6 If your data source supports multiple namespaces, you can select a namespace from the drop-down list to display only the database tables within a selected namespace. To search for a namespace, type the namespace in the field. The choices in the drop-down list are filtered as you type.

7 To expand the name of a table and view a list of columns in the table, click the Expand icon next to the table name. Each column in the table is displayed, along with its data type.

8 To filter the list of database tables, type the name of a table in the search field. The list of tables is updated automatically as you type.

9 By default, MicroStrategy creates a cache of the database’s tables and columns when a data source connection is first used.

   • To view a tooltip containing the time the cache was created, hover the cursor over the Information icon at the top of the Available Tables panel.
   • To update the list of available tables, click the Update All icon at the top of the Available Tables panel. The list of namespaces available in the namespace drop-down list is also updated.

Select the data to be imported

10 To add a table to your imported data, click and drag the name of the table from the Available Tables panel to the Editor panel in the middle of the page. The table name is displayed, with a list of the data columns contained in the table.
11 Define the data to import from the table by selecting from the following:

You can refresh the display of the database tables in the Editor panel by clicking the **Update Tables** icon at the top of the Editor panel.

- To include a data column in your imported data, double-click the column. The column name is bolded to indicate that the column will be imported. The column is also added to the Sample Preview panel.

- To include all the data columns in the table in your imported data, double-click **Add all columns** in the top row of the table. The names of the columns are bolded to indicate that the columns will be imported. The columns are also added to the Sample Preview panel.

- To remove a column from being included in your imported data, in the Sample Preview panel, hover the cursor over the name of the column and click the arrow that appears. Click **Delete**. The name of the column is unbolded to indicate that it will not be imported. The column also is removed from the Sample Preview panel.

- To remove a table and all of its columns from the data import, click the **Delete** icon next to the name of the table. The table is removed from the Editor panel, and the columns are removed from the Sample Preview panel.

12 You can add more tables by repeating the steps above, beginning at **Select the data to be imported, page 70**.

13 To import data from multiple tables that have a column of data in common, create a join between the columns of the tables. For example, if the first table contains City_ID and Revenue columns, and the second table contains City_ID and Profit columns, you can relate the data in the tables by creating a join between the City_ID columns.

To create a join, click and drag the name of the column from the first table onto the name of the column from the second table. The join is automatically created and a line representing the join is displayed in the Editor panel, running from the first column to the second column. To change the join type or join operator, or to delete the join, click the line representing the join and select the appropriate option. For more information about joins and detailed steps to define joins, see **Defining joins between columns in database tables, page 78**.

14 To aggregate and import data from a column, in the Editor panel, right-click the name of the column that contains the data to aggregate, point to **Basic Functions**, then select the function to use to aggregate
data. The column with its aggregation function is displayed in the Sample Preview panel.

15 To import data based on an expression on a column, complete the following steps:

a In the Editor panel, right-click name of the column to base the expression on, point to All Functions, point to the type of function to use (such as Math Functions or Logical Operators), and then select the function to use. The Function Arguments dialog box opens.

b Specify the appropriate arguments for the function. For example, for the AddDays function, you need to provide the number of Days to use as the offset.

c Click OK. The Expression dialog box opens, with the function displayed.

d In the Expression pane, modify the expression as needed. You can type additional syntax, or insert an additional function into the expression by doing the following:

a Click the Insert icon.

b Point to Functions, point to the type of function to use (such as Math Functions or Logical Operators), and then select the function to use. The Function Arguments dialog box opens.

c Specify the appropriate options to provide arguments for the function and click OK. Your function is added to the Expression pane.

e To check your condition for valid syntax, click the Syntax validation icon. If the condition is valid, a message is displayed in the bottom of the Expression pane to inform you that your syntax is valid. If the condition is not valid, the message explains the syntax problem.

f To clear the contents of the Expression pane, click Clear.

g When you are finished creating your expression, click Save. The column with its expression is displayed in the Sample Preview panel.

16 To create a simple filter that determines which data to import, complete the following steps:

a In the Editor panel, right-click the name of the column to base the filter on, point to All Filters, point to the type of filter to use (such as Math Basic or String), and then select the filter to use (such as In List or Like). The Enter Value dialog box opens.
b Specify the value or values to compare the data column to. Click **OK**. The Filters dialog box opens.

c Click **OK**. Your filter is automatically created and a filter icon is displayed next to the name of the data column.

For detailed steps to create a filter based on a complex expression and to view a summary of all filters, see *Creating and managing filters to determine which data to import from a database, page 75.*

17 Repeat the appropriate steps above to select and define the data that you want to import.

- If you select multiple tables from the same database instance, and all the tables have the same structure (that is, the same columns and data type), a dialog box opens. You can select whether or not to treat the tables as a single partitioned table.

You can add tables from multiple database instances. Select a different data source connection in the Data Sources panel, and add the table as described above.

18 Once you are satisfied with the data that you have selected, click the **Execute SQL** icon. A preview of your data is displayed in the Sample Preview panel. You can change the SQL query used to select data. For steps, see *Customizing the SQL query used when importing data, page 74.*

19 If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can define data columns as attributes or metrics, automatically generate additional geographic data, change the data type of a data column, and so on. For steps, see *Previewing your data and specifying data import options, page 121.*

20 Click **Finish**. The Save Data Options dialog box opens.

21 Select one of the following:

- To connect live to the database to retrieve data, click **Connect Live**. Connecting live is useful if you are working with a large amount of data, when importing into the dashboard may not be feasible.

- To import all the data into your dashboard, click **Import as an In-memory Dataset**. Importing the data leads to faster interaction with the data, but more RAM memory will be used.
The selected data is available in your dashboard.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

### Customizing the SQL query used when importing data

By default, when you select data to import by dragging and dropping tables, selecting columns, and so on, MicroStrategy automatically generates the SQL query that is required to import your data from the database. You can view and edit the query directly to customize the way that your data is imported.

**Prerequisite**

- The following steps assume that you are in the process of importing data from a database, as described above.

**To change the SQL query used when importing data**

1. On the Import Data from Tables page, click the **Edit SQL** icon. The query that will be used to import your data is displayed in the Editor panel.

2. Type your query in the Editor panel as you would when importing data using a Freeform script. To clear the entire query, click the **Clear** icon. If you type a multi-pass SQL statement, the data returned is from the last SELECT pass that you typed in the Editor panel.

You can undo your changes and return to selecting the data to import, by clicking the **Convert to Query Builder** icon. A confirmation message is displayed, notifying you that any changes that you made while manually editing the query will be reverted. Click **OK**.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Connecting to a Data Source to Import Data, page 487*
Creating and managing filters to determine which data to import from a database

When you are importing data from a database, you can use a filter, or condition, to determine which data to import. Steps to create a simple filter are included in *Importing data from a database by building a SQL query, page 67*. Follow the steps below to:

- Define a more complex filter by using a function (such as Max or If)
- Modify an existing filter
- Specify the operator used to join filter qualifications
- Delete a filter

**Prerequisites**

- The steps below assume that you are importing data from a database by building a SQL query and have added at least one database table to the Editor panel. For steps to import data from a database, see *Importing data from a database by building a SQL query, page 67*.
- To specify the operator used to join filter qualifications, you must create at least two filters.

**To filter the data to import based on a complex expression**

1. On the Editor panel’s toolbar in the Import from Tables page, click **Filter**. The Filters dialog box opens.
2. Click **Add Condition**. The New Condition dialog box opens.
3 In the Expression pane, type the condition that you want to define. As you type, matching objects are displayed in a drop-down list. You can click an object or continue to type.

4 To insert a function into the condition, complete the following steps:
   a Click the Insert icon, point to Functions, point to the type of function to use (such as Logical or Math), and select the function (such as Max or If) to use. The Function Arguments dialog box opens.
   b Type the table name in the text field, and search suggestions are displayed.
   c Select the appropriate options to provide arguments for the function and click OK. Your function is displayed in the Expression pane.

5 To check your condition for valid syntax, click the Syntax validation icon. If the condition is valid, a message appears in the bottom of the Expression pane to inform you that your syntax is valid. If the condition is not valid, the message explains the syntax problem.

6 To clear the contents of the Expression pane, click Clear.

7 Repeat the steps above as appropriate to define your condition.

8 When you are finished editing your condition, click Save to apply your changes. Your filter is created and a filter icon is displayed next to the name of the data column.

To modify a filter that determines the data to import

1 On the Editor panel’s toolbar in the Import from Tables page, click Filter. The Filters dialog box opens with a list of all the filters that you have created.

2 Click the filter to modify. The Condition Editor dialog box opens.

3 In the Expression pane, type the condition that you want to define.

4 To insert a function into the condition, complete the following steps:
   a Click the Insert icon, point to Functions, point to the type of function to use (such as Logical or Math), and select the function (such as Max or If) to use. The Function Arguments dialog box opens.
b Select the appropriate options to provide arguments for the function and click OK. Your function is displayed in the Expression pane.

5 To check your modified condition for valid syntax, click the Syntax validation icon ✓. If the condition is valid, a message is displayed in the bottom of the Expression pane to inform you that your syntax is valid. If the condition is not valid, the message explains the syntax problem.

6 To clear the contents of the Expression pane, click Clear ✗.

7 Repeat the steps above as appropriate to define your condition.

8 When you are finished editing your condition, click Save to apply your changes and save the condition.

9 Repeat the appropriate steps above to continue modifying each filter condition.

10 Click OK to apply your changes.

---

**To specify the operator used to join filter qualifications**

1 On the Editor panel’s toolbar in the Import from Tables page, click Filter. The Filters dialog box opens with a list of all the filters that you have created.

2 By default, the AND operator is used to join filter qualifications. To change the operator, click the And operator between the filters whose operator you want to specify, then click the operator to use, such as And Not or Or.

3 Click OK to apply your changes.

---

**To delete a filter that determines the data to import**

1 On the Editor panel’s toolbar in the Import from Tables page, click Filter. The Filters dialog box opens with a list of all the filters that you have created.

2 Hover the cursor over the filter to delete, then click the Delete Condition icon. The filter is deleted.

3 Click OK to apply your changes.
Defining joins between columns in database tables

When you are importing data from a database, you can use a join to relate data from one table with data from another table. Creating this relationship between data in different tables allows you to include the data from multiple database tables on the same dashboard. The join specifies a column that the two tables have in common. In most cases, an ID column can be used to join two tables. The column used to join tables should keep the records unique, to ensure that the records are combined accurately.

For example, you have a City_ID attribute that uniquely identifies each city in your data source. If your first table contains City_ID and Revenue columns, and the second table contains City_ID and Profit columns, you can relate the data in the tables by creating a join between the two City_ID columns. This allows you to create a dashboard that shows both Revenue and Profit for each city.

Creating a join is important to avoid a cartesian product, or cross join, when MicroStrategy automatically generates the SQL to retrieve data from your database tables.

Follow the steps below to create a join between the columns in two database tables and to select additional options for the join, such as the join type and join operator.

For a detailed explanation of joins, see the Advanced Reporting Guide.

Prerequisite

- The steps below assume that you are importing data from a database by building a SQL query and have added at least two database tables to the Editor panel. For steps to import data from a database, see Importing data from a database by building a SQL query, page 67.

To define a join between the columns of two tables

1. In the Editor panel of the Import from Tables page, click and drag the name of the column from the first table onto the column from the second
table. An inner join is created and a line representing the join is displayed in the Editor panel, running from the column in the first table to the column in the second table.

2 You can specify additional options for the join, such as the join type or join operator. Click the line representing the join, then select one of the following:

- To only include records in which the joined columns from both tables satisfy the join condition, select **Inner Join**.

- To include all records from the column in the first table and only those records from the column in the second table in which the join condition is satisfied, select **Left Outer Join**.

- To include all records from the column in the second table and only those records from the column in the first table in which the join condition is satisfied, select **Right Outer Join**.

  Right Outer Joins are not supported for Google BigQuery data.

- To include all records from both tables, select **Outer Join**.

- To select an operator to use to compare columns, click **More Options**. The Join Options dialog box opens. Do the following:

  a  In the **Join** area, select the join type, such as **Inner Join** or **Left Outer Join**, as described above.

  b  In the **Join Operator** area, select the operator to use to compare columns in the join, such as greater than (<) or equals (=).

  c  Click **OK** to apply your changes.

- To delete the join, select **Delete**.

**Related topic**

- *Importing data from a database by building a SQL query, page 67*
Importing data from a database by picking relational tables

You can import data from a database or Hadoop directly into MicroStrategy Desktop, for use in creating dashboards. An intuitive visual interface makes it easy to build to import your data by dragging and dropping relational tables.

You can also import data from Google BigQuery by picking tables. For steps, see Importing data from Google BigQuery, page 99.

Prerequisites

- Importing data from a database requires a connection to a data source. You can create the connection before you begin importing or during the import process. For steps to create a data source connection, see Creating a data source connection to a relational data source, page 488.

To import data from a database by picking relational tables

1. Open a dashboard by choosing from the following:
   - To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   - To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2. Do one of the following:
   - To import data into a new dataset, from the toolbar, click the Add Data icon  
     , and then select External Data. The Connect to Your Data page opens.
   - To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.
Select the data source

3 Do one of the following:

• To import data from Hadoop, click Hadoop.

• To import data from a specific database in Hadoop, hover your cursor over Hadoop, click List of Databases, and select a database.

   If you select Pig, the Import from Tables page opens, so that you can type a custom database query to import a table. For steps, see Customizing your SQL query while importing data from Google BigQuery or Hadoop, page 117.

• To select a specific database, hover your cursor over Database, and select a database from the list of databases.

• To import data from any available data source connection, click Database.

The Select Import Options dialog box opens.

4 Select Pick Tables and click Next. The Import from Tables page opens. If you selected a specific database, only the data source connections that correspond to the selected database are displayed. If you did not select a database, all available data source connections are displayed.

5 From the Data Sources panel on the left, select the name of the data source connection that contains the data to import. A list of the database tables in the selected data source is displayed in the Available Tables panel.

   You can create a new connection to a data source while importing your data. For steps to create a new data source connection, see Creating a data source connection to a relational data source, page 488.

6 If your data source supports multiple namespaces, you can select a namespace from the drop-down list to display only the database tables within a selected namespace. To search for a namespace, type the namespace in the field. The choices in the drop-down list are filtered as you type.

7 To filter the list of database tables, type the name of a table in the search field. The list of tables is updated automatically as you type.

8 By default, MicroStrategy creates a cache of the database’s tables and columns when a data source connection is first used.
• To view a tooltip containing the time the cache was created, hover the cursor over the **Information** icon 🤝 at the top of the Available Tables panel.

• To update the list of available tables, click the **Update All** icon ⬇️ at the top of the Available Tables panel. The list of namespaces available in the namespace drop-down list is also updated.

**Select the data to be imported**

9. To add a table to your imported data, click and drag the name of the table from the Available Tables panel to the Editor panel in the middle of the page.

10. If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can define data columns as attributes or metrics, automatically generate additional geographic data, change the data type of a data column, and so on. For steps, see *Previewing your data and specifying data import options, page 121*.

11. Click **Finish**. The Save Data Options dialog box opens.

12. Select one of the following:

   • To connect live to the database to retrieve data, click **Connect Live**. Connecting live is useful if you are working with a large amount of data, when importing into the dashboard may not be feasible.

   • To import all the data into your dashboard, click **Import as an In-memory Dataset**. Importing the data leads to faster interaction with the data, but more RAM memory will be used.

13. The selected data is available in your dashboard.

   • For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.

   • For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

• *Importing Data into MicroStrategy Desktop, page 55*

• *Best practices: Importing data into MicroStrategy Desktop, page 59*
Importing custom data by typing or pasting values

You can type or paste data directly into MicroStrategy Desktop using the Create Custom Data page. For example, you can create a quick lookup table by typing product IDs and descriptions directly into MicroStrategy Desktop. You can copy and paste data from a table on a web page, from an Excel worksheet, and so on. You can also edit or republish data that has already been imported.

To type or paste the values to import

1. Open a dashboard by choosing from the following:
   - To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select **New**.
   - To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select **Open**. Navigate to and select the dashboard to run.

2. Do one of the following:
   - To import data into a new dataset, from the toolbar, click the Add Data icon ☰, and then select **External Data**. The Connect to Your Data page opens.
   - To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click **Add a New Table**. The Connect to Your Data page opens.

Select the data source

3. Click **Add Custom Data**. The Create Custom Data page opens.
4 Add data to the worksheet by choosing from the following:

- To type data directly into a cell, click the cell and type a value. When finished, press **ENTER** to apply your changes.

- To copy data in the worksheet or from other applications, highlight the data and press **CTRL + C** (for Mac, use **CMD + C**) to copy it to the clipboard.

- To cut data from the worksheet or from other applications, highlight the data and press **CTRL + X** (for Mac, use **CMD + C**). The data is moved to the clipboard.

- To paste data from the clipboard into the worksheet, click the area on the worksheet to paste the data into and press **CTRL + V**. The data on the clipboard is pasted into the worksheet.

5 You can insert additional rows and columns in which to enter data in the worksheet. Choose from the following:

- To insert a blank row directly above a selected row in the worksheet, select the row and click the **Insert Row** icon.

- To add a blank row to the bottom of the worksheet, click the **Add Row** icon.

- To insert a blank column directly to the left of a selected column in the worksheet, select the column and click the **Insert Column** icon.

- To add a blank column to the right of the worksheet, click the **Add Column** icon.

6 You can delete unneeded data from the worksheet. Choose from the following:

- To clear the contents of one or more cells, rows, or columns, select the data to clear from the worksheet and press **DELETE**. All the selected cells are cleared of data.

- To delete a row, select the row and click the **Delete Row** icon.

- To delete a column, select the column and click the **Delete Column** icon.

7 To clear the worksheet of all data, click the **Clear Sheet** icon.

8 If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For
example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see *Previewing your data and specifying data import options, page 121*.

9 Click **Finish**. The selected data is imported into your dashboard as a dataset.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

⚠️ If you republish the data, or refresh the data after editing it, the clipboard is populated with the final data in the table. This data could be very different from the data that you originally added to the clipboard, depending on the subsequent operations, such as data wrangling or parsing, that you performed on the data.

For example, you copy and paste data into a table, complete some data wrangling which changes the data, and save the dataset. When you refresh the dataset, the Create Custom Data page will contain the final table data by default, with the data wrangling already applied. If you continue with this data, the data wrangling processes are re-applied to the already-wrangled data. You should replace the final data with the original data or an updated version that can accept the data wrangling processes, before uploading it.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*

## Importing data from a BI tool

You can import reports and queries from SAP Business Objects Universe (BO), Oracle Business Intelligence Enterprise Edition (OBIEE), and IBM Cognos Framework Manager directly into MicroStrategy Desktop. This allows you to explore your existing data and data model with MicroStrategy’s intuitive visualizations.
At a high level, the steps to connect to a BI tool and import data consist of the following; each step contains a link to a detailed procedure:

1  Define a connection to a database: While you are importing data from a BI tool, you can choose to create a new database connection, or use an existing connection. For steps to create a database connection, see Connecting to a Data Source to Import Data, page 487.

2  Make an SAP BO, Oracle, or IBM Cognos report or query available as a web service and obtain the URL for your data import query. For background information, see the following:
   •  Creating a web service in SAP BO, page 86
   •  Creating a web service in OBIEE, page 87
   •  Creating a web service in IBM Cognos, page 88

3  Import the data, as described in Importing data from a BI source into Desktop, page 89.

The third-party products discussed in this guide are manufactured by vendors independent of MicroStrategy. MicroStrategy makes no warranty, express, implied, or otherwise, regarding these products, including their performance or reliability.

Obtaining the URL for the query

Creating a web service in SAP BO

For SAP BO, you need to obtain the URL of the query in Web Services Description Language (WSDL). You can use either the SAP BO Query as a Web Service tool or the SAP BO Web Intelligence tool. In either product, complete the following steps:

1  Create a new query for the data that you want to import into MicroStrategy Desktop.
   
   Do not include a prompt in the query.

2  Publish the query as a web service. A URL is created for the query.

3  Click the URL to load the web service definition in a web browser.
4 Click the Web Services Description Language (WSDL) link on the page.

5 Copy the URL from the WSDL page. Use this URL during the data import process.

An example WSDL URL from SAP BO is shown below:

http:///vmafmsap003:6405/dswsbobje/qaawsservices/?wsdl&cuid=AbBc68vTU8RljolUpjjTHa4

The above steps contain high-level information required to use SAP BO with MicroStrategy. See your SAP BO documentation for the latest information.

Creating a web service in OBIEE

For OBIEE, you need to obtain the URL of the query in Web Services Description Language (WSDL). The OBIEE web service is called BI Services for SOA. Although it is installed by default as part of the Oracle Fusion Middleware Control, it is not enabled by default.

Complete the following steps:

1 If it is not already enabled, enable the BI Services for SOA, as described in the steps below:
   a Open the Credentials page of Oracle Fusion Middleware Control.
   b Create a new credential map called oracle.bi.enterprise if it does not exist already.
   c Create a new credential key called wsil.browsing, using any valid repository user name and password. This user name is used for browsing the target web catalog only, not for invoking the report.
   d Restart the entire managed server.

2 View the full listing of the Web Services Inspection Language (WSIL) web services for each OBIEE report by opening http://localhost:portnumber/biservices/inspection in a web browser.

3 Find your report in the web browser, and click its link to execute the report.
4 Copy the URL from the executed report. Use this WSDL URL during the data import process.

An example WSDL URL from OBIEE is shown below:


The previous steps contain high-level information required to use OBIEE with MicroStrategy. See your OBIEE documentation for the latest information.

Creating a web service in IBM Cognos

For IBM Cognos, you need to obtain the URL of the query as XML. You use the IBM Cognos Mashup Service (CMS).

You must have an IBM Cognos SDK license to use CMS.

1 Open the following URL in a web browser to generate the XML that displays Public Folders and My Folders in IBM Cognos. Replace localhost and cognosversion with your information.

http://localhost/cognosversion/cgi-bin/cognos.cgi/rds/wsil

2 Copy the URL for the folder that contains your report, for example, the Public Objects folder. Open that URL.

3 Repeat the previous step until the contents of a folder are reports instead of other folders.

4 Copy the URL for the report. Open that URL. The WSDL URL is displayed. An example is shown below:

http://172.29.156.187/ibmcognos/cgibin/cognos.cgi/rds/wsdl/path/Public%2520Folders/Samples/Models/GO%2520Sales%2520%2528query%2529/Report%2520Studio%2520Report%2520Samples/Cognos%2520Report

5 Replace wsdl in the URL with ReportData and add ?fmt=Dataset to the end of the URL. The revised URL generates the report in XML format. An example is shown below:
http://172.29.156.187/ibmcognos/cgibin/cognos.cgi/rds/ReportData/path/Public%2520Folders/Samples/Models/GO%2520Sales%2520%2528query%2529/Report%2520Studio%2520Report%2520Samples/Cognos%2520Report?fmt=Dataset

6 Copy the revised URL. Use this XML URL during the data import process.

Note the following:

- Only the first table is extracted from a report that contains multiple tables.
- The previous steps contain high-level information required to use IBM Cognos with MicroStrategy. See your IBM Cognos documentation for the latest information.

Importing data from a BI source into Desktop

After you have made the report or query available as a web service and obtained the URL of the query, you can import the data into Desktop.

Prerequisites

- You have created a web service to connect to the report or query in SAP BO, Oracle, or IBM Cognos. You will need the URL of that report or query. For steps, see the following:
  - Creating a web service in SAP BO, page 86
  - Creating a web service in OBIEE, page 87
  - Creating a web service in IBM Cognos, page 88
- An SAP BO query cannot include prompts.
- Only the first table is extracted from an IBM Cognos report that contains multiple tables.
To import data from a BI source

1  Open a dashboard by choosing from the following:
   •  To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   •  To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2  Do one of the following:
   •  To import data into a new dataset, from the toolbar, click the Add Data icon , and then select External Data. The Connect to Your Data page opens.
   •  To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

Select the data source

3  Click BI Sources. The BI Sources page opens.

4  From the Select a connection drop-down list, select the data source to use to import data.

5  You can import multiple reports and queries at the same time; each report or query will create an individual table in the cube. For each report or query to import, complete the following steps:
   a  In the Enter URL field, type the URL for the report or query in SAP BO, Oracle, or IBM Cognos that has been made available as a web service.
   b  Click Add to add the URL to the list of queries.

6  If you want to preview and modify your data before importing, click Prepare Data. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see Previewing your data and specifying data import options, page 121.
7 Click **Finish**. The selected data is imported into your dashboard as a dataset.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*

---

**Importing data from a Dropbox file**

You can import data from a file stored on Dropbox directly into MicroStrategy Desktop.

**Prerequisites**

- Read *Best practices: Importing data into MicroStrategy Desktop, page 59*.
- The following file types can be used to import data:
  - .xls
  - .xlsx
  - .txt
  - .csv
- For text files and CSV files, MicroStrategy Desktop uses English (United States) localization settings to import data. For example, a comma is used as the separator symbol for every three digits.
- For Excel files, MicroStrategy Desktop uses the localization settings specified in the MicroStrategy User Preferences. For steps to specify locale and internationalization settings, see *Specifying the display language preferences, page 618*. 
• Configure the OAuth parameters, as described in Configuring OAuth parameters for a data source, page 498. You will need the Client ID and Client Secret that Dropbox provides when MicroStrategy Desktop is configured as a remote access application.

To import data from a Dropbox file

1 Open a dashboard by choosing from the following:
   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   • To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2 Do one of the following:
   • To import data into a new dataset, from the toolbar, click the Add Data icon , and then select External Data. The Connect to Your Data page opens.
   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

Select the data source

3 Click Dropbox.
   • If you are not logged in to your Dropbox account, log in to Dropbox using your Dropbox user name and password.
   • If a message is displayed asking you to allow MicroStrategy to access the files and folders in your Dropbox, click Allow.

4 Your Dropbox files are displayed on the left. Drag and drop the file to import from the left pane to the right pane. You can drag and drop multiple files.
   • To refresh the contents of your Dropbox account and retrieve the most up-to-date files, click the Refresh icon .
   • To access a different Dropbox account, click Sign Out at the top of the page. Log into the new Dropbox account to display the files and folders in this account.
5 If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see *Previewing your data and specifying data import options, page 121*.

6 Click **Finish**. The selected data is imported into your dashboard as a dataset.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*

**Importing data from Facebook**

You can import data from Facebook into MicroStrategy Desktop.

You can gather valuable business information from Facebook pages, to monitor brand awareness or assess the effectiveness of an advertising campaign, for example. You can import the likes made on a Facebook page, the posts made on the Facebook page, and the likes and comments made on those posts.

**Prerequisites**

- Read *Best practices: Importing data into MicroStrategy Desktop, page 59*.
- Configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source, page 498*. You will need the Client ID and Client Secret that Facebook provides when MicroStrategy Desktop is configured as a remote access application.
To import data from Facebook

1 Open a dashboard by choosing from the following:
   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   • To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2 Do one of the following:
   • To import data into a new dataset, from the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.
   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

Select the data source

3 Click Facebook.

4 Log into your Facebook account and click Authorize App to allow MicroStrategy to access your tweets. The Import Data from Facebook page opens.

Select the data to be imported

5 In the Search for Pages field, type the text to search for and click Search. A list of pages matching your search term is displayed. For each page, its name, category, and number of likes are displayed, with a link to its Facebook profile.

6 You can filter the search by selecting a time frame for user posts. To do this, follow the steps below:
   a Click Advanced Options. The Advanced Options dialog box opens.
   b Do one of the following:
      □ To choose a time frame, select it from the Optional Time Parameters drop-down list. You can choose Last N Minutes, Last
N Hours, Last N Days, Last N Weeks, or Last N Months. Type the number in the Where N field.

- To specify dates, select Custom from the Optional Time Parameters drop-down list. Type the Start Date in MM/DD/YYYY format, or select it from the calendar. Type the End Date in MM/DD/YYYY format, or select it from the calendar. You can use both dates, or only one.

  c  Click OK.

7  To view a page, click the Link button for that page. The page opens in another tab. When you have finished reviewing the page, click the MicroStrategy Web tab.

8  Select the page to import.

9  If you want to preview and modify your data before importing, click Prepare Data. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see Previewing your data and specifying data import options, page 121.

10 Click Finish. The selected data is imported into your dashboard as a dataset.

  a  For steps to work with datasets on a dashboard, see Managing data in a dashboard, page 151.

  b  For steps to create a dashboard, see Creating a dashboard, page 146.

Related topics

- Importing Data into MicroStrategy Desktop, page 55
- Best practices: Importing data into MicroStrategy Desktop, page 59
- Creating a dashboard, page 146
Importing data from Google Analytics

You can import web site statistics data from your Google Analytics account into MicroStrategy Desktop.

You can import Google Analytics data in the following ways:

• By using any of the prebuilt queries in MicroStrategy. You can also use these queries as a starting point for your own specific query, by viewing the query used to retrieve data and modifying it to import the data that you are interested in.

• By creating a Google Analytics query to select specific data to import. You can type your query directly or use the Google Analytics Query Explorer tool to build the query.

The steps below contain both approaches.

Prerequisites

• Read *Best practices: Importing data into MicroStrategy Desktop, page 59.*

• Configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source, page 498.* You will need the Client ID and Client Secret that Google Analytics provides when MicroStrategy Desktop is configured as a remote access application.

To import data from Google Analytics

1 Open a dashboard by choosing from the following:

   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.

   • To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2 Do one of the following:

   • To import data into a new dataset, from the toolbar, click the Add Data icon , and then select External Data. The Connect to Your Data page opens.
• To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select **Edit Dataset**. The Preview page opens. Click **Add a New Table**. The Connect to Your Data page opens.

**Select the data source**

3 Click **Google Analytics**.

• If you are not logged into your Google account, sign in using your Google username and password.

• If a message is displayed asking you to allow MicroStrategy to access your Google Analytics data, select **Allow Access**.

4 Next to **Select your Account, Web Property, and Profile**, click the **Edit** icon.

5 From the **Account** drop-down list, select your Google Analytics account.

6 From the **Web Property** drop-down list, select the web property that contains the data to import. The web property is the set of web pages or applications on which your Google Analytics tracking code is installed.

7 From the **Profile** drop-down list, select the Google Analytics profile to use to import data. The profile (also called a view) determines which subset of data from the web property can be imported.

8 Next to **Select Date Range**, click the **Edit** icon.

9 From the **Select Date Range** drop-down list, select one of the following:

• To import data from a date range that MicroStrategy provides, select the date range, such as Today or This Month.

• To import data from a custom date range, select **Custom Range**. In the **From** field, provide the start date of the range. In the **To** field, type the end date of the range. You can provide the date by:
  - Typing the date in YYYY-MM-DD format.
  - Selecting the date from the calendar.
  - Typing a relative date, in an input supported by the Google Analytics API. For example, you can type `today`, `yesterday`, or `NdaysAgo` where `N` is a positive number.
To import data using a prebuilt query in MicroStrategy or by creating a Google Analytics query to select specific data, do one of the following:

- **To import data based on a prebuilt query in MicroStrategy:**
  a. Select the **Pick a Report** option. A list of reports is displayed in the pane below.
  b. Browse to and select the report.
  c. You can use the report as a starting point, then define filtering, sorting, and additional options for importing data. To do so, hover the cursor over the name of the report and click the **Edit** icon. The query that represents the report is displayed. Edit the query to select the data that you are interested in, as described in the steps below.

- **To import data by creating a Google Analytics query to select data:**
  a. Select the **Write your own query** option. An example query is displayed in the Write Your Own Query pane below, based on the Account, Web Property, Profile, and Date Range options you selected in the steps above.
  b. Edit the example query by typing directly in the pane.
  c. You can edit and update the Account, Web Property, Profile, or Date Range options for the query. Select the appropriate options as described in the steps above, then click **Update Query**. The query is updated to reflect your selections.

  If you selected one of the MicroStrategy-provided date ranges in the Select Date Range area above, your query contains text such as `dynamic-date={Last 3 months}`. This MicroStrategy-specific text is replaced with the appropriate Google Analytics query syntax when your data is imported.

11 If you have made changes to the selections in the Account, Web Property, Profile, or Date Range options and want these changes to be applied to the query, click **Update Query**.

12 If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can define data columns as attributes or metrics, automatically generate additional geographic data, and so on. For steps, see **Previewing your data and specifying data import options, page 121**.
13 Click **Finish**. The selected data is imported into your dashboard as a dataset.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*

**Importing data from Google BigQuery**

You can import data from Google BigQuery into MicroStrategy Desktop by:

- Selecting a single table or multiple tables to import. Steps are provided below.

- Building a SQL query to import a table. For steps, see *Importing data from a database by building a SQL query, page 67*.

- Typing a custom database query to import a table. For steps, see *Importing data from a database by typing a query, page 113*.

**Prerequisites**

- You must activate the Google BigQuery API on the project's Google account and enable billing for the project. For steps, refer to the BigQuery documentation.

- Configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source, page 498*. You will need the Client ID and Client Secret that Google BigQuery provides when MicroStrategy Desktop is configured as a remote access application.

- Google BigQuery restricts the amount of data you can import at one time. If your project contains a large amount of data, consider adding filters to your query to retrieve only the data you need. For the most up-to-date
data restrictions, see https://developers.google.com/bigquery/quota-policy#queries.

• Read Best practices: Importing data into MicroStrategy Desktop, page 59.

---

**To import data from Google BigQuery by picking tables**

1 Open a dashboard by choosing from the following:
   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   • To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2 Do one of the following:
   • To import data into a new dataset, from the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.
   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

**Select the data source**

3 Click Google BigQuery.

4 If you are not logged into your Google account, sign in using your Google username and password.

5 If a message is displayed asking you to allow MicroStrategy to access your Google BigQuery data, select Allow Access. The Select Import Options dialog box opens.

6 Select Pick Tables and then click Next. The Import from Tables page opens.

7 From the Projects panel on the left, select the project that contains the data to import. A list of the tables in the selected project is displayed in the Available Datasets panel.
To display only the tables in a single Google BigQuery dataset in the Available Datasets panel, select the dataset's name from the drop-down list. To search for a dataset, type the name of the dataset in the field.

To view a list of columns in the table, click the arrow icon next to the table name. Each column in the table is displayed, along with its data type. You can filter the list of database tables by typing the name of a table in the search field.

Select the data to be imported

To add a table to your imported data, click and drag the name of the table from the Available Tables panel to the Editor panel in the middle of the page.

If you want to preview and modify your data before importing, click Prepare Data. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can define data columns as attributes or metrics, insert column headers, and so on. For steps, see Previewing your data and specifying data import options, page 121.

Click Finish. The Save Data Options dialog box opens.

Select one of the following:

- To connect live to the database to retrieve data, click Connect Live. Connecting live is useful if you are working with a large amount of data, when importing into the dashboard may not be feasible.

- To import all the data into your dashboard, click Import as an In-memory Dataset. Importing the data leads to faster interaction with the data, but more RAM memory will be used.

The selected data is available in your dashboard.

- For steps to work with datasets on a dashboard, see Managing data in a dashboard, page 151.

- For steps to create a dashboard, see Creating a dashboard, page 146.

Related topics

- Customizing your SQL query while importing data from Google BigQuery or Hadoop, page 117

- Combining data in tables with joins in Google BigQuery, page 102
Combining data in tables with joins in Google BigQuery

You can combine the data in two tables by creating a join between the tables. For example, if the first table contains City and Revenue columns, and the second table contains City and Profit columns, you can relate the data in the tables by creating a join between the City columns.

To combine data in three or more tables, create a join between two of the tables, then create a join between one of those two tables and a third table, and so on, until all of the tables are joined.

The syntax of the JOIN clause that you write depends on the size of the tables you are joining, so it is helpful to know before creating a join whether the tables contain more than 8 MB of compressed data, Google BigQuery's maximum for tables joined with the default JOIN clause. Lookup tables typically do not contain more than 8 MB of compressed data, but fact tables may. The steps below provide steps to create each type of join, depending on the size of the tables you are joining.

Prerequisite

- The steps below assume that you are in the process of importing data from Google BigQuery, and have added at least two tables to the editor pane. For steps to import data from Google BigQuery, see Importing data from Google BigQuery, page 99.

To create a join that combines data in two tables

1. On the Import Data from Tables page, do one of the following:
   - If you know the size of the tables you are joining, do one of the following:
     - If one table contains more than 8 MB of compressed data and the other table does not, click and drag the name of the column from the larger table onto the column from the smaller table. An inner
join is created and a line representing the join is displayed in the editor pane, running from the first column to the second column.

- If both tables contain more than 8 MB of compressed data or both tables contain less than 8 MB of compressed data, click and drag the name of the column from one table onto the column from the other table. The order does not matter. An inner join is created and a line representing the join is displayed in the editor pane, running from the first column to the second column. If the tables you joined contain more than 8 MB of compressed data, edit the SQL query used to import your data, as described in the following steps.

- If you do not know the size of the tables you are joining, click and drag the name of the column from one table onto the name of the column from the second table. Test whether the join you created is valid by clicking the **Execute SQL** icon.

  - If a preview of your data displays in the Data Preview pane below, then the join is valid and was successfully created. The second table that you joined contains less than 8 MB of compressed data.

  - If an error displays stating that the **JOIN** operator's right-side table must be a small table, then the second table that you joined is too large and the join could not be created. Click the join and select **Delete**. Create a new join by clicking and dragging the name of the column from the second table onto the first table. Click the **Execute SQL** icon.

- If a preview of your data displays in the Data Preview pane below, then the join was successfully created.

- If the error message displays a second time, then both tables you are joining contain over 8 MB of compressed data. Edit the SQL query used to import your data, as described in the following steps.

2. You can change the type of join used or delete the join. You can create inner joins or left outer joins between two tables, as described below. Google BigQuery does not support other join types, such as a full outer join or right outer join. In addition, Google BigQuery uses the default equals (=) operator to compare columns and does not support other operators.

To change the type of join used or delete the join, click the line representing the join and select one of the following:

- To only include records in which the joined columns from both tables satisfy the join condition, select **Inner Join** (default).
• To include all records from the column in the first table and only those records from the column in the second table in which the join condition is satisfied, select **Left Outer Join**.

• To delete the join, select **Delete**.

3 If you are creating a join between two tables that contain more than 8 MB of compressed data, you must edit the SQL query used to import your data. Do the following:

a Add any additional columns of data that you want to import. Create any filters, aggregations, or expressions based on the columns that you are importing.

b Once you have defined the data you want to import, from the top of the editor pane, click the **Edit SQL** icon  . The SQL query used to import your data is displayed in the editor pane, as shown in the example query below:

```sql
SELECT github_nested.repository_url repository_url
FROM publicdata:samples.github_nested github_nested
JOIN publicdata:samples.github_nested github_nested_1
    ON (github_nested.repository_url = github_nested_1.repository_url) LIMIT 1
```

c After the word **JOIN**, highlighted in blue, type **EACH**, as shown below:

```sql
SELECT github_nested.repository_url repository_url
FROM publicdata:samples.github_nested github_nested
JOIN EACH publicdata:samples.github_nested github_nested_1
    ON (github_nested.repository_url = github_nested_1.repository_url) LIMIT 1
```

4 Continue importing your data, as described in *Select the data to be imported*, page 101, or customizing your query, as described in *Customizing your SQL query while importing data from Google BigQuery or Hadoop*, page 117.

**Related topics**

• *Importing data from Google BigQuery*, page 99

• *Customizing your SQL query while importing data from Google BigQuery or Hadoop*, page 117
Importing data from a file stored on Google Drive

You can import data from a file stored on Google Drive directly into Desktop Analytics. You can modify your file directly from your Google Drive folder, as with any other folder on your computer.

MicroStrategy does not store Google credentials.

Prerequisites

- The following file types can be used to import data:
  - .xls
  - .xlsx
  - .txt
  - .tsv
  - .prn
  - .csv
- For text files and CSV files, MicroStrategy Desktop uses English (United States) localization settings to import data. For example, a comma is used as the separator symbol for every three digits.
- For Excel files, MicroStrategy Desktop uses the localization settings specified in the Desktop Preferences. For steps to specify locale and internationalization settings, see Specifying the display language preferences, page 618.
- Configure the OAuth parameters, as described in Configuring OAuth parameters for a data source, page 498. You will need the Client ID and Client Secret that Google Drive provides when MicroStrategy Desktop is configured as a remote access application.
To import data from a file on Google Drive

1 Open a dashboard by choosing from the following:
   • To create a new, blank dashboard, from the **File** menu in MicroStrategy Desktop, select **New**.
   • To add data to an existing dashboard, from the **File** menu in MicroStrategy Desktop, select **Open**. Navigate to and select the dashboard to run.

2 Do one of the following:
   • To import data into a new dataset, from the toolbar, click the **Add Data** icon , and then select **External Data**. The Connect to Your Data page opens.
   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select **Edit Dataset**. The Preview page opens. Click **Add a New Table**. The Connect to Your Data page opens.

Select the data source

3 Click **Google Drive**.

4 If you are not logged into your Google account, sign in using your Google username and password.

5 If a message is displayed asking you to allow MicroStrategy to access your Google Drive data, select **Allow Access**.

6 Your Google Drive files are displayed on the left. Drag and drop the file to import from the left pane to the right pane.

7 If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see *Previewing your data and specifying data import options, page 121*. 
8 Click **Finish**. The selected data is imported into your dashboard as a dataset.

- If an error is encountered, a message is displayed. Do one of the following:
  - To ignore the file with the error, click **Yes**.
  - To display the file with the error, click **No**. Fix the error and click **Next**.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Creating a dashboard, page 146*

**Importing data from a Salesforce report**

You can import data from a report stored on Salesforce.com into MicroStrategy Desktop.

- In addition to importing data directly from Salesforce.com reports, you can import data by creating a data source connection to Salesforce.com, then using a Freeform query, such as SQL, SOQL, or XQuery, to select your data. For steps to import data using a Freeform query, see *Importing data from a database by typing a query, page 113*.

**Prerequisites**

- Read *Best practices: Importing data into MicroStrategy Desktop, page 59*.
- Configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source, page 498*. You will need the Client ID and
Client Secret that Salesforce provides when MicroStrategy Desktop is configured as a remote access application.

**To import data from a Salesforce report**

1. Open a dashboard by choosing from the following:
   - To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select **New**.
   - To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select **Open**. Navigate to and select the dashboard to run.

2. Do one of the following:
   - To import data into a new dataset, from the toolbar, click the **Add Data** icon, and then select **External Data**. The Connect to Your Data page opens.
   - To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select **Edit Dataset**. The Preview page opens. Click **Add a New Table**. The Connect to Your Data page opens.

3. Click **Salesforce Reports**. A Salesforce login page opens.

4. Log in to Salesforce.com by typing your Salesforce.com user name and password in the **User Name** and **Password** fields, then click **Log into Salesforce**.

5. Your Salesforce files are displayed on the left. Drag and drop the file to import from the left pane to the right pane.

6. If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can import your data in a tabular or cross-tabbed layout, define data columns as attributes or metrics, insert column headers, and so on. For steps, see *Previewing your data and specifying data import options, page 121*.

7. Click **Finish**. The selected data is imported into your dashboard as a dataset.
• For steps to work with datasets on a dashboard, see Managing data in a dashboard, page 151.

• For steps to create a dashboard, see Creating a dashboard, page 146.

Related topics

• Importing Data into MicroStrategy Desktop, page 55
• Best practices: Importing data into MicroStrategy Desktop, page 59
• Creating a dashboard, page 146

Importing data from a sample file

You can import sample business data provided with MicroStrategy Desktop to get a quick sense of how MicroStrategy's business reporting capabilities can help you explore and analyze your data.

To import data from a sample file

1  Open a dashboard by choosing from the following:

   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.

   • To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2  Do one of the following:

   • To import data into a new dataset, from the toolbar, click the Add Data icon , and then select External Data. The Connect to Your Data page opens.

   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

3  Click Sample Files. The File Samples page opens, listing the available MicroStrategy sample files.
4 Select at least one sample file.

5 If you want to preview and modify your data before importing, click **Prepare Data**. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can define data columns as attributes or metrics. For steps, see *Previewing your data and specifying data import options, page 121*.

6 Click **Finish**. The selected data is imported into your dashboard as a dataset.
   - For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
   - For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Creating a dashboard, page 146*

**Importing data from Twitter**

You can use Desktop to search for tweets via your Twitter account, and import the tweets into Desktop. Twitter can be a valuable resource to explore how your company’s customers are engaging with your products and marketing campaigns.

**Prerequisites**

- Read *Best practices: Importing data into MicroStrategy Desktop, page 59*.

- Configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source, page 498*. You will need the Client ID and Client Secret that Twitter provides when MicroStrategy Desktop is configured as a remote access application.
To import data from Twitter

1. Open a dashboard by choosing from the following:
   • To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   • To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2. Do one of the following:
   • To import data into a new dataset, from the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.
   • To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

Select the data source

3. Click Twitter.

4. Log into your Twitter account and click Authorize App to allow MicroStrategy to access your tweets. The Connect to Twitter page opens.

Select the data to be imported

5. In the Search field, type the text to search for and click Search. A list of tweets matching your search term is displayed.
   • You can use operators to create a more sophisticated search. For a list of the available search operators, click Operators. Click an operator to add it to the search box, and then edit the search string.
   • To search a different Twitter account, click Sign Out at the top of the page. Log into the new Twitter account, and begin your search again.

6. Select the tweet or tweets to import.

7. If you want to preview and modify your data before importing, click Prepare Data. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For
example, you can define data columns as attributes or metrics, insert column headers, and so on. For steps, see Previewing your data and specifying data import options, page 121.

8 Click Finish. The selected data is imported into your dashboard as a dataset.

- For steps to work with datasets on a dashboard, see Managing data in a dashboard, page 151.
- For steps to create a dashboard, see Creating a dashboard, page 146.

Related topics

- Importing Data into MicroStrategy Desktop, page 55
- Best practices: Importing data into MicroStrategy Desktop, page 59
- Creating a dashboard, page 146

Importing data from Hadoop

You can import files and run queries on data stored in a Hadoop Distributed File System. You can import data from Hadoop by:

- Selecting a single table or multiple tables to import. For steps, see Importing data from a database by picking relational tables, page 80.

- Building a SQL query to import a table. For steps, see Importing data from a database by building a SQL query, page 67.

- Typing a custom query to import a table. For steps, see Importing data from a database by typing a query, page 113.

Related topics

- Importing Data into MicroStrategy Desktop, page 55
- Best practices: Importing data into MicroStrategy Desktop, page 59
- Creating a dashboard, page 146
Importing data from a database by typing a query

A Freeform script, or query, is a MicroStrategy feature that allows you to write your own database queries to retrieve data from a relational database, giving you full control over accessing your data. You can import data using a Freeform query directly into MicroStrategy Desktop, for use in creating dashboards. For example, you can import data from a database using SQL, from third-party web services using XQuery, from Salesforce.com using SOQL, or from Hadoop using HiveQL. You can import data from Google BigQuery or Hadoop.

Prerequisites

- Read *Best practices: Importing data into MicroStrategy Desktop*, page 59.

- Importing data from a database requires a connection to a data source. You can create the connection before you begin importing or during the import process. For steps to create a data source connection, see *Creating a data source connection to a relational data source*, page 488.

- If you are importing from Google BigQuery:
  - You must activate the Google BigQuery API on the project’s Google account and enable billing for the project. For steps, refer to the BigQuery documentation.
  - You must configure the OAuth parameters, as described in *Configuring OAuth parameters for a data source*, page 498. You will need the Client ID and Client Secret that Google BigQuery provides when MicroStrategy Desktop is configured as a remote access application.
  - Google BigQuery restricts the amount of data you can import at one time. If your project contains a large amount of data, consider adding filters to your query to retrieve only the data you need. For the most up-to-date data restrictions, see https://developers.google.com/bigquery/quota-policy#queries.

- You can use these steps to access the Salesforce database on a Windows machine. To access Salesforce on a Mac, see *Importing data from a Salesforce report*, page 107.
To import data by typing a Freeform query

1 Open a dashboard by choosing from the following:
   - To create a new, blank dashboard, from the File menu in MicroStrategy Desktop, select New.
   - To add data to an existing dashboard, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2 Do one of the following:
   - To import data into a new dataset, from the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.
   - To add data to a dataset already on the dashboard, click the arrow next to the dataset name in the Datasets panel and select Edit Dataset. The Preview page opens. Click Add a New Table. The Connect to Your Data page opens.

Select the data source

3 Do one of the following:
   - To import data from Hadoop, click Hadoop.
   - To import data from a specific database in Hadoop, hover your cursor over Hadoop, click List of Databases, and select a database.
     - If you select Pig, the Import from Tables page opens, so that you can type a custom database query to import a table. For steps, see Customizing your SQL query while importing data from Google BigQuery or Hadoop, page 117.
   - To import data from Google BigQuery, complete the following steps:
     a Click Google BigQuery.
     b If you are not logged into your Google account, sign in using your Google username and password.
     c If a message is displayed asking you to allow MicroStrategy to access your Google BigQuery data, select Allow Access.
   - To select a specific database, hover your cursor over Database, and select a database from the list of databases.
• To import data from any available data source connection, click Database.

The Select Import Options dialog box opens.

4 Select Type a Query and click Next. The Import from Tables page opens. If you selected a database, only the data source connections that correspond to the selected database are displayed. If you did not select a database, all available data source connections are displayed.

5 From the Data Sources panel on the left, select the name of the data source that contains the data to import. A list of the database tables in the selected data source is displayed in the Available Tables panel.

   You can create a new connection to a data source while importing your data. For steps to create a new data source connection, see Creating a data source connection to a relational data source, page 488.

6 If your database source supports multiple namespaces, you can select a namespace from the drop-down list to display only the database tables within a selected namespace. To search for a namespace, type the namespace in the field. The choices in the drop-down list are filtered as you type.

7 To expand the name of a table and view a list of columns in the table, click the Expand icon next to the table name. Each column in the table is displayed, along with its data type.

8 To filter the list of database tables, type the name of a table in the search field. The list of tables is updated automatically as you type.

9 By default, MicroStrategy creates a cache of the database’s tables and columns when a data source connection is first used.

   • To view a tooltip containing the time the cache was created, hover the cursor over the Information icon.

   • To update the list of available tables, click the Update All icon. The list of namespaces available in the namespace drop-down list is also updated.
10 You can type a Freeform script to select data from the database, or automatically generate the Freeform script to use to select data. Do one of the following:

- To select data from the database by typing a Freeform script, type your script in the Editor panel. If you type a multi-pass SQL statement, the data returned will be from the last SELECT pass that you typed in the Editor panel.

- To automatically generate a Freeform script to select the data from all of the columns in a table, drag and drop the table from the Available Tables panel to the Editor panel. The Freeform script is automatically added to the Editor panel. You can edit the Freeform script as desired. If you have already typed text in the Editor panel, the Freeform script that you just added is automatically highlighted, treated as the last SELECT pass, and will be executed when you click the Execute SQL icon.

- To automatically generate a Freeform script to select the data in a column, drag and drop the column from the Available Tables panel to the Editor panel. The Freeform script is automatically added to the Editor panel. You can edit the Freeform script as desired. If you have already typed text in the Editor panel, the Freeform script that you just added is automatically highlighted, treated as the last SELECT pass, and will be executed when you click the Execute SQL icon.

11 You can delete sections of your Freeform script by deleting text in the Editor panel. To clear the entire Freeform script, click the Clear icon.

**Execute the script**

12 To run your Freeform script, click the Execute SQL icon. A preview of your query results is displayed below the Editor panel in the Data Preview panel.

13 If you want to preview and modify your data before importing, click Prepare Data. A preview of the data to import is displayed on the Preview page. You can modify your data before it is imported. For example, you can define data columns as attributes or metrics, automatically generate additional geographic data, change the data type of a data column, and so on. For steps, see *Previewing your data and specifying data import options, page 121.*

14 Click Finish. The Save Data Options dialog box opens.
15 Select one of the following:

- To connect live to the database to retrieve data, click **Connect Live**. Connecting live is useful if you are working with a large amount of data, when importing into the dashboard may not be feasible.

- To import all the data into your dashboard, click **Import as an In-memory Dataset**. Importing the data leads to faster interaction with the data, but more RAM memory will be used.

16 The selected data is available in your dashboard.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.

- For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Connecting to a Data Source to Import Data, page 487*
- *Managing database connections, page 496*
- *Creating a dashboard, page 146*

### Customizing your SQL query while importing data from Google BigQuery or Hadoop

By default, when you select data from Google BigQuery or Hadoop by dragging and dropping tables, selecting columns, and so on, MicroStrategy automatically generates the SQL query required to import your data from the database. You can view and edit the query directly to customize the way your data is imported, as described in the steps below. You can also undo your customizations and return to using MicroStrategy's visual interface, as described in *To undo customizations to your query, page 119*.
Prerequisite

- The steps below assume that you are in the process of importing data by typing a query. For steps, see "Importing data from a database by typing a query, page 113."

To customize your query

1. On the Import Data from Tables page, click the Edit SQL icon. The query that will be used to import your data is displayed in the Editor panel.

2. Type your query in the editor panel. As you type your custom query, keep in mind the following:
   - Queries are written as single-pass `SELECT` statements. Other standard SQL statements, such as `CREATE`, are not supported by Google BigQuery. For a list of supported SQL clauses, functions, and operators, see the BigQuery Query Reference.
   - When aggregating over a column that has a large number of distinct values, BigQuery recommends that you use a `GROUP EACH BY` clause instead of a `GROUP BY` clause.
   - If you are creating a join between tables, the syntax of the `JOIN` clause that you write depends on the size of the tables that you are joining. It is helpful to know before creating a join whether the tables contain more than 8 MB of compressed data, Google BigQuery's maximum for tables joined with the default `JOIN` clause. Lookup tables typically do not contain more than 8 MB of data, but fact tables can. If you do not know the size of the tables you are joining, see "Combining data in tables with joins in Google BigQuery, page 102" for steps to create a join between tables without knowing their size.
   - If you are creating a join on two tables and one of the tables contains less than 8 MB of data, the smaller table must be on the right side of the `JOIN` clause. In the sample code shown below, the underlined table is the smaller table.

```sql
SELECT github_nested.repository.owner WJXBF50,
github_nested.repository.name WJXBF51,
github_nested.repository.description WJXBF52
FROM publicdata:samples.github_nested github_nested
JOIN publicdata:samples.github_timeline github_timeline
ON (github_nested.repository.owner = github_timeline.repository_owner)
WHERE (github_nested.repository.owner like 'JumstartLab'
or github_nested.repository.owner like 'bitcoin')
```
If both tables contain less than 8 MB of data, the order of the tables in the JOIN clause does not matter.

If you are creating a join on two tables and both tables contain more than 8 MB of data, use a JOIN EACH clause, for example, FROM table1 JOIN EACH table2.

If you are combining data from three or more tables and only one table contains more than 8 MB of data, use normal JOIN clauses, with the large table on the left side of the first JOIN clause. In the sample code below, the underlined table is the largest table.

```
select github_nested.repository.url Repository.url
from publicdata:samples.github_nested github_nested
join publicdata:samples.github_timeline github_timeline
    on (github_nested.repository.url = github_timeline.repository_url)
join publicdata:samples.wikipedia wikipedia
    on (github_nested.repository.name = wikipedia.title)
```

If you are combining data from three or more tables and two or more tables contain more than 8 MB of data, use JOIN EACH clauses, for example, FROM table1 JOIN EACH table2 JOIN EACH table3.

3 To run your custom query, click the Execute SQL icon 🔂. A preview of your query results is displayed in the Data Preview pane below.

4 Once you are satisfied with the results, you can finish importing your data, starting with Execute the script, page 116.

To undo customizations to your query

If you have chosen to edit your query directly, you can undo your customizations and return to selecting the data that you want to import by dragging and dropping data on the editor panel.

1 Click the Convert to Query Builder icon 🚚. A confirmation message is displayed, notifying you that any changes that you made while manually editing the query will be reverted.

2 Click OK.

Related topics

- Importing data from Google BigQuery, page 99
Suggesting a data source for data import

If the data source that you want to use is not available, you can suggest it as a possible future addition to Desktop by sending an email to MicroStrategy.

Prerequisites

- A dashboard is already open. For steps, see Opening MicroStrategy Desktop, page 16.
- You must be connected to the Internet.

To suggest a data source for data import

1. From the toolbar, click the Add Data icon 🔄. The Connect to Your Data page opens.
2. Click Suggest a Data Source.
3. An email is created in your default email program. The email will be sent to product feedback at MicroStrategy, and the subject is automatically set to Analytics Desktop: New Data Source Suggestion.
4. Type a message indicating the new data source that you would like to use, and why it is important to you.
5. Click Send.

Related topic

- Importing Data into MicroStrategy Desktop, page 55
Previewing your data and specifying data import options

When you import data into MicroStrategy Desktop, a preview of your data is displayed. You can select options to modify your data before it is imported, or make changes to your data after it has been imported. For example, MicroStrategy Desktop automatically designates data columns in your file as attributes or metrics based on the values contained in each data column, with attributes displayed in blue with an attribute icon and metrics displayed in orange with a metric icon. You can manually designate data columns as attributes or metrics before the dataset is saved.

You can:

• Display a preview of the data before it is imported.
• Select the worksheet of data to import, if you are importing the data from an Excel workbook with more than one worksheet.
• Add more data from the same data source or a different one.
• Remove a table from the import process.
• Designate a data column of data as an attribute or a metric.

To quickly convert multiple attributes to metrics, or multiple metrics to attributes, use the All Objects View page, page 536.

• Assign a geo role to a data column, to generate additional geographical data and to allow for easier integration with map-based visualizations.
• Use data columns as attribute forms to define a new, multiform attribute, if your data contains different attribute forms of the same attribute saved in separate data columns.
• Divide a very large dataset into multiple segments, called partitions, to improve the performance of your dashboard. For reasons to use partitions and the steps to create them, see Improving performance: Partitioning large datasets and creating search indexes, page 127.
• Define attribute relationships, which are associations between attributes that specify how attributes are connected. The relationships give meaning to the data by providing logical associations of attributes based on business rules. For steps to define attribute relationships, see Defining relationships between attributes, page 138.
For data that is imported from sources other than a database, you can also:
- Choose whether to import your data in a tabular or cross-tabbed layout
- Insert column headers into the data, if the file does not provide them

Steps to perform these tasks are below.

**Prerequisites**

- This procedure assumes that you have already begun importing data. The Preview page is displayed after you select a data source to import from, select the data to import, and click **Prepare Data**. For a list of the data sources that you can import from, and links to steps to import data, see *Importing Data into MicroStrategy Desktop, page 55*.
- Read *Best practices: Importing data into MicroStrategy Desktop, page 59*.

### To specify data import options using the Preview page

1. If you are importing data from an Excel workbook with more than one worksheet of data, the Select Worksheets dialog box opens. From the list of worksheets, select the check box for the worksheet to import data from. Click **Select**.

2. The Preview page opens, displaying a preview of the data that will be imported. If you selected multiple files to create a multi-table dataset, you can change which file is previewed by clicking a different table.

3. To add more data to this dataset, click **Add a New Table**. The Connect to Your Data page opens. Import the data, as described in *Importing Data into MicroStrategy Desktop, page 55*. After you select a data source and the data to import, click **Prepare Data** to return to the Preview page.

4. If you added a table that you do not want to import, you can remove it. Hover your cursor over the table to remove, click the menu icon, and select **Delete**.

5. Hover your cursor over the table to modify, click the menu icon, and select **Parse**. The Parse Your Data page opens.

   - The Parse option is not available if you are importing data from a database. Continue specifying data import options beginning with *Define a data column, page 124*. 


By default, MicroStrategy Desktop assumes that your data is stored in a simple tabular layout, with each column in the table containing a separate attribute or metric, as shown in the image below.

You can also import data stored in a cross-tabbed layout, with attributes and metrics stored in both table rows and columns. An example of a crosstabbed table is shown in the image below.

Select one of the following options:

- To import data from a simple tabular layout, select **Tabular**. By default, MicroStrategy Desktop uses the first row of data as headers for the imported data columns. These column headers are then displayed as the names of the attributes and metrics that you define.

  If the data in the imported file does not provide column headers for the data columns, you can specify the column headers manually by doing the following:

  a  Select the **Insert new column headers** check box. A default column header is automatically inserted for each data column.

  b  To specify a name for a column header, hover the cursor over a column, then click the arrow icon in the top right. Select **Rename**, then type a name for the header in the field and press ENTER.

- To import data from a cross-tabbed layout, select **Crosstab**. A preview of your data is displayed, with cells of data that contain metric data, attribute data, and metric header names each displayed in
separate colors. The legend in the top right lists the colors in which each type of data is displayed. Perform the following steps:

a Click and drag the edges of the Metric Data area to highlight each cell that contains metric data.

b Specify which cells contain metric header information by doing one of the following:

• If no metric headers are contained in the file, select the No Metric Headers check box.

• If metric headers are included in the file, clear the No Metric Headers check box. Click and drag the Metric Header Block area to highlight the cells that contain metric header data.

7 Click **Apply** to return to the Preview page.

**Define a data column**

8 At the top of the page, click the table that contains the data column to define. A preview of the table's data is displayed at the bottom of the page.

You can view, search, and define objects across all tables by clicking **All Objects View**. The All Objects View page opens. All the options described below are available, but you cannot preview the data. You can convert multiple attributes to metrics, or multiple metrics to attributes, using this page. For more information on the All Objects View page, see *All Objects View page, page 536*.

9 To exclude a data column from the imported data, hover the cursor over the column, then click the arrow icon, and select **Do Not Import**.

10 You can define a data column as an attribute or metric. For background information on attributes and metrics, see *Understanding how MicroStrategy works with and stores data, page 49*.

Hover the cursor over a column, then click the arrow icon, and select one of the following:

• To define the data column as an attribute, select **Convert to Attribute**.

• To define the data column as a metric, select **Convert to Metric**.

11 You can assign a geo role to the data column, to generate additional geographical data and to allow for easier integration with map-based
visualizations. For background information about geo roles, see "Preparing your data to display on maps: Geo roles, page 135." To assign a geo role, hover the cursor over a column, then click the arrow icon, and do one of the following:

- To assign a geo role to the data column, point to **Define Geography**, then select the geo role to assign, such as **City**, **State**, or **Latitude**. Select the check box next to each attribute to have automatically generated based on the data column, then click **OK**.

- To define the data column without assigning it a geo role, point to **Define Geography**, select **None**, then click **OK**.

The Define Geography option is not available for data imported from Hadoop.

12 To change the data type of the column, hover the cursor over the column, then click the arrow icon, point to **Change Data Type**, and select the data type to use.

13 To rename the data column, hover the cursor over the column, then click the arrow icon, and select **Rename**. Type a name in the field and press **ENTER**.

14 Each column in a table will be imported as a separate attribute. If your data contains different attribute forms of the same attribute saved in separate columns, you can create a multiform attribute to combine the forms into a single attribute. For example, the LU_CALL_CENTER TABLE contains two columns, Call Ctr ID and Call Center Name, which will be imported as two attributes. You can create a single Call Center attribute that uses the columns as attribute forms. To create a multiform attribute, complete the following steps:

a Select the columns to use as attribute forms by holding the Shift key while selecting them.

b Right-click the selected columns and select **Create Multiform Attribute**. The Create Multiform Attribute dialog box opens.

c Type the name to use for the attribute in the **New Attribute Name** field.

d For each attribute form, select the correct **Form Category**, such as ID or Description, from the drop-down list.

e For each attribute form, determine whether or not the form is displayed, as described below:
To display the attribute form, select the **Display Form** check box.

To hide the attribute form, clear the **Display Form** check box.

Click **Submit** to create the new multiform attribute and return to the Preview page. The multiform attribute replaces the columns that were used to create it.

15 Repeat the appropriate steps above, starting at *Define a data column, page 124*, for each data column that you want to define.

**Finish importing the data**

16 You can explore your data to evaluate its quality and usability, and then refine your data to improve its quality before you import it into MicroStrategy Desktop. This process is also known as data wrangling. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on. For steps, see *Refining your data quality before importing, page 129*.

17 You can improve performance by partitioning a very large dataset and creating search indexes for attributes. For reasons to use partitioning and search indexes, as well as steps to create them, see *Improving performance: Partitioning large datasets and creating search indexes, page 127*.

You can also access group partitioning for a table. Hover the cursor over the name of the table, click the **Menu** icon, and select **Group Partition**.

18 To import the data, click **Finish**. The selected data is imported into your dashboard as a dataset.

- For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151*.
- For steps to create a dashboard, see *Creating a dashboard, page 146*.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Improving performance: Partitioning large datasets and creating search indexes, page 127*
- *Refining your data quality before importing, page 129*
- *Preparing your data to display on maps: Geo roles, page 135*
Improving performance: Partitioning large datasets and creating search indexes

If you are importing very large datasets into MicroStrategy Desktop, you can divide the dataset into multiple segments, called partitions. The data in the partitions is processed simultaneously, improving the performance of your dashboard.

You divide your dataset based on an attribute, called a partition attribute. When you choose a partition attribute, all the tables that contain the attribute are partitioned. It is recommended that the partition attribute be present in as many fact tables as possible.

The number of partitions that you split your dataset into should be less than or equal to the number of CPU cores on your machine.

For detailed information on determining whether your dataset is appropriate for partitioning, and for choosing an appropriate partition attribute, see the In-memory Analytics Guide.

If you will create filters that use a search box in the dashboard, you can improve the performance of the search by creating a search index for the attributes in your dataset. However, creating search indexes takes up additional memory in your machine.

The following steps cover partitioning and creating a search index.

**Prerequisite**

- This procedure assumes that you have already begun importing data, and are previewing your data. The Preview page is displayed after you select a data source to import from, configure the data source, and click **Prepare Data**. For a list of the data sources that you can import from, and links to steps to import data, see *Importing Data into MicroStrategy Desktop, page 55.*
To improve performance

1. On the Preview page, click **All Objects View**. The All Objects View page is displayed, showing the attributes and metrics for your dataset, and the data tables that they are based on.

   **To partition the dataset**

2. From the **Partition Attribute** drop-down list, select the attribute to use to split the dataset.

   It is recommended that the partition attribute be present in as many fact tables as possible. For detailed guidelines and considerations to choose an appropriate partition attribute for your dataset, see the *In-memory Analytics Guide*.

3. In the **Number of Partitions** field, type the number of partitions to split your dataset into.

   The number of partitions should be less than or equal to the number of CPU cores on your machine.

   **To create a search index**

4. To create a search index for an attribute, in the **Search Index** column, enable the switch for the attribute.

   Creating a search index for an attribute improves performance for filters that use a search box on that attribute. You can create search indexes on any attributes in your dataset. However, creating search indexes uses additional memory on your machine.

5. To save your changes, click **Save**. You are returned to the Preview page.

Related topics

- *Importing Data into MicroStrategy Desktop, page 55*
- *Previewing your data and specifying data import options, page 121*
- *Creating a dashboard, page 146*
Refining your data quality before importing

You can explore your imported data to evaluate its quality and usability. You can then prepare your data to improve its quality before you import it into MicroStrategy Desktop. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on. You can refine the data from different sources to standardize the format for all the data. You can also use data wrangling as a data discovery tool and to bypass some traditional extraction, transformation, and loading (ETL) methods.

On the Wrangle Your Data page, you work with sample data (a subset of your actual data) to build a script of functions that will clean, transform, and prepare your data, also known as data wrangling. To build the script, you:

1. Select data. This can be a data column or part of a cell.
2. Select a function to apply to the selected data. For example, you can split the selection into multiple columns or change the data type.
3. The function and data are added to the script.
4. Repeat the steps above until you have refined and improved your data.
5. You can view all the changes that you made to your data, by scrolling through the script. To undo a function and all the functions applied after it, click the function in the History Script area. Similarly, you can redo functions by clicking a function in the History Script area. All undone functions applied before the selected function are re-applied.
6. Save the completed script.

The script is saved with the dataset and therefore in the dashboard. The completed script is applied to your data when you publish the cube. You can also export the script, to save the functions in order. You can then import the saved script to apply to another set of data. Steps for both are included in the procedure.

You can:

- Delete a column or row.
- Remove duplicate cells or rows.
- Extract data to create a new column, by specifying:
- A fixed length of characters to extract
- The character that indicates where to begin extracting data
- The character that indicates where to stop extracting data
- Filter data, so that you can focus on refining smaller subsets of data. Rows are not deleted when they are filtered; they are only hidden from view.
- Find and replace a cell or characters in cells.
- Split the selected data into separate columns or cells by specifying:
  - A fixed length of characters to split
  - The character to split the selection at
  - The character that indicates where to begin the split
  - The character that indicates where to end the split
- Split the selected cell into separate rows by specifying the character to split the selection at.
- Change data to title case (each word begins with an uppercase letter), uppercase, or lowercase.
- Replace the codes in HTML-encoded data with the correct characters, so that the text becomes more readable. For example, you can refine the encoded text MicroStrategy%2C%20Inc. into MicroStrategy, Inc. using the Unescape HTML function.
- Change the data type.
- Copy selected data into blank space (Fill Down).
- Blank out cells that contain repeated data (Blank Down).
- Add characters before or after the text in cells (Pad). For example, if your Region column contains “South” and “North”, you can add “ern” using the Pad After function. The column then contains “Southern” and “Northern”.
- Trim leading and trailing white space.
- Remove blocks of white space.
- Group similar data into a cluster and replace values in the cluster.
- Duplicate selected data into another column.
• Rename selected data.
• Concatenate or combine two columns into a new column.
• Swap columns and rows (Transpose).

If you republish or refresh your data, the data wrangling steps are applied to the new data. For example, if you changed a text column to all uppercase, the same text column will be displayed as uppercase in the republished data. For background information on republish and refreshing your data, see *Refreshing and updating your imported data: Republishing datasets, page 141.*

**Prerequisites**

• You can refine data imported from the following data sources:
  - Files imported from your computer or network, or uploaded from a URL
  - Custom data typed or pasted directly into MicroStrategy Desktop
  - Dropbox
  - Google Analytics
  - Google Drive
  - Salesforce
  - Sample files

• This procedure assumes that you have already begun importing data, and are previewing your data. The Preview page is displayed after you select a data source to import from, configure the data source, and click **Prepare Data.** For a list of the data sources that you can import from, and links to steps to import data, see *Importing Data into MicroStrategy Desktop, page 55.*

---

**To refine your data before importing it**

1. On the Preview page, click **Wrangle.** The Wrangle Your Data page opens, displaying a sample of your dataset.
2 You can import a saved script of functions to apply to your data. To import a script, follow the steps below:

   a Click **Import** in the History Script area. The Import History Script dialog box opens.

   b Do one of the following:
      ▪ To import a saved script, click **Browse**.
      ▪ Copy a script into the interface.

   c Click **Apply**. The functions are applied to your data sample and you are returned to the Wrangle Your Data page.

   d If you do not want to make any additional changes to the data, click **OK** to apply the script, as displayed in the History Script area, to your actual data. You are returned to the Preview page.

3 Select a data column or part of a cell to apply a function to. A list of suggested functions is displayed, based on the selected data.

4 Select a function to apply to the selected data, from either the suggested functions or the **Select Function** drop-down list.

   ▪ For a function that needs no further input, like facet, the function is automatically applied to your data.

   ▪ If the function needs parameters, define the parameters, then click **Apply** to apply the function to your data.

   ▪ If you change a column’s data type to date, type the date format of your data into the **Input Date Format** field, using the characters in *Valid date and time forms for wrangling your data, page 541*. For example, if your data displays 01022014 for January 2, 2014, type the date format MMddyyyy in the field. After the data is converted to a date, the dates are displayed in yyyy-MM-dd format. That is, January 2, 2014 displays as 2014-01-02.

   The sample data is updated to preview the effect of the function.

5 To work with a smaller subset of data, filter the data using the following steps:

   a Select the data to work with.

   b Select one of the following from the **Select Function** drop-down list:
      ▪ To filter text by selecting values from the data, select **Text Facet**. A list of the text values in the selected data is displayed. To filter the
selection, click the text value to display in the selection. You can instead display all values except the selected value, by clicking **Exclude**. This option can be helpful when you do not know the exact values in your data.

- To filter text by typing values, select **Text Filter**. Type the text to filter by.

- To filter numeric data, select **Numeric Facet**. A graph is displayed of the numbers in the selected data. Move the start point and end point of the graph to filter the range of values to display in the selection.

- To filter data consisting of dates, select **Timeline Facet**. A graph is displayed of the dates in the selected data. Move the start point and end point of the graph to filter the range of dates to display in the selection.

Rows are not deleted when you use a facet function; they are only hidden from the data preview.

- You can apply functions to the filtered data, as described above.

- To undo a specific filter, click the arrow icon in the title of the filter, and select **Reset**.

- To undo all filters, click the arrow icon of any filter title, and select **Reset ALL Facets**.

- To delete a specific filter, click the arrow icon in the title of the filter, and select **Delete**.

- To delete all filters, click the arrow icon of any filter title, and select **Delete ALL Facets**.

6 To group similar data into a cluster and replace values in the cluster, complete the following steps.

- Select the data to work with.

- From the **Select Function** drop-down list, select **Cluster and Edit**. The Cluster and Edit dialog box opens. The selected data has been grouped into clusters of related data.

- To change the algorithm used to group the data, select a different algorithm from the **Algorithm** drop-down list.
d To replace all the cluster's values with a new value, complete the following steps:
   a Select the check box of the cluster.
   b In the **New Cell Value** field, type the replacement value.

e Repeat the step above for each cluster to update.

f Do one of the following:
   - To replace the values of the selected clusters and recluster the data, click **Merge and Recluster**. Repeat the steps above as needed.
   - To replace the values of the selected clusters and continue refining data, click **Merge and Close**. You are returned to the Refine Your Data page.

7 To edit data directly in a cell, complete the following steps:
   a Hover your cursor over the cell to edit and click the **Edit** icon 🖍.
   b Make your changes in the dialog box that opens.
   c You can choose to change the selected cell or the entire column. For example, if you select a cell that contains *Books* and change it to *Book*, you can choose to change only that cell. If you apply the change to all the cells, all the *Books* cells in the column are changed to *Book*. Select one of the following:
      - To make the changes to the selected cell only, click **Apply**.
      - To make the changes to all cells in the column of the selected cell, click **Apply to All**.

8 To undo a function, click the function in the History Script area. All functions applied after the selected function are also undone.

9 To redo a function, click the function in the History Script area. All undone functions applied before the selected function are also re-applied.

10 To undo all the actions in the script, click **Reset to Initial Data** in the History Script area. Your data is returned to its original state. The history script is not deleted until you select another function, which causes a new script to begin.
You can export the script, to save the functions in order. You can then import the saved script to apply to another set of data. To export the script, complete the following steps:

a Click **Export** in the History Script area. The Extract History Script dialog box opens, displaying the full script.

b Click **Save** to save the script into a file, to save the functions for later use.

c Click **Close** to return to the Wrangle Your Data page.

When you have completed refining and cleaning your data, click **OK** to apply the script, as displayed in the History Script area, to your actual data. You are returned to the Preview page.

**Related topics**

- *Previewing your data and specifying data import options, page 121*
- *Importing Data into MicroStrategy Desktop, page 55*

### Preparing your data to display on maps: Geo roles

Geo roles indicate that a data column contains geographical information, making it easier to display geographical data on mapping visualizations. When your data includes geographical information, you can prepare your data to be displayed on a map by assigning geo roles to each data column that contains geographical data. See the following:

- For background information about preparing your data for displaying on map-based visualizations, such as the ESRI Map visualization, see *Geo roles and map-based visualizations, page 135.*

- For steps to assign geo roles, see *Assigning geo roles, page 137.*

### Geo roles and map-based visualizations

During the data import process, MicroStrategy Desktop automatically attempts to determine if any data columns in the data that you have chosen to import contain geographical information, such as city or latitude...
information. When Desktop determines that a data column contains geographical information, Desktop automatically assigns a geo role to identify the type of information that the data column contains. You can also assign geo roles manually.

Assigning a geo role to a data column lets you easily display your geographic data in map-based visualizations that require latitude and longitude information, such as the ESRI Map visualization with map markers or a density map. When you assign the Country, State, City, ZIP Code, or Location geo role to a data column, Desktop automatically adds latitude and longitude information to the attribute. For example, you import a data column containing the names of multiple cities, create an attribute called City, and assign it the City geo role. Desktop automatically adds latitude and longitude information for each city to the City attribute. When you create an ESRI Map visualization, you can use the City attribute to provide latitude and longitude information for locations in the visualization. Alternatively, you can import separate columns of data for latitude and longitude information, and create separate Latitude and Longitude attributes. For example, you can assign the Latitude geo role to the latitude data column, and assign the Longitude geo role to the longitude data column. You can then use the Latitude and Longitude attributes to display map markers or a density map on an ESRI Map visualization.

Assigning a geo role to a data column also lets you easily display your geographic data on map-based visualizations that require general location information, such as the ESRI Map visualization that displays areas. If you assign a geo role to the attribute that contains location information, and then create an ESRI Map visualization with areas, Desktop uses the attribute’s geo role to determine the default base map to display in the visualization. The visualization will automatically display the first base map that supports the attribute’s geo role. For example, if the attribute’s geo role is State, the U.S. States Names base map will be displayed in the visualization by default. If a geo role has not been assigned to an attribute, you select the appropriate base map to use.

**Automatically creating additional geographical information based on your data**

Once a data column has been assigned a geo role, you can improve the depth of the geographical information available for your data by having Desktop automatically generate attributes containing higher levels of geographical data based on the data column. For example, if the data column contains city data, you can have Desktop automatically generate the State attribute, which contains the state each city is located in.
For detailed information about which attributes can be generated for each geo role, see the Project Design Guide.

Assigning geo roles

You can assign a geo role when you preview data during the import data process. After you import data, you can assign a geo role, as described in Modifying, renaming, showing, and hiding dataset objects in a dashboard, page 162.

Prerequisite

- The following steps assume that you have already begun importing data. The Preview page is displayed after you select a data source to import from, select the data to import, and click Prepare Data. For a list of the data sources that you can import from, and links to steps to import data, see Importing Data into MicroStrategy Desktop, page 55.

To assign a geo role while importing data

1. On the Preview page, hover the cursor over the data column to assign a geo role to, then click the arrow icon, point to Define Geography, and select one of the following:

   - To assign a geo role to the data column, select the geo role to assign, such as City, State, or Latitude. Select the check box next to each attribute to have automatically generated based on the data column, then click OK.

   - To define the data column without assigning it a geo role, select None, then click OK.

Related topics

- Importing Data into MicroStrategy Desktop, page 55
- Creating an ESRI Map visualization that displays map markers, page 228
- Creating an ESRI Map visualization that displays a density map, page 233
- Creating an ESRI Map visualization that displays areas, page 239
Defining relationships between attributes

Attribute relationships are associations between attributes that specify how attributes are connected. Attribute relationships define how tables and columns are joined and used, and which tables are related to other tables. Without relationships, there is no interaction between data, and therefore no logical structure. The relationships give meaning to the data by providing logical associations of attributes based on business rules.

Every attribute relationship has two parts—a parent and a child. A child must always have a parent and a parent can have multiple children. The parent attribute is at a higher logical level than the child is. For example, in a relationship between Year and Quarter, Year is the parent attribute and Quarter is the child.

Relationship types are defined by the attribute elements that exist in the related attributes. Each type is described below:

- **One-to-one**: Each element in the parent attribute corresponds to one and only one element in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute. A common example of a one-to-one relationship is citizen and taxpayer ID. A citizen can have only one taxpayer ID and a taxpayer ID can be assigned to only one citizen.

- **One-to-many**: Each element in the parent attribute corresponds to one or more elements in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute. These are the most common types of attribute relationships. Year has a one-to-many relationship to quarter. One year has many quarters, but a specific quarter can be in one year only. This assumes that quarters are defined with an accompanying year such as Q4 2006, Q1 2007, and so on.

- **Many-to-one**: Each element in the parent attribute corresponds to one and only one element in the child attribute, and each child attribute corresponds to one or more elements in the parent attribute. Many-to-one relationships are the same type of relationship as a one-to-many, but it is defined from a different perspective. For example, year is described above as having a one-to-many relationship to quarter. This means that quarter has a many-to-one relationship to year.
Many-to-many: Each element in the parent attribute can have multiple children and each child element in the child attribute can have multiple parents. In banking, customers and accounts are an example of a many-to-many relationship. One customer can have many accounts, and each account can be associated with many customers, such as in the case of a joint checking account.

Steps to create relationships between the attributes that you import are provided below.

**Prerequisite**

- The following steps assume that you have already begun importing data. The Preview page is displayed after you select a data source to import from, select the data to import, and click **Prepare Data**. For a list of the data sources that you can import from, and links to steps to import data, see *Importing Data into MicroStrategy Desktop, page 55*.

**To define relationships between attributes**

1. On the Preview page, hover the cursor over the name of a table, click the **Menu** icon, and select **Define Relationships**. The Define Relationships dialog box opens.

2. To add a new relationship, complete the following steps:
   a. Click **Add a New Relation**. A blank relationship is displayed.
   b. From the drop-down list in the **Parent Attribute** column, select the parent attribute. The parent attribute is at a higher logical level than the child is.
   c. From the drop-down list in the **Child Attribute** column, select the child attribute.
   d. By default, the relationship is defined as one to many. You can select a different relationship type from the drop-down list in the **Relationship** column:
      - **1:1**: Each element in the parent attribute corresponds to one and only one element in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute.
1:Many: Each element in the parent attribute corresponds to one or more elements in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute.

Many:1: Each element in the parent attribute corresponds to one and only one element in the child attribute, and each child attribute corresponds to one or more elements in the parent attribute.

Many:Many: Each element in the parent attribute can have multiple children and each child element in the child attribute can have multiple parents.

3 You can edit existing relationships, by changing the Parent Attribute, Child Attribute, and Relationship options.

4 To delete all the relationships for the table, click Delete All.

5 When you have defined all the relationships for the table, click Save to return to the Preview page.

Related topics

- Previewing your data and specifying data import options, page 121
- Importing Data into MicroStrategy Desktop, page 55
- Providing business context to data: Attributes, page 50

Editing imported data

You can edit data that you have imported and saved as a dataset. For example, you can add new data columns, rename columns, change data types, and so on. As another example, if you imported your data from a database using a custom database query, you can edit the query, then import and save a different set of results.

By default, when you edit your saved data, all of your existing data is overwritten with the new data. If you want to add new data to your existing data, or replace existing data, you can republish a dataset. For background information and steps, see Refreshing and updating your imported data: Republishing datasets, page 141.
**Prerequisite**

- The steps below assume that you have already imported the data that you want to edit.

---

**To edit your imported data**

1. If your dashboard is not already open, from the **File** menu in MicroStrategy Desktop, select **Open**. Navigate to and select the dashboard to run.

2. In the Datasets panel, hover your cursor over the name of the dataset to edit, click the arrow icon, and select **Edit Dataset**. The Preview page opens.

   If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.

3. You can define each data column, such as specifying whether it is an attribute or a metric or assigning it a geo role. You can wrangle your data, which is refining the data to improve quality. For a full list of options and steps, see *Previewing your data and specifying data import options*, page 121.

---

**Related topics**

- *Refreshing and updating your imported data: Republishing datasets*, page 141
- *Importing Data into MicroStrategy Desktop*, page 55
- *Best practices: Importing data into MicroStrategy Desktop*, page 59

---

**Refreshing and updating your imported data: Republishing datasets**

You can ensure that the data in your dashboard is current by updating your imported data by republishing or refreshing your datasets. For example, your dataset contains sales information for your department. Your data source is updated every quarter with sales information for the most recent quarter. You can add the most recent sales information to your dataset by republishing your dataset.
You can specify whether new data replaces or adds to your existing data. For example, your dataset contains accumulated cost information for your department, while your external data source contains cost information for the most recent month only. You can add cost information for the most recent month to your dataset, without deleting the information for previous months, by adding new data. If the data source contains updates to the data already in your dataset, you can update the existing data and add new data. You can also replace all the data in your dataset with the data from the data source.

If your dataset contains multiple tables, you can select which tables to republish, and how to refresh them (by replacing all the data, adding only new data, and so on).

If you want to add new data columns to your imported data, rename columns, change data types, and so on, you can edit the dataset. For steps, see *Editing imported data, page 140*.

By default, when you republish imported data, MicroStrategy Desktop attempts to automatically update the dataset with new data from the original data source. If MicroStrategy is unable to import data from the original data source (for example, if the original data source cannot be found or if the data was imported using a query but the query cannot be executed successfully), you must re-specify the data source using the same steps originally used to import your data. You can hover the cursor over the information icon to display a detailed description of the problems MicroStrategy Desktop encountered during the republishing process. If the names or data types of the data columns originally used to publish the dataset have changed, or if data columns are now missing, you must define new data columns as attributes and metrics. For full steps to import data from a specific data source, see *Importing Data into MicroStrategy Desktop, page 55*.

If you refined your data using Data Wrangling before you originally imported it, the same process is applied to the data when you republish it. For example, if you changed a text column to all uppercase, the same text column will be displayed as uppercase in the republished data. For background information on refining your data, see *Refining your data quality before importing, page 129*.

You can specify that your data is automatically refreshed, and set how the refresh frequency; for steps, see *Dashboard Properties dialog box, page 572*. 
Prerequisite

- The steps below assume that you have already imported the data to republish.

To republish a dataset

1. If your dashboard is not already open, from the File menu in MicroStrategy Desktop, select Open. Navigate to and select the dashboard to run.

2. In the Datasets panel, hover your cursor over the name of the dataset to republish, click the arrow icon, and select Republish Cube. The Republish dialog box opens.
   - If the Datasets panel is not displayed, from the View menu, select Dataset Panel.
   - If the Republish Cube option is not available, the dataset may have been imported from a MicroStrategy server and cannot be republished.

3. For each table or file to refresh, complete the following steps:
   a. Select the check box for that table or file. To update all the tables or files, select the check box at the top of the dialog box.
   b. For a file uploaded from your computer or network, click Upload, then navigate to and select the file that contains your data. Click Open.
   c. For custom data imported by typing or pasting values, click Upload. Review and make changes to the custom data, then click Upload.
   d. Select one of the following Refresh Policy options to determine how your dataset will be updated:
      - To overwrite your existing data, select Replace existing data.
      - To update your existing data, as well as add new data that was not previously included in your existing data, select Update existing data and add new data.
      - To update your existing data, select Update existing data.
To retain your existing data without modifying it, as well as add new data that was not previously included in your existing data, select **Add new data**.

4 Click **Finish**. The selected tables or files are republished and the dataset is updated.

5 If any errors, such as mismatched data types or missing columns, are encountered during the republishing process, a message is displayed. Follow the directions in the message to fix the errors.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Editing imported data, page 140*
INTRODUCTION

A dashboard is an interactive display that you can create to showcase and explore business data. You can add visual representations of the data (called visualizations) to the dashboard to make your data easier to interpret, perform manipulations on the data to customize which information to display, organize data into multiple sheets (or “pages”) to provide a logical flow to your dashboard, and so on. You can quickly and easily create a polished dashboard without requiring a lot of design time.

For steps to create and work with dashboards, see the following sections:

• Creating a dashboard, page 146
• Managing data in a dashboard, page 151
• Formatting a dashboard, page 167
• Saving and exporting a dashboard, page 175

For steps to create and format visualizations, see the following sections:

• Displaying a visual representation of your data: Visualizations, page 179
• Creating visualizations using data from multiple datasets, page 252
• Formatting visualizations, page 264

You can add other objects, such as text, images, and Web content to the dashboard. For descriptions of these objects, and steps to create them, see Adding Text, Images, and Web Content, page 305. You can create new attributes, metrics, and groups of attribute elements, based on existing objects. For descriptions of these objects, and steps to create them, see Creating New Attributes, Metrics, and Groups, page 317.

Related topics
• About MicroStrategy Desktop, page 2
• Understanding how MicroStrategy works with and stores data, page 49
• Importing Data into MicroStrategy Desktop, page 55

Creating a dashboard

A dashboard is an interactive display that you can create to showcase and explore business data. You can add simple visual representations of the data (called visualizations) to the dashboard to make the data easier to interpret, perform manipulations on the data to customize which information to display, organize data into multiple sheets (or “pages”) to provide a logical flow to your dashboard, and so on. You can quickly and easily create a polished dashboard without requiring a lot of design time using
visualizations and pre-defined, presentation-quality formatting. An example of a dashboard is shown below:

You can add data to a dashboard by importing the data from a file, database, or the results of a custom database query (a Freeform script). For an overview of importing data, see Importing Data into MicroStrategy Desktop, page 55.

Dashboards open by default in Visual Insight Mode, where you can easily drag and drop attributes and metrics to display data, create filters, group data, and more. You can also maximize the amount of space available for data display by viewing dashboards in Presentation Mode. For steps, see Viewing dashboards in Presentation Mode, page 422.

For more information on the types of visualizations available to be added to a dashboard, including examples and data requirements, see Displaying a visual representation of your data: Visualizations, page 179.

Prerequisite

- To create a dashboard by importing data, you must have access to the file (Excel spreadsheet, text, or CSV file) or the data source that contains the data to import. For best practices information for importing data, see Best practices: Importing data into MicroStrategy Desktop, page 59.
To create a dashboard

1. In MicroStrategy Desktop, from the File menu, select New. A blank dashboard is created.
   - If you are on the Welcome page, click Create Dashboard.

To import data into the dashboard

2. Click the Add Data icon on the toolbar. The Connect to Your Data Source page opens.

3. Click the data source, and select the appropriate options to import and edit your data. For detailed steps to import data, see Importing Data into MicroStrategy Desktop, page 55.

4. The selected data is imported into your dashboard as a dataset. Datasets provide the data in a dashboard; by adding multiple datasets to a dashboard, you can use attributes and metrics from multiple datasets to create visualizations, analyze data, and so on. For steps, see Managing data in a dashboard, page 151.

   You can also use data from a project on a server. After you log in to the server, the project’s objects are displayed in the All Objects panel in the Datasets panel. You can use the objects to create visualizations, filters, derived objects, and so on, in the same way as using objects from a dataset. For steps, see Using data from a project on a server, page 483.

To add content to the dashboard

5. You can add visualizations to the dashboard. A visualization is a simple visual representation of your data. For steps to add a specific type of visualization, see the related links below:
   - Creating a Graph visualization, page 181
   - Creating a Grid visualization, page 220
   - Creating a Heat Map visualization, page 223
   - Creating an ESRI Map visualization that displays map markers, page 228
   - Creating an ESRI Map visualization that displays a density map, page 233
6 After you create a visualization, you can format it, to rename attributes or metrics, choose whether to display a visualization’s title bar, whether to apply banding to values in a grid, and so on. For steps and a complete list of formatting options, see Formatting visualizations, page 264.

7 You can add text, images, and Web content to the dashboard. For background information and steps to perform a specific task, see the appropriate link below:

- Adding text, page 307
  Text can serve as a label for your data or provide background information, a description, or instructions for the dashboard.
- Adding an image, page 312
- Adding web content, page 314
  An HTML container displays the contents of a web page or content formatted in HTML.

8 You can create new attributes, metrics, and groups of attribute elements based on existing objects. For background information and steps to perform a specific task, see the appropriate link below:

- Creating a metric based on existing objects: Derived metrics, page 318
  Derived metrics are metrics that you can create based on existing metrics on the dashboard. A derived metric performs a calculation on the fly with the data available on a dashboard, without re-executing the dashboard against the data source.
- Creating an attribute based on existing objects: Derived attributes, page 344
  Derived attributes are attributes that you can create based on existing dataset objects that are already included in the dashboard. Once you create a derived attribute, it works the same as any other attribute. For example, you can add it to a visualization.
- Grouping attribute values in a dashboard, page 349
You can replace multiple attribute elements with a single group in a visualization. For example, you can group regions into areas such as North, South, and Central. You can create a new group by combining attribute elements with a calculation, such as sum or average. Groups allow you to manipulate the display of your data.

9 You can organize your content into multiple pages and sheets, as described below:

- **Adding, modifying, and deleting sheets, page 374**
  Sheets allow you to create layers of data that are filtered in different ways. Each sheet has a separate set of filters, allowing you to create different filters for different sheets. Each sheet is displayed on a separate tab in the dashboard.

- **Adding, modifying, and deleting pages, page 376**
  Pages allow you to create layers of data that are filtered in the same way. Each sheet in a dashboard can contain multiple pages.

10 You can limit and select the data displayed in the dashboard by filtering the data. You can filter data based on an attribute, the ranking of elements in an attribute, or a metric. You can filter a sheet, a visualization, or another filter. For steps, see *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369.*

11 You can format the dashboard, including selecting whether to use a light-colored or dark-colored display theme and how the Filter panel is displayed. For steps, see *Formatting a dashboard, page 167.*

To save your dashboard

12 Click the **Save** icon on the toolbar. The Save As dialog box is displayed.

13 Navigate to the location to save the dashboard to, then type a name and description for the dashboard in the **Name** and **Description** fields.

14 Click **OK**. The dashboard is saved.

Related topics

- *About MicroStrategy Desktop, page 2*
- *Providing business context to data: Attributes, page 50*
Managing data in a dashboard

A dataset is a set of data that can be displayed on a dashboard. In Desktop, datasets provide the data to be displayed in a dashboard, in objects such as visualizations, filters, text fields, and so on. A dataset can come from a variety of data sources, including an Excel spreadsheet imported from a folder on your computer or downloaded from an URL, a database imported by building a SQL query or picking relational tables, a MicroStrategy project, and so on. (For a complete list of data sources, see Importing Data into MicroStrategy Desktop, page 55.) By adding multiple datasets to a dashboard, you can use objects from multiple datasets to create visualizations, analyze data, and so on.

Each object in a dataset is defined as either an attribute or a metric.

- An attribute is a business concept, such as Product, Employee, Month, and so on. An attribute serves as a label for a group of metrics, providing a context for the metrics. For a more detailed description and examples of attributes, see Providing business context to data: Attributes, page 50.

- A metric is a business measure or key performance indicator, such as Revenue, Profit, Employee Headcount, or Probability of Purchase. Metrics are the calculations performed on data stored in your database. A metric on a dashboard shows a list of values that are used for analytical calculations. For a more detailed description and examples of metrics, see Calculating data: Metrics, page 52.

Managing data in a dashboard includes the following tasks:

- You can add, replace, and remove datasets from a dashboard, as described in Adding, replacing, and removing datasets in a dashboard, page 152.

- If the dashboard contains multiple datasets, you can decide which datasets determine the values that appear in the dashboard. When you add a dataset to a dashboard, it is automatically designated as a primary dataset. All the values in a primary dataset are displayed in the dashboard. A dataset’s values can instead by displayed only if the values are also available in another dataset, by designating the dataset as a secondary dataset. For steps and examples, see Selecting which datasets determine the dashboard's available values, page 158.
• You can determine whether a dataset directly accesses its data source or stores the data in memory. For steps, see Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160.

• You can ensure that your dashboard displays the most up-to-date data available by refreshing a dataset. For steps, see Refreshing and updating your imported data: Republishing datasets, page 141.

• You can modify, rename, show, and hide dataset objects, as described in Modifying, renaming, showing, and hiding dataset objects in a dashboard, page 162.

Related topics

• About MicroStrategy Desktop, page 2

• Creating a dashboard, page 146

• Importing Data into MicroStrategy Desktop, page 55

Adding, replacing, and removing datasets in a dashboard

You can modify your datasets in the following ways:

• You can add a dataset to a dashboard; for steps, see Adding a dataset to a dashboard, page 153.

If you add multiple datasets to a dashboard, you must link the attributes that are shared in common across multiple datasets. Linking the common attributes allows the data in one dataset to relate to the data in other datasets. For steps to link attributes that are shared in common, see Linking data shared across multiple datasets, page 259. For an introduction to creating visualizations using multiple datasets, see Creating visualizations using data from multiple datasets, page 252.

• You can replace a single dataset or all the datasets in the dashboard with a single dataset; for steps, see Replacing datasets in a dashboard, page 154.

You can specify the replacement dataset in any of the following ways:

- Importing new data from a data source
- Selecting a dataset already in the dashboard
For each dataset object in the replaced dataset, you must specify how to replace it. For example, you can replace an attribute or a metric with another attribute or metric, or delete it from the dashboard. For a derived attribute or metric, you can keep its definition. Each replacement method is explained in the steps in Replacing datasets in a dashboard, page 154.

- You can remove a dataset from a dashboard; for steps, see Removing a dataset from a dashboard, page 157.

If you remove a dataset from a dashboard, some objects on the dashboard can contain references to data that is no longer available. These controls will be automatically updated to remove references from the removed dataset. For example, if a visualization contains attributes and metrics from a single dataset, and the dataset is removed from the dashboard, the visualization is cleared and no longer contains any data.

If you add objects from a project to the dashboard, a dataset to contain these objects is created and displayed in the Datasets panel. You can remove the project dataset from the Datasets panel, just as with any other dataset. If you add additional objects to the dashboard from the project after deleting the original dataset, a new dataset is automatically added to the dashboard to contain the new objects.

**Adding a dataset to a dashboard**

If you add objects from a project to the dashboard, a dataset to contain these objects is automatically created and displayed in the Datasets panel. For steps to connect to a server and add object from a project, see Using data from a project on a server, page 483.

**Prerequisites**


- Review the prerequisites for the data source type (such as a file or database), as described in the respective Importing data sections linked below.

---

**To add a dataset to a dashboard**

1. From the File menu, select Open. Navigate to and select the dashboard to modify.
2 Click the **Add Data** icon 🔄 on the toolbar. The Select a Data Source page opens.

3 From the **Import Into** drop-down list, select whether to import the data into a new dataset or into an existing dataset.

4 Click the data source, and select the appropriate options to import and edit your data. For detailed steps to import data, see *Importing Data into MicroStrategy Desktop, page 55.*

5 If you add multiple datasets to a dashboard, you must link the attributes that are shared in common across multiple datasets. For an introduction to creating visualizations using multiple datasets, see *Creating visualizations using data from multiple datasets, page 252.* For steps to link attributes that are shared in common, see *Linking data shared across multiple datasets, page 259.*

**Replacing datasets in a dashboard**

**Prerequisite**

- If you will replace the dataset by importing data, do the following:
  - Read *Best practices: Importing data into MicroStrategy Desktop, page 59.*
  - Review the prerequisites for the data source type (such as a file or database), as described in *Importing Data into MicroStrategy Desktop, page 55.*

**To replace datasets in a dashboard**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.
3 You can replace a single dataset or all the datasets in the dashboard. Select one of the following:

- To replace a single dataset, in the Datasets panel, complete the following steps:
  
  a Hover the cursor over the name of the dataset to replace, then click the arrow icon on the right.
  
  b Point to **Replace Dataset With**, then select one of the following:
  
  - To replace the dataset by importing new data from a data source, select **Data Import**. The Select a Data Source page opens. Import data, as described in *Importing Data into MicroStrategy Desktop, page 55*.
  
  - To replace the dataset with dataset already in the dashboard, select the replacement dataset.

The Replace Objects dialog box opens.

- To replace all the datasets with a single dataset, complete the following steps:
  
  a Hover the cursor over the name of the Datasets panel, then click the **Menu** icon ↓.
  
  b Point to **Replace All Datasets**, then select one of the following:
  
  - To replace the datasets by importing new data from a data source, select **Data Import**. The Select a Data Source page opens. Import data, as described in *Importing Data into MicroStrategy Desktop, page 55*.
  
  - To replace the dataset with dataset already in the dashboard, select the replacement dataset.

The Replace Objects dialog box opens.

4 If you have renamed or applied number formatting to dataset objects in one or more of the datasets being replaced in a visualization, you can keep the new names and number formatting in the visualization after the dataset is replaced. Do one of the following:

- To discard name and number formatting changes, select the **Clear object alias and number format on dashboard** check box.

- To keep name and number formatting changes, clear the **Clear object alias and number format on dashboard** check box.
For each dataset object in the Current Objects column, select the replacement method, as described below:

- For each attribute, from the drop-down list under **New Objects**, select one of the following:
  - To replace the attribute with an existing attribute from the new dataset, select the attribute to use as a replacement. For example, if elements of the attribute being replaced are displayed as choices in a filter, the filter is updated to contain elements of the new attribute.
  - To remove the attribute from the dashboard, select **Remove From Dashboard**. If the attribute is displayed in the dashboard (for example, in a visualization or filter), the attribute and its values are removed.

- For each derived attribute, from the drop-down list under **New Objects**, select one of the following:
  - To keep the derived attribute as part of the new dataset and keep its existing definition, select **Keep Existing Definition**. If a attribute that is part of the derived attribute's formula is replaced, it will also be replaced in the definition of the derived attribute. For example, if a derived attribute is defined as `Concat(Leftstr(Employee@FirstName,1),".",Employee@LastName)`, and you replace Employee with InternationalEmployees, the derived attribute's formula is updated to `Concat(Leftstr(InternationalEmployees@FirstName,1),".",InternationalEmployees@LastName)`.
  - To replace the derived attribute with an existing attribute from the new dataset, select the attribute to use as a replacement.
  - To remove the derived attribute from the dashboard, select **Remove From Dashboard**. If the derived attribute is displayed in the dashboard (for example, in a visualization or filter), the derived attribute and its values are removed.

- For each metric, from the drop-down list under **New Objects**, select one of the following:
  - To replace the metric with an existing metric from the new dataset, select the metric to use as a replacement.
  - To remove the metric from the dashboard, select **Remove From Dashboard**. If the metric is displayed in the dashboard (for
example, in a visualization or filter), the metric and its values are removed.

• For each derived metric, from the drop-down list under New Objects, select one of the following:
  
  ▪ To keep the derived metric as part of the new dataset and keep its existing metric formula, select **Keep Existing Definition**. If a metric that is part of the derived metric's formula is replaced, it will also be replaced in the definition of the derived metric. For example, if a derived metric is defined as **Revenue - Cost**, and you replace Revenue with Regional Revenue and Cost with Regional Cost, the derived metric's formula is updated to **Regional Revenue - Regional Cost**.
  
  ▪ To remove the derived metric from the dashboard, select **Remove From Dashboard**. If the derived metric is displayed in the dashboard (for example, in a visualization or filter), the derived metric and its values are removed.

6 Click **OK** to apply your changes. The dataset is replaced and the dashboard is updated to reflect the new dataset.

### Removing a dataset from a dashboard

**To remove a dataset from a dashboard**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 On the Datasets panel, hover the cursor over the name of the dataset to remove, then click the **Menu** icon. Select **Remove**. The dataset is removed from the dashboard.

• If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.

**Related topics**

- *About MicroStrategy Desktop, page 2*
- *Creating a dashboard, page 146*
- *Creating visualizations using data from multiple datasets, page 252*
Selecting which datasets determine the dashboard’s available values

If a dashboard contains multiple datasets, you can decide which datasets determine the values that appear in the dashboard.

- To display all the values in a dataset, regardless of whether they appear in other datasets, designate the dataset as a primary dataset. When you add a dataset to a dashboard, it automatically becomes a primary dataset. You can have multiple primary datasets in a dashboard.

- To display a dataset’s values only if the values are also available in another dataset, designate the dataset as a secondary dataset. You can have multiple secondary datasets in a dashboard.

For example, a dashboard contains the following datasets:

- Regional Revenue dataset

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Northwest</td>
<td>$2,239,951</td>
</tr>
</tbody>
</table>

- Regional Profit dataset

<table>
<thead>
<tr>
<th>Region</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$764,323</td>
</tr>
<tr>
<td>Northeast</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td>$266,986</td>
</tr>
<tr>
<td>South</td>
<td>$336,675</td>
</tr>
</tbody>
</table>
If you place the region, revenue, and profit objects on a grid, all the regions are displayed, even if they do not have both a revenue value and a profit value, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$764,323</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td>$2,239,951</td>
<td>$266,986</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$336,675</td>
</tr>
</tbody>
</table>

All the values for the Region attribute are displayed in the grid because both datasets are, by default, primary datasets.

If you change the Regional Profit dataset to be a secondary dataset, its values are displayed only if a primary dataset contains the same value. In this example, South is not displayed on the grid because the primary dataset Regional Revenue does not contain data for the South region. Central is displayed, even though it does not have any Profit data, because it belongs to a primary dataset. All values are displayed for primary datasets, regardless of whether they appear in other datasets.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
<td></td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$764,323</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td>$2,239,951</td>
<td>$266,986</td>
</tr>
</tbody>
</table>

If both datasets are defined as secondary datasets, only the values that appear in all the datasets are displayed. In this case, only Mid-Atlantic, Northeast, and Northwest are displayed, since they are common to both datasets.

<table>
<thead>
<tr>
<th>Region</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
<td>$764,323</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,415</td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Northwest</td>
<td>$2,239,951</td>
<td>$266,986</td>
</tr>
</tbody>
</table>
Prerequisite

- The dashboard contains multiple datasets. For steps to add datasets, see *Adding, replacing, and removing datasets in a dashboard, page 152*.

To select which datasets determine the available values

1. In the dashboard, on the Datasets panel, hover the cursor over the name of the dataset to modify, then click the arrow icon, point to **Join Behavior**, and select one of the following:
   - To display all the values in a dataset, select **Primary**.
   - To display a dataset’s values only if the values are also available in another dataset, select **Secondary**.

Related topics

- *Adding, replacing, and removing datasets in a dashboard, page 152*
- *Managing data in a dashboard, page 151*

Selecting how a dataset accesses its data: Direct data access vs. in-memory

You can determine how a dashboard accesses the data in a specific dataset. The following access modes are available:

- **Direct Data Access mode**: Visualizations in the dashboard that contain data from the dataset are treated as if they run directly against the data source. Dragging and dropping dataset objects onto visualizations using Direct Data Access mode can be slower than when using In-Memory mode, as dataset results must be retrieved before they can be displayed. However, a huge dataset can perform better when data is incrementally retrieved using direct data access.

- **In-Memory mode**: Dataset results are retrieved from the data source and stored in memory. Visualizations in the dashboard that contain data from the dataset display subsets of these stored results, which can increase the speed with which data is displayed.
If you upload the dashboard to a MicroStrategy server, so that you or other users can view and work with it in MicroStrategy Web,

The dataset access method also affects how the data is accessed in MicroStrategy Web if you upload the dashboard to a MicroStrategy server. When you upload a dashboard to a server, you or other users can view and work with it in MicroStrategy Web. For steps to upload a dashboard, see *Saving a dashboard onto a MicroStrategy server, page 474*.

- If the data source uses in-memory data access, an in-memory cube is created from the data when the dashboard is uploaded. This cube is used whenever the dashboard is viewed in MicroStrategy Web. If the Web user refreshes the data, the MicroStrategy server connects directly to the data source to retrieve new data to repopulate the cube.

- If the data source uses direct data access, the uploaded dashboard does not contain data. When the dashboard is viewed in MicroStrategy Web, the server connects directly to the data source to obtain the data.

Certain data sources support only Direct Data Access mode or In-Memory mode. To allow you to select the access mode for a dataset, the data source that provides data for the dataset must support both modes.

- If the dataset contains data from a data source that only supports Direct Data Access mode, the dataset only supports Direct Data Access mode.

- If the dataset contains data from a data source that only supports In-Memory mode, the dataset only supports In-Memory mode.

The table below contains a list of data source types organized by the access modes they support.

<table>
<thead>
<tr>
<th>Direct Data Access Mode Only</th>
<th>Both Direct Data Access and In-Memory Modes</th>
<th>In-Memory Mode Only</th>
</tr>
</thead>
</table>
| • Objects from a connected server | • Relational databases, including:  
  • Picking a table  
  • Building a SQL query  
  • Typing a query  
  • Accessing Hadoop files  
  • Google BigQuery | • All other data sources |

**Prerequisite**

- The dataset must be of a type that supports both Direct Data Access and In-Memory mode.
To define the access mode for a dataset

1. From the **File** menu in MicroStrategy Desktop, select **Open**. Navigate to and select the dashboard to modify.

2. In the Datasets panel, hover the cursor over the name of the dataset and click the arrow icon in the top right.

3. From the menu, point to **Data Access Mode**, then select one of the following:
   - To have the dashboard store dataset results in memory and display data based on the stored results, select **In-Memory**.
   - To have the dataset directly access data from its data source, select **Direct**. The name of the dataset is displayed in a grey italic font in the Datasets panel.

Related topics

- *About MicroStrategy Desktop, page 2*
- *Creating a dashboard, page 146*
- *Adding, replacing, and removing datasets in a dashboard, page 152*

Modifying, renaming, showing, and hiding dataset objects in a dashboard

If a dataset in your dashboard contains many dataset objects, you can hide specific dataset objects from display in the Datasets panel. For example, if you decide to import a large amount of data from a file, but do not remove every unwanted data column before importing the data into your dashboard, you can hide the unwanted attributes and metrics.

Tasks for working with dataset objects are listed below:

- *To hide dataset objects in the Datasets panel, page 163*
- *To show hidden objects in the Datasets panel, page 164*
- *To rename a dataset object, page 164*
• To create a derived metric based on an attribute, page 164

If the attribute contains numeric values, the values of the metric are calculated based on the sum of elements in the attribute. If the attribute does not contain numeric values, the metric is created as a count metric.

• To create a derived attribute based on a metric, page 165

Each value in the metric is displayed as a separate element in the attribute.

• To define the geo role for an attribute, page 165

A geo role associates geographical information, such as city or longitude, with a data column, allowing you to integrate your data with ESRI Map visualizations. For background information on geo roles, see Preparing your data to display on maps: Geo roles, page 135.

• To create a derived attribute with additional time information, page 166

You can improve the depth of time-related information available for your data by generating attributes containing higher levels of time data based on an existing attribute in a dashboard. For example, if the attribute contains month data, the Year attribute, which contains the year of each month, can be generated.

• To replace a dataset object, page 166

You can replace a dataset object with another dataset object in all the visualizations and filters in the dashboard.

---

To hide dataset objects in the Datasets panel

1  From the File menu, select Open. Navigate to and select the dashboard to modify.

2  In the Datasets panel, select the dataset object to hide. You can select multiple objects at once by pressing CTRL and clicking each object to select it.

   •  If the Datasets panel is not displayed, from the View menu, select Dataset Panel.

3  Right-click the object and select Hide. The object is hidden from the Datasets panel.
To show hidden objects in the Datasets panel

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. In the Datasets panel, click the **Menu** icon, and point to **Show Hidden Objects**. A list of hidden objects is displayed, organized by dataset. You can view or collapse the list of hidden objects in a dataset by clicking the arrow icon next to the dataset's name.
   - If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.

3. Click the check box for each object to show in the Datasets panel.

4. Click **OK** to apply your changes. The selected objects are shown in the Datasets panel.

To rename a dataset object

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. In the Datasets panel, right-click the object and select **Rename**.
   - If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.

3. Type a name for the object and press ENTER. The object is renamed and the new name is displayed in the Datasets panel, as well as in any visualizations that contain the object. Attributes are renamed across all datasets in the dashboard. Metrics are renamed within the selected dataset.

To create a derived metric based on an attribute

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. In the Datasets panel, right-click the attribute and select **Duplicate as Metric**. A new metric is created based on the attribute and displayed in
the Datasets panel. If the attribute contains numeric values, the values of the metric are calculated based on the sum of elements in the attribute. If the attribute does not contain numeric values, the metric is created as a count metric. The original attribute is not modified and remains on the dashboard.

- If the Datasets panel is not displayed, from the View menu, select Dataset Panel.

The Duplicate as Metric option is not available for a derived attribute.

**To create a derived attribute based on a metric**

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. In the Datasets panel, right-click the metric and select Duplicate as Attribute. A new attribute is created based on the metric and displayed in the Datasets panel. Each value in the metric is displayed as a separate element in the attribute. The original metric is not modified and remains on the dashboard.

- If the Datasets panel is not displayed, from the View menu, select Dataset Panel.

The Duplicate as Attribute option is not available for a derived metric.

**To define the geo role for an attribute**

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. In the Datasets panel, right-click the attribute and point to Mark Geographic Role.

- If the Datasets panel is not displayed, from the View menu, select Dataset Panel.

3. Select the type of geographic data the attribute contains, such as City, State, or Country. The Geo Attribute dialog opens.
Select the check box next to each attribute you want to have automatically generated based on the attribute. Click OK to apply your changes.

Depending on the type of data, you can define your data in more specific detail by having MicroStrategy automatically generate additional geographic information based on the contents of the data column. For example, if the column is assigned the City data type, you can have MicroStrategy automatically generate separate attributes for country and state information. For detailed information about which attributes can be generated for each geo role, see the Creating and Configuring a Project chapter of the Project Design Guide.

To create a derived attribute with additional time information

You base the derived attribute on an attribute with a data type of Date, Time, or DateTime. The attribute must also contain a date attribute form.

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. In the Datasets panel, right-click the attribute to base additional time attributes on, then point to Create Time Attributes. The Time Attribute dialog box opens.

   - If the Datasets panel is not displayed, from the View menu, select Datasets Panel.

3. Select the check box next to each attribute to automatically generate.

4. Click OK to apply your changes.

To replace a dataset object

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. In the Datasets panel, right-click the object and point to Replace Reference With. Click the name of the dataset object to replace the selected dataset object with. The object is replaced with the selected dataset object in any visualizations and filters in the dashboard.

   - If the Datasets panel is not displayed, from the View menu, select Dataset Panel.
Formatting a dashboard

Once you have created a dashboard, you can select options to format its display, such as the dashboard’s color theme and the fonts and colors of the dashboard’s objects. For descriptions of the formatting options, see the following:

- **Selecting the display theme for a dashboard, page 167**

  Choose from the Light or Dark display themes to quickly change the overall look and feel of your dashboard.

- **Creating color palettes to customize display themes, page 169**

  A color palette applies to the objects, such as a graph’s bar risers or heat map’s rectangles, displayed in all the visualizations in the dashboard. Each display theme contains built-in color palettes, but can also contain other color palettes for more variety and customization options.

- **Defining default fonts and colors for the objects in the dashboard, page 173**

  You can select the font used to display all text in the dashboard, the font used for the titles of all filters and visualizations, and the background color and border used for all containers. Containers display the visualizations, filters, text, images, and HTML containers on a dashboard.

Selecting the display theme for a dashboard

The Light and Dark display themes quickly change the overall look and feel of your dashboards.

Each display theme contains built-in color palettes. A color palette applies to the objects, such as a graph’s bar risers or heat map’s rectangles, displayed in
all the visualizations in the dashboard. You can create additional color palettes to customize the colors of your visualizations. For steps, see *Creating color palettes to customize display themes, page 169.*

**To select the display theme for a dashboard**

1. In the dashboard, from the **Format** menu, select one of the following:
   - To display the dashboard using a light-colored display theme, select **Light Theme**.
   - To display the dashboard using a dark-colored display theme, select **Dark Theme**.
Creating color palettes to customize display themes

You can customize the display of dashboards using display themes and color palettes. Desktop includes the Light and Dark display themes, which can be used to quickly change the overall look and feel of dashboards. For examples of the Light and Dark display themes, see Defining default fonts and colors for the objects in the dashboard, page 173.

Each display theme contains built-in color palettes, but can also contain color palettes that you create to provide more variety and customization options. A color palette applies to the objects, such as a graph’s bar risers or heat map’s rectangles, displayed in all the visualizations in the dashboard. If the same attribute is used to color the objects in different visualizations, the values for that attribute use the same color in the visualizations. If you create multiple color palettes, you can choose to display your dashboard in one set of colors for one audience, and in a different set of colors for another audience.

For example, the bar graph and pie graph shown below are both colored by customer region. Nevada, in the Southwest region, is displayed in aqua in
both visualizations. This example uses the default color palette for the Light Theme.

![Bar Graph](image1)

![Pie Graph](image2)

You can create additional color palettes, to change and customize the colors applied to the objects. You can choose the colors of your company’s logo, for instance. If you create a color palette using oranges, greens, and purples, and then select it as the color palette for the dashboard, the visualizations shown above are displayed in the new color palette, as shown below. All the values
for each attribute are still displayed in a single color. Nevada, in the Southwest region, is displayed in orange.

To create a color palette

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. From the **Format** menu, select **Custom Color Palette**. The Color Palette dialog box opens, displaying the built-in color palettes and any custom color palettes that have already been created.
3 Click **Add a Palette**. A color picker is displayed.

4 Double-click each color to add to the color palette. A swatch representing the color is added to the preview pane at the bottom of the color picker.

5 To remove a color from the color palette, double-click the color in the preview pane at the bottom.

6 If you want to select colors that are not in the color picker or define colors using hex codes, complete the following steps:
   a Click the **Paint Palette** icon
   b To add a displayed color, click the color in the ring. To adjust the color’s darkness, click the shade in the box. Double-click the color to add it. A swatch representing the color is added to the preview pane at the bottom of the color picker.
   c To use a hex code to add a color, type the hex code in the **Color hex** box and press ENTER.
   d To remove a color, click the color in the preview pane.
   e To switch back to the color picker, click the **Color Picker** icon

7 When the color palette is complete, click **OK** to save it and return to the Color Palette dialog box. The color palette is created and displayed in the Custom area.

8 Click **OK** to return to the dashboard.

---

**To apply a color palette to a dashboard**

1 From the dashboard’s **Format** menu, select the color palette to apply to the dashboard.

---

**To edit or delete a color palette**

1 From the dashboard’s **Style** menu, select **Custom Color Palette**. The Color Palette dialog box opens, displaying the built-in color palettes and any custom color palettes that have already been created.
2 Hover over the color palette in the Custom area, then select one of the following:

- To edit the color palette, click the **Edit** icon 📐. In the color picker that opens, select the appropriate options to define the color palette, as described in *To create a color palette, page 171*.

- To delete the color palette, click the **Delete** icon ☐️. The color palette is deleted.

The color palettes displayed in the Built-in area are default color palettes and cannot be edited or deleted.

3 Click **OK** to return to the dashboard.

**Related topics**

- *Defining default fonts and colors for the objects in the dashboard, page 173*

- *Formatting a dashboard, page 167*

**Defining default fonts and colors for the objects in the dashboard**

You can select the font used to display all text in the dashboard, the font used for the titles of all filters and visualizations, and the background color and border used for all containers. Containers display the visualizations, filters, text, images, and HTML containers on a dashboard.

Formatting options for individual objects in the dashboard, such as individual visualizations, images, filters, and so on, override formatting applied at the dashboard level. Use formatting at the dashboard level to provide the default display options, and then customize each object as needed. For example, to provide a unified appearance, you can display all objects with a grey background and black border, using these dashboard level formatting options. However, for the visualization that you want to stand out, select a white background and red border.

As you make changes, the new formats are displayed in the preview pane on the right.
To define default fonts and colors for the objects in the dashboard

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. From the **Format** menu, select **Dashboard Formatting**. The Dashboard Formatting Properties dialog box opens.

3. From the **Overall Font** drop-down list, select the font family to use to display all text in the dashboard.

4. To determine the font formatting options for all titles displayed in the dashboard, specify the following options in the Title area. For example, you can choose to display the titles of all visualizations and filters in the dashboard using bold, 14-point font.
   - From the **Font** drop-down list, determine the font to use to display titles in the dashboard.
   - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
   - From the drop-down list, determine the font size to use to display titles in the dashboard.
   - From the color palette, determine the font color to use to display titles in the dashboard.
   - From the **Fill Color** palette, determine the background color to use to display titles in the dashboard.
   - Determine the horizontal alignment of the title text. The options are **Left**, **Center**, **Right**, and **Justify**.

5. To format the containers used to display visualizations, filters, text, images, and HTML containers in the dashboard, specify the following options in the Container area:
   - Select the background color for containers from the **Fill Color** palette.
   - Select the line style of the container borders from the **Border Style** drop-down list. The default is Thin.
   - Select the color of the container borders from the **Border Color** palette. (Available if a border style is selected.)
Related topic

- *Formatting a dashboard, page 167*

**Saving and exporting a dashboard**

You can save a dashboard, or export the entire dashboard or an individual visualization. For steps, see the following sections:

- *Saving a dashboard, page 175* as an MSTR file
- *Exporting a dashboard, page 176* as an image or a PDF
- *Exporting a visualization, page 178* as a comma-separated values (CSV) file, Excel spreadsheet, image, or PDF

You can also save dashboards to a MicroStrategy server, to share them with other users and access the dashboards from another device. For steps, see *Saving a dashboard onto a MicroStrategy server, page 474.*

**Saving a dashboard**

You can make changes to a dashboard, then save it for easy access at a later date.

The entire dashboard, including visualizations, filters, and so on, as well as the associated datasets, is saved as a .mstr file. You can share this file with other MicroStrategy Desktop users, or upload this file to transfer your data from Desktop to the latest version of MicroStrategy Web. Other users can open the file in their own environments and modify the imported dashboard. For steps to upload a dashboard to a MicroStrategy server, see *Saving a dashboard onto a MicroStrategy server, page 474.*

---

**To save a dashboard**

1. In a dashboard, select one of the following:
   - To save the dashboard, click the **Save** icon on the toolbar.
If you are working on a dashboard that has already been saved, a confirmation message appears. Click Yes to save your changes and return to the dashboard.

If you are saving a new dashboard, the Save As dialog box opens.

- To save a copy of an existing dashboard using a different name, from the File menu, select Save As. The Save As dialog box opens.

2 Browse to the folder to save your dashboard in, then type a name in the File Name field.

3 Click OK to save the dashboard.

If a dashboard with the same name already exists in the folder, a Confirm Overwrite message is displayed.

- To overwrite the existing dashboard, click Yes.
- To save it as a different dashboard, click No and provide a name.

Related topics

- Exporting a dashboard, page 176
- Exporting a visualization, page 178

Exporting a dashboard

You can view a dashboard’s results outside of MicroStrategy Desktop, by exporting the dashboard. For example, you can view the dashboard results in a PDF file within Adobe Reader, print the PDF, or share your dashboard and data with other MicroStrategy users.

You can export a dashboard to the following formats:

- **Image**: Export the visible portion of the dashboard as an image, including pages and visualizations. The image is saved as a PNG file.

- **PDF file**: Export the dashboard as a PDF file. You can view the PDF on any device with a PDF reader, such as another computer, a Linux machine, a Nook, or a Kindle.

- **MicroStrategy file**: Save the dashboard and its associated data as a .mstr file. You can share this file with other Analytics Desktop users, or use this file to transfer your data from Analytics Desktop to the latest...
version of MicroStrategy Web. For steps, see *Saving a dashboard, page 175*.

### Prerequisite

- To export a map-based visualization, export the entire dashboard or the individual visualization as an image. Steps to export a dashboard as an image are below; for steps to export a visualization as an image, see *Exporting a visualization, page 178*.

### To export a dashboard

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to export.

2. From the **File** menu, point to **Export** and select one of the following:
   - If you modify the dashboard after opening it, you must save your changes before exporting the dashboard and associated data as a MicroStrategy file. To save the dashboard, click the **Save** icon. For detailed steps, see *Saving a dashboard, page 175*.

   - To export the dashboard as a PDF, select **PDF**.
   - To export the dashboard as an image, select **Image**.

   The Save As dialog box opens.

3. Navigate to the location to save the exported file, then specify a name for the file in the **File Name** field. Click **Save**. The file is saved.

### Related topics

- *Saving a dashboard, page 175*
- *Exporting a visualization, page 178*
Exporting a visualization

You can view and interact with a visualization outside of MicroStrategy Desktop, by exporting the visualization. You can export a visualization to the following formats:

- **Data**: Save the data in a visualization as a tabular comma-separated values (CSV) file. For example, a Graph visualization contains a line graph that displays revenue data across several different product categories. You can save the data in the visualization as a CSV file, with revenue data for each product category displayed in a tabular format, with values separated by commas.

- **Excel**: Save the data in a visualization as an Excel spreadsheet file.

- **PDF**: Export the visualization as a PDF file. You can view the PDF on any device with a PDF reader, such as another computer, a Linux machine, a Nook, or a Kindle.

The exporting formats available vary based on the type of visualization that you are exporting.

**Prerequisite**

- The steps below assume that you have already created the visualization that you want to export. For steps, see *Displaying a visual representation of your data: Visualizations, page 179*.

**To export a visualization**

1. In the dashboard, hover the cursor over the title bar of the visualization to export, then click the arrow icon in the top right. Point to **Export**, and select one of the following:
   - To export the data in the visualization as a CSV file, select **Data**.
   - To export the data in the visualization as an Excel file, select **Excel**.
   - To export the visualization as a PDF file, select **PDF**.

   The Save As dialog box opens.

2. Navigate to the location in which to save the file and specify a name for the file in the **File Name** field. Click **OK**. The visualization is saved in the selected format in the specified location.
Displaying a visual representation of your data: Visualizations

A visualization is a visual representation of the data in a dashboard, such as a grid, line chart, or heat map. Visualizations provide a variety of ways for you to display and interact with the data in a dashboard. For example, you can explore the relationships between data elements by creating a Network visualization, or create visually striking graphs that summarize key business indicators in a clear, easy-to-understand format. Each visualization can include data from multiple datasets at once. Each panel or sheet in a dashboard can contain multiple visualizations.

You can add the following visualizations to a dashboard:

- **ESRI Map visualization**: You can display your data as markers, density maps, or areas on an interactive map using the ESRI Map visualization. For example, you can create a ESRI Map visualization that displays how customer households are clustered in different parts of the country using a density map, or display retail locations as a series of map markers that users can click to view additional information about stores in their area. For steps, see *Creating an ESRI Map visualization, page 227*.

- **Graph visualization**: You can display your data in a graphical format and choose between a variety of different graphs. For steps, see *Creating a Graph visualization, page 181*. You can choose from a variety of graph styles to use to display the data, including:
  - Area Chart
  - Bar Chart
  - Bubble Chart
  - Combo Chart
  - Line Chart
Pie Chart

On the Visualization Gallery, Graph visualizations are displayed as Bar Chart, Line Chart, Area Chart, Bubble Chart, Pie Chart, and Combo Chart.

- **Grid visualization**: You can display your data in an interactive grid, allowing you to pivot, sort, move, drill, filter, and perform additional manipulations on data displayed in the grid. You can also understand your data and prepare it for displaying on other types of visualizations by using the Grid visualization as an intermediate tool. For steps, see *Creating a Grid visualization, page 220*.

- **Heat Map visualization**: You can display your data as a combination of nested, colored rectangles. Each rectangle represents an attribute element, and is colored and sized according to the value of metrics in the visualization, allowing you to quickly grasp the state and impact of a large number of variables at one time. For steps, see *Creating a Heat Map visualization, page 223*.

- **Network visualization**: You can display your data as a network of nodes, with lines between the nodes representing the relationships between attribute values. For steps, see *Creating a Network visualization, page 243*.

You can also add custom visualizations. See the MicroStrategy Developer Library (MSDL), part of the MicroStrategy SDK product, for steps to create and use custom visualizations.

If your dashboard contains multiple datasets, you can display their data in a visualization. For steps, see *Creating visualizations using data from multiple datasets, page 252*.

After you add a visualization to a dashboard, you can easily gain additional insights into your data by changing the type of visualization used to display your data. For steps, see *Changing the type of visualization displayed, page 246*. You can also add, remove, or replace data in the visualization, as described in *Adding, replacing, and removing data from visualizations, page 251*.

**Related topics**

- *Duplicating visualizations, page 247*
- *Moving visualizations, page 248*
- *Deleting visualizations, page 250*
Creating a Graph visualization

You can quickly explore your data in a polished graphical display with a Graph visualization. The Graph visualization is a powerful, interactive visualization that allows you to display your data using a variety of graph styles, then customize it to suit your needs. You can choose from a variety of graph styles to use to display the data, including:

- Area Chart
- Bar Chart
- Bubble Chart
- Combo Chart
- Line Chart
- Pie Chart

Using a Graph visualization, you can:

- Organize the data displayed in the graph based on a specific attribute. For example, a bar graph contains unit sales data for several regions. You can choose to display a different bar for each individual store within each region.

- Color graph elements (such as bubbles, lines, or bar risers) by an attribute or a metric. For example, you can choose to display a different color for each element in an attribute. You can choose to have graph elements automatically colored based on the value of a metric, with the darkest colors being displayed for the largest metric values.

- Automatically size graph elements based on the value of a metric, with the largest elements being displayed for the largest metric values.

- Slice your data, by displaying a graph for each combination of attribute elements in the rows and columns of the Graph visualization. For
example, you can display the revenue data for each Region as a separate line graph, or display a bar graph containing store sales for each year.

An example of a Graph visualization is displayed in the image below. The data in the visualization is shown as a series of bar graphs, with a separate bar riser displayed for each Call Center. The bar riser for each Call Center is displayed in a different color. Finally, the data is sliced to display a separate graph for the revenue and profit data for each product category by quarter.

The following are general steps to create a Graph visualization:

1. Determine the graph style that you want to use, based on the data that you want to display. For example images and data requirements for each graph style, see Minimum data requirements to create each Graph visualization style, page 183.

2. Add attributes and metrics to the visualization, to display the data using the graph style that you have chosen.

3. Select additional display options, such as whether to size or color graph elements (such as bar risers or bubbles) based on attributes or metric values.

4. Slice the data to show the graphs at the level of data that you want to display. Slicing means separating data into rows or columns of graph with an attribute. Alternatively, you can display a single set of graphs, with one graph for each combination of attributes. For a more detailed description, including example images, see Splitting a graph into separate rows or columns with an attribute, page 190.
For steps to create a specific type of Graph visualization, see the appropriate link below:

- For steps to create area, bar, and line graphs, see *Creating area, bar, or line graphs, page 192*.
- For steps to create bubble or scatter graphs, see *Creating a bubble or scatter graph, page 196*.
- For steps to create a graph with graph markers displayed in a grid layout, see *Creating a graph with graph markers displayed in a grid layout, page 200*.
- For steps to create a pie or ring graph, see *Creating a graph with pies or rings, page 202*.
- For steps to create a combination graph, see *Creating a combination graph, page 209*.
- For steps to create a dual-axis graph, see *Creating a dual-axis graph, page 215*.

Before you create a Graph visualization, you should be familiar with adding and displaying data in a Graph visualization. The following sections provide a general overview:

- *Adding data to a Graph visualization, page 188*
- *Splitting a graph into separate rows or columns with an attribute, page 190*
- *Displaying metric data in a visualization using the Metric Names attribute, page 186*

**Minimum data requirements to create each Graph visualization style**

The table below contains example images and data requirements for each graph style available for the Graph visualization. Steps to create each graph style follow.

After you create a Graph visualization, you can format it. For example, you can determine the shape used to display graph elements, whether to have MicroStrategy optimize space in the visualization by automatically sizing
graph elements, and so on. For steps, see *Formatting a Graph visualization, page 283.*

<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Requirements</th>
<th>Example Graph</th>
</tr>
</thead>
</table>
| Line        | • One attribute  
• One metric | ![Line Graph Example](image) |
| Bar         | • One attribute  
• One metric | ![Bar Graph Example](image) |
| Area        | • One attribute  
• One metric | ![Area Graph Example](image) |
| Scatter     | • Two metrics  
• One attribute (optional) | ![Scatter Graph Example](image) |
<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Requirements</th>
<th>Example Graph</th>
</tr>
</thead>
</table>
| Bubble            | • Three metrics  
                    • One attribute (optional)                                                   | [Image]       |
|                   | You can display a bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. See *Creating a bubble or scatter graph, page 196.* |               |
| Grid              | • Two attributes  
                    • Two metrics (optional)                                                   | [Image]       |
|                   | You can use the Grid style to identify trends across combinations of data. Each marker in the grid can be automatically sized or colored based on the value of a metric. See *Creating a graph with graph markers displayed in a grid layout, page 200.* |               |
| Pie or Ring       | • One attribute  
                    • One metric                                                                | [Image]       |
|                   | You can view the contribution of attribute elements or metrics to a total by displaying data in a pie or ring graph. See *Creating a graph with pies or rings, page 202.* |               |
| Combination       | • One attribute  
                    • Two metrics                                                               | [Image]       |
|                   | You can display the values of multiple metrics plotted on a graph, with each metric represented by a different graph type. For example, you can display cost using bar risers and display revenue as a line graph. See *Creating a combination graph, page 209.* |               |
Displaying metric data in a visualization using the Metric Names attribute

The Metric Names attribute is an attribute that contains the names of the metrics in a graph. You can determine how to display these metrics by placing the Metric Names attribute on the appropriate area of the Editor panel. For example, you can add the Metric Names attribute to the Break By area of a line graph to display a separate line for each metric in the graph. The Metric Names attribute can be placed on any area that accepts attributes.

The Metric Names attribute is automatically added to the Editor panel when you add metrics to the visualization. You can then choose how to display the metrics by placing the Metric Names attribute on one of the following areas:

- **Vertical**: The metrics can be used either to separate data into rows of graphs, or to display values along the Y-axis. Right-click, Left Row or Left Axis.
- **Horizontal**: The metrics can be used either to separate data into columns of graphs, or to display values along the X-axis. Right-click, Top Column or Bottom Axis.
- **Break By**: Display a graph item for each metric, such as a bar or line.
- **Slice**: Display a wedge for each metric in the Angle area. This option is available for pie or ring graphs.

You can also color graph items based on the metrics that they represent, by clicking and dragging the Metric Names attribute from any of the above areas to the Color By area. For example, in an area graph containing the Profit per Employee, Revenue per Employee, and Cost per Employee metrics, you can display each metric using a different colored area.
In a pie or ring graph, if you have placed at least two metrics in the Angle area and there are no metrics in the Horizontal area or Vertical area, the Metric Names attribute controls the location in which the names of the metrics in the Angle area are displayed. If you have placed metrics on the Horizontal area or the Vertical area, or for all other types of graphs, the Metric Names attribute controls the display of the metrics in the Horizontal area or Vertical area.

For example, in the image below, a visualization containing pie graphs is displayed. The Profit and Profit Per Employee metrics are placed on the Angle area, and no metrics have been placed on the Vertical or Horizontal areas. The Metric Names attribute, which controls the display of Profit and Profit per Employee, is placed on the Horizontal area. As a result, separate columns of pie graphs for Profit and Profit Per Employee are displayed in the visualization.

You can determine whether to use the metrics to separate data into columns of graphs, or display values along the X-axis. In the image below, the Metric Names attribute has been placed on the bottom X-axis. As a result, the graphs are no longer divided into columns for Profit and Profit Per
Employee. Instead, Profit and Profit Per Employee are displayed along the X-axis.

### Adding data to a Graph visualization

You can add data to a Graph visualization by clicking and dragging dataset objects onto the Vertical or Horizontal areas on the visualization’s Editor panel. You can also click and drag dataset objects onto the visualization itself; the dataset objects are automatically placed on the correct area in the Editor panel, depending on where you placed them in the visualization.

Each dataset object on the Vertical or Horizontal areas displays an icon indicating the location in which the object is displayed:

- **Left Axis**: The dataset object is displayed on the left vertical axis.
- **Right Axis**: The dataset object is displayed on the right vertical axis.
- **Top Axis**: The dataset object is displayed on the top horizontal axis.
- **Bottom Axis**: The dataset object is displayed on the bottom horizontal axis.
• Top Column (available for attributes): The attribute is used to split the data into columns of graphs. A separate column is displayed for each element in the attribute.

• Left Row (available for attributes): The attribute is used to split the data into rows of graphs. A separate row is displayed for each element in the attribute.

You can quickly add or rearrange the display of dataset objects in the Graph visualization by dragging them directly onto the graph area. For example, you can drag an attribute from the left vertical axis to the bottom horizontal axis. To do so, click and drag the object to its new location, so that a blue indicator is displayed in the place where you want to move the object. In the image below, the Profit Margin metric is being added to the right vertical axis.

![Graph Visualization with Profit Margin Metric]

You can place metrics on the top, bottom, left, or right axes of a graph visualization. Metrics can be added to up to two different axes at one time. These can be adjacent axes, in the case of scatter and bubble graphs, or opposite axes, in the case of dual-axis graphs.

Attributes can be placed on the left vertical axis or the bottom horizontal axis (also called the traditional graph axes).
Splitting a graph into separate rows or columns with an attribute

If you place more than one attribute on either the Vertical area or the Horizontal area, the attributes at the top of the area are used to split (or slice) your data into rows or columns of graphs.

For example, in the graph below, Region and State are placed on the Vertical area. By default, Region is used to split the data into rows of graphs. A separate row is displayed for each element in the attribute, in this case, for each region. This is indicated by the Left Row icon next to the Region name. Each region’s row contains a bar graph for each state in the region.
You can instead display one set of bar graphs, with a bar graph for each region and state combination. To do this, display Region on the left axis, along with State. Both attributes are displayed with the Left Axis icon.

You can split data based on any attribute, including the Metric Names attribute, which contains the names of the metrics in the graph. For an introduction to the Metric Names attribute, see "Displaying metric data in a visualization using the Metric Names attribute, page 186."

If you split the data into both rows and columns, a table of graphs is displayed, with a graph for each combination of the attribute elements.

Steps to use an attribute to split data into rows or columns of graphs, or display all attribute combinations in a single set of graphs, are included in "To create and add an area, bar, or line graph to a dashboard, page 192."
Creating area, bar, or line graphs

You can create area, bar, or line graphs using the Graph visualization:

- An area graph displays your data as a vertical or horizontal area graph. The area represents metric values for each element of an attribute.
- A bar graph displays your data as a vertical or horizontal bar graph. The bars represent metric values for each element of an attribute.
- A line graph displays your data as a vertical or horizontal line graph. The lines represent metric values for each element of an attribute.

Prerequisite

- You should be familiar with the general workflow for adding data to a Graph visualization and slicing your data into rows and columns. For details, see Adding data to a Graph visualization, page 188 and Splitting a graph into separate rows or columns with an attribute, page 190.

To create and add an area, bar, or line graph to a dashboard

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the Insert Visualization icon. A blank visualization is added to the dashboard.

3. If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4. On the Visualization Gallery, select one of the following:
   - To create an area chart, click the Area Chart icon.
   - To create a bar chart, click the Bar Chart icon.
   - To create a line chart, click the Line Chart icon.

5. If the Datasets panel is not displayed, from the View menu, select Dataset panel.
If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as described in the steps below. You can also drag objects from the Datasets panel directly onto the visualization.

To view data requirements for a graph style, hover your cursor over the visualization icon in the Visualization Gallery. For example images for each graph style, see Minimum data requirements to create each Graph visualization style, page 183.

To display values along the X-axis and Y-axis of the graph, perform the following steps:

• To display a vertical area, bar, or line graph:
  a To display attribute elements on the X-axis, place at least one attribute in the Horizontal area.
  b To display metric values on the Y-axis, place at least one metric in the Vertical area.

• To display a horizontal area, bar, or line graph:
  a To display metric values on the X-axis, place at least one metric in the Horizontal area.
  b To display attribute elements on the Y-axis, place at least one attribute in the Vertical area.

To color the items in the graph based on attributes or metrics, place objects on the Color By area, as follows:

• To color the graph items based on an attribute, place at least one attribute on the Color By area. Each value in the attribute is displayed using a different color. For example, you can display the sales data for each employee using a different bar riser color. If you add more than one attribute to the Color By area, each combination of the attribute values is displayed using a different color.

If other graphs and heat maps are colored based on the same attribute, each attribute value will display in the same color across all the graphs and heat maps. Desktop automatically selects the colors based on the color palette, but you can select a color for each attribute value. For steps, see Formatting a Graph visualization, page 283.
• To color graph items based on the value of a metric, place one metric on the **Color By** area. The graph items in the visualization are automatically shaded based on the value of the metric. For example, you can automatically color the areas in an area graph based on the value of the Profit metric, with larger profit values displayed using darker colors and smaller profit values displayed using lighter colors.

• To color graph items based on the metric that each item represents, place the Metric Names attribute on the **Color By** area. Each metric in the visualization is displayed using a different color. For example, you can display the Revenue, Cost, and Profit metrics using a different color for each metric.

10 To display a separate graph item for each element in an attribute, place at least one attribute in the **Break By** area. For example, you can display the revenue data for each Region as a separate line graph, or display a bar riser for each year of data. If you add more than one attribute to the Break By area, a graph element is displayed for each combination of the attribute elements.

11 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269.*

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form.** Select one of the following:

• To display an attribute form in the visualization, select the check box next to its name.

• To hide an attribute form in the visualization, clear the check box next to its name.

12 You can select which graph subtype to display in the visualization, or allow the subtype to be automatically chosen. Do one of the following:

• To select a specific graph subtype, select **Absolute**, **Stacked**, or **Percent**.

• To allow MicroStrategy to determine the graph subtype to use to display your data, select the **Automatic subtype** check box.

13 To size the graph items based on the value of a metric, place one metric in the **Size By** area. Graph items corresponding to large metric values are automatically displayed as larger in size, while graph elements for small metric values are displayed as smaller in size. For example, in a line
graph, lines representing larger metric values are displayed as thicker than lines representing smaller metric values.

* The Size By option is not available for Area Charts.

14 If you add multiple attributes to the Vertical or Horizontal area, the attributes at the top of the area are used to split your data into rows or columns of graphs, one row or column for each attribute element. If you slice the data into both rows and columns, a table of graphs is displayed, with a graph for each combination of the attribute elements. If data is not split, one set of graphs is displayed, with a graph for each combination of attributes. For an example, see *Splitting a graph into separate rows or columns with an attribute, page 190.*

- You can slice your data into an additional row of graphs. The last attribute in the Vertical area is displayed on the left axis, as indicated by the Left Axis icon next to the attribute name. Right-click this attribute and select **Left Row.**

- You can slice your data into an additional column of graphs. The last attribute in the Horizontal area is displayed on the bottom axis, as indicated by the Bottom Axis icon next to the attribute name. Right-click this attribute and select **Top Column.**

- If an attribute is displayed on a row, you can switch it to display on the left axis instead. Any attributes below it in the Vertical area are also displayed on the left axis. Right-click an attribute that displays the Left Row icon and select **Left Axis.**

- If an attribute is displayed on a column, you can switch it to display on the bottom axis instead. Any attributes below it in the Horizontal area are also displayed on the bottom axis. Right-click an attribute that displays the Top Column icon and select **Bottom Axis.**

15 To display additional metrics in a tooltip when you hover the cursor over a graph element, place the metrics that you want to display on the **Tooltip** area.

16 You can define other options, such as whether graph items are displayed as squares, lines, or circles. For steps, see *Formatting a Graph visualization, page 283.*

17 To save the dashboard, click the **Save** icon.

**Related topics**

- *Formatting a Graph visualization, page 283*
Creating a bubble or scatter graph

You can create a Graph visualization that contains a bubble or scatter graph:

- A bubble graph displays a bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. Bubbles representing attribute elements are graphed on a scatter plot, then sized based on the value of a metric.

- A scatter graph displays a scatter plot that allows you to visualize the trends of two different metrics for a set of attribute elements. A scatter graph is similar to a bubble graph, but does not size the markers in the graph based on the value of a metric.
Prerequisite

- You should be familiar with the general workflow for adding data to a Graph visualization and slicing your data into rows and columns. For details, see Adding data to a Graph visualization, page 188 and Splitting a graph into separate rows or columns with an attribute, page 190.

To create and add a bubble or scatter graph to a dashboard

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the Insert Visualization icon. A blank visualization is added to the dashboard.

3. If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4. On the Visualization Gallery, click the Bubble Chart icon.

5. If the Datasets panel is not displayed, from the View menu, select Dataset panel.

6. If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

7. Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as described in the steps below. You can also drag objects from the Datasets panel directly onto the visualization.

   To view data requirements for a graph style, hover your cursor over the visualization icon in the Visualization Gallery. For example images for each graph style, see Minimum data requirements to create each Graph visualization style, page 183.

8. To determine the metric used to position each marker on the X-axis of the graph, place the metric in the Horizontal area.

9. To determine the metric used to position each marker on the Y-axis of the graph, place the metric in the Vertical area.
To determine the size of the bubbles in the graph, place one metric in the **Size By** area. Bubbles corresponding to large metric values are automatically displayed as larger in size, while bubbles for small metric values are displayed as smaller in size.

If the Horizontal, Vertical, and Size By areas contain the same number of metrics, tuples of bubbles will be displayed on the Graph visualization. If the Horizontal area contains more metrics than the Vertical and Size areas, the additional metrics in the Horizontal area are ignored. If the Vertical area contains more metrics than the Horizontal and Size areas, the additional metrics in the Vertical area are ignored.

To color the graph markers, place objects on the **Color By** area, as follows:

- To color the graph markers based on an attribute, place at least one attribute on the **Color By** area. Each value in the attribute is displayed using a different color. For example, you can display the sales data for each employee using a different bubble color. If you add more than one attribute to the Color By area, each combination of the attribute values is displayed using a different color.

  If other graphs and heat maps are colored based on the same attribute, each attribute value will display in the same color across all the graphs and heat maps. Desktop automatically selects the colors based on the color palette, but you can select a color for each attribute value. For steps, see *Formatting a Graph visualization, page 283*.

- To color markers based on the value of a metric, place one metric on the **Color By** area. The markers in the visualization are shaded based on the value of the metric. For example, you can automatically color the bubbles in a bubble graph based on the value of the Profit metric, with larger profit values displayed using darker colors and smaller profit values displayed using lighter colors.

- To color graph items based on the metric that each item represents, place the Metric Names attribute on the **Color By** area. Each metric in the visualization is displayed using a different color. For example, you can display the Revenue, Cost, and Profit metrics using a different color for each metric.

To display a separate graph marker for each element in an attribute, place at least one attribute in the **Break By** area. For example, you can display the revenue data for each Region as a separate marker, or display a marker for each year of data. If you add more than one attribute to the
Break By area, a graph element is displayed for each combination of the attribute elements.

13 Once you have added data to the visualization, you can choose to slice the data into rows and columns of separate graphs, based on attributes. If you slice the data into both rows and columns, a table of graphs is displayed, with a graph for each combination of the attribute elements. Choose from the following:

• To display a row of graphs in the visualization, click and drag at least one attribute to the top of the Vertical area. Each graph is displayed in a separate row, one for each element in the attribute.

• To display a column of graphs in the visualization, click and drag at least one attribute to the top of the Horizontal area. Each graph is displayed in a separate column, one for each element in the attribute.

14 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see Selecting which attribute forms to display in a visualization, page 269.

To select the attribute forms, in the Editor panel, right-click the attribute and point to Display Attribute Form. Select one of the following:

• To display an attribute form in the visualization, select the check box next to its name.

• To hide an attribute form in the visualization, clear the check box next to its name.

15 To display additional metrics in a tooltip when you hover the cursor over a graph element, place the metrics that you want to display on the Tooltip area.

16 You can define other options, such as the shape of graph markers. For steps, see Formatting a Graph visualization, page 283.

17 To save the dashboard, click the Save icon.

Related topics

• Formatting a Graph visualization, page 283
• Analyzing data in a graph, page 427
Creating a graph with graph markers displayed in a grid layout

You can analyze trends across combinations of data using markers displayed in a grid layout. You can size or color each marker in the grid based on the value of a metric.

In the example graph below, a separate marker is displayed for each combination of product category and sales region. Markers representing large revenue values are displayed in dark blue, and markers for smaller revenue values are displayed in light blue.

---

**To create and add a graph that displays markers in a grid layout to a dashboard**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the **Insert Visualization** icon. A blank visualization is added to the dashboard.
3 If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4 On the Visualization Gallery, click the Bubble Chart icon.

5 If the Datasets panel is not displayed, from the View menu, select Dataset Panel.

6 If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

7 Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as described in the steps below. You can also drag objects from the Datasets panel directly onto the visualization.

   To view data requirements for a graph style, hover your cursor over the visualization icon in the Visualization Gallery. For example images for each graph style, see Minimum data requirements to create each Graph visualization style, page 183.

8 Place at least one attribute in the Horizontal area. A column of bubbles will be displayed for each element in this attribute.

9 Place at least one attribute in the Vertical area. A row of bubbles will be displayed for each element in this attribute.

10 To color the graph markers, place objects on the Color By area, as follows:

   • To color the graph markers based on an attribute, place at least one attribute on the Color By area. Each value in the attribute is displayed using a different color. For example, you can display the sales data for each employee using a different bubble color. If you add more than one attribute to the Color By area, each combination of the attribute values is displayed using a different color.

      If other graphs and heat maps are colored based on the same attribute, each attribute value will display in the same color across all the graphs and heat maps. Desktop automatically selects the colors based on the color palette, but you can select a color for each attribute value. For steps, see Formatting a Graph visualization, page 283.

   • To color markers in the grid based on the value of a metric, place the metric in the Color By area.
11 To size markers in the grid based on the value of a metric, place the metric in the **Size By** area.

12 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269.*

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form**. Select one of the following:

- To display an attribute form in the visualization, select the check box next to its name.
- To hide an attribute form in the visualization, clear the check box next to its name.

13 To display additional metrics in a tooltip when you hover the cursor over a graph item, place the metrics that you want to display on the **Tooltip** area.

14 You can define other options, such as the shape of graph markers. For steps, see *Formatting a Graph visualization, page 283.*

15 To save the dashboard, click the **Save** icon 📝.

**Related topics**

- *Formatting a Graph visualization, page 283*
- *Analyzing data in a graph, page 427*
- *Creating a Graph visualization, page 181*
- *Displaying a visual representation of your data: Visualizations, page 179*
- *Creating a dashboard, page 146*

**Creating a graph with pies or rings**

You can view the contribution of attribute elements or metrics to a total by displaying your data in a pie or ring graph. In the example below, a pie graph displays the contribution of each region to the yearly profit. At a glance, you
can see that the Northeast region (displayed in green) contributes the most profit in both years.

<table>
<thead>
<tr>
<th>Year</th>
<th>Profit</th>
<th>Profit per Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>2011</td>
<td><img src="image1.png" alt="Pie chart for 2011" /></td>
<td><img src="image2.png" alt="Pie chart for 2011" /></td>
</tr>
<tr>
<td>2012</td>
<td><img src="image3.png" alt="Pie chart for 2012" /></td>
<td><img src="image4.png" alt="Pie chart for 2012" /></td>
</tr>
</tbody>
</table>

You can take advantage of a variety of display styles to display pie or ring graphs. For example, you can display pie graphs in a scatter layout, or display ring graphs in a grid. For a list of available display styles, see Display styles for pie or ring graphs, page 207. If your Graph visualization contains pies or rings displayed in the same position in the visualization, the graphs are overlaid on top of each other, as shown in the image below. A white circle is displayed around pie graphs that have been overlaid on top of other pie graphs to distinguish them as separate graphs.
Prerequisite

- You should be familiar with the general workflow for slicing your data into rows and columns. For details, see *Splitting a graph into separate rows or columns with an attribute, page 190.*

To create and add a pie or ring graph to a dashboard

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the Insert Visualization icon 📊. A blank visualization is added to the dashboard.

3. If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4. On the Visualization Gallery, click the Pie Chart icon 🥧.

5. If the Datasets panel is not displayed, from the View menu, select Dataset panel.

6. If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon 🏷 to display the Editor panel.

7. Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as described in the steps below. You can also drag objects from the Datasets panel directly onto the visualization.

   To view data requirements for a graph style, hover your cursor over the visualization icon in the Visualization Gallery. For example images for each graph style, see *Minimum data requirements to create each Graph visualization style, page 183.*

8. To determine the size of wedges in the pie or ring graph, place at least one metric on the Angle area. Wedges that represent larger metric values are displayed as larger than wedges that represent smaller metric values. If you add multiple metrics to the Angle area, each metric in the Angle area is used to display a separate pie or ring graph in the visualization.

9. To determine the number of wedges in the pie or ring graph, choose from the following:
To display a wedge for each element of an attribute, place at least one attribute on the **Slice** area.

To display a wedge for each metric in the Angle area, place the Metric Names object on the **Slice** area.

### 10 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269.*

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form.** Select one of the following:

- To display an attribute form in the visualization, select the check box next to its name.
- To hide an attribute form in the visualization, clear the check box next to its name.

### 11 You can display the pie or ring graphs in a visualization using a variety of different display layouts. For example, you can display pie graphs in a scatter graph, or arrange ring graphs in a grid, with a ring graph for each combination of attribute elements displayed on the X-axis and Y-axis. For a list of possible layouts that you can choose from when designing pie or ring graphs and the data requirements to display each layout type, as well as example images, see *Display styles for pie or ring graphs, page 207.*

Click and drag attributes and metrics to the **Horizontal** and **Vertical** areas on the Editor panel to display the graph using a specific display layout.

**Determine color, break by, and sizing options**

### 12 To color the wedges in a visualization, choose from the following:

- To color the wedges based on the attribute value that each wedge represents, place at least one attribute on the **Color By** area. Each value in the attribute is displayed using a different color.

  If other graphs and heat maps are colored based on the same attribute, each attribute value will display in the same color across all the graphs and heat maps. Desktop automatically selects the colors based on the color palette, but you can select a color for each attribute value. For steps, see *Formatting a Graph visualization, page 283.*

- To color the wedges based on the value of a metric, place one metric on the **Color By** area. Wedges corresponding to smaller metric values
are displayed as lighter in color than wedges corresponding to larger metric values.

- To color the wedges based on the metric each wedge represents, place the Metric Names object on the Color By area. Each metric in the Angle area is displayed using a different color.

13 You can display a separate ring or pie graph for each element in an attribute, each metric in the Angle area, or both. For example, you can display the revenue data for each Region as a separate pie graph. This option is available if the Slice area is empty and there are no attributes or metrics displayed on the X-axis or Y-axis, or if there is an attribute in the Slice area and at least one metric on either the X-axis or Y-axis of the graph.

- To display a separate graph for each element in an attribute, place at least one attribute in the Break By area. If you add more than one attribute to the Break By area, a graph is displayed for each combination of the attribute elements.

- To display a separate graph for each metric in the Angle area, click and drag the Metric Names object onto the Break By area.

14 To have the pie or ring graphs automatically sized based on the value of a metric, place one metric in the Size By area. Pie or ring graphs corresponding to large metric values are automatically displayed as larger in size, while pie or ring graphs for small metric values are displayed as smaller in size.

**Slice the data into rows and columns**

15 Once you have added data to the visualization, you can choose to slice the data into rows and columns of separate graphs, based on attributes. If you slice the data into both rows and columns, a table of graphs is displayed, with a graph for each combination of the attribute elements. Choose from the following:

- To display a row of graphs in the visualization, click and drag at least one attribute to the top of the Vertical area. If an arrow icon is displayed in the Vertical area, the attribute should be placed above the arrow. Each graph is displayed in a separate row, one for each element in the attribute.

- To display a column of graphs in the visualization, click and drag at least one attribute to the top of the Horizontal area. If an arrow icon is displayed in the Horizontal area, the attribute should be placed above the arrow. Each graph is displayed in a separate column, one for each element in the attribute.
16 To display additional metrics in a tooltip when you hover the cursor over a graph element, place the metrics you want to display on the **Tooltip** area.

17 To save the dashboard, click the **Save** icon.

**Display styles for pie or ring graphs**

You can display the pie or ring graphs in a visualization using a variety of different display layouts. For example, you can display pie graphs in a scatter graph, or arrange ring graphs in a grid, with a ring graph for each combination of attribute elements displayed on the X-axis and Y-axis. The table below displays a list of possible layouts that you can choose from when designing pie or ring graphs and the data requirements to display each layout type, as well as example images.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Minimum Data Requirements</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the pie or ring graphs in a vertical layout</td>
<td>• One metric in the Vertical area</td>
<td><img src="image.png" alt="Example Image" /></td>
</tr>
<tr>
<td>Goal</td>
<td>Minimum Data Requirements</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Display the pie or ring graphs in a horizontal layout</td>
<td>• One metric in the Horizontal area</td>
<td><img src="image1.png" alt="Pie Chart Example" /></td>
</tr>
<tr>
<td>Display the pie or ring graphs in a scatter graph layout</td>
<td>• One metric in the Vertical area</td>
<td><img src="image2.png" alt="Scatter Chart Example" /></td>
</tr>
<tr>
<td>Display the pie or ring graphs in a bubble graph layout</td>
<td>• One metric in the Vertical area</td>
<td><img src="image3.png" alt="Bubble Chart Example" /></td>
</tr>
<tr>
<td></td>
<td>• One metric in the Horizontal area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• One metric in the Horizontal area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• One metric in the Size By area</td>
<td></td>
</tr>
</tbody>
</table>
Creating a combination graph

Combination graphs display a combination of different graph shapes in the same Graph visualization. For example, you can use combination graphs for stock volume graphs, which combine the line graph and bar graph. You can display a graph that contains sales statistics, with actual sales values displayed using bar risers and target sales values displayed as tick marks overlaid on top of the bars. Each metric in a combination graph can be

<table>
<thead>
<tr>
<th>Goal</th>
<th>Minimum Data Requirements</th>
<th>Example</th>
</tr>
</thead>
</table>
| Display the pie or ring graphs in a grid layout | • One attribute in the Vertical area  
• One attribute in the Horizontal area | ![Example of a grid layout with pie charts] |

Related topics

- Formatting a Graph visualization, page 283
- Analyzing data in a graph, page 427
- Creating a Graph visualization, page 181
- Displaying a visual representation of your data: Visualizations, page 179
- Creating a dashboard, page 146
displayed using a different shape. Steps to create and add a combination graph to a dashboard are provided below.

In the image above, multiple metrics are displayed in a single graph. You can also slice your data to display multiple rows or columns of graphs. For example, you can display each metric in a separate graph, and use a different graph shape for each metric. To do so, you slice the graph using the Metric Names attribute. Steps to slice your data into multiple graphs are included below.
A combination graph can display the following graph shapes:

- Areas
- Bars
- Circles
- Squares
- Lines
- Ticks (also called tick marks)

In a stacked combination graph, each metric is displayed in the graph in the order in which it appears in the Vertical or Horizontal area on the visualization’s Editor panel.

In an absolute combination graph, each metric is displayed in order according to the shape used to represent the metric’s values in the graph, as follows (shapes with higher priority are displayed at the top of the list):

1. Areas
2. Bars
3. Circles or Squares
4. Lines or Ticks

If more than one metric is displayed using shapes with the same display priority, the order in which they appear in the Vertical or Horizontal area determines the order in which they are displayed.

You can convert an existing area, bar, or line graph into a combination graph by right-clicking the name of a metric in the graph, pointing to **Change Shape**, and selecting the type of shape to use to display metric values. For steps to create an area, bar, or line graph, see *Creating area, bar, or line graphs, page 192*.

---

**To create a combination graph**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.
2 To add a new visualization to the dashboard, from the toolbar, click the **Insert Visualization** icon. A blank visualization is added to the dashboard.

3 On the Visualization Gallery, select the **Combo Chart** icon.
   - If the Visualization Gallery is not displayed, from the **View** menu, select **Visualization Gallery**.

4 If the Datasets panel is not displayed, from the **View** menu, select **Dataset panel**.

5 If the Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

6 Add data to the visualization. From the **Datasets** panel, click and drag objects to the **Editor** panel, as described in the steps below. You can also drag objects from the Datasets panel directly onto the visualization.

   To view data requirements for a graph style, hover your cursor over the visualization icon in the Visualization Gallery. For example images for each graph style, see **Minimum data requirements to create each Graph visualization style, page 183**.

7 To display values along the X-axis and Y-axis of the graph, perform the following steps:
   - To display a vertical combination graph:
     a To display attribute elements on the X-axis, place at least one attribute in the **Horizontal** area.
     b To display metric values on the Y-axis, place at least one metric in the **Vertical** area.
   - To display a horizontal combination graph:
     a To display metric values on the X-axis, place at least one metric in the **Horizontal** area.
     b To display attribute elements on the Y-axis, place at least one attribute in the **Vertical** area.
To color the items in the graph based on attributes or metrics, place objects on the **Color By** area, as follows:

- To color the graph items based on an attribute, place at least one attribute on the **Color By** area. Each value in the attribute is displayed using a different color. For example, you can display the sales data for each employee using a different bar riser color. If you add more than one attribute to the Color By area, each combination of the attribute values is displayed using a different color.

  If other graphs and heat maps are colored based on the same attribute, each attribute value will display in the same color across all the graphs and heat maps. Desktop automatically selects the colors based on the color palette, but you can select a color for each attribute value. For steps, see *Formatting a Graph visualization*, page 283.

- To color graph items based on the value of a metric, place one metric on the **Color By** area. The graph items in the visualization are automatically shaded based on the value of the metric. For example, you can automatically color the areas in a graph based on the value of the Profit metric, with larger profit values displayed using darker colors and smaller profit values displayed using lighter colors.

- To color graph items based on the metric that each item represents, place the Metric Names attribute on the **Color By** area. Each metric in the visualization is displayed using a different color. For example, you can display the Revenue, Cost, and Profit metrics using a different color for each metric.

To display a separate graph item for each element in an attribute, place at least one attribute in the **Break By** area. For example, you can display the revenue data for each Region as a separate line, or display a bar riser for each year of data. If you add more than one attribute to the Break By area, a graph item is displayed for each combination of the attribute elements.

You can select which graph subtype to display in the visualization, or allow the subtype to be automatically chosen. Do one of the following:

- To select a specific graph subtype, select **Absolute**, **Stacked**, or **Percent**.

- To allow MicroStrategy to determine the graph subtype to use to display your data, select the **Automatic subtype** check box.

To size the graph items based on the value of a metric, place one metric in the **Size By** area. Graph items corresponding to large metric values are displayed as larger in size, while graph items for small metric values are...
displayed as smaller in size. For example, lines representing larger metric values are displayed as thicker than lines representing smaller metric values.

12 Once you have added data to the visualization, you can choose to slice the data into rows and columns of separate graphs, based on attributes. If you slice the data into both rows and columns, a table of graphs is displayed, with a graph for each combination of the attribute elements. Choose from the following:

- To display a row of graphs in the visualization, click and drag at least one attribute to the top of the **Vertical** area. Each graph is displayed in a separate row, one for each element in the attribute.

- To display a column of graphs in the visualization, click and drag at least one attribute to the top of the **Horizontal** area. Each graph is displayed in a separate column, one for each element in the attribute.

13 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see **Selecting which attribute forms to display in a visualization, page 269**.

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form**. Select one of the following:

- To display an attribute form in the visualization, select the check box next to its name.

- To hide an attribute form in the visualization, clear the check box next to its name.

14 To display additional metrics in a tooltip when you hover the cursor over a graph item, place the metrics that you want to display on the **Tooltip** area.

15 To change the shape used to display a metric in the graph, right-click the name of the metric in the Editor panel. You can also select the name of the metric in the graph. Point to **Change Shape**, then select the shape to use to display the metric. Repeat this step as necessary to define the shape to use to display each metric in the graph.

16 To save the dashboard, click the **Save** icon 🔄.
Creating a dual-axis graph

A dual-axis graph is useful for displaying metrics that contain very different ranges of values. For example, a dashboard includes a Profit metric that returns currency information in the thousands and millions. The same dashboard also includes a Profit Margin metric that returns percentages such as 25%. These two metrics would benefit from being shown on graph axes that use different graph scales to display values.

A dual-axis graph displays two different graph axes, displayed on opposite sides of the graph. This can be the left and right vertical axes, as shown in the image below, or the top and bottom horizontal axes. The following example is a dual-axis graph that displays the Profit and Profit Margin metrics on different axes, with different scales.
To create a dual-axis graph, you create an area, bar, or line graph and add a metric to be displayed on the graph’s second axis. Steps to create a dual-axis graph are below.

Dual-axis graphs that contain a bar graph on each axis or an area graph on each axis are not supported.

**Prerequisite**

- The steps below assume that you have already created an area, bar, or line graph to modify. For steps, see *Creating area, bar, or line graphs*, page 192.

**To create and add a dual-axis graph to a dashboard**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. If the Datasets panel is not displayed, from the **View** menu, select **Dataset panel**.

3. If the Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

4. Select the area, bar, or line graph to convert to a dual-axis graph.
5 Add data to the visualization. From the **Datasets** panel, click and drag objects to the **Editor** panel, as described in the steps below. You can also drag objects from the Datasets panel directly onto the visualization.

To view data requirements for a graph style, hover your cursor over the visualization icon in the Visualization Gallery. For example images for each graph style, see *Minimum data requirements to create each Graph visualization style, page 183*.

6 To display the values of a metric on the graph’s second axis, from the Datasets panel, click and drag a metric onto the second axis. The second axis must be placed on the axis that is opposite from the graph axis that you have already placed metric values on.

In the example below, the Profit metric is graphed on the left vertical axis. The Profit Margin metric is being added to the right vertical axis to create a dual-axis graph.

7 You can add multiple dual-axis graphs to the same Graph visualization. For example, you can create a dual-axis graph that displays Profit and Profit Margin, then add a dual-axis graph with axes for Revenue and Revenue Per Employee. Perform the following steps:

- If the first dual-axis graph in your visualization displays metrics on the vertical axes:
  - To add a new dual-axis graph to the visualization, from the Datasets panel, click the metric to place on the first axis of the new dual-axis graph, and drag it to the bottom of the Vertical area.
b In the Editor panel, right-click **Metric Names**, then select **Left Row**. A second dual-axis graph is added to the visualization.

c From the Datasets panel, click and drag a metric onto the second axis in the new dual-axis graph.

d Repeat the appropriate steps above as necessary to continue adding dual-axis graphs to the visualization.

- If the first dual-axis graph in your visualization displays metrics on the horizontal axes:

  a To add a new dual-axis graph to the visualization, from the Datasets panel, click the metric to place on the first axis of the new dual-axis graph, and place it on the bottom of the Horizontal area.

  b In the Editor panel, right-click **Metric Names**, then select **Top Column**. A second dual-axis graph is added to the visualization.

  c From the Datasets panel, click and drag a metric onto the second axis in the new dual-axis graph.

  d Repeat the appropriate steps above as necessary to continue adding dual-axis graphs to the visualization.

An example of adding a second dual-axis graph to a Graph visualization is displayed below.

Once you have added data to the visualization, you can choose to slice the data into rows and columns of separate graphs, based on attributes. If you slice the data into both rows and columns, a table of graphs is
displayed, with a graph for each combination of the attribute elements. Choose from the following:

- To display a row of graphs in the visualization, click and drag at least one attribute to the top of the **Vertical** area. Each graph is displayed in a separate row, one for each element in the attribute.

- To display a column of graphs in the visualization, click and drag at least one attribute to the top of the **Horizontal** area. Each graph is displayed in a separate column, one for each element in the attribute.

9 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269.*

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form.** Select one of the following:

- To display an attribute form in the visualization, select the check box next to its name.

- To hide an attribute form in the visualization, clear the check box next to its name.

10 To save the dashboard, click the **Save** icon 📝.

**Related topics**

- *Formatting a Graph visualization, page 283*
- *Analyzing data in a graph, page 427*
- *Creating a Graph visualization, page 181*
- *Displaying a visual representation of your data: Visualizations, page 179*
- *Creating a dashboard, page 146*
Creating a Grid visualization

You can display your data in a tabular layout with a Grid visualization, as shown in the image below.

You can quickly interact with data in the grid to customize your view of the information displayed in the visualization. For example, you can:

- Sort attribute elements or metric values in ascending or descending order, or use multiple conditions to sort data.
- Rearrange attributes and metrics, or swap the rows and columns displayed in the grid.
- Filter data to display only selected attribute elements or metric values.
- Add and display subtotals in the grid.
You can also understand your data and prepare it for displaying on other types of visualizations by using the Grid visualization as an intermediate tool. For example, you can:

- Select a subset of your business data to display by filtering and drilling on the data in a Grid visualization, and then change the Grid visualization into the type of visualization that you want to use to display your data. For steps to filter or drill on data in a Grid visualization, see *Analyzing data in a grid, page 434*. For steps to change a visualization type, see *Changing the type of visualization displayed, page 246*.

- Easily view the values of attributes and metrics in a dataset. For example, you have a dataset that contains unfamiliar data. You can quickly familiarize yourself with the data by displaying the data in a Grid visualization. Follow the steps below to display your data in a Grid visualization.

- Identify and resolve problems with your datasets. For example, when you link attributes that are shared in common across datasets, you can confirm whether the data linking created the expected results by displaying data from the linked datasets in a Grid visualization. Once you are satisfied, you can change the visualization into the type of visualization that you want to use to display your data. For background information about using multiple datasets in a dashboard, see *Creating visualizations using data from multiple datasets, page 252*. For steps to change a visualization type, see *Changing the type of visualization displayed, page 246*.

Follow the steps below to insert a Grid visualization, then select and add data to display in the visualization.

---

**To add a Grid visualization to a dashboard**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the **Insert Visualization** icon 📊. A blank visualization is added to the dashboard.

3. On the Visualization Gallery, click the **Grid** icon 📊.

   If the Visualization Gallery is not displayed, from the **View** menu, select **Visualization Gallery**.
4 If the Datasets panel is not displayed, from the View menu, select Dataset panel.

5 If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

6 Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as follows:

   • To add an attribute to the rows, drag the attribute to the Rows area.
      An attribute is a business concept, such as Region or Income Bracket, that provides a label for the numerical data (metrics) in your dashboard.
   • To add an attribute to the columns, drag the attribute to the Columns area.
   • To add a metric to the visualization, drag the metric to the Metrics area. The Metric Names object, an attribute created by MicroStrategy Desktop, is automatically added to the Editor panel. You can drag and drop the Metric Names object to the Rows or Columns area of the Editor panel, to change whether the metrics are displayed on the rows or columns of the grid.
      A metric is a calculation performed on your data to provide a business measure or key performance indicator, such as Revenue, Profit, Employee Headcount, or Probability of Purchase.

      You can also drag objects from the Datasets panel directly onto the visualization.

7 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see Selecting which attribute forms to display in a visualization, page 269.

   To select the attribute forms, in the Editor panel, right-click the attribute and point to Display Attribute Form. Select one of the following:

   • To display an attribute form in the visualization, select the check box next to its name.
   • To hide an attribute form in the visualization, clear the check box next to its name.
8  To save your dashboard and the new Grid visualization, click the **Save** icon.

**Related topics**

- *Formatting a Grid visualization, page 293*
- *Formatting visualizations, page 264*
- *Analyzing data in a grid, page 434*
- *Creating a Graph visualization, page 181*
- *Creating a dashboard, page 146*

**Creating a Heat Map visualization**

You can quickly grasp the state and impact of a large number of variables at one time by displaying your data with a Heat Map visualization. A Heat Map visualization is a combination of nested, colored rectangles, each
representing an attribute element. Heat Maps are often used in the financial services industry to review the status of a portfolio.

The rectangles contain a wide variety and many shadings of colors, which emphasize the weight of the various components. In a Heat Map visualization:

- The size of each rectangle represents its relative weight. In the example above, Total Emissions determines the size of the rectangles. The legend provides information about the minimum and maximum values.

- The color of each rectangle represents its relative value. For example, in the image above, larger values of the Percentage of Total Emissions are green and smaller values are red. The legend provides the range of values for each color.
The large areas, such as the Europe area of rectangles in the image above, represent different groups of data.

The small rectangles, such as Germany in the image above, represent individual attribute values.

Follow the steps below to create a blank Heat Map visualization, then select and add data to display in the visualization.

To create and add a Heat Map visualization to a dashboard

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the Insert Visualization icon. A blank visualization is added to the dashboard.

3. On the Visualization Gallery, click the Heat Map icon.

   If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4. If the Datasets panel is not displayed, from the View menu, select Dataset panel.

5. If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

6. Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as follows. You can also drag objects from the Datasets panel directly onto the visualization.

   • Drag at least one attribute to the Grouping area. The elements of the attribute are displayed in the visualization. For example, if the attribute is Year, a rectangle for each year is displayed in the visualization.

   You can drag additional attributes to the Grouping area to group the rectangles in the visualization in a larger area. For example, in the example image above, the Region attribute contains the element South and the Call Center attribute contains the elements New Orleans and Memphis. If Region is placed above Call Center in the

Grouping area, an area called South is displayed in the visualization, with the rectangles New Orleans and Memphis inside. You can add additional attributes to further group the rectangles in the Heat Map.

- To select the metric that determines the size of each rectangle, drag the metric to the **Size By** area. Rectangles for large metric values are displayed as larger than rectangles for small metric values.

- To have the rectangles colored automatically based on the value of a metric or the values in an attribute, drag the attribute or metric to the **Color By** area.

  If other graphs and heat maps are colored based on the same attribute, each attribute value will display in the same color across all the graphs and heat maps. Desktop automatically selects the colors based on the color palette, but you can select a color for each attribute value. For steps, see *Formatting a Heat Map visualization, page 296*.

7 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269*.

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form**. Select one of the following:

- To display an attribute form in the visualization, select the check box next to its name.

- To hide an attribute form in the visualization, clear the check box next to its name.

8 To display additional metrics in a tooltip when you hover the cursor over a rectangle, place the metrics to display on the **Tooltip** area.

9 To save your dashboard and the new Heat Map visualization, click the **Save** icon.

**Related topics**

- *Formatting a Heat Map visualization, page 296*
- *Formatting visualizations, page 264*
- *Analyzing data in a heat map, page 438*
• Creating a dashboard, page 146

Creating an ESRI Map visualization

You can display your data as markers, density maps, or areas on an interactive map using the ESRI Map visualization. For example, you can create a ESRI Map visualization that displays how customer households are clustered in different parts of the country using a density map, or display retail locations as a series of map markers that users can click to view additional information about stores in their area. Depending on how you want to display data on a map, select which type of ESRI Map visualization to use based on the following information:

• Map markers are ideal when you want to display an individual map marker for each geographic location, such as a marker for each store. You can display map markers as static image markers or bubble markers:
  □ Image markers are fixed size images that mark locations on the map. You can color image markers or replace image markers in the visualization with a different image based on the value of a metric.
  □ Bubble markers provide two visual cues to help users analyze data displayed on a map: size and color. You can choose to size each bubble marker in the visualization based on the value of a metric, with the largest bubbles being displayed for the largest metric values. You can have bubble markers colored based on the value of a metric.

For an example and steps to create this type of visualization, see Creating an ESRI Map visualization that displays map markers, page 228.

• A density map helps you understand patterns and trends for many geographic locations by displaying color gradients based on the concentration of geographic data. For example, you can display locations with a high concentration of stores in red, and locations with a low concentration of stores in blue. See Creating an ESRI Map visualization that displays a density map, page 233.

• Map areas are colored, two-dimensional areas on a map that represent geographic regions, such as countries, states, and counties. You can color-code areas based on the value of a metric. For an example and steps to create this visualization, see Creating an ESRI Map visualization that displays areas, page 239.
Creating an ESRI Map visualization that displays map markers

You can display your data as locations on an interactive map using the ESRI Map visualization. You can display the locations as map markers, which are ideal when you want to display an individual map marker for each geographic location. For example, you can display retail locations as a series of map markers that you can click to view additional information about stores in their area.

You can display map markers as static image markers or bubble markers:

- Image markers are fixed size images that mark locations on the map. You can color image markers or replace image markers in the visualization with a different image based on the value of a metric.

- Bubble markers provide two visual cues to help you analyze data displayed on a map: size and color. You can choose to size each bubble marker in the visualization based on the value of a metric, with the largest bubbles being displayed for the largest metric values. You can have bubble markers colored based on the value of a metric.

You can:

- View different types of maps, such as a topographical map or a satellite image.

- Cluster map markers in a circle when a large number of map markers are displayed in the same map area. You can zoom in on the area and display individual map markers by clicking a cluster.

- Display additional information about a location when you click a location in the visualization, by adding tooltips.

For steps to create an ESRI Map visualization that displays map markers, see Steps to create an ESRI Map visualization that displays map markers, page 230.

Providing geographical information for an ESRI Map visualization that displays map markers

To display map markers in the ESRI Map visualization, you must provide the latitude and longitude of each location in the map. You provide this information when you are importing data by assigning a geo role to a data column, as described in Preparing your data to display on maps: Geo roles,
You provide latitude and longitude information for an ESRI Map visualization in one of the following ways:

- Define a single attribute and assign it a geo role to identify what type of geographical information it contains. MicroStrategy Desktop automatically adds latitude and longitude information to the attribute, enabling you to display the attribute data as map markers.

  For example, your data source includes the names of cities where your company has field offices. You can create an attribute called City, which contains the names of these cities, then assign it the City geo role. MicroStrategy Desktop automatically adds latitude and longitude information for each city to the City attribute. You can then use the City attribute to provide latitude and longitude information for map markers in the visualization.

MicroStrategy Desktop automatically adds latitude and longitude information to data columns that you assign the Country, State, City, ZIP Code, or Location geo roles.

MicroStrategy adds latitude and longitude information to an attribute by adding attribute forms to the attribute. An attribute form is a component of an attribute that provides additional descriptive information about the attribute. Attribute forms appear in the Editor panel of an ESRI Map visualization when you display your data using an attribute that has been assigned a geo role for which MicroStrategy automatically adds latitude and longitude information. For example, in the example above, the supplemental latitude and longitude information is contained in the attribute forms City@Latitude and City@Longitude. You can select which attribute forms are displayed in the visualization; for steps, see Selecting which attribute forms to display in a visualization, page 269.

- Define two separate attributes to provide the latitude and longitude information of each location.

  For example, your data source has latitude and longitude information for each of your company’s stores. You can create one attribute that contains the latitude of each store, and assign the attribute the Latitude geo role. You can create a second attribute that contains the longitude of each store, and assign the second attribute the Longitude geo role. You can then use the two Latitude and Longitude attributes to provide latitude and longitude information for map markers in the visualization.

For background information about importing data into MicroStrategy Desktop, see Importing Data into MicroStrategy Desktop, page 55.
Steps to create an ESRI Map visualization that displays map markers

Prerequisites

- The steps below assume that the dashboard’s dataset already includes attributes that provide the geographical location of each map marker in the ESRI Map visualization. You can provide location information in one of the following ways:
  - Provide one attribute that has been assigned a geo role for which MicroStrategy automatically adds the latitude and longitude information for each map marker. For example, you can provide an attribute that has been assigned the Country, State, City, ZIP Code, or Location geo roles during the data import process.
  - Provide two separate attributes, as follows:
    - One attribute that contains the latitude of each map marker. For example, you can provide an attribute that has been assigned the Latitude geo role during the data import process.
    - One attribute that contains the longitude of each map marker. For example, you can provide an attribute that has been assigned the Longitude geo role during the data import process.

To create and add an ESRI Map visualization that displays map markers

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. From the toolbar, click the **Insert Visualization** icon. A new blank visualization is added to the dashboard.

3. On the Visualization Gallery, click the **ESRI Map** icon.

   - If the Visualization Gallery is not displayed, from the **View** menu, select **Visualization Gallery**.

4. If the Properties panel is not displayed, from the **View** menu, select **Properties Panel**. If the Properties panel is hidden behind another panel, click the **Properties** icon to display the Properties panel.
5 From the **Map Style** drop-down list, select the display theme to apply to the map, such as Street Map, Terrain Map, and so on.

6 From the **Map Type** drop-down list, select **Marker**.

7 You can enable map markers to be clustered together and displayed as a circle when a large number of map markers must be displayed in the same map area. You can double-click on a cluster to zoom in on the area and display individual map markers. From the **Clustering** drop-down list, select one of the following:
   
   - To display items on the map as clustered, select **On**.
   - To display items on the map without clustering, select **Off** (default).

8 You can determine the type of map marker to display on the map. From the **Marker Style** drop-down list, select the type of map marker to display, such as Bubbles or Pins.

9 You can determine whether or not a legend is displayed for the map. The legend shows the relationship between the color of each marker and the metric value for that location. Do one of the following:
   
   - To display the legend, select the **Show Legend** check box.
   - To hide the legend, clear the **Show Legend** check box (default).

10 If the Datasets panel is not displayed, from the **View** menu, select **Dataset panel**.

11 If the Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the **Editor** icon to display the Editor panel.

12 Add data to the visualization. From the **Datasets** panel, click and drag objects to the **Editor** panel, as follows:
   
   - To provide the locations in the visualization using one attribute with latitude and longitude information added by MicroStrategy, click and drag the attribute containing location information to the **Geo Attribute** area. MicroStrategy Desktop automatically detects the latitude and longitude attribute forms and displays their names in the Latitude and Longitude areas. Steps to select which attribute forms to display in the map are included in this procedure. For example, you can display the attribute’s description form but not the latitude and longitude forms.
• To provide the locations in the visualization using separate latitude and longitude attributes, do the following:
  
a  Click and drag the attribute that contains the latitude information to the **Latitude** area.
  
a  Click and drag the attribute that contains the longitude information to the **Longitude** area.

You can also drag objects from the Datasets panel directly onto the visualization.

13 You can color map markers in the visualization based on the value of a metric. From the Datasets panel, click and drag the metric to use to color the map markers to the **Color By** area.

14 You can size bubble markers in the visualization based on the value of a metric, with the largest bubbles being displayed for the largest metric values. From the Datasets panel, click and drag the metric to use to size the bubble markers to the **Size By** area.

15 You can display the map markers in different colors, or replace image markers with a different image based on the value of the metric. To do so, you must define a threshold on the metric used to display the map markers. In the **Color By** area, right-click the metric and select **Thresholds**. The Thresholds Editor opens. For steps to select the appropriate options to define a threshold on the metric, see *Adding or removing a threshold in a visualization, page 273*.

16 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269*.

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form**. Select one of the following:

• To display an attribute form in the visualization, select the check box next to its name.

• To hide an attribute form in the visualization, clear the check box next to its name.

17 By default, when you click a map marker in the visualization, a tooltip containing additional information about the location is displayed. You can include additional metrics or attributes in the tooltip. To do this,
from the **Datasets** panel, click and drag the metrics or attributes that you want to display to the **Tooltip** area.

18 To save your dashboard, click the **Save** icon 📝.

**Related topics**

- *Formatting an ESRI Map visualization that displays map markers, page 299*
- *Formatting visualizations, page 264*
- *Analyzing data in a map, page 441*
- *Creating an ESRI Map visualization that displays a density map, page 233*
- *Creating an ESRI Map visualization that displays areas, page 239*
- *Displaying a visual representation of your data: Visualizations, page 179*

**Creating an ESRI Map visualization that displays a density map**

You can display your data as locations on an interactive map using the ESRI Map visualization. You can display the locations in a density map, which helps you understand patterns and trends for many geographic locations by displaying color gradients based on the concentration of geographic data. For example, you can display locations with a high concentration of stores in
red, and locations with a low concentration of stores in blue, as in the example below:

![Map visualization example](image)

You can:

- Customize the color theme used to display areas in the map.
- View different types of maps, such as a topographical map or a satellite image.
- Display additional information about a location when you click a location in the visualization, by adding tooltips.

For steps to create an ESRI Map visualization that displays a density map, see *Steps to create an ESRI Map visualization that displays a density map, page 236.*

**Providing geographical information for an ESRI Map visualization that displays a density map**

To display a density map in the ESRI Map visualization, you must provide the latitude and longitude of each location in the map. You provide this information when you are importing data by assigning a geo role to a data column, as described in *Preparing your data to display on maps: Geo roles,*
You provide latitude and longitude information for an ESRI Map visualization in one of the following ways:

- Define a single attribute and assign it a geo role to identify what type of geographical information it contains. MicroStrategy Desktop automatically adds latitude and longitude information to the attribute, enabling you to display the attribute data as a density map.

For example, your data source includes the names of cities where your company has field offices. You can create an attribute called City, which contains the names of these cities, then assign it the City geo role. MicroStrategy Desktop automatically adds latitude and longitude information for each city to the City attribute. You can then use the City attribute to provide latitude and longitude information for locations in the visualization.

MicroStrategy Desktop automatically adds latitude and longitude information to data columns that you assign the Country, State, City, ZIP Code, or Location geo roles.

MicroStrategy adds latitude and longitude information to an attribute by adding attribute forms to the attribute. An attribute form is a component of an attribute that provides additional descriptive information about the attribute. Attribute forms appear in the Editor panel of an ESRI Map visualization when you display your data using an attribute that has been assigned a geo role for which MicroStrategy automatically adds latitude and longitude information. For example, in the example above, the supplemental latitude and longitude information is contained in the attribute forms City@Latitude and City@Longitude. You can select which attribute forms are displayed in the visualization; for steps, see *Selecting which attribute forms to display in a visualization, page 269.*

- Define two separate attributes to provide the latitude and longitude information of each location.

For example, your data source has latitude and longitude information for each of your company’s stores. You can create one attribute that contains the latitude of each store, and assign the attribute the Latitude geo role. You can create a second attribute that contains the longitude of each store, and assign the second attribute the Longitude geo role. You can then use the two Latitude and Longitude attributes to provide latitude and longitude information for locations in the visualization.

For background information about importing data into MicroStrategy Desktop, see *Importing Data into MicroStrategy Desktop, page 55.*
Steps to create an ESRI Map visualization that displays a density map

Prerequisites

- The steps below assume that the dashboard’s dataset already includes attributes that provide the geographical location of each location in the ESRI Map visualization. You can provide location information in one of the following ways:
  - Provide one attribute that has been assigned a geo role for which MicroStrategy automatically adds the latitude and longitude information for each location. For example, you can provide an attribute that has been assigned the Country, State, City, ZIP Code, or Location geo roles during the data import process.
  - Provide two separate attributes, as follows:
    - One attribute that contains the latitude of each location. For example, you can provide an attribute that has been assigned the Latitude geo role during the data import process.
    - One attribute that contains the longitude of each location. For example, you can provide an attribute that has been assigned the Longitude geo role during the data import process.

To create and add an ESRI Map visualization that displays a density map

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. From the toolbar, click the Insert Visualization icon. A new blank visualization is added to the dashboard.

3. On the Visualization Gallery, click the ESRI Map icon.

   If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4. If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.
5 From the **Map Style** drop-down list, select the type of map to display in the visualization, such as Streets or Terrain Map.

6 From the **Map Type** drop-down list, select **Density**.

7 Under **Color Bands**, select the color theme to display. For example, to display areas with a low density of locations of interest in blue and areas with a high density in red, select the color theme that changes from blue to red.

8 You can determine whether or not a legend is displayed for the map. The legend shows the relationship between the color of each marker and the metric value for that location. Do one of the following:

   - To display the legend, select the **Show Legend** check box.
   - To hide the legend, clear the **Show Legend** check box (default).

9 If the Datasets panel is not displayed, from the **View** menu, select **Dataset panel**.

10 If the Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon 📊 to display the Editor panel.

11 Add data to the visualization. From the **Datasets** panel, click and drag objects to the **Editor** panel, as follows:

   - To provide the locations in the visualization using one attribute with latitude and longitude information added by MicroStrategy, click and drag the attribute containing location information to the **Geo Attribute** area. MicroStrategy Desktop automatically detects the latitude and longitude attribute forms and displays their names in the Latitude and Longitude areas. Steps to select which attribute forms to display in the map are included in this procedure. For example, you can display the attribute’s description form but not the latitude and longitude forms.
• To provide the locations in the visualization using separate latitude and longitude attributes, do the following:
  
  a Click and drag the attribute that contains the latitude information to the **Latitude** area.
  
  a Click and drag the attribute that contains the longitude information to the **Longitude** area.

  You can also drag objects from the Datasets panel directly onto the visualization.

12 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269*.

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form**. Select one of the following:

• To display an attribute form in the visualization, select the check box next to its name.

• To hide an attribute form in the visualization, clear the check box next to its name.

13 By default, when you click a location in the visualization, a tooltip containing additional information about the location is displayed. You can include additional metrics or attributes in the tooltip. To do this, from the **Datasets** panel, click and drag the metrics or attributes that you want to display to the **Tooltip** area.

14 To save your dashboard, click the **Save** icon.

**Related topics**

• *Formatting an ESRI Map visualization that displays a density map, page 300*

• *Formatting visualizations, page 264*

• *Analyzing data in a map, page 441*

• *Creating an ESRI Map visualization that displays map markers, page 228*

• *Creating an ESRI Map visualization that displays areas, page 239*
Creating an ESRI Map visualization that displays areas

You can display your data as locations on an interactive map using the ESRI Map visualization. You can display the locations as map areas, which are colored, two-dimensional areas on a map that represent geographic regions, such as countries, states, and counties. You can color-code areas based on the value of a metric. The following ESRI Map visualization color-codes U.S. states based on a metric’s values:

You can:

- View different types of maps, such as a topographical map or a satellite image.
- Display areas in the visualization with different colors based on the value of a metric.
- Display additional information about a location when you click an area in the visualization, by adding tooltips to the map areas.

For steps to create an ESRI Map visualization that displays areas, see *Steps to create an ESRI Map visualization that displays areas, page 241.*
Providing geographical information for an ESRI Map visualization that displays areas

To display areas in the ESRI Map visualization, you must provide an attribute whose values include the names of each area in the map’s base map. The base map is an ESRI map that contains the shape of each area that can be displayed in the visualization. For example, the base map for Countries of the World contains the shape information required to display each country on a world map. The base maps available in MicroStrategy Desktop include the following:

- Countries of the world
- United States counties
- United States state abbreviations
- United States state names
- United States ZIP codes
- World administrative divisions

For example, your data source includes the names of countries where your company has sales representatives. You can create an attribute called Country, which contains the names of these countries, then use the Country attribute to provide location information for areas in a visualization that uses the Countries of the World base map.

MicroStrategy Desktop uses the attribute that contains location information to determine the default base map to display in the visualization. If a geo role, such as State or Country, has been assigned to this attribute, the visualization will automatically display the first base map that supports the geo role as the attribute. For example, if the attribute’s geo role is State, the U.S. States Names base map will be displayed in the visualization by default. If a geo role has not been assigned to the attribute, you select the appropriate base map to use.

You create and assign geo roles to attributes while you are importing data. For background information about assigning geo roles, including steps, see Preparing your data to display on maps: Geo roles, page 135. For background information about importing data into MicroStrategy Desktop, including steps, see Importing Data into MicroStrategy Desktop, page 55.
Steps to create an ESRI Map visualization that displays areas

Prerequisite

- The steps below assume that you have already created an attribute with the name of each location that you want to display in the visualization. Each element in the attribute should contain the name of a location defined in the base map, as described above. For example, if the base map defines an area for Japan, the country attribute should contain an element named Japan.

To create and add an ESRI Map visualization that displays areas

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the Insert Visualization icon. A blank visualization is added to the dashboard.

3. On the Visualization Gallery, click the ESRI Map icon.

   If the Visualization Gallery is not displayed, from the View menu, select Visualization Gallery.

4. If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.

5. From the Map Style drop-down list, select the type of map to display in the visualization, such as Streets or Terrain Map.

6. From the Map Type drop-down list, select Area.

7. From the Boundaries drop-down list, select the name of the base map to use to display areas in the map, such as World Administrative Divisions or U.S. States Names.

8. You can determine whether or not a legend is displayed for the map. The legend shows the relationship between the color of each marker and the metric value for that location. Do one of the following:

   - To display the legend, select the Show Legend check box.
• To hide the legend, clear the **Show Legend** check box (default).

9 If the Datasets panel is not displayed, from the **View** menu, select **Dataset panel**.

10 If the Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon 📊 to display the Editor panel.

11 From the **Datasets** panel, click and drag the attribute containing the location information for each area to the **Geo Attribute** area in the **Editor** panel. You can also drag objects from the Datasets panel directly onto the visualization.

12 To display map areas in different colors based on the value of a metric, from the **Datasets** panel, click and drag the metric to the **Color By** area.

13 You can customize the colors used to display map areas based on the value of the metric in the Color By section. To do so, you must define a threshold on the metric. In the **Color By** area, right-click the metric and select **Thresholds**. The Thresholds Editor opens. For steps to select the appropriate options to define a threshold on the metric, see *Adding or removing a threshold in a visualization, page 273*.

14 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see *Selecting which attribute forms to display in a visualization, page 269*.

To select the attribute forms, in the Editor panel, right-click the attribute and point to **Display Attribute Form**. Select one of the following:

- To display an attribute form in the visualization, select the check box next to its name.
- To hide an attribute form in the visualization, clear the check box next to its name.

15 By default, when you click an area in the visualization, a tooltip containing additional information about the location is displayed. You can include additional metrics or attributes in the tooltip. To do this, from the **Datasets** panel, click and drag the metrics or attributes that you want to display to the **Tooltip** area.

16 To save your dashboard, click the **Save** icon 📋.
Creating a Network visualization

You can quickly and easily identify relationships between related items and clusters by displaying your data with a Network visualization. For example, a Network visualization is useful when visualizing a social network or performing a market basket analysis. Attribute elements are displayed as nodes in the visualization, with lines (called edges) drawn between the nodes to represent relationships between elements. Once the visualization is created, you can view characteristics of the nodes and the relationships between them, using display options such as node size, edge thickness, and edge color. For example, if a node is displayed for each store in a country, you
can display a connection between two nodes using a thicker line if the two stores share a large number of customers.

Follow the steps below to create a blank Network visualization, then select and add data to display in the visualization.

**To create and add a Network visualization to a dashboard**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. To add a new visualization to the dashboard, from the toolbar, click the **Insert Visualization** icon 🌱. A blank visualization is added to the dashboard.

3. On the Visualization Gallery, click the **Network** icon 🌱. If the Visualization Gallery is not displayed, from the **View** menu, select **Visualization Gallery**.

4. If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.
5 If the Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

6 Add data to the visualization. From the Datasets panel, click and drag objects to the Editor panel, as follows:

   • Drag an attribute to the From Item area. Each element of this attribute will be displayed as a node in the visualization.

   • Drag an attribute to the To Item area. Each element of this attribute will be displayed as a node in the visualization.

   • Drag a metric to the Edge Size area. This metric determines the thickness of each edge, with edges for larger metric values displayed as thicker than edges for small metric values.

   • Drag a metric to the Edge Color area. Each edge in the visualization is automatically colored based on the value of this metric.

   • Drag a metric to the Item Size area. This metric determines the size of each node, with nodes for larger metric values displayed as larger than nodes for small metric values.

   You can also drag objects from the Datasets panel directly onto the visualization.

7 For each attribute in the Editor panel, you can select which attribute forms are displayed in the visualization. An attribute form is a descriptive category for an attribute. For a more detailed description, including how to select what attribute information to display in the headers, see Selecting which attribute forms to display in a visualization, page 269.

To select the attribute forms, in the Editor panel, right-click the attribute and point to Display Attribute Form. Select one of the following:

   • To display an attribute form in the visualization, select the check box next to its name.

   • To hide an attribute form in the visualization, clear the check box next to its name.
8 To save your dashboard and the new Network visualization, click the **Save** icon 📋.

**Related topics**

- *Formatting a Network visualization, page 302*
- *Formatting visualizations, page 264*
- *Analyzing data in a Network visualization, page 445*
- *Creating a Graph visualization, page 181*
- *Creating a dashboard, page 146*

**Changing the type of visualization displayed**

Once you have added a visualization to a dashboard, you can quickly change the type of visualization used to display your data.

---

**To change the visualization’s display type**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 If the Visualization Gallery is not displayed, from the **View** menu, select **Visualization Gallery**.

3 Select the visualization to change, and click the icon for the new visualization type in the Visualization Gallery.

   To view a visualization’s name and data requirements, hover the cursor over the icon of the visualization type in the Visualization Gallery.

4 You can customize the display of the visualization by adding, replacing, and removing attributes and metrics from the visualization. For steps, see *Adding, replacing, and removing data from visualizations, page 251*. For background information and data requirements to create each type of visualization, see the related links below.
Duplicating visualizations

You can create a new visualization by duplicating an existing visualization, and then modifying it. When you copy a visualization, by default the new visualization is added to the page that is currently displayed. You can specify a different page or sheet to add the copy of the visualization to. Each sheet of a dashboard is displayed on a separate tab. A page is a layer on a sheet; each sheet can have multiple pages on it. All pages on a sheet are filtered in the same way; sheets can be filtered in different ways. For an explanation of sheets and pages, and steps to create them, see Layering and organizing data for filtering, page 372.

To create a copy of a visualization in the same page

1  From the File menu, select Open. Navigate to and select the dashboard to modify.

2  Hover the cursor over the visualization to copy, then click the arrow icon on the right. Select Duplicate. The new visualization is added to the dashboard in the current page.
To copy a visualization to a specific sheet or page

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. Hover the cursor over the visualization to copy, then click the arrow icon on the right. Point to Copy To, then do one of the following:
   - To copy the visualization to an existing page, select the page to copy the visualization to.
   - To create a new page and copy the visualization to it, select New Panel.
   - To copy the visualization to an existing sheet, select the sheet to copy the visualization to.
   - To create a new sheet and copy the visualization to it, select New Sheet. A message is displayed notifying you that the filters in the currently displayed sheet will not be copied to the new sheet along with the visualization. Click OK.

The new visualization is added to the dashboard.

Related topics

- Displaying a visual representation of your data: Visualizations, page 179
- Layering and organizing data for filtering, page 372

Moving visualizations

After you create a visualization in a dashboard, you can change the position of the visualization within the dashboard. You can move a visualization:

- To a different position within the same page. For steps, see To move a visualization’s position within a page, page 249.
- To a different page. For steps, see To move a visualization to another page, page 249.
- To a different sheet. For steps, see To move a visualization to another sheet, page 250.
You can create layers of data in a dashboard using sheets, with each sheet displayed on a separate tab and filtered differently. You can switch between sheets by clicking the tab of the sheet to display. For a description of sheets and steps to create a sheet, see *Adding, modifying, and deleting sheets, page 374.*

Each sheet can contain multiple pages, or layers of data, that are filtered in the same way. When a sheet contains multiple pages, a row of dots, each representing a page, is displayed at the bottom of the sheet. The current page is marked with a blue dot. To change the page that is displayed, click a different dot. For a description of pages and steps to create a page, see *Adding, modifying, and deleting pages, page 376.*

**Prerequisite**

- To move a visualization’s position within the same page, there must be at least two visualizations in the page.

---

**To move a visualization’s position within a page**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. If the visualization’s title bar is not displayed, hover the cursor over the visualization, click the arrow icon in the top right, then select **Show Title Bar**.

3. Click the visualization’s title bar and drag it to its new location in the dashboard. A blue bar indicates where the visualization will be displayed.

---

**To move a visualization to another page**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Hover the cursor over the visualization to move, then click the arrow icon on the right.

3. Point to **Move To**, then select one of the following:
   - To move the visualization to an existing page, select the page to move the visualization to.
To create a new page to move the visualization to, select **New Panel**.

4 The new visualization is moved to the selected page.

---

**To move a visualization to another sheet**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 Hover the cursor over the visualization to move, then click the arrow icon on the right.

3 Point to **Move To**, then select one of the following:
   - To move the visualization to an existing sheet, select the sheet to move the visualization to.
   - To create a new sheet to move the visualization to, select **New Sheet**.

4 The visualization is moved to the selected sheet.

**Related topics**

- *Displaying a visual representation of your data: Visualizations, page 179*
- *Adding, modifying, and deleting sheets, page 374*
- *Adding, modifying, and deleting pages, page 376*
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*

---

**Deleting visualizations**

You can delete a visualization on a dashboard.

---

**To delete a visualization from a dashboard**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.
2 Hover the cursor over the visualization to delete, click the arrow icon on the right, and select **Delete**. The visualization is removed from the dashboard.

**Related topic**

- *Displaying a visual representation of your data: Visualizations, page 179*

## Adding, replacing, and removing data from visualizations

Once you have created and added a visualization to a dashboard, you can add, replace, or remove data from the visualization.

If you have added more than one dataset to your dashboard, a visualization can include data from multiple datasets at the same time. For more details about creating a visualization using data from multiple datasets, see *Creating visualizations using data from multiple datasets, page 252*.

**Prerequisite**

- If you are including data from more than one dataset on a visualization, you must link the attributes that are shared in common across datasets. For steps to link attributes across datasets, see *Linking data shared across multiple datasets, page 259*.

### To add, replace, or remove data in a visualization

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 If the Datasets panel is not displayed, from the **View** menu, select **Datasets Panel**.

3 If the visualization’s Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon 📊 to display the Editor panel.

4 Click the visualization to modify.
5 Add, replace, and remove data from the visualization by doing one of the following:

- To add data to the visualization, click and drag an attribute or metric from the Datasets panel onto the appropriate area in the visualization’s Editor panel, so that a green indicator line is displayed in the location to place the attribute or metric. The attribute or metric is added to the visualization and displayed.

- To replace an attribute or metric that has already been added to the visualization, click the name of the object on the visualization’s Editor panel, then select the item to replace the object with.

- To remove data from the visualization, in the visualization’s Editor panel, right-click the object to remove, then select Remove. The object is removed from the visualization.

6 Repeat the appropriate steps above to add, replace, and remove data from the visualization as desired.

Related topics

- Managing data in a dashboard, page 151
- Creating visualizations using data from multiple datasets, page 252
- Defining the primary dataset to use to display data in a visualization, page 263
- Linking data shared across multiple datasets, page 259
- Displaying a visual representation of your data: Visualizations, page 179

Creating visualizations using data from multiple datasets

If your dashboard contains more than one dataset, you can include data from multiple datasets in a visualization.

To create visualizations using multiple datasets:
• The dashboard that contains the visualization must include at least two datasets. For steps to add multiple datasets to a dashboard, see *Managing data in a dashboard, page 151.*

• You must link any related attributes that appear in more than one dataset.

By default, when you import a new dataset directly into a dashboard that contains at least one dataset, the new dataset is automatically linked to attributes that already exist in the dashboard. You can also manually link attributes that are shared across multiple existing datasets. An attribute that is linked across multiple datasets is displayed with a link icon \(\leftrightarrow\) and is displayed as one attribute when added to a visualization.

You can choose to unlink attributes that are already linked. Unlinked attributes with the same name are treated as two separate attributes when displayed in a visualization.

For background information on linking and steps to manually link or unlink attributes, see *Linking data shared across multiple datasets, page 259.*

You can add data to a visualization that uses multiple datasets as you would to a visualization that uses a single dataset. When you link attributes, MicroStrategy Desktop automatically displays the appropriate data in the visualization.

For example, in the image below:

• The Northern dataset contains the Region attribute and the Profit metric. The Central, Mid-Atlantic, Northeast, and Northwest regions are included in the dataset.

• The Southern dataset contains the Region attribute and the Revenue metric. The Central, South, Southeast, and Southwest regions are included in the dataset.

• The Region attribute in the Northern dataset is linked to the Region attribute in the Southern dataset.

In the image below, the two original datasets are displayed in the two Grid visualizations on the top, with their dataset names displayed in the title bar. The Grid visualization on the bottom contains data from both datasets: the
Creating visualizations using data from multiple datasets

MicroStrategy Desktop combines the data from the datasets and displays the combined grid with information that is as complete as possible. Because Revenue data does not exist for the Mid-Atlantic, Northeast, and Northwest regions, the corresponding cells in the grid are displayed as blank. In contrast, the Central region is included in both of the original datasets, so it has both Profit and Revenue data.

If you combine data from multiple datasets in a visualization, and the datasets contain attribute data that can be used to relate multiple attributes to each other, MicroStrategy Desktop can use the relationships between the attributes to calculate additional data. For example, consider the following scenario:

- Dataset 1 contains Region, Year, and Category.
- Dataset 2 contains Region and Year.
- Dataset 3 contains Region and Category.
- The Year attribute in Dataset 1 is linked with the Year attribute in Dataset 2, the Category attribute in Dataset 1 is linked with the Category attribute in Dataset 3, and the Region attribute is linked across all three datasets.

In the image below, the contents of each dataset are displayed in the three grid visualizations at the top. Data from all the datasets is combined in the linked Region attribute, the Profit metric from the Northern dataset, and the Revenue metric from the Southern dataset.
bottom Grid visualization. As shown in the image, Dataset 1 contains each of the attributes in Dataset 2 and Dataset 3.

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Category</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northwest</td>
<td>2011</td>
<td>Books</td>
<td>$45,522</td>
</tr>
<tr>
<td>Northwest</td>
<td>2011</td>
<td>Electronics</td>
<td>$423,115</td>
</tr>
<tr>
<td>Northwest</td>
<td>2011</td>
<td>Movies</td>
<td>$58,707</td>
</tr>
<tr>
<td>Northwest</td>
<td>2011</td>
<td>Music</td>
<td>$66,652</td>
</tr>
<tr>
<td>Northwest</td>
<td>2012</td>
<td>Books</td>
<td>$49,595</td>
</tr>
<tr>
<td>Northwest</td>
<td>2012</td>
<td>Electronics</td>
<td>$473,230</td>
</tr>
<tr>
<td>Northwest</td>
<td>2012</td>
<td>Movies</td>
<td>$77,354</td>
</tr>
<tr>
<td>Northwest</td>
<td>2012</td>
<td>Music</td>
<td>$76,537</td>
</tr>
</tbody>
</table>

Data in the combined grid is calculated at the level of Region, Year, and Category. The Revenue data from Dataset 1 is available at the Region-Year-Category level, so a different Revenue value is displayed for each combination of Region, Year, and Category.

However, the Profit metric from Dataset 2 is available at the Region-Year level, and contains no Category information. As a result, the combined grid contains Profit data at the Region-Year level, and repeats for all four categories. Similarly, the Cost metric from Dataset 3 is available at the Region-Category level, and contains no Year information. As a result, the combined grid contains Cost data at the Region-Category level, and repeats for each year in the visualization.

### Determining which data is displayed in a visualization

When you create a visualization that contains linked data from multiple datasets, you can determine which data is included in the visualization:

- For visualizations that contain attributes and metrics, the data displayed in the visualization is determined by the metrics added to the visualization, then by the dataset defined as the visualization's primary dataset. For details, see *For visualizations that contain attributes and metrics, page 256.*
• For visualizations that contain only attributes, the data displayed in the visualization is determined by the dataset defined as the visualization’s primary dataset. For details, see *For visualizations that contain only attributes, page 258.*

**For visualizations that contain attributes and metrics**

For visualizations that contain attributes and metrics, you can determine which attribute elements are displayed in the visualization by adding metric data.

For example, in the image below:

• The first dataset contains the Category attribute and the Profit metric. Only data for Movies and Music is included in the dataset.

• The second dataset contains the Category attribute and the Revenue metric. Only data for Books and Movies is included in the dataset.

• The Category attribute in the first dataset is linked with the Category attribute in the second dataset.

The combined Revenue and Profit grid at the bottom contains the linked Category attribute, the Revenue metric, and the Profit metric. Because either Revenue or Profit data exists for the Books, Movies, and Music categories, Books, Movies, and Music are all included in the combined grid.

<table>
<thead>
<tr>
<th>Category</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Movies</td>
<td>$254,698</td>
</tr>
<tr>
<td>Music</td>
<td>$180,044</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$2,640,094</td>
</tr>
<tr>
<td>Movies</td>
<td>$4,098,943</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Category</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$2,640,094</td>
<td></td>
</tr>
<tr>
<td>Movies</td>
<td>$4,098,943</td>
<td>$254,698</td>
</tr>
<tr>
<td>Music</td>
<td></td>
<td>$180,044</td>
</tr>
</tbody>
</table>

In the example above, both of the original datasets contained different metrics. When more than one dataset contains the same metric, you can specify which dataset provides the metric values displayed when the datasets are combined in a visualization. To display the metric from a specific dataset, add the metric from the desired dataset to the data included in a visualization.
For example, in the image below, both datasets contain the Profit metric. The Category attribute in the first dataset is linked to the Category attribute in the second dataset. The Combined Profit grid contains the Profit metric from the first dataset. Because data exists for the Movies and Music categories, the Movies and Music categories are displayed.

To display data for multiple datasets, you can add the metric from each dataset to the grid. When you import your data, MicroStrategy creates a separate object ID for each metric, even if metrics in different datasets have the same name. For example, the Profit metric in Dataset 1 is assigned a different ID from the Profit metric in Dataset 2, even though both metrics are named “Profit.” Although metrics from different datasets can have the same name, they are treated as separate metrics because of their different object IDs.

For example, in the image below, the Profit metric from the first dataset is displayed in the first column and the Profit metric from the second dataset is displayed in the second column. Because data exists for the Books, Electronics, Movies, and Music categories, all categories are displayed on the grid. The two Profit metrics have separate object IDs, and are therefore treated as separate metrics and displayed in separate columns.
For visualizations that contain only attributes

For visualizations that contain only attributes, the visualization’s primary dataset determines which attribute elements are included in the visualization, as follows:

- If a dataset is selected as the primary dataset: For each attribute in the visualization, only attribute elements included in the primary dataset are displayed in the visualization. Attribute elements that exist only in other datasets are not displayed.
- If the visualization has no primary dataset: For each attribute in the visualization, all attribute elements are displayed, regardless of which dataset they belong to.

For example, a dashboard has two datasets, both containing the City attribute. The first dataset contains the cities Detroit, New York, Pittsburgh, and San Francisco. The second dataset contains the cities New York, Pittsburgh, St. Louis, and Washington. The City attribute in the first dataset is linked to the City attribute in the second dataset.

<table>
<thead>
<tr>
<th>City</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detroit</td>
<td>$2,239,951</td>
</tr>
<tr>
<td>New York</td>
<td>$8,554,415</td>
</tr>
<tr>
<td>Pittsburgh</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>San Francisco</td>
<td>$5,029,366</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>City</th>
<th>Customer Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>New York</td>
<td>1,432</td>
</tr>
<tr>
<td>Pittsburgh</td>
<td>731</td>
</tr>
<tr>
<td>St. Louis</td>
<td>554</td>
</tr>
<tr>
<td>Washington</td>
<td>1,206</td>
</tr>
</tbody>
</table>

In the image below, the Grid visualization contains the City attribute. The first dataset is defined as the primary dataset for the visualization. As a result, the visualization contains only elements from the first dataset: Detroit, New York, Pittsburgh, and San Francisco.
In the image below, the visualization has no primary dataset. All elements of City from all datasets in the dashboard are displayed in the visualization: Detroit, New York, Pittsburgh, San Francisco, St. Louis, and Washington.

The grid source of a visualization that uses multiple datasets is automatically determined by the last attribute added to the visualization. You can also manually define the primary dataset for a visualization. For steps, see *Defining the primary dataset to use to display data in a visualization, page* 263.

**Related topics**

- *Managing data in a dashboard, page* 151
- *Linking data shared across multiple datasets, page* 259
- *Defining the primary dataset to use to display data in a visualization, page* 263
- *Displaying a visual representation of your data: Visualizations, page* 179
- *Adding, replacing, and removing data from visualizations, page* 251
- *Dashboard Editor: Visualization Gallery, page* 568

**Linking data shared across multiple datasets**

When you are creating a dashboard, you can:

- Display data from multiple datasets in the same visualization.
- Use a visualization based on one dataset as a filter to update the data displayed in a visualization based on another dataset.
- Group data from one dataset based on an attribute that exists in another dataset.
To achieve any of these goals, you must link the attributes that are shared in common across multiple datasets. For example, you have one dataset that contains Customer ID, Customer Name, and Profit data, and another dataset that contains Customer ID and Shipping Cost data. You can link the two Customer ID attributes, allowing you to display Customer Name, Profit, and Shipping Cost in one visualization, group Shipping Cost data by Customer Name, and so on.

You can have MicroStrategy automatically attempt to link data by importing a new dataset directly into a dashboard that contains the attribute to which you want to link the data, or you can link data manually while you are editing a dashboard.

By default, when you import a new dataset directly into a dashboard that contains at least one dataset, the new dataset is automatically linked to attributes that already exist in the dashboard. MicroStrategy attempts to link attributes that share the same name.

You can also manually link attributes when you are editing a dashboard. Manually linking attributes allows you to link attributes across multiple existing datasets. The attributes that you link to each other should uniquely identify each record, to ensure that the results are calculated accurately. In most cases, an ID attribute can be used to link attributes. The attributes that you link must be the same data type. You can link an attribute to attributes in one or more datasets.

When you link data in one dashboard, all other dashboards that contain the linked attributes are automatically updated.

An attribute that is linked across multiple datasets is displayed with a link icon and is displayed as one attribute when added to a visualization.

You can choose to unlink attributes that are already linked, if the link is incorrect for your needs. Unlinked attributes with the same name are treated as two separate attributes when displayed in a visualization.

**Prerequisites**

- If you are linking attributes during data import:
  - You are previewing the data. For steps, see *Previewing your data and specifying data import options, page 121*.

- If you are linking attributes while viewing a dashboard:
You have already created the dashboard to modify. For steps to create a dashboard, see *Creating a dashboard, page 146*.

The dashboard must include at least two datasets. For steps to add a dataset to a dashboard, see *Managing data in a dashboard, page 151*.

The dashboard is open. For steps, see *Opening MicroStrategy Desktop, page 16*.

- You must have write access to at least one of the datasets in the intended link.
- Read *Creating visualizations using data from multiple datasets, page 252*.

---

**To manually link data in a dashboard**

1. Do one of the following:
   - If you are importing data, in the Tables area on the Preview page during data import, right-click the attribute to link, and select **Link To Other Datasets**.
   - If you are viewing the dashboard, in the Datasets panel, right-click the attribute to link, and select **Link To Other Datasets**.

   The Link Attributes Editor is displayed.

   Any attributes that are already linked are shown with the link icon \( \rightarrow \) in the Tables area or Datasets panel.

2. From the **Links to** drop-down list, select the attribute to link the selected attribute to. You can type the name of an attribute in the field to narrow the list of choices.

3. You can define which attribute forms to create the link based on. Click **Show Attribute Forms**, then perform the following steps:

   At least one of the attribute forms that you link must be the ID attribute form.
   
   a. From the drop-down list next to the first attribute, select the attribute form to link.
   
   b. From the drop-down list next to the second attribute, select the attribute form to link to.
4 To link additional pairs of attributes, click **Add a Link**, then repeat the appropriate steps above to define a link for each pair.

5 To remove a link, hover the cursor over the link to delete and click **X**.

6 Click **OK** to apply your changes. The selected attributes are linked and their icons are updated in the Datasets panel.

---

**To manually unlink data in a dashboard**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**. Any attributes that are already linked are shown with the link icon 💍.

3 In the Datasets panel, click the link icon 💍 of the attribute to unlink.

---

**To manually unlink data while importing data**

1 On the Tables area on the Preview page during data import, any attributes that are already linked are shown with the link icon 💍.

2 Right-click the attribute to unlink, and select **Unmap**.

---

**Related topics**

- *Creating visualizations using data from multiple datasets*, page 252
- *Defining the primary dataset to use to display data in a visualization*, page 263
- *Managing data in a dashboard*, page 151
- *Adding, replacing, and removing data from visualizations*, page 251
Defining the primary dataset to use to display data in a visualization

When you create a visualization that contains data from multiple datasets, you can determine which data is included in the visualization.

- For visualizations that contain attributes and metrics, the data displayed in the visualization is determined by the metrics added to the visualization, then by the dataset defined as the visualization's primary dataset. For details, see *For visualizations that contain attributes and metrics, page 256.*

- For visualizations that contain only attributes, the data displayed in the visualization is determined by the dataset defined as the visualization’s primary dataset. For details, see *For visualizations that contain only attributes, page 258.*

The primary dataset of a visualization that uses multiple datasets is automatically determined by the last attribute added to the visualization. You can also manually define the primary dataset for a visualization. Follow the steps below to manually define the primary dataset for a visualization.

The primary dataset of a visualization is indicated by a check mark next to the dataset’s name in the Datasets panel.

**Prerequisite**

- The dashboard that contains the visualization must include at least two datasets. For steps to add a dataset to a dashboard, see *Managing data in a dashboard, page 151.*

---

**To define the primary dataset for a visualization**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization to modify.

3. Hover the cursor over the visualization, then click the arrow icon in the top right. Point to **Set Primary Dataset**, then select the name of the dataset to use as the grid source. You can also select **None**, to define the visualization as having no grid source. The visualization is updated.
Formatting visualizations

Once you have added a visualization to a dashboard, you can format the visualization. You can rename attributes or metrics, choose whether to display a visualization’s title bar, whether to apply banding to values in a grid, and so on. For a complete list, see General formatting for visualizations, page 265.

Besides these general formatting options, each type of visualization has specific formatting that can be applied to it, as described in Formatting specific visualization types, page 264.

You can edit a visualization in Formatting Mode to quickly select formatting options for a specific part of the visualization, such as the titles, row axes, or legend. In Formatting Mode, when you select an object in the visualization, the appropriate formatting options for the object are automatically displayed in the visualization’s Properties panel. While you are viewing a visualization in Formatting Mode, other visualizations in the dashboard are greyed out and unavailable, allowing you to concentrate on a single visualization at a time. For steps to format a visualization in Formatting Mode, see Using Formatting Mode for visualizations, page 267.

Formatting Mode is available for Graph, Heat Map, and Network visualizations.

Formatting specific visualization types

For steps to select formatting options for a specific type of visualization, see the appropriate topic below:

• Formatting a Graph visualization, page 283
• Formatting a Grid visualization, page 293
• Formatting a Heat Map visualization, page 296
• Formatting an ESRI Map visualization that displays map markers, page 299
• Formatting an ESRI Map visualization that displays a density map, page 300
• Formatting an ESRI Map visualization that displays areas, page 301
• Formatting a Network visualization, page 302

General formatting for visualizations

For steps to select general formatting options for any type of visualization, see the appropriate topic below:

• To rename an attribute or metric, page 265
• To show or hide the title bar for a visualization, page 266
• To size a visualization in a dashboard, page 266
• To maximize the display of a visualization or restore it to its default size, page 266
• Selecting which attribute forms to display in a visualization, page 269
• Formatting numeric values in a visualization, page 271
• Adding or removing a threshold in a visualization, page 273

A threshold applies formatting, such as color-coding, to a visualization based on the value of a metric.

To rename an attribute or metric

1 In the visualization’s Editor panel, right-click the attribute or metric to rename, and select Rename.
   • If the visualization’s Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

2 Type a new name for the attribute or metric in the field, then press ENTER. The object is renamed in the selected visualization.
To show or hide the title bar for a visualization

Displaying a title bar for a visualization enables you to provide a descriptive title for the visualization, as well as rearrange the visualizations displayed in a dashboard by clicking and dragging the visualization’s title bar to a new position.

1 Hover the cursor over the visualization to modify, then click the arrow icon displayed in the top right.

2 Do one of the following:
   • To display the title bar, select Show Title Bar.
   • To hide the title bar, select Hide Title Bar.

To size a visualization in a dashboard

1 Hover the cursor over the edge of the visualization to resize, so that the cursor becomes double arrows. Click and drag the edge of the visualization to size it.

To maximize the display of a visualization or restore it to its default size

If you maximize the display of a visualization, it is resized to fit the entire visualization area.

1 Do one of the following:
   • If the visualization's title bar is displayed, do one of the following:
     □ To maximize the display of the visualization, click the Maximize icon.
     □ To restore the visualization to its original size, click the Restore icon.
   • If the visualization’s title bar is not displayed, hover the cursor over the visualization and click the arrow icon in the top right, then select one of the following:
     □ To maximize the display of the visualization, select Maximize.
To restore the visualization to its original size, select **Restore**.

**Related topics**

- *Displaying a visual representation of your data: Visualizations, page* 179
- *Selecting which attribute forms to display in a visualization, page* 269
- *Formatting numeric values in a visualization, page* 271
- *Adding or removing a threshold in a visualization, page* 273
- *Moving visualizations, page* 248
- *Formatting a dashboard, page* 167

**Using Formatting Mode for visualizations**

You can edit a visualization in Formatting Mode to quickly select formatting options for a specific part of the visualization, such as the titles, row axes, or legend. In Formatting Mode, when you select an object in the visualization, the appropriate formatting options for the object are automatically displayed in the visualization’s Properties panel. While you are viewing a visualization in Formatting Mode, other visualizations in the dashboard are greyed out and unavailable, allowing you to concentrate on a single visualization at a time.

In addition, many interactive capabilities that are unrelated to formatting are unavailable in Formatting Mode, including:

- Keep Only
- Drill
- Exclude
- Show Data
- Highlighting selected elements in the visualization
- Allowing the visualization to update the data displayed in another visualization
- Sorting data in the visualization
- Dragging and dropping dataset objects onto the visualization
You can use Formatting Mode to select display options for the following visualization types:

- Graph
- Heat Map
- Network

**To format a visualization in Formatting Mode**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Right-click the visualization to modify and select **Format**.

3. Click the object in the visualization to format. The Properties panel is automatically updated to display the appropriate formatting options for the object.

   - If the Properties panel is not displayed, from the View menu, ensure that Properties Panel is selected. If the Properties panel is hidden behind another panel, click the Properties icon Ḗ to display the Properties panel.

4. Select the appropriate options to format the visualization. For a detailed list of the formatting options available for a specific visualization type, see the related links below:

   - *Dashboard Editor: Graph: Properties, page 576*
   - *Dashboard Editor: Heat Map: Properties, page 595*
   - *Dashboard Editor: Network: Properties, page 601*

5. To exit formatting mode, right-click the visualization and click **Format**, to clear the check mark.

**Related topic**

*Formatting visualizations, page 264*
Selecting which attribute forms to display in a visualization

You can choose which attribute forms are displayed for a specific attribute. An attribute is a business concept, such as Region or Income Bracket, that provides a label for the numerical data (metrics) in your dashboard. An attribute form is a descriptive category for an attribute. While most attributes have only the forms ID and Description, an attribute such as Customer can have many other forms, such as First Name, Last Name, Address, Email Address, and so on. (For a more detailed description of attributes and attribute forms, see Providing business context to data: Attributes, page 50.)

For example, for the Customer attribute described above, you can display the First Name and Email Address forms in a grid. You can then export that data as an Excel file to use to create a special email only sales promotion.

Selecting which attribute forms to display is helpful when you are working with attributes containing geographic information. You can select whether or not to display the latitude and longitude information for an attribute, when that information is stored in separate attribute forms.

You can also determine what attribute information is displayed in the attribute and attribute form headers in the visualization. For example, you can choose to have a header containing the attribute form name automatically displayed above each attribute form shown in a grid, or have a single header automatically displayed for each attribute in a grid, with each header containing only the attribute name.

---

To select which attribute forms to display in a visualization

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization to format.

3. In the visualization’s Editor panel, right-click the object and point to **Display Attribute Form**.

   - If the visualization’s Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

4. To display an attribute form in the visualization, select the check box next to its name.
5 To hide an attribute form in the visualization, clear the check box next to its name.

6 From the Display Attribute Form Names drop-down list, select one of the following:

- To automatically display the attribute name in the header of each attribute in the grid, select **Off** (default). No attribute form names are included in the grid.

- To automatically display a header for each attribute form in the grid, with each header consisting of the attribute name followed by the attribute form name, select **On**.

- To automatically display a header for each attribute form in the grid, with each header consisting of only the attribute form name, select **Form name only**.

- To have a header automatically displayed for each attribute form in the grid and have the attribute name included only in the header for the first attribute form for each attribute, select **Show attribute name once**. The remaining attribute forms are displayed using the attribute form name only.

- To automatically display either headers for each attribute or each attribute form depending on the number of attribute forms visible in the grid for each attribute, select **Automatic**. If only one attribute form is shown in the grid for an attribute, the attribute is displayed with a header containing the attribute’s name. If more than one of the attribute’s forms are visible in the grid, each attribute form is displayed with a header containing the attribute name followed by the attribute form name.

7 Click **OK** to apply your changes.

**Related topics**

- *Displaying a visual representation of your data: Visualizations, page 179*
- *Formatting visualizations, page 264*
Formatting numeric values in a visualization

You can apply formatting to numeric values in a visualization. For example, you can choose to display 1,000 as a currency value, such as $1,000.00, or in scientific format, as 1E03.

To format numeric values in a visualization

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. Click the visualization to format.

3. In the visualization’s Editor panel, right-click the object whose values you want to format, and select Number Format. You can also right-click the object’s name or value in the visualization itself.
   - If the visualization’s Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

4. From the drop-down list, select the type of number formatting that you want to use to display numeric values, as described below. As you make changes, a preview of the numeric value is displayed at the bottom of the dialog box.
   - To display numbers without any special formatting, select General.
   - To display numbers with a fixed number of decimal places, select Fixed, then perform the following steps:
     a. From the Negative drop-down list, select the format to use to display each value.

     b. You can choose whether to display numbers with a separator symbol every three digits. To display the separator, select the Show 1000 separator check box. Numbers are displayed with a separator symbol every three digits (for example, 1,000,000). To display numbers without the separator symbol, such as 1000000, clear the Show 1000 separator check box.

     c. You can add additional decimal places to the displayed numbers, or decrease the number of decimal places shown. Do one of the following:

        • To add decimal places, click the Increase Decimal icon.
• To decrease the number of decimal places, click the **Decrease Decimal** icon.

• To display numbers formatted as currency, select **Currency**, then perform the following steps:
  a. From the symbol drop-down list, select the currency symbol to use display the numeric values.
  b. From the position drop-down list, select the position to display the currency symbol in, such as Left, Right, Left with Space, or Right with Space.
  c. From the **Negative** drop-down list, select the format to display the currency values in.
  d. You can add additional decimal places to the displayed numbers, or decrease the number of decimal places shown. Do one of the following:
      • To add decimal places, click the **Increase Decimal** icon.
      • To decrease the number of decimal places, click the **Decrease Decimal** icon.

• To display numbers formatted as dates, select **Date**. From the second drop-down list, select the format to use to display the dates.

• To display numbers formatted as time values, select **Time**. From the second drop-down list, select the format to use to display each time value.

• To display numbers as percentages, select **Percentage**, then perform the following steps:
  a. From the **Negative** drop-down list, select the format to use to display the percentages.
  b. You can add additional decimal places to the displayed numbers, or decrease the number of decimal places shown. Do one of the following:
      • To add decimal places, click the **Increase Decimal** icon.
      • To decrease the number of decimal places, click the **Decrease Decimal** icon.

• To display numbers as fractions, select **Fraction**. From the second drop-down list, select the format to use to display the fractions.
• To display numbers in scientific format, select **Scientific**. You can add additional decimal places to the displayed numbers, or decrease the number of decimal places shown. Do one of the following:
  - To add decimal places, click the **Increase Decimal** icon.
  - To decrease the number of decimal places, click the **Decrease Decimal** icon.

• To display numbers in a condensed format, such as 1.5 M for 1,500,000, select **Custom**, then click **Condense**.

• To display numbers in a custom number format, select **Custom**. In the field, type the format to use to display numbers, along with the symbols to use to display them. The pound symbol (#) represents the numeric value. For example, to display a number with two decimal places, such as 12.34, type #.#.

5 Click **OK** to apply your changes.

**Related topics**

- *Displaying a visual representation of your data: Visualizations*, page 179
- *Formatting visualizations*, page 264

**Adding or removing a threshold in a visualization**

You can highlight metric data in a visualization by applying formatting to the visualization when data fulfills a specific condition. This formatting is called a threshold. For example, a Grid visualization displays revenue data for different geographical regions. You can use thresholds to display revenue values less than $500,000 in red, or replace values greater than $5,000,000 with a company logo. Thresholds can make analyzing large amounts of data easier because images are easy to locate and different colors are quickly identified.

A threshold is made up of two parts: the condition and the formatting that will be applied to the values that meet the condition. Conditions can vary in complexity depending upon the type of threshold that is created. The data that meets the condition is considered to be data that has passed the threshold of the condition. Once a metric value meets the threshold condition, the formatting is automatically applied to the value.
You can apply thresholds to:

- ESRI Map visualizations that display map markers. You can customize the colors used to display map markers or replace image markers with a different image, based on the value of the selected metric.

- ESRI Map visualizations that display areas. The map areas are displayed in different colors based on the value of the selected metric.

- Graph visualizations. You can customize the colors used to display the visualization.

- Grid visualizations.

- Heat Map visualizations. The rectangles of the visualization are automatically colored based on the value of the selected metric.

- Network visualizations. Edges in the visualization are automatically colored based on the value of the selected metric.

For steps to create a threshold, see *Creating a threshold, page 274*. For steps to remove a threshold, see *Removing a threshold, page 278*.

You can create multiple thresholds on the same visualization, including thresholds with multiple conditions that can be based on attributes as well as metrics; for steps, see *Creating a threshold using multiple qualifications, page 278*.

You can apply the threshold formatting to:

- The values of a metric

- The subtotals of a metric

- Both the values and subtotals of a metric

Steps are included in *Creating a threshold using multiple qualifications, page 278*.

**Creating a threshold**

**Prerequisite**

- The steps below assume that you have already created the visualization that you want to add a threshold from, and added a metric in the correct area of the Editor panel.
For steps to create visualizations, see *Displaying a visual representation of your data: Visualizations, page 179.*

---

**To create a threshold in a visualization**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization to add the threshold to.

3. If the visualization’s Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the **Editor** icon to display the Editor panel.

4. From the visualization’s Editor panel, right-click the metric to define a threshold on, and select **Thresholds**. The Threshold Editor opens.

   • To customize the colors used to display map markers or replace image markers with a different image in an ESRI Map visualization that displays map markers, right-click a metric in the **Color By** area.

   • To customize the colors of the map areas in an ESRI Map visualization that displays areas, right-click a metric in the **Color By** area.

   • To customize the colors in a Graph visualization, right-click a metric in the **Color By** area.

   • To color-code a metric in a Grid visualization, right-click a metric in the **Metrics** area.

   • To color-code rectangles in a Heat Map visualization, right-click a metric in the **Color By** area.

   • To color-code edges in a Network visualization, right-click a metric in the **Edge Color** area.

5. Do one of the following:

   • If the Thresholds Type option is displayed, select one of the following:
To display your data using different colors based on the value of the metric, select the **Color-based** option. From the **Color** drop-down list, select a set of colors to apply to the values, such as Green or Red.

To replace your data with images based on the value of the metric, select the **Image-based** option. From the **Images** drop-down list, select a set of images to replace the values with, such as Arrows or Rounded Push Pin.

- If the Thresholds Type option is not displayed, from the **Color** drop-down list, select a set of colors to apply to the values, such as Green or Red.

The **Threshold Type** option is shown for visualizations that support replacing metric values with images.

6 To quickly reverse the order of colors or images used to display data that falls within each range, click **Reversed**. For example, if small, medium, and large data values are displayed in green, yellow, and red respectively, you can quickly choose to display small values in red, medium values in yellow, and large values in green.

7 From the **Based on** drop-down list, select the metric to use to define the threshold.

8 From the next drop-down list, select one of the following:

- To create a threshold based on the value of the metric, select **Value**. For example, you can display metric values greater than 5 million in blue.

- To create a threshold based on the top n metric values, select **Highest**. For example, you can display the top 5 metric values in red.

- To create a threshold based on the bottom n metric values, select **Lowest**. For example, you can display the bottom 5 metric values in green.

- To create a threshold based on the top n percent of metric values, select **Highest %**. For example, you can display the top 10% of metric values with a green arrow.

- To create a threshold based on the bottom n percent of metric values, select **Lowest %**. For example, you can display the bottom 50% of metric values with a red arrow.
9 If the Break By option is displayed, from the **Break By** drop-down list, select the attribute level to restart counting rank or percent values for the metric. To continue counting without restarting, select **None**. This option is only available for thresholds that are based on rank or percent values.

10 Each band displayed in the threshold slider represents a different range of metric values. The color or image displayed above the band represents the formatting used to display values that fall within its range. To modify the range covered by a band, choose from the following:

- To increase or decrease the range of values covered by the band, click and drag a thumb left or right along the slider.

- To change the location of a thumb to a specific value, click the thumb. Double-click the value displayed above the thumb, then type the value and press ENTER.

11 For thresholds that use colors rather than images, you can select the color to apply to a specific range of values, define new bands, and so on. Choose from the following:

- To create a new band, right-click the band to split and select **Add Color Band**. The selected band is divided evenly into two separate bands. You can then change the band’s range, as described above.

- To change the color applied to the range of values covered by a band, double-click the band, then select the new color from the palette.

- To delete a band, right-click the band and select **Delete**. The band is deleted.

- To delete a thumb, right-click the thumb and select **Delete**. The thumb is deleted.

12 To preview your changes in the visualization, click **Apply**.

13 Once you have finished defining the threshold, click **OK**. The threshold is created.
Removing a threshold

To remove all thresholds defined using a metric

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. Click the visualization to remove the threshold from.

3. From the visualization’s Editor panel, right-click the name of the metric to clear thresholds for, then select Clear Thresholds. All thresholds defined for the metric are cleared, and no longer affect the display of data in the visualization.
   - If the visualization’s Editor panel is not displayed, from the View menu, select Editor Panel. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

Creating a threshold using multiple qualifications

You can format data in a visualization in a dashboard based on multiple attribute or metric qualifications. A qualification is the condition that the data must meet for the formatting to be applied.

For example, if you want all revenue values over $40,000 in a Grid visualization formatted in a red, Arial font, you can create and format a threshold for that range. On the same visualization, you can have all revenue values below $10,000 appear as an image of an arrow pointing down. You can create thresholds that consist of multiple conditions at once. For example, you can highlight data for sales teams in a specific geographic region whose sales were above $750,000 and whose costs were below $200,000.

Prerequisite

- The steps below assume that you have already created the visualization that you want to add a threshold from, and added a metric in the correct area of the Editor panel.

- For a Grid visualization, a metric must be placed in the Metrics area.

- For a Network visualization, a metric must be placed in the Edge Color area.
• For an ESRI Map visualization, Graph visualization, or Heat Map visualization, a metric must be placed in the Color By area.

For steps to create visualizations, see *Displaying a visual representation of your data: Visualizations, page 179.*

• Multiple attribute or metric qualifications in a threshold are not available for bar graphs.

---

**To create a threshold based on multiple attribute or metric qualifications**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization to add the threshold to.

3. If the visualization’s Editor panel is not displayed, from the **View** menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the **Editor** icon to display the Editor panel.

4. From the visualization’s Editor panel, right-click the metric to define a threshold on, and select **Thresholds**. The Threshold Editor opens.

   • To customize the colors used to display map markers or replace image markers with a different image in an ESRI Map visualization that displays map markers, right-click a metric in the **Color By** area.

   • To customize the colors of the map areas in an ESRI Map visualization that displays areas, right-click a metric in the **Color By** area.

   • To customize the colors in a Graph visualization, right-click a metric in the **Color By** area.

   • To color-code a metric in a Grid visualization, right-click a metric in the **Metrics** area.

   • To color-code rectangles in a Heat Map visualization, right-click a metric in the **Color By** area.

   • To color-code edges in a Network visualization, right-click a metric in the **Edge Color** area.

5. Click **Advanced Thresholds Editor**. The Advanced Thresholds Editor opens.
Define a threshold

6 Click **New Condition**. A new threshold is added to the list.

7 In the Based On list, select the object to base the threshold on. Follow the appropriate steps below depending on whether you are basing the condition on a metric or an attribute:

- If you are creating a condition based on a metric, select a comparison operator, such as Greater Than or Less Than. Do one of the following:
  
  - To compare the metric to a specified value, type the value in the field.
  
  - To compare the metric to the value of another metric, select the metric in the list.

- If you are creating a condition based on an attribute, do one of the following:
  
  - To define your condition by selecting attribute elements from a list:
     
     a Under Select, do one of the following:
        
        - To format data only for elements you select, click **In List**. For example, you can format data for Books and Movies only.
        
        - To format data for all elements except those you select, click **Not in List**. For example, you can format data for all product categories except Books and Movies.
     
     b Select each attribute element to include in the condition.

  - To define your condition based on attribute form values:
     
     a Under Qualification, select the attribute form to base the condition on. For example, you can qualify the condition based on the attribute element’s ID form, one of its description forms, or the DATE form if the attribute is time-based.
     
     b From the list of operators to the right, select a comparison operator such as Greater Than or Less Than. Do one of the following:
        
        - To compare the attribute form to a specified value, type the value in the field.
– To compare the first attribute form to a second attribute form, in the Attribute list, click the attribute to use, then select the second attribute form from the drop-down list.

8 Click the **Apply** icon to create the new threshold. The threshold is created and added to the list.

9 You can add multiple conditions to an individual threshold. To add a new condition to a threshold, click the arrow icon to the right of the threshold, then click **New Condition**. A new condition is created and added to the threshold. Perform the appropriate steps, beginning at **Define a threshold, page 280** to define each new condition.

**Grouping and combining conditions in a threshold**

10 You can change the operator used to combine the conditions in a threshold. Click the operator displayed between the conditions, then select the operator to use to combine the conditions, such as AND or AND NOT.

11 You can group conditions together by shifting them to the left or right. Grouped qualifications will be evaluated together when the filter is applied to the report data.

- To group conditions, hover the cursor over the space between two conditions, then click the **Group Conditions** icon. The conditions are shifted to the right.

- To ungroup conditions, hover the cursor over the space between two conditions, then click the **Ungroup Conditions** icon. The conditions are shifted to the left.

A threshold must contain at least three conditions to group conditions.

12 You can change the order in which conditions are evaluated. To do so, click and drag each condition to its new location in the list. Conditions at the top of the list are evaluated before conditions at the bottom of the list.

**Formatting the threshold**

13 Click the formatting preview displayed to the right of the threshold. In the **Name** field, type a name for the threshold.

14 You can choose to replace data that meets the threshold’s conditions with text, a symbol, or an image. Do one of the following:
• To replace data that meets the conditions, select the Replace Data check box. From the drop-down list, select one of the following:
  ▪ To replace the data with text, select Replace Text. In the field, type the text to replace the data with.
  ▪ To replace the data with a symbol, select Quick Symbol. From the drop-down list, select the symbol to use to replace the data.
  ▪ To replace the data with an image, select Image. In the field, type the location of the image.

• To format data that meets the conditions without replacing the data, clear the Replace Data check box (default).

15 Select appropriate font formatting options to format the data, such as the font type, and whether to display data using Bold, Italic, Underline, or Strikethrough formatting.

16 From the Fill color palette, select the background color to use to display the data values.

17 From the Border style drop-down list, select the line style of the border to display around the data values.

18 From the Border color palette, select the color of the border to display around the data values.

19 Click the Apply icon to apply your formatting changes. The formatting preview displayed to the right of the threshold is updated.

**Editing, duplicating, rearranging, and deleting thresholds**

20 Choose from the following:

• To edit a threshold, click the threshold and select the appropriate options to define the threshold, as described in Define a threshold, page 280.

• To create a copy of a threshold, click the arrow icon to the right of the threshold. Select Duplicate. A copy of the threshold is created and displayed in the list.

• To move the threshold up in the list, click the arrow icon to the right of the threshold. Select Move Up.

• To move the threshold down in the list, click the arrow icon to the right of the threshold. Select Move Down.
• To determine whether to apply the threshold formatting to metric values, metric subtotal values, or both, click the arrow icon to the right of the threshold. Point to **Apply to**, then select one of the following:
  
  ▪ To apply formatting only to the metric values that meet the threshold conditions, select **Metric only**.
  
  ▪ To apply formatting only to metric subtotal values that meet the threshold conditions, select **Subtotals only**.
  
  ▪ To apply formatting to both metric values and subtotals that meet the threshold conditions, select **Metric and subtotals only**.
  
• To delete a threshold, click **X** to the right of the threshold. The threshold is deleted.

21 Repeat the appropriate steps above as necessary to define each threshold.

22 When you have finished creating all the thresholds, click **OK** to apply your changes.

**Related topics**

• *Formatting visualizations, page 264*

• *Displaying a visual representation of your data: Visualizations, page 179*

**Formatting a Graph visualization**

You can format a Graph visualization, to determine the shape used to display graph elements, whether to have MicroStrategy optimize space in the visualization by automatically sizing graph elements, and so on.

You can quickly define the color of an attribute value in a Graph visualization. For example, you can choose to display data for Electronics as red. If a bar graph is used, the bar riser for Electronics is displayed in red. If a pie chart is used, the pie slice for Electronics is red.

When you change the display color for an attribute value, other graphs and heat maps will use the same color to display the value. All the graphs and heat maps must color the graph items based on the same attribute. For example, a dashboard contains a bar graph and a pie chart, both showing data colored by geographical region. An area graph displays data colored by product category. If you select dark green for the Southeast region's bar riser
in the graph, the slice for Southeast is colored dark green in the pie chart. Since the area graph is colored by category, the region’s color does not apply to the area graph.

For steps, see To define the color used to display a specific attribute value, page 292.

You can display reference lines in a Graph visualization. A reference line, also referred to as a base line, is a user-defined vertical or horizontal line in the graph. Use reference lines to compare, reference, or measure against the data values displayed in the graph. For example, in a Graph visualization that displays regional revenue values, you can define a reference line for your target revenue, to see at a glance how each region compares to the target. For steps, see To display a reference line in a Graph visualization, page 286.

You can display a trend line for each metric or for a specific metric only. A trendline represents trends in your data. You can extend a trend line beyond your existing data to forecast or predict future values. For steps, see To display a trend line in a Graph visualization, page 289.

You can abbreviate the X-axis and Y-axis values in the visualization, or allow them to display fully. For steps, see To determine whether X-axis and Y-axis values in a Graph visualization are abbreviated, page 291.

You can highlight metric data in a Graph visualization by applying formatting to the visualization when data fulfills a specific condition. For steps to create threshold formatting, see Adding or removing a threshold in a visualization, page 273.

If you are formatting the visualization in Formatting Mode, you can also click an area of the graph to format it. The appropriate formatting options are automatically displayed in the Properties panel. For background information on Formatting Mode, see Using Formatting Mode for visualizations, page 267.

To format a Graph visualization

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. If the Properties panel is not displayed, from the View menu, select Properties.
3 Right-click the Graph visualization, and select **Format** to enter formatting mode.

4 To format a specific part of the visualization, such as the legend or graph axis, select the object to format, as follows:
   - To select high-level formatting options for the object, click the object. For example, you can click a row axis to format all graph axes in the visualization.
   - To select specific formatting options for the object, double-click the object. For example, you can double-click a row axis to format only the row axis in the visualization.

5 The Properties panel displays the relevant formatting options for the selected object, as described below. You can display formatting options for different parts of the Graph visualization by selecting items in the drop-down list at the top of the Properties panel, such as **Legend** or **Rows and Columns**. To display the formatting options for a specific part of the graph, select the part of the graph, such as a bar, line, graph legend, or row header. The Properties panel is automatically updated to display the relevant formatting properties.
   - **Data Exploration options, page 576**, are general graph formatting options to determine how to display graph axes, the maximum and minimum size of graph items, whether to display the legend or labels for graph items, whether to display banding, and so on.
   - **Trend Lines options, page 579**, enable, define, and format trend lines. For example, you can select the type of trend line and the line color to display for a specific metric. You can extrapolate values from the trend line to create forecasts. For steps to create a trend line, see **To display a trend line in a Graph visualization, page 289**.
   - **Reference Lines options, page 582**, enable, define, and format reference lines. For example, you can select the type of reference line to display (such as maximum or median), the level (each chart, each row, each column), and whether to display labels. For steps to create a reference line, see **To display a reference line in a Graph visualization, page 286**.
   - **Title and Container options, page 583**, format the title, background, and borders of the visualization.
   - **Legend options, page 584**, format the legend of the visualization, including whether or not to display the legend.
• **Axis options, page 585**, format the graph axes of the visualization. You can display and format axis labels, axis titles, and grid lines. You can also format axis lines.

• **Rows and Columns options, page 587**, format the rows and columns of the graphs in the visualization. You can format all the rows and columns the same way, or format row text, column text, row headers, column headers, row values, and column values individually.

• **Shapes options, page 588**, format the graph items, such as graph markers and data labels.

6 To exit formatting mode, right-click the visualization and select **Exit Format**.

7 To specify the following options, select **Data Exploration** from the drop-down list at the top of the Properties panel, and then click **More Options**. For detailed descriptions of each option, see **More Options dialog box, page 604**. Click **Save** to close the More Options dialog box and return to the dashboard.

- To determine how headers for attributes and attribute forms are displayed in the graph. For steps, and a more detailed description of the options, see **Selecting which attribute forms to display in a visualization, page 269**.

- To determine how null and zero metric values are hidden in the graph.

- To determine how filtering data through other visualizations works.

- To define the join behavior for attributes and metrics.

---

**To display a reference line in a Graph visualization**

Reference lines are available if the X or Y axis contains a metric. Reference lines are not available for 100% stacked graphs. You can add multiple reference lines, using different reference line types, to the same Graph visualization.

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 On the numeric axis of the Graph visualization to add a reference line to, right-click the label of the metric to display a reference line for. Point to **Add Reference Line**, and determine the height of the reference line by selecting one of the following:
• To display a reference line at the level of the highest data point in the graph, select **Maximum**.

• To display a reference line at the level of the lowest data point in the graph, select **Minimum**.

• To display a reference line at the average value of all data points in the graph, select **Average**.

• To display a reference line at the median value of all data points in the graph, select **Median**.

• To display a reference line at the height of the first data point plotted in the graph, select **First**.

• To display a reference line at the height of the last data point plotted in the graph, select **Last**.

• To display a reference line at a custom value, select **Constant**. In the field, type the value.

Your reference line is created and displayed in the graph.

3 Right-click the metric label on the numeric axis, and select **Edit Reference Line**. The Properties panel opens, displaying the reference line formatting properties.

**Define the reference line**

4 Determine whether to display a single reference line across each graph in the visualization, or use the same reference line across each row, column, or individual graph. From the **Level** drop-down list, select one of the following:

• To display a separate reference line for each chart in the visualization, select **Per cell**.

• To display a separate reference line for each row of charts in the visualization, select **Per row**.

• To display a separate reference line for each column of charts in the visualization, select **Per column**.

• To have each chart share the same reference line, select **Entire table**.

The Level option is available for all reference line types except **Constant**.
To show a label for the reference line, do the following:

a  Select the **Show label** check box.

b  Click one of the following:

- To display the type of reference line shown in the visualization, such as Maximum or Average, click **Type**.
- To display the name of the metric used to create the reference line, click **Metric**.
- To display the value of the reference line, click **Value**.

If a label is displayed, format the label text using the following **Font** options:

- Select the font type from the first drop-down list.
- Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
- Select the font size from the drop-down list.
- Select the font color from the color palette.

To add another reference line based on this metric, click **Add** in the **Type** field, and select the height of the reference line. (The different options are described above.) Continue creating the reference line, beginning with *Define the reference line, page 287*.

To add a reference line based on another metric, select the metric from the drop-down list on the Properties panel. Click **Add** in the **Type** field, and select the height of the reference line. (The different options are described above.) Continue creating the reference line, beginning with *Define the reference line, page 287*.

To remove a reference line, right-click the metric’s label on the numeric axis of the Graph visualization, point to **Remove Reference Line**, and select the reference line to remove.
To display a trend line in a Graph visualization

Trend lines are not available for stacked or clustered graphs for which there is more than one metric series displayed in the graph, or for percent graphs. At least one axis must have numeric values displayed on it.

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. On the numeric axis of the Graph visualization to add a trend line to, right-click the label of the metric to display a trend line for. Select **Enable Trendline**. A trend line is displayed for the metric.

3. Right-click the metric label on the numeric axis, and select **Edit Trendline**. The Properties panel opens, displaying the trend line formatting properties.

4. From the **Line** color palette, select the color to display the trend line.

5. From the drop-down list next to **Line**, select the line style to use to display the trend line. The default is Thin.

6. From the **Model** drop-down list, select the type of trend line to display. The options are:

   - **Best-fit**: Display the trend line that best fits the data, defined as the trend line with the highest r-squared value.

   - **Linear**: Display a linear trend line, which is a best-fit straight line that is used with simple linear data sets. Your data is linear if the pattern in its data points resembles a line. A linear trend line represents data that is increasing or decreasing at a steady rate.

   - **Logarithmic**: Display a logarithmic trend line, which is a best-fit curved line that is most useful when the rate of change in the data increases or decreases quickly and then levels out. Available if the graph values are positive.

   - **Exponential**: Display an exponential trend line, which is a curved line that is most useful when data values rise or fall at increasingly higher rates.

   - **Power**: Display a power trend line, which is a curved line that is best used with data sets that compare measurements that increase at a specific rate.
• **Polynomial**: Display a polynomial trend line, which is a curved line that is used when data fluctuates. For example, you can use a polynomial trend line to analyze gains and losses over a large data set. The order of the polynomial corresponds to the number of upward and downward fluctuations in the data. Your data fluctuates if the pattern in its data points resembles a line with hills and valleys. Generally speaking, an order 2 polynomial has up to one hill or valley, an order 3 polynomial has up to two hills or valleys, and so on. In the field, type the degree of the polynomial, from 2 to 6.

7 Determine whether to display a single trend line across each graph in the visualization, or use the same trend line across each row, column, or individual graph. From the **Level** drop-down list, select one of the following:

- To display a separate trend line for each chart in the visualization, select **Per cell**.
- To display a separate trend line for each row of charts in the visualization, select **Per row**.
- To display a separate trend line for each column of charts in the visualization, select **Per column**.
- To have each chart share the same trend line, select **Entire table**.

8 By default, a separate trend line is displayed for each attribute in the Break By area. To display a single line for the break-by attributes, clear the **Include Break By Attribute** check box.

   The Include Break By Attribute check box is available for graphs other than scatter or bubble, and if the graph has metrics displayed on only one axis.

9 You can enable forecasting, which displays the trend line past the available data. To enable forecasting, do one of the following:

- If the graph contains metrics on only one axis, complete the following steps:
  a  Select the **Extrapolate values by adjusting the horizontal axis** check box.
  b  To display additional periods to the right of the graph, select the number of periods in the **Forward** field.
  c  To display additional periods to the left of the graph, select the number of periods in the **Backward** field.
To display additional periods in the graph based on seasons, select the **Seasons** check box.

The Seasons check box is available for the time-based attributes Quarter, Month, and Day.

- If the graph contains metrics on both axes, complete the following steps:
  
  a. Select the **Enable forecasting** check box.
  
  b. From the drop-down list, select the metric to display the trend line for.
  
  c. In the **Min** field, type the minimum value at which to display the trend line. This value must be less than the minimum value available in the data.
  
  d. In the **Max** field, type the maximum value at which to display the trend line. This value must be greater than the maximum value available in the data.

10 To remove a trend line, right-click the metric label on the numeric axis, and clear **Enable Trendline**. The trend line is removed for the metric.

---

**To determine whether X-axis and Y-axis values in a Graph visualization are abbreviated**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 Click the Graph visualization to format.

3 If the Editor panel is not displayed, from the **View** menu, select **Editor Panel**.

4 In the Editor panel, right-click a metric in the **Vertical** or **Horizontal** area, and select one of the following:

   - To abbreviate metric values, select **Condense Label** (default).
   
   - To display metric values without abbreviation, clear **Condense Label**. If this metric is included on the same area (the Horizontal area or Vertical area) and the same axis as other metrics in the
visualization, perform the following steps for each metric that shares the same area and axis:

a Right-click the metric in the Editor panel, and clear **Condense Label**.

b Right-click the metric in the Editor panel, point to **Number Format**, then select the appropriate options to apply the same number formatting to this metric as the first metric that you formatted. Click **OK** to apply your changes. For detailed steps to apply number formatting to a metric, see *Formatting numeric values in a visualization, page 271*.

5 Repeat the appropriate steps above to format both X-axis and Y-axis values.

---

**To define the color used to display a specific attribute value**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 In each graph and heat map that will use the same color scheme for an attribute, place the attribute in the **Color By** area of the visualization’s Editor panel. Desktop automatically selects the colors of the attribute values.

3 For each attribute value that you want to color, in the graph, do one of the following:
   - Right-click the attribute value in the graph, then point to **Fill Color**. From the color palette, select the color to use to display the attribute value.
   - In the graph legend, right-click the colored square that represents the attribute value. From the **Fill** color palette, select the color to use to display the attribute value.

4 To restore an attribute value to its default color, in the color palette, select **Automatic**.

**Related topics**

- *Formatting visualizations, page 264*
- *Creating a Graph visualization, page 181*
• Creating a dual-axis graph, page 215
• Creating a graph with pies or rings, page 202
• Analyzing data in a graph, page 427

Formatting a Grid visualization

You can choose the font, background color, and borders for each part of a Grid visualization, such as the column headers, row headers, values, container, and title. You can also define the padding, column height, row height, whether to merge row and column headers, and so on. You can add subtotals for any of the attributes in the Grid visualization.

You can highlight metric data in a Grid visualization by applying formatting to the visualization when data fulfills a specific condition. For steps to create threshold formatting, see Adding or removing a threshold in a visualization, page 273.

You can also rename attributes or metrics, choose whether to display a visualization’s title bar, and so on. For a complete list, see General formatting for visualizations, page 265.

To format a Grid visualization

1 From the File menu, select Open. Navigate to and select the dashboard to modify.

2 Click the Grid visualization to format.

3 If the Properties panel is not displayed, from the View menu, select Properties.

4 To format the column headers, from the drop-down list at the top of the Properties panel, select Column Header Area. You can select:
   • The font of the column headers, including font type, font size, and font color, whether to apply bold formatting, and so on.
   • The background color of the column header.
   • The border style and color of the horizontal and vertical borders.
   • The horizontal and vertical alignment.
• Whether or not to wrap the header text.

5 To format the row headers, from the drop-down list at the top of the Properties panel, select **Row Header Area**. You can select:

• The font of the row headers, including font type, font size, and font color, whether to apply bold formatting, and so on.

• The background color of the row header.

• The border style and color of the horizontal and vertical borders.

• The horizontal and vertical alignment.

• Whether or not to wrap the header text.

6 To format the data cells, from the drop-down list at the top of the Properties panel, select **Value Area**. You can select:

• The font of the row headers, including font type, font size, and font color, whether to apply bold formatting, and so on.

• The background color of the values.

• The border style and color of the horizontal and vertical borders.

• The horizontal and vertical alignment.

• Whether or not to wrap the text.

7 To format the container in which the Grid visualization is displayed, from the drop-down list at the top of the Properties panel, select **Container**. You can select:

• The background color of the container.

• The border style and color of the horizontal and vertical borders.

8 To format the title bar, from the drop-down list at the top of the Properties panel, select **Title**. You can select:

• The font of the title bar, including font type, font size, and font color, whether to apply bold formatting, and so on.

• The background color of the title bar.

9 To determine the space between the values in the grid and each data cell, click one of the following **Padding** options:

• Small
• Medium
• Large

10 To specify the column width, select one of the following from the **Columns** drop-down list:

• To stretch the grid's columns to fit the size of the available space in the grid container, select **Auto Fit to Window** (default).

• To size the width of the grid's columns to fit the data in the column, select **Auto Fit to Contents**. All extra space in the grid is removed.

• To display each column using a fixed width, select **Fixed**. From the drop-down list, select the column to adjust, then type the width of the column in pixels. You can also select **All Columns** from the drop-down list, then type the column width for every column in the grid.

11 To specify the row height, select one of the following from the **Rows** drop-down list:

• To size the height of the grid's rows to fit the data in the row, select **Auto Fit to Contents**. All extra space in the grid is removed.

• To display each row using a fixed height, select **Fixed**. In the **Row Height** field, type the height of the row in pixels.

12 To specify the following options, select **Data Exploration** from the drop-down list at the top of the Properties panel, and then click **More Options**. For detailed descriptions of each option, see *More Options* dialog box, page 604. Click **Save** to close the More Options dialog box and return to the dashboard.

• Determine whether to show or hide the row or column headers.

• Determine whether to merge row or column headers that are repeated in the grid.

• Determine whether to prevent the row or column headers in the grid from being realigned or shifted by locking the headers.

• To remove or display the word "Metrics" on the grid, in an extra column.

• To determine how headers for attributes and attribute forms are displayed in the grid. For steps, and a more detailed description of the options, see *Selecting which attribute forms to display in a visualization*, page 269.
• To determine how null and zero metric values are hidden in the grid.
• To determine how filtering data through other visualizations works.
• To define the join behavior for attributes and metrics.

To add subtotals to a Grid visualization

1 From the File menu, select Open. Navigate to and select the dashboard to modify.

2 In the Grid visualization, hover the cursor over the attribute or metric to display subtotals for, then click the arrow icon. Point to Show Totals.

3 Select the check box next to each subtotal to display, then click OK.

4 By default, subtotals are shown at the bottom of the grid. To display them at the top of the grid, right-click the subtotal in the grid and select Move to Top. To display them at the bottom of the grid again, right-click the subtotal in the grid and select Move to Bottom.

5 You can quickly display or hide all subtotals in the grid by clicking the Show Totals icon \(\sum\) in the visualization's Editor panel.

Related topics
• Formatting visualizations, page 264
• Creating a Grid visualization, page 220
• Analyzing data in a grid, page 434

Formatting a Heat Map visualization

You can format a Heat Map visualization to determine how rectangles in the visualization are sized and positioned; whether to show or hide labels, the legend, and metric values; the position of the header; and so on. You can also select the background color of the visualization, rectangles, and legend.

You can color-code the rectangles by defining a threshold on a metric. For steps, see Adding or removing a threshold in a visualization, page 273.
You can quickly define the color of an attribute value in a Heat Map visualization. For example, you can choose to display data for Electronics as red, so that any Electronics rectangle in the heat map is displayed in red.

When you change the display color for an attribute value, other graphs and heat maps will use the same color to display the value. All the graphs and heat maps must color the graph items based on the same attribute. For example, a dashboard contains a bar graph and a heat map, both showing data colored by geographical region. An area graph displays data colored by product category. If you select dark green for the Southeast region's bar riser in the graph, the rectangle for Southeast is colored dark green in the heat map. Since the area graph is colored by category, the region's color does not apply to the area graph.

For steps, see *To define the color used to display a specific attribute value, page 298.*

You can also rename attributes or metrics, choose whether to display a visualization’s title bar, and so on. For a complete list, see *General formatting for visualizations, page 265.*

---

**To format a Heat Map visualization**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the Heat Map visualization to format.

3. If the Properties panel is not displayed, from the **View** menu, select **Properties**.

4. You can display formatting options for different parts of the visualization by selecting items in the drop-down list at the top of the Properties panel, such as **Data Exploration**.

   - **Data Exploration options, page 596**, are general formatting options to determine how to display rectangles, whether to display labels for rectangles, where to display rectangle headers, and so on.

   - **Title options, page 594**, format the title, background, and rectangle headers of the visualization.

   - **Legend options, page 598**, format the legend of the visualization, including whether or not to display the legend.
5 To specify the following options, select **Data Exploration** from the drop-down list at the top of the Properties panel, and then click **More Options**. For detailed descriptions of each option, see **More Options dialog box, page 604**. Click **Save** to close the More Options dialog box and return to the dashboard.

- To determine how headers for attributes and attribute forms are displayed in the graph. For steps, and a more detailed description of the options, see **Selecting which attribute forms to display in a visualization, page 269**.
- To determine how null and zero metric values are hidden in the graph.
- To determine how filtering data through other visualizations works.
- To define the join behavior for attributes and metrics.

---

### To define the color used to display a specific attribute value

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 In each graph and heat map that will use the same color scheme for an attribute, place the attribute in the **Color By** area of the visualization’s Editor panel. Desktop automatically selects the colors of the attribute values.

3 For each attribute value that you want to color, in the heat map, do one of the following:

- To quickly change the color for one attribute value, right-click a rectangle representing the attribute value in the heat map, then click **Format**. From the **Fill** color palette, select the color to use to display the attribute value.

- To change the color for multiple attribute values, select **Data Exploration** from the drop-down list at the top of the Properties panel. For each attribute value to change, complete the following steps:
  a From the **Shape Color** drop-down list, select the attribute value.
  b From the color palette in the next drop-down list, select the color to use to display the attribute value.

4 To restore an attribute value to its default color, in either color palette, select **Automatic**.
Related topics

- Formatting visualizations, page 264
- Creating a Heat Map visualization, page 223
- Analyzing data in a heat map, page 438

Formatting an ESRI Map visualization that displays map markers

You can format an ESRI Map visualization that displays map markers to determine whether items in the map are clustered together.

You can color map markers in the visualization based on the value of a metric by defining a threshold on the metric used to display the map markers. For steps, see Adding or removing a threshold in a visualization, page 273.

You can also rename attributes or metrics, choose whether to display a visualization’s title bar, and so on. For a complete list, see General formatting for visualizations, page 265.

To determine whether to cluster map markers in an ESRI Map visualization

Map items can be clustered together and displayed as a circle when a large number of map markers must be displayed in the same map area. You can double-click on a cluster to zoom in on the area and display individual map markers.

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. Click the ESRI Map visualization to format.

3. If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.

4. On the Properties panel, from the Clustering drop-down list, select one of the following:
   - To allow MicroStrategy to determine whether to cluster map markers, select Automatic.
• To display items on the map as clustered, select **On**.

• To display items on the map without clustering, select **Off** (default).

5 You can determine whether to refit the map area displayed in the visualization when the user selects map locations. Select one of the following from the **Zoom behavior on filtering** drop-down list:

• **Keep current zoom level** (default): Select this option to keep the current level of magnification when locations are selected on the map.

• **Dynamically change zoom level**: Select this option to zoom in on and refit the contents of the visualization to best display the selected locations on the map.

**Related topics**

• *Formatting visualizations, page 264*

• *Creating an ESRI Map visualization that displays map markers, page 228*

• *Analyzing data in a map, page 441*

### Formatting an ESRI Map visualization that displays a density map

For an ESRI Map visualization that displays a density map, you can select the color theme to use when color-coding areas in the map.

You can also rename attributes or metrics, choose whether to display a visualization’s title bar, and so on. For a complete list, see *General formatting for visualizations, page 265*.

---

**To format an ESRI Map visualization that displays a density map**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the ESRI Map visualization to format.
3 If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.

4 On the Properties panel, from the Density Map Color Gradient drop-down list, select the color theme to apply to areas in the visualization. For example, to display areas with a low density of locations of interest as blue, and areas with a high density as red, select the color theme Rainbow.

5 You can determine whether to refit the map area displayed in the visualization when the user selects map locations. Select one of the following from the Zoom behavior on filtering drop-down list:

   • Keep current zoom level (default): Select this option to keep the current level of magnification when locations are selected on the map.

   • Dynamically change zoom level: Select this option to zoom in on and refit the contents of the visualization to best display the selected locations on the map.

Related topics

   • Formatting visualizations, page 264
   • Creating an ESRI Map visualization that displays a density map, page 233
   • Analyzing data in a map, page 441

Formatting an ESRI Map visualization that displays areas

You can display map areas in different colors based on the value of a metric by defining a threshold on the metric. For steps, see Adding or removing a threshold in a visualization, page 273.

You can also rename attributes or metrics, choose whether to display a visualization’s title bar, and so on. For a complete list, see General formatting for visualizations, page 265.
To format an ESRI Map visualization that displays areas

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. Click the ESRI Map visualization to format.

3. If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.

4. You can determine whether to refit the map area displayed in the visualization when the user selects map locations. On the Properties panel, select one of the following from the Zoom behavior on filtering drop-down list:
   - **Keep current zoom level** (default): Select this option to keep the current level of magnification when locations are selected on the map.
   - **Dynamically change zoom level**: Select this option to zoom in on and refit the contents of the visualization to best display the selected locations on the map.

Related topics

- Formatting visualizations, page 264
- Creating an ESRI Map visualization that displays areas, page 239
- Analyzing data in a map, page 441

Formatting a Network visualization

Once you create a Network visualization, you can customize the display of the visualization. For example, you can display labels for nodes in the visualization, determine how node sizes are calculated, show where each edge starts and stops by displaying arrows on the edge, and so on.

You can also have edges in the visualization automatically colored based on the value of a metric. For steps, see Adding or removing a threshold in a visualization, page 273.
You can also rename attributes or metrics, choose whether to display a visualization’s title bar, and so on. For a complete list, see *General formatting for visualizations, page 265.*

---

**To format a Network visualization**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the Network visualization to format.

3. If the Properties panel is not displayed, from the **View** menu, select **Properties**.

4. You can display formatting options for different parts of the visualization by selecting items in the drop-down list at the top of the Properties panel, such as **Data Exploration**.

   - **Data Exploration options, page 596**, are general formatting options to format node labels, node edges, the display theme for the visualization, and so on.

   - **Title options, page 594**, format the title and background of the visualization.

   - **Legend options, page 598**, format the legend of the visualization, including whether or not to display the legend.

5. To specify the following options, select **Data Exploration** from the drop-down list at the top of the Properties panel, and then click **More Options**. For detailed descriptions of each option, see *More Options dialog box, page 604.* Click **Save** to close the More Options dialog box and return to the dashboard.

   - To determine how headers for attributes and attribute forms are displayed in the graph. For steps, and a more detailed description of the options, see *Selecting which attribute forms to display in a visualization, page 269.*

   - To determine how null and zero metric values are hidden in the graph.

   - To determine how filtering data through other visualizations works.

   - To define the join behavior for attributes and metrics.
Related topics

- Formatting visualizations, page 264
- Creating a Network visualization, page 243
- Analyzing data in a Network visualization, page 445
Introduction

A dashboard is an interactive display that you can create to showcase and explore business data. The main focus of a dashboard is the visualizations, which are visual representations of your data. You can also add other objects, to display different kinds of data in different ways, or label and describe data.

You can add the following to a dashboard:

- Text, which can serve as a label for your data or provide background information, a description, or instructions for the dashboard. In the example below, the text underneath the logo provides instructions for using the dashboard. For steps, see Adding text, page 307.

- Images, such as a corporate logo, as shown in the example below, or a photograph. For steps, see Adding an image, page 312.
• Web content, which displays real-time information from the web directly in your dashboard. In the example below, today’s weather forecast is displayed. For steps, see *Adding web content, page 314.*

You can create new attributes, metrics, and groups of attribute values, based on existing objects, to present your data in different ways. For steps and examples, see *Creating New Attributes, Metrics, and Groups, page 317.*

**Related topics**

• *About MicroStrategy Desktop, page 2*

• *Creating Dashboards and Visualizations, page 145*

• *Creating New Attributes, Metrics, and Groups, page 317*
Adding text

Once you have created a dashboard, you can add text to the dashboard. Text can serve as a label for your data or provide background information, a description, or instructions for the dashboard. You can reposition, resize, and format the text. In the example below, the text at the top of the dashboard provides tips for using the grid. The text has been formatted to display in a smaller font.

You can sort, pivot, and add totals to the grid.

<table>
<thead>
<tr>
<th>Category</th>
<th>Region</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>North</td>
<td>$123</td>
<td>$234</td>
</tr>
<tr>
<td>Books</td>
<td>South</td>
<td>$234</td>
<td>$543</td>
</tr>
<tr>
<td>Electronics</td>
<td>North</td>
<td>$342</td>
<td>$4,335</td>
</tr>
<tr>
<td>Electronics</td>
<td>South</td>
<td>$4,523</td>
<td>$5,221</td>
</tr>
<tr>
<td>Movies</td>
<td>North</td>
<td>$3,420</td>
<td>$4,532</td>
</tr>
<tr>
<td>Movies</td>
<td>South</td>
<td>$789</td>
<td>$4,523</td>
</tr>
</tbody>
</table>

You can type the text to display, as in the example above, or you can drag and drop a dataset object into the text field. When you use a dataset object, the text automatically changes depending on what is displayed in the dashboard (also known as dynamic text). You can combine both text and dataset objects in the same text field.

For example, you can use a combination of text and a dataset object as a title. Your dashboard, which is filtered on the Region attribute, contains a visualization that displays metric values for your regions. Add a text field, type “Revenue and Profit Data for ” (note the extra space) in the text field, and then drag and drop the Region attribute into it. When you select the Northeast region in the Filter panel, the text field displays “Revenue and Profit Data for Northeast”, and the visualization displays metric values for the Northeast region only. If you select another region in the Filter panel, both the text field and the visualization automatically change.

For steps to add text, see Adding and formatting text, page 310.

Displaying the results of a derived metric in a text field

You can use a text field to create a list of all the elements for an attribute. An attribute element is a value of an attribute. For example, North is an element of the Region attribute.
To do this, create a derived metric with the definition `ConcatAgg(Attribute@form)`, replacing `Attribute` with the name of the attribute and `form` with the name of the attribute form. (An attribute form is additional descriptive information about an attribute. For example, the attribute Customer has the forms First Name, Last Name, Address, Email Address, and so on.) Drag the derived metric into the text field. The attribute elements are displayed as a comma-separated list, such as North,South,East,West.

**Creating a dynamic metric using a text field**

You can create a metric by typing a function directly in the text field. For example, you can type `{REVENUE-COST}`, where Revenue and Cost are both metrics, in the text field.

**Combining text and dataset objects in a text field**

In the following example, text and dataset objects are combined. The words `Cost = Revenue - Profit =` are text that was typed in, while `{REVENUE}` and `{COST}` are the metrics displayed in the grid. A metric was created with the formula `{REVENUE - COST}`. The dollar sign in front of the created metric was typed, because the Revenue and Cost metrics are formatted in the dashboard, but the created metric needs the currency formatting.

![Image](image.png)

The Revenue and Cost metrics are each displayed as a single value, as shown below. They show the total of all the Revenue values and Profit values, as
shown in the totals in the grid. The metric that is created is also calculated at the grand total level.

![Image of a grid showing cost and profit calculations.](image)

### Displaying dashboard information using a text field

You can display dashboard information, such as the dashboard name and description, or the current date and time in a text field. The available codes are described in the following table. Be sure to include the braces ({} ) when you type the code in the text field.

<table>
<thead>
<tr>
<th>Description</th>
<th>Code</th>
<th>Sample Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date &amp; Time</td>
<td>{&amp;DATETIME}</td>
<td>11/15/2003 7:10:55 PM</td>
</tr>
<tr>
<td>Current date and time, of the client computer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current user</td>
<td>{&amp;USER}</td>
<td>Jane User</td>
</tr>
<tr>
<td>The full name, not the login, of the user who views the dashboard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dashboard name</td>
<td>{&amp;DOCUMENT}</td>
<td>Regional Sales Summary</td>
</tr>
<tr>
<td>Project name</td>
<td>{&amp;PROJECT}</td>
<td>MicroStrategy Tutorial</td>
</tr>
<tr>
<td>The name of the project in which the dashboard is stored</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dashboard execution time</td>
<td>{&amp;EXECUTIONTIME}</td>
<td>11/15/2013 7:11:15 PM</td>
</tr>
</tbody>
</table>
For example, you add the {&DOCUMENT} code to a text field in a dashboard named Regional and Category Data, as shown below:

The dashboard name is displayed, as shown below:

---

**Adding and formatting text**

Text can serve as a label for your data or provide background information, a description, or instructions for the dashboard. You can reposition, resize, and format the text. For example, text at the top of the dashboard can provide tips for using the grid. For more examples of text, see *Adding text*, page 307.

---

**To add and format a text field**

1. In the dashboard’s toolbar, click the **Insert** icon 
   ![Insert icon](Image)
   then click **Text**. The text field is automatically added to the dashboard.
2 Add the text to display, as described below. You can combine both text and dataset objects in the same text field. For an example, see *Combining text and dataset objects in a text field, page 308.*

- To add text, in the field, type the text to display, and then press ENTER. For an example, see *Adding text, page 307.*

- To add a dataset object, drag and drop the object from the Datasets panel into the text field. For examples, see *Combining text and dataset objects in a text field, page 308.*

- To display dashboard information, type the code into the text field. For a list of the available codes, and an example, see *Displaying dashboard information using a text field, page 309.*

**To format the text**

3 If the text contains numeric data, you can format the numbers, as described below:

   a Hover the cursor over the text field, then click the arrow icon displayed to the right, and select **Number Format**.

   b From the drop-down list, select the type of number formatting to use to display numeric values.

   c Select the appropriate format options, such as the separator symbol, currency symbol, and number of decimal places.

   d Click **OK** to save the number formatting.

4 Select the appropriate options to format your text, such as font type, font size, and direction in the Properties panel. For detailed information on each of the text formatting options, see *Dashboard Editor: Text properties, page 616.*

   - If the Properties panel is not displayed, from the **View** menu, select **Properties Panel**. If the Properties panel is hidden behind another panel, click the **Properties** icon to display the Properties panel.

5 To select the background color of the text, select the color from the **Fill Color** palette.

6 To add a border around the text, do the following:

   a Select the type of border from the **Border Style** drop-down list.

   b Select the border’s color from the **Border Color** palette.
To edit, move, resize, or delete a text field

1. To edit a text field, click the text to edit, then type the new text to display.

2. To move a text field, click and drag the text field, so that a blue indicator line is displayed in the location to move the text field to. The text field is moved and displayed in its new location.

3. To resize a text field, hover the cursor over the edge of the text field to size. Click and drag the edge to change the size of the text field.

4. To delete a text field, hover the cursor over the text field to delete, then click the arrow icon displayed to the right, and select Delete. The text field is removed from the dashboard.

Related topics

- Adding text, page 307
- Adding Text, Images, and Web Content, page 305

Adding an image

Once you have created a dashboard, you can add images to the dashboard. For example, you can add a corporate logo or photo to your dashboard. You can specify that the image opens a URL when you click the image. For example, if you click your corporate logo, your company’s home page opens.

To add and format an image

1. In the dashboard, in the toolbar, click the Insert icon , then click Image. A placeholder is automatically added to the dashboard and displayed in an image container.

2. In the Input Image Path field in the image container, type the location of the image, such as http://www.example.com/myimage.gif, and click OK.
3  To move the image, click and drag the image to its new location in the dashboard, so that an indicator line is displayed in the location to place the image. The image is moved to its new location and displayed.

To format the image

4  If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.

5  You can keep the image's original aspect ratio when the image is resized; select one of the following on the Properties panel:

- To maintain the image's aspect ratio when the image is resized, select the Lock Aspect Ratio check box (default).
- To resize the image without maintaining the aspect ratio, clear the Lock Aspect Ratio check box.

If the Properties panel is not displayed, from the View menu, select Properties Panel. If the Properties panel is hidden behind another panel, click the Properties icon to display the Properties panel.

6  To size the image, choose from the following:

- To quickly size the image's container, hover the cursor over the edge of the container. The cursor becomes double arrows. Click and drag the edge of the container to resize it. If you choose to size the image based on the dimensions of its container, as described below, the image is automatically sized to fit the container.
- To size the image using specific sizing options, from the Size drop-down list on the Properties panel, select one of the following:
  - To display the image with a specific width and height, select Fixed To, then do the following:
    - Type the width of the image, in pixels, in the X field.
    - Type the height of the image, in pixels, in the Y field.
  - To size the image so that its width and height fit inside its container, select Fit to Container. If the space available to display the image does not match the image's original aspect ratio, blank space is displayed.
  - To size the image so that it fills its container, select Fill Container. If the space available to display the image does not
match the image’s original aspect ratio, a portion of the image is cropped to fit the size of the available space.

- To stretch the image so that it fills all space available in its container, select **Stretch**.
- To restore the image to its original size, click **Restore to Original Size**.

7 To select the background color of the image’s container, select the color from the **Fill Color** palette.

8 To add a border around the image, do the following:
   a Select the type of border from the **Border Style** drop-down list.
   b Select the border’s color from the **Border Color** palette.

9 You can use the image as a link to a specific URL when you click the image. By default, linking is disabled. To enable it, complete the following steps:
   a From the **Link** drop-down list, select **Navigate to URL**.
   b In the field, type the URL to link to.
   c In the **Tooltip** field, type a tooltip to display when you hover the cursor over the image.

---

**To delete an image**

1 In the dashboard, hover the cursor over the image to delete, then click the arrow icon, and select **Delete**. The image is deleted from the dashboard.

**Related topic**

- *Adding Text, Images, and Web Content, page 305*

---

**Adding web content**

Once you have created a dashboard, you can display real-time information from the web, directly in your dashboard. The dashboard can display the contents of a web page, such as a stock ticker running in real time next to a
grid that shows historical stock information. The dashboard can display content formatted in HTML, such as a web-based chat client. In the dashboard below, today's weather forecast is displayed.

To display web content, add an HTML container to the dashboard, as described below.

**To add and format an HTML container**

1. In the dashboard’s toolbar, click the **Insert** icon 💬, then click **HTML Container**. A blank HTML container is added to the dashboard.

2. You can choose to directly type HTML in the field, or display the contents of a web page in an iFrame. In the HTML container, select one of the following:
   - To display the contents of a web page in an iFrame, click **iFrame**. In the field, type the URL of the web page.
   - To directly type HTML in the field, click **HTML Text**. In the field, type the HTML code to add to the dashboard.
3 To move the HTML container, click and drag the HTML container to the appropriate location in the dashboard, so that an indicator line is displayed in the location to place the HTML container. The HTML container is moved to its new location and displayed.

**To format the HTML container**

4 If the Properties panel is not displayed, from the **View** menu, select **Properties Panel**. If the Properties panel is hidden behind another panel, click the **Properties** icon 📊 to display the Properties panel.

5 To select the background color of the HTML container, select the color from the **Fill Color** palette.

   The background color is applied to an HTML container that uses HTML text, not an iFrame. The background color is displayed behind the text.

6 To add a border around the HTML container, do the following:
   a. Select the type of border from the **Border Style** drop-down list.
   b. Select the border’s color from the **Border Color** palette.

**To delete an HTML container from a dashboard**

1 In the dashboard, hover the cursor over the HTML container to delete and click the arrow icon, then select **Delete**. The HTML container is removed from the dashboard.

**Related topics**

- *Adding text, page 307*
- *Adding an image, page 312*
- *Adding Text, Images, and Web Content, page 305*
5

CREATING NEW ATTRIBUTES, METRICS, AND GROUPS

Introduction

A dashboard is an interactive display that you can create to showcase and explore business data. The main focus of a dashboard is the visualizations, which are visual representations of your data. You can create new attributes and metrics based on existing objects, to present your data in different ways. For steps and examples, see Creating a metric based on existing objects: Derived metrics, page 318 and Creating an attribute based on existing objects: Derived attributes, page 344. You can customize your data by grouping multiple attribute values into a single item (called a derived element). For steps and examples, see Grouping attribute values in a dashboard, page 349.

Related topics

- About MicroStrategy Desktop, page 2
- Creating Dashboards and Visualizations, page 145
- Adding Text, Images, and Web Content, page 305
Creating a metric based on existing objects: Derived metrics

You can create a new metric while you are viewing a dashboard. For example, you can subtract the values of one metric from the values of another metric, such as Revenue Forecast - Revenue. You can calculate a monthly average, for example, Yearly Profit / 12. If a dashboard shows the dollar sales for a particular region, you can create a derived metric to view the same data in millions, defined as Dollar Sales / 1,000,000.

Derived metrics are metrics that you can create based on existing objects on the dashboard. A derived metric performs a calculation on the fly with the data available on a dashboard, without re-executing the dashboard against the data source. Derived metrics are saved and displayed only on the specific dashboard on which they are created. You can only use objects already existing in a dashboard to create a derived metric. If the derived metric requires data that is not available in the Datasets panel, the dataset must be updated and resaved before the new data is displayed.

For steps to create derived metrics, see Adding a derived metric to a dashboard, page 319. For steps to modify and delete an existing derived metric, see Editing or deleting derived metrics in a dashboard, page 343.

Derived metrics calculate subtotals and dynamic aggregation both for functions that have a default dynamic aggregation (such as sum or minimum) and for functions that do not have a default dynamic aggregation (such as average and count distinct). For a complete list of the functions, as well as more details about dynamic aggregation, see the In-memory Analytics Guide.

Related topics

- Adding a derived metric to a dashboard, page 319
- Calculating data: Metrics, page 52
- Refreshing and updating your imported data: Republishing datasets, page 141
- Creating New Attributes, Metrics, and Groups, page 317
Adding a derived metric to a dashboard

You can create new metrics (called derived metrics) based on attributes and metrics that have already been added to a dashboard. For example, you can create a new metric by subtracting the values of one metric from the values of another metric, such as Revenue Forecast - Revenue. You can rank a metric’s value from least to greatest, or display metric values as percentages of an accumulated total. For a more detailed description on derived metrics, see Creating a metric based on existing objects: Derived metrics, page 318.

The following high-level steps describe how to create a basic derived metric:

1. Select the function. The function is the calculation applied to the data. Functions include rank, percent to total, moving total, running total, and more.

2. Select parameters and input values to define the function.

For example, if you are creating a rank metric, select whether to display the metric values in ascending or descending order. Next, you select how to break the ranking data. Breaking the rank calculation restarts the ranking calculation. For instance, you can select an attribute, and the total is restarted for each element in the attribute.

For detailed steps to create a basic derived metric and immediately display it on a visualization, see To create a basic derived metric on a visualization, page 320. You can also create and add a basic derived metric to a dashboard without adding it to a specific visualization, by using the Metric Editor. For steps, see To create a basic derived metric on the dashboard, page 321. Both methods add the derived metric to the list of dataset objects in the dashboard’s Datasets panel, so that you can use the metric in visualizations, text fields, and so on.

You can also create a derived metric by:

- Adding, subtracting, multiplying, or dividing existing metrics. See Creating a derived metric by combining the values of metrics, page 322.

- Selecting how to aggregate an existing metric. See Creating a derived metric by selecting the aggregation function, page 325.

- Basing the metric on an attribute. See Creating a derived metric from an attribute, page 327.

  - If the attribute contains numeric values, the values of the metric are calculated based on the sum of elements in the attribute.
Creating a metric based on existing objects: Derived metrics

- If the attribute does not contain numeric values, the metric is created as a count metric.
- Typing the metric formula directly, using custom expressions, and add conditional calculations to create more sophisticated metrics to meet your needs. See *Creating a new derived metric from scratch, page 328*.
- Using R analytics to perform statistical analysis. See *Providing statistical analysis from R analytics, page 341*.

**Prerequisite**

- The following steps assume that you have already created the visualization to add the derived metric to. For steps, see *Displaying a visual representation of your data: Visualizations, page 179*. If you want to create and a basic derived metric to a dashboard without adding it to a specific visualization, use the Metric Editor, as described in *To create a basic derived metric on the dashboard, page 321*.

---

**To create a basic derived metric on a visualization**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. From the visualization’s Editor panel, right-click the metric to use to create the derived metric, point to **Shortcut Metric**, and select the function, such as Running Total, Rank, or Percent Change.

   - If the function that you want to use is not listed, click **More Functions**. The Metric Editor opens. To continue creating the derived metric, see *To select and define the function, page 321*.

3. Select the appropriate options to define the derived metric.

   For example, if you are creating a running total, select the function to use for the calculation, such as Sum to calculate a running sum or Average for a running average. Then, select how to break the running total. Breaking the running total restarts the total. For instance, you can select an attribute, and the total is restarted for each element in the attribute.

4. Click **OK**. The new metric is added to the visualization. The derived metric is also added to the dashboard, in the Datasets panel, so that you can use it in other objects on the dashboard.
To create a basic derived metric on the dashboard

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. On the Datasets panel, right-click the metric to use to create the derived metric, and select **New Metric**. The Metric Editor opens.

   **To select and define the function**

3. Click **Switch to Function Editor**.

4. Type a name for the metric in the **Metric Name** field.

5. From the **Functions** list on the left, browse to and select the function to use to create the derived metric.
   - To display only functions from a specific category in the pane, select the category from the drop-down list.
   - To search for a function, type a function name in the search field.
   - To view a description of a function, hover your cursor over the function.

6. In the pane to the right, select the appropriate options to define the function, as described below. To view more details about the function, including descriptions of the options and examples, click **Details** at the bottom of the interface.
   - If you selected an aggregation function (also referred to as a grouping function), such as Sum, First, or Maximum, the Level field is displayed. Perform the following steps:
     a. Select the metric to group, in the second drop-down list.
     b. If the function requires any parameters, they are listed. Select the appropriate options to define each parameter, then click **OK** to apply your changes. For an explanation of a function parameter, click the **Information** icon next to the parameter.
     c. By default, the function is calculated at the level of the attributes on the visualization on which the metric is placed. You can specify an attribute to use as the level, by selecting the attribute from the **Level** drop-down list.
For example, if a visualization contains Region and Category, by default the metric calculates regional and category values on that visualization. If you select Region as the level, the metric calculates the regional revenue values on that visualization; it does not include a breakdown by Category. This allows you to compare revenue across regions.

- If you selected a non-aggregation function, such as data mining, date, OLAP, and ranking functions, you are presented with options to define the input values (called arguments) for the function, as well as any parameters you can use to determine the behavior of the function. For example, the NTile function has two parameters, Ascending and Tiles. Ascending controls whether the NTiles are ordered in ascending or descending order, while Tiles sets the number of splits. Perform the following steps:
  
a. For each argument listed, type a value to use as input values of the function.
  
b. For each parameter listed, type a value or select the parameter value from the drop-down list.

7 By default, the aggregation and subtotal behavior is automatically determined. You can change the behavior, to specify whether the derived metric is calculated using the whole dataset or calculated using the data in the visualization that it is placed on. For an explanation of when you need to change the behavior, and steps to do so, see Changing the aggregation and subtotal behavior for a derived metric, page 338.

8 Click Save. The new metric is added to the dashboard.

Related topics

- Creating a metric based on existing objects: Derived metrics, page 318
- Editing or deleting derived metrics in a dashboard, page 343
- Calculating data: Metrics, page 52

Creating a derived metric by combining the values of metrics

You can create new metrics (called derived metrics) based on metrics that have already been added to a dashboard. For a more detailed description of derived metrics, see Creating a metric based on existing objects: Derived metrics, page 318.
You can create a new metric by combining existing metrics with an arithmetic operator. Arithmetic operators allow you to add, subtract, multiply, divide, or average the selected metrics. You can find the minimum or maximum value of the selected metrics. Use a constant in the derived metric. For example, you estimate your future revenue will be 10% higher than your current revenue. To display this estimate, multiply the Revenue metric by 1.1. You can also create a metric that calculates the difference between the metrics as a percentage.

See the table below for steps to create a derived metric using these various methods.

<table>
<thead>
<tr>
<th>To...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combine two metrics with an arithmetic operator</td>
<td>To create a new metric based on an arithmetic calculation, page 323</td>
</tr>
<tr>
<td>Combine three or more metrics with an arithmetic operator</td>
<td>To create a new metric by combining the values of multiple metrics, page 324</td>
</tr>
<tr>
<td>Calculate the average, maximum, or minimum of metrics</td>
<td>To create a new metric by combining the values of multiple metrics, page 324</td>
</tr>
<tr>
<td>Select a metric formula, such as Metric1/Metric or Metric2-Metric1</td>
<td>To create a new metric by combining the values of multiple metrics, page 324</td>
</tr>
<tr>
<td>Use a constant in the derived metric</td>
<td>To create a new metric based on an arithmetic calculation, page 323</td>
</tr>
</tbody>
</table>

You can create a derived metric and immediately display it on a visualization, or you can create and add a derived metric to a dashboard without adding it to a specific visualization. Both methods add the derived metric to the list of dataset objects in the dashboard’s Datasets panel, so that you can use the metric in visualizations, text fields, and so on.

**Prerequisite**

- If you want to add the derived metric to a visualization, you must have already created the visualization. For steps, see *Displaying a visual representation of your data: Visualizations, page 179.*

---

**To create a new metric based on an arithmetic calculation**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.
When you create and add a derived metric to a dashboard, you can also add the derived metric immediately to a specific visualization to be displayed. Do one of the following:

- To create the metric without adding it to a visualization, from the Datasets panel, right-click the metric to use to create the derived metric, and select Calculation.

- To create the metric and add it immediately to a specific visualization, from the visualization’s Editor panel, right-click the metric to use to create the derived metric, and select Calculation.

The selected metric is displayed by default as the first metric in the calculation, but you can change it. From the first drop-down list, select another metric, or type a number in the field.

Click the arithmetic operator to use to combine the metrics.

From the next drop-down list, select the second metric to use in the calculation, or type a number in the field.

Click OK. The new metric is added to the dashboard.

---

To create a new metric by combining the values of multiple metrics

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. When you create and add a derived metric to a dashboard, you can also add the derived metric immediately to a specific visualization to be displayed. Do one of the following:

   - To create the metric without adding it to a visualization, from the Datasets panel, press CTRL and click the metrics to use to create the derived metric.

   - To create the metric and add it immediately to a specific visualization, from the visualization’s Editor panel, press CTRL and click the metrics to use to create the derived metric.

3. Right-click the selected metrics, point to Calculation, and then select the function to use to combine the metrics. The options are:

   - To add the metrics together, select Add.

   - To calculate the average of the selected metrics, select Average.
• To calculate the maximum across each of the selected metrics, select **Greatest**.

• To calculate the minimum across each of the selected metrics, select **Least**.

• To calculate the product of the selected metrics, select **Multiply**.

The following options are available if you have selected two metrics:

• To divide the first metric that you selected by the second, select **Metric1/Metric2**.

• To divide the second metric that you selected by the first, select **Metric2/Metric1**.

• To subtract the second metric that you selected from the first, select **Metric1-Metric2**.

• To subtract the first metric that you selected from the second, select **Metric2-Metric1**.

• To calculate the difference between the metrics as a percentage of the second metric that you selected, select \((\text{Metric1-Metric2})/\text{Metric2}\).

• To calculate the difference between the metrics as a percentage of the first metric that you selected, select \((\text{Metric2-Metric1})/\text{Metric1}\).

The metric is created and added to the dashboard.

**Related topics**

• *Adding a derived metric to a dashboard, page 319*

• *Editing or deleting derived metrics in a dashboard, page 343*

• *Creating a metric based on existing objects: Derived metrics, page 318*

• *Calculating data: Metrics, page 52*

**Creating a derived metric by selecting the aggregation function**

You can create new metrics (called derived metrics) based on metrics that have already been added to a dashboard. For a more detailed description of derived metrics, see *Creating a metric based on existing objects: Derived metrics, page 318.*
You can create a derived metric by selecting the aggregation function used to calculate values in an existing metric. Aggregation functions are used to calculate subtotals for the metric. Examples are Sum, Average, Standard Deviation, and Median. For example, you can create a derived metric that calculates the average of the Revenue metric values. The derived metric is automatically named Avg(Revenue), although you can change it. See Editing or deleting derived metrics in a dashboard, page 343 for steps to rename a derived metric.

You can create a derived metric and immediately display it on a visualization, or you can create and add a derived metric to a dashboard without adding it to a specific visualization. Both methods add the derived metric to the list of dataset objects in the dashboard’s Datasets panel, so that you can use the metric in visualizations, text fields, and so on.

**Prerequisite**

- If you want to add the derived metric to a visualization, you must have already created the visualization. For steps, see Displaying a visual representation of your data: Visualizations, page 179.

---

To create a new metric by selecting an aggregation function

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. When you create and add a derived metric to a dashboard, you can also add the derived metric immediately to a specific visualization to be displayed. Do one of the following:

   - To create the metric without adding it to a visualization, from the Datasets panel, right-click the metric to use to create the derived metric, and select **Aggregate By**.

   - To create the metric and add it immediately to a specific visualization, from the visualization’s Editor panel, right-click the metric to use to create the derived metric, and select **Aggregate By**.

3. Select the aggregation function to use to calculate metric values. The new metric is added to the dashboard.
Related topics

- **Adding a derived metric to a dashboard, page 319**
- **Editing or deleting derived metrics in a dashboard, page 343**
- **Creating a metric based on existing objects: Derived metrics, page 318**
- **Calculating data: Metrics, page 52**

Creating a derived metric from an attribute

You can create new metrics (called derived metrics) based on attributes that have already been added to a dashboard. For a more detailed description of derived metrics, see **Creating a metric based on existing objects: Derived metrics, page 318**.

You can create a derived metric from an existing attribute. The existing attribute is not deleted from the dashboard; it is duplicated and changed into a metric. The metric’s definition depends on the definition of the attribute:

- If the attribute contains numeric values, the values of the metric are calculated based on the sum of the elements in the attribute.

  For example, the Age attribute contains employee age data, as numeric values. You want to calculate the average age of employees in different departments. Create a derived metric from the Age attribute, which will aggregate all the employees’ ages. You can then average the Age metric for each department.

- If the attribute does not contain numeric values, the metric is created as a count metric. The derived metric counts the number of attribute elements.

  For example, the Region attribute contains text values: Northeast, Midwest, Southwest, and so on, for a total of 12 regions. You need the number of regions, so you create a derived metric from the Region attribute. The derived metric’s value is 12.

A derived metric created from an attribute is created on the dashboard. It is added to the list of dataset objects in the dashboard’s Datasets panel, so that you can use the metric in visualizations, text fields, and so on.
Creating a metric based on existing objects: Derived metrics

To create a new metric based on an attribute

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. From the Datasets panel, right-click the attribute to use to create the derived metric, then select Duplicate as Metric. The new metric is created and added to the dashboard.

   The Duplicate as Metric option is not available for a derived attribute.

Related topics

- Adding a derived metric to a dashboard, page 319
- Editing or deleting derived metrics in a dashboard, page 343
- Creating a metric based on existing objects: Derived metrics, page 318
- Calculating data: Metrics, page 52

Creating a new derived metric from scratch

You can create new metrics (called derived metrics) based on attributes and metrics that have already been added to a dashboard. For a more detailed description of derived metrics, see Creating a metric based on existing objects: Derived metrics, page 318.

Creating a derived metric from scratch allows you to customize the metric and make it more sophisticated to fit your needs. You can:

- Build custom expressions, such as percent-to-total metrics or expressions that use custom functions created with the MicroStrategy Function Plug-In Wizard. For an introduction to the MicroStrategy Function Plug-In Wizard, see the Functions Reference.

- Create a metric by typing the metric formula directly.

- Add conditional calculations, to create groups of data by filtering metric values. For example, you can group regions into poor revenue producers and good revenue producers. This supplements the conditional analysis...
provided by filters and thresholds. For steps, see *Performing conditional calculations: If and Case functions, page 333*.

- Perform statistical analysis by creating derived metrics based on R analytics. For steps, see *Providing statistical analysis from R analytics, page 341*.

For example, you can create a nested metric, where one aggregation function is enclosed inside another. A sample metric formula is $\text{Avg}(\text{Sum}(\text{Revenue}))$. The inner function $\text{Sum}$ calculates the total for the Revenue fact, and the outer function $\text{Avg}$ calculates the average of that result. If you want to know the average revenue per category for every region, you can create a nested metric that first calculates the revenue for all categories, and then calculates the average for each region. The metric is defined as:

$\text{Avg}(\text{Sum}(\text{Revenue}) \{\sim, \text{Category}\}) \{\sim, \text{Region}\}$

The inner formula, $\text{Sum}(\text{Revenue})$, calculates the revenue at the Category level. The outer formula then calculates the average of the resulting values at the Region level.

To create a metric, you must define the metric's formula, which consists of arithmetic operators (+, -, *, and /) and functions. The operators and functions can be applied to attributes or metrics. An example of the formula of a compound metric is $\text{RunningAvg}(\text{Cost})$, where $\text{Cost}$ is a metric and $\text{RunningAvg}$ is a function that calculates the running average. Another example is $\text{Sum}(\text{Cost}) + \text{Sum}(\text{Profit})$, where $\text{Cost}$ and $\text{Profit}$ are metrics and $\text{Sum}$ is a function that calculates the sum. In this case, the summation of the $\text{Cost}$ metric is added to the summation of the $\text{Profit}$ metric.

To add functions to the metric formula, you must select any options required to define the function. For example, if you want to add a grouping function, such as $\text{Sum}$, $\text{Average}$, $\text{First}$, or $\text{Maximum}$, you must define the function's expression, and you can also change the attribute level that the metric aggregates at. If you want to add a non-grouping function, such as data mining, date, OLAP, and ranking functions, you must define the input values (called arguments) for the function, as well as any parameters you can use to determine the behavior of the function. For the syntax of metric formulas that use grouping functions, see the *Advanced Metrics* chapter of the *Advanced Reporting Guide*. For the syntax for non-grouping functions, see the *Functions Reference*.

You can create a derived metric and immediately display it on a visualization, or you can create and add a derived metric to a dashboard without adding it to a specific visualization. Both methods add the derived metric to the list of
dataset objects in the dashboard's Datasets panel, so that you can use the metric in visualizations, text fields, and so on.

Follow the steps below to create sophisticated derived metrics from scratch, using attributes, metrics, functions, and arithmetic operators.

If you want to create a metric by selecting objects and being guided through the process, and the metric that you want to create does not include custom expressions, click **Switch to Function Editor**, then see *To create a basic derived metric on the dashboard, page 321.*

**Prerequisites**

- If you want to add the derived metric to a visualization, you must have already created the visualization. For steps, see *Displaying a visual representation of your data: Visualizations, page 179.*
- You are comfortable working with functions and metric levels.

---

**To create a derived metric from scratch**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. When you create and add a derived metric to a dashboard, you can also add the derived metric immediately to a specific visualization to be displayed. Do one of the following:
   - To create the metric without adding it to a visualization, from the Datasets panel, right-click the dataset to add the metric to, and select **New Metric**.
   - To create the metric and add it immediately to a specific visualization, from the visualization’s Editor panel, right-click the metric to use to create the derived metric, and select **New Metric**.

   The Metric Formula Editor opens.

3. Type a name for the metric in the **Metric Name** field.

4. In the editor pane to the right, begin typing the metric formula. You can type arithmetic operators (such as + and -) and values directly in the
metric expression. You can quickly add objects such as attributes, metrics, and functions to the metric by choosing from the following:

- To add a dataset object to the metric, from the **Objects** list, double-click the name of an object to add it to the editor pane. You can narrow down the list of dataset objects displayed by typing the name of the object in the search field, or by selecting a specific category of dataset object from the drop-down list, as follows:
  - To display all dataset objects across all datasets in the dashboard, select **All**.
  - To display the dataset objects in a specific dataset, select the name of the dataset.
  - To display metrics only, select **Metric**.
  - To display attributes only, select **Attribute**.

- To add a function to the metric, perform the following steps:
  a. From the **Functions** list to the left, browse to and select the function to use to create the derived metric. You can filter the list of functions displayed by typing the name of a function in the search field, or selecting a function category from the drop-down list. You can click **Details** at the bottom of the dialog box to see a description of the function, examples, and syntax information.
  b. Hover the cursor over the name of the function, then click **Edit**.
     - If you selected an aggregation function (also known as a grouping function), such as Sum, Average, First, or Maximum, the **Expression** field is displayed, along with settings for defining the level and condition. Perform the following steps:
       a. Type the function expression in the **Expression** field. As you type, matching objects are displayed in a drop-down list. You can click an object or continue to type. You can type multiple objects, such as **Revenue-Profit**.
       b. If the **Function Parameters** icon is displayed, you can define function parameters, such as whether to use all values in the calculation or to calculate using only the unique values. Click the **Function Parameters** icon. Select the appropriate options to define each parameter, then click **OK** to apply your changes. For a list of the function parameters for a specific function, click **Details** at the bottom of the dialog box.
c By default, the function is calculated at the level of the attributes on the visualization on which the metric is placed. You can specify the attributes to use in the metric calculation, regardless of what is contained on any visualization that the metric is placed on. To change the level, select an attribute from the Level drop-down list. You can add multiple attributes.

– If you selected a non-aggregation function, such as data mining, date, OLAP, and ranking functions, you are presented with options to define the input values (called arguments) for the function, as well as any parameters you can use to determine the behavior of the function. For example, the NTile function has two parameters, Ascending and Tiles. Ascending controls whether the NTiles are ordered in ascending or descending order, while Tiles sets the number of splits. To view a list of the arguments and parameters for the function, click Details at the bottom of the dialog box. Perform the following steps:

  a For each argument listed, type a value to use as input values of the function.

  b For each parameter listed, type a value or select the parameter value from the drop-down list.

  c When finished, click Add to add the function to the metric. The function, including the arguments you provided, is displayed in the editor pane.

5 Repeat the appropriate steps above to continue defining your metric formula. For example, you can add another metric, operator, or function to the formula. To delete the metric formula and begin again, click Clear All.

6 When you have completed the metric formula, click Validate. The Formula Editor displays a status message below the metric expression, indicating whether or not the new metric expression is correct. When the message displays as Valid Metric Formula, the metric expression is correct.

7 By default, the aggregation and subtotal behavior is automatically determined. You can change the behavior, to specify whether the derived metric is calculated using the whole dataset or calculated using the data in the visualization that it is placed on. For an explanation of when you need to change the behavior, and steps to do so, see Changing the aggregation and subtotal behavior for a derived metric, page 338.
When finished, click **Save** to save your changes. Your derived metric is created and added to the dashboard.

**Performing conditional calculations: If and Case functions**

Conditional calculations can be used to supplement the conditional analysis provided with filtering and thresholds in MicroStrategy Desktop. For example, you can provide conditional analysis by combining data into different groups based on the value of one or more metrics in a dashboard.

For example, MicroStrategy Desktop comes with the Airline Flight Analysis sample dashboard, which includes the following Day of the Week Stats visualization:

<table>
<thead>
<tr>
<th>Day Of Week</th>
<th>Number Of Flights</th>
<th>Avg On-time (%)</th>
<th>Avg Delay (min)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>785</td>
<td>70%</td>
<td>14.6</td>
</tr>
<tr>
<td>Mon</td>
<td>783</td>
<td>59%</td>
<td>35.8</td>
</tr>
<tr>
<td>Tue</td>
<td>971</td>
<td>57%</td>
<td>13.4</td>
</tr>
<tr>
<td>Wed</td>
<td>953</td>
<td>59%</td>
<td>14.8</td>
</tr>
<tr>
<td>Thu</td>
<td>780</td>
<td>61%</td>
<td>40.8</td>
</tr>
<tr>
<td>Fri</td>
<td>824</td>
<td>56%</td>
<td>15.6</td>
</tr>
<tr>
<td>Sat</td>
<td>808</td>
<td>64%</td>
<td>14.0</td>
</tr>
</tbody>
</table>

You can assess the performance of flights based on the average on-time percentage. For example, an average on-time percentage of 60% or lower is considered poor performance, while anything else is considered good performance. You can create a new Performance metric that includes a conditional analysis based on the Avg On-time (%) metric, as shown below.

<table>
<thead>
<tr>
<th>Day Of Week</th>
<th>Number Of Flights</th>
<th>Avg On-time (%)</th>
<th>Avg Delay (min)</th>
<th>Performance (If function)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>785</td>
<td>70%</td>
<td>14.6</td>
<td>Good</td>
</tr>
<tr>
<td>Mon</td>
<td>783</td>
<td>59%</td>
<td>35.8</td>
<td>Poor</td>
</tr>
<tr>
<td>Tue</td>
<td>971</td>
<td>57%</td>
<td>13.4</td>
<td>Poor</td>
</tr>
<tr>
<td>Wed</td>
<td>953</td>
<td>59%</td>
<td>14.8</td>
<td>Poor</td>
</tr>
<tr>
<td>Thu</td>
<td>780</td>
<td>61%</td>
<td>40.8</td>
<td>Good</td>
</tr>
<tr>
<td>Fri</td>
<td>824</td>
<td>56%</td>
<td>15.6</td>
<td>Poor</td>
</tr>
<tr>
<td>Sat</td>
<td>808</td>
<td>64%</td>
<td>14.0</td>
<td>Good</td>
</tr>
</tbody>
</table>

This conditional analysis can be done by creating a derived metric that uses the **If** conditional function. The Performance metric shown above uses the following formula:

```
IF([[Avg On-time (%)] <= .6),"Poor","Good")
```
You can then continue this analysis by selecting the cell that says Good in the row for Sunday, then from the drop-down list point to **Drill**, and select **Origin Airport Name**. This updates the visualization to include the origin airport and display data for Sunday only, as shown below.

<table>
<thead>
<tr>
<th>Day Of Week</th>
<th>Origin Airport Name</th>
<th>Number Of Flights</th>
<th>Avg On-time (%)</th>
<th>Avg Delay(min)</th>
<th>Performance (If function)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>General Lyman</td>
<td>60</td>
<td>98%</td>
<td>8.0</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Honolulu International</td>
<td>366</td>
<td>50%</td>
<td>13.1</td>
<td>Poor</td>
</tr>
<tr>
<td>Sun</td>
<td>Kahului Airport</td>
<td>137</td>
<td>90%</td>
<td>7.3</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Keahole</td>
<td>77</td>
<td>96%</td>
<td>15.4</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Lihue Airport</td>
<td>85</td>
<td>67%</td>
<td>3.6</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Los Angeles International</td>
<td>8</td>
<td>63%</td>
<td>8.7</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Mccarran International</td>
<td>8</td>
<td>75%</td>
<td>9.5</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Metropolitan Oakland International</td>
<td>4</td>
<td>75%</td>
<td>81.0</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Portland International</td>
<td>8</td>
<td>75%</td>
<td>15.5</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Sacramento International</td>
<td>4</td>
<td>50%</td>
<td>12.0</td>
<td>Poor</td>
</tr>
<tr>
<td>Sun</td>
<td>San Diego International</td>
<td>4</td>
<td>75%</td>
<td>36.0</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>San Francisco International</td>
<td>4</td>
<td>67%</td>
<td>34.0</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>San Jose International</td>
<td>4</td>
<td>75%</td>
<td>13.0</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Seattle/Tacoma International</td>
<td>12</td>
<td>75%</td>
<td>25.0</td>
<td>Good</td>
</tr>
<tr>
<td>Sun</td>
<td>Sky Harbor International</td>
<td>4</td>
<td>100%</td>
<td>0.0</td>
<td>Good</td>
</tr>
</tbody>
</table>

If you want to qualify the values of a metric into more than two groups, you can create a derived metric using the **Case** function. For example, you can modify the Performance metric to use the following expression, which qualifies performance into three groups rather than only two groups:

```
Case(([Avg On-time (%)] <= 0.6),"Poor",([Avg On-time (%)] > 0.65),"Excellent","Good")
```

This expression will display the results in the example below, which includes an Excellent group to denote airports that have an average on-time percentage greater than 65%.

<table>
<thead>
<tr>
<th>Day Of Week</th>
<th>Number Of Flights</th>
<th>Avg On-time (%)</th>
<th>Avg Delay(min)</th>
<th>Performance (Case function)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>785</td>
<td>70%</td>
<td>14.6</td>
<td>Excellent</td>
</tr>
<tr>
<td>Mon</td>
<td>783</td>
<td>59%</td>
<td>35.8</td>
<td>Poor</td>
</tr>
<tr>
<td>Tue</td>
<td>971</td>
<td>57%</td>
<td>13.4</td>
<td>Poor</td>
</tr>
<tr>
<td>Wed</td>
<td>953</td>
<td>59%</td>
<td>14.8</td>
<td>Poor</td>
</tr>
<tr>
<td>Thu</td>
<td>700</td>
<td>61%</td>
<td>40.0</td>
<td>Good</td>
</tr>
<tr>
<td>Fri</td>
<td>824</td>
<td>56%</td>
<td>15.6</td>
<td>Poor</td>
</tr>
<tr>
<td>Sat</td>
<td>808</td>
<td>64%</td>
<td>14.0</td>
<td>Good</td>
</tr>
</tbody>
</table>
The `Case` function provides the same conditional analysis as the `If` function. However, the `If` function can only qualify metric values into two different groups, while the `Case` function can qualify metric values into two or more groups. The `Case` function allows you to specify two or more conditions to use to evaluate the metrics you are interested in.

You can apply qualifications on more than one metric in an `If` or `Case` function. For example, you can assess the performance of flights based on both the average on-time percentage and the average delay time in minutes. Having an average on-time percentage of 60% or lower combined with an average delay time of 15 minutes or greater is considered poor performance, while anything else is considered good performance. You can create a new Performance metric that includes a conditional analysis based on the Avg On-time (%) metric and the Avg Delay (min) metric, as follows:

```
IF(((Avg On-time (%)) <= 0.6) And ([Avg Delay (min)] >= 15)), "Poor", "Good")
```

The example below shows the results of this conditional analysis.

<table>
<thead>
<tr>
<th>Day Of Week</th>
<th>Number Of Flights</th>
<th>Avg On-time (%)</th>
<th>Avg Delay (min)</th>
<th>Performance (multiple metrics)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>785</td>
<td>73%</td>
<td>14.6</td>
<td>Good</td>
</tr>
<tr>
<td>Mon</td>
<td>703</td>
<td>59%</td>
<td>35.6</td>
<td>Poor</td>
</tr>
<tr>
<td>Tue</td>
<td>971</td>
<td>57%</td>
<td>13.4</td>
<td>Good</td>
</tr>
<tr>
<td>Wed</td>
<td>953</td>
<td>59%</td>
<td>14.8</td>
<td>Good</td>
</tr>
<tr>
<td>Thu</td>
<td>780</td>
<td>61%</td>
<td>40.8</td>
<td>Good</td>
</tr>
<tr>
<td>Fri</td>
<td>824</td>
<td>55%</td>
<td>15.6</td>
<td>Poor</td>
</tr>
<tr>
<td>Sat</td>
<td>808</td>
<td>64%</td>
<td>14.0</td>
<td>Good</td>
</tr>
</tbody>
</table>

Since a conditional analysis is created as a derived metric, rather than included in a visualization as a filter, all the results of a conditional analysis are displayed on a visualization at once. In the examples above, this allows you to view data about all airports, both those that are performing well and those that are performing poorly. Applying a filter to a visualization, in contrast, hides the data on a visualization that does not meet the filter condition.

---

### To perform conditional calculations with derived metrics

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.
2 From the Datasets panel, right-click the dataset to add the metric to, and select **New Metric**. The Metric Formula Editor opens.

- If the Datasets panel is not displayed, from the **View** menu, select **Datasets Panel**.

3 Type a name for the metric in the **Metric Name** field.

4 From the **Functions** list to the left, browse to and select the If or Case function to use to create the derived metric.

5 Hover the cursor over the name of the function, then click the pencil icon. The options to define the input values (called arguments) for the function are displayed. To view details of the arguments for the function, click **Details** at the bottom of the dialog box.

6 Type the values to use as arguments, as described below:

- **The syntax for the If function is** \( \text{IF(Condition, TrueResult, FalseResult)} \) where:
  - **Condition** is the conditional expression. The condition can contain metrics, comparison and logical operators, and constants. The condition must be evaluated to be TRUE or FALSE.
  - **TrueResult** is a constant or metric value to return if the condition is TRUE. To display text as the value that is returned, enclose the text in double quotes (" ").
  - **FalseResult** is a constant or metric value to return if the condition is FALSE. To display text as the value that is returned, enclose the text in double quotes (" ").

- **The syntax for the Case function is** \( \text{Condition(Condition1, ReturnValue1, Condition2, ReturnValue2,..., DefaultValue)} \) where:
  - **Condition1** is the first condition to evaluate. The condition can contain metrics, comparison and logical operators, and constants.
  - **ReturnValue1** is a constant or metric value to return if the Condition1 condition is TRUE. To display text as the value that is returned, enclose the text in double quotes (" ").
  - **Condition2** is the second condition to evaluate. The condition can contain metrics, comparison and logical operators, and constants.
Return Value 2 is a constant or metric value to return if the Condition 2 condition is TRUE. To display text as the value that is returned, enclose the text in double quotes (" ").

The ... (ellipsis) represents any number of condition and return value combinations that can be used to create another logical group. Every condition must have a return value.

DefaultValue is a constant or metric value to return if none of the conditions are TRUE. To display text as the value that is returned, enclose the text in double quotes (" ").

7 When finished, click Add to add the function to the metric. The function, including the arguments you provided, is displayed in the editor pane.

8 Click Validate. The Formula Editor displays a status message below the metric expression, indicating whether or not the new metric expression is correct. When the message displays as Valid Metric Formula, the metric expression is correct.

9 When finished, click Save to save your changes. Your derived metric is created and added to the dashboard. You can now add the derived metric to a visualization, as described in Adding, replacing, and removing data from visualizations, page 251.

Related topics

- Providing statistical analysis from R analytics, page 341
- Adding a derived metric to a dashboard, page 319
- Editing or deleting derived metrics in a dashboard, page 343
- Creating a metric based on existing objects: Derived metrics, page 318
- Calculating data: Metrics, page 52
- Creating a filter for the data on a visualization, page 402
- Adding or removing a threshold in a visualization, page 273
Changing the aggregation and subtotal behavior for a derived metric

By default, the aggregation and subtotal behavior for derived metrics is automatically determined. (Dynamic aggregation is the roll-up of metric values that occurs when an attribute is removed from a visualization.) If you need a different calculation than the values provided by the default automatic behavior, you can use manual mode. Manual mode allows you to specify whether the derived metric is calculated using the whole dataset (the base) or the data in the visualization that it is placed on.

For example, a dataset contains Region, Category, and Subcategory, with the Revenue metric. The grid is subtotaled at the Category and Region levels, returning the maximum revenue in the category or region, as shown below.
(The subtotal values will help you understand the dynamic aggregation that occurs later.)

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Subcategory</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>Movies</td>
<td>Action</td>
<td>$143,853</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
<td>Comedy</td>
<td>$158,956</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
<td>Drama</td>
<td>$161,321</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
<td>Horror</td>
<td>$147,361</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
<td>Kids/Family</td>
<td>$154,195</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
<td>Maximum</td>
<td>$184,264</td>
</tr>
<tr>
<td>North</td>
<td>Music</td>
<td>Alternative</td>
<td>$184,264</td>
</tr>
<tr>
<td>North</td>
<td>Music</td>
<td>Country</td>
<td>$172,325</td>
</tr>
<tr>
<td>North</td>
<td>Music</td>
<td>Pop</td>
<td>$176,310</td>
</tr>
<tr>
<td>North</td>
<td>Music</td>
<td>Rock</td>
<td>$131,029</td>
</tr>
<tr>
<td>North</td>
<td>Music</td>
<td>Maximum</td>
<td>$184,264</td>
</tr>
<tr>
<td>North</td>
<td>Maximum</td>
<td>Maximum</td>
<td>$184,264</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>Action</td>
<td>$96,909</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>Comedy</td>
<td>$169,437</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>Drama</td>
<td>$166,384</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>Horror</td>
<td>$174,163</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>Kids/Family</td>
<td>$145,591</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>Maximum</td>
<td>$174,163</td>
</tr>
<tr>
<td>South</td>
<td>Music</td>
<td>Alternative</td>
<td>$148,462</td>
</tr>
<tr>
<td>South</td>
<td>Music</td>
<td>Country</td>
<td>$127,623</td>
</tr>
<tr>
<td>South</td>
<td>Music</td>
<td>Pop</td>
<td>$167,013</td>
</tr>
<tr>
<td>South</td>
<td>Music</td>
<td>Rock</td>
<td>$113,020</td>
</tr>
<tr>
<td>South</td>
<td>Music</td>
<td>Maximum</td>
<td>$174,163</td>
</tr>
<tr>
<td>South</td>
<td>Maximum</td>
<td>Maximum</td>
<td>$174,163</td>
</tr>
<tr>
<td>Maximum</td>
<td></td>
<td></td>
<td>$184,264</td>
</tr>
</tbody>
</table>

You create two derived metrics, returning the maximum revenue at the level of Region:

- The Max Revenue (visualization) metric uses the attributes on the visualization when dynamic aggregation is triggered.
- The Max Revenue (base) metric uses the attributes on the dataset (the base) when dynamic aggregation is triggered.
Remove the subtotals from the grid and add the derived metrics. Remove Subcategory from the grid, to trigger dynamic aggregation. The new grid is shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Revenue</th>
<th>Max Revenue (visualization)</th>
<th>Max Revenue (base)</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>Movies</td>
<td>$765,686</td>
<td>$765,686</td>
<td>$184,264</td>
</tr>
<tr>
<td>North</td>
<td>Music</td>
<td>$663,928</td>
<td>$663,928</td>
<td>$184,264</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
<td>$752,484</td>
<td>$752,484</td>
<td>$174,163</td>
</tr>
<tr>
<td>South</td>
<td>Music</td>
<td>$557,018</td>
<td>$557,018</td>
<td>$174,163</td>
</tr>
</tbody>
</table>

Notice that the two Max Revenue metrics return different values. The Max Revenue (visualization) metric is returning the maximum revenue value from what is displayed on the visualization. That is, the metric is choosing between the two revenue values for each region. The Max Revenue (base) metric returns the maximum revenue value at the subcategory level (which is the level of the dataset or base), the same as the subtotals calculated in the previous grid.

To change the aggregation and subtotal behavior of a derived metric

1. From the File menu, select Open. Navigate to and select the dashboard to modify.
2. Right-click the derived metric and select Edit Derived Metric. The Metric Editor opens.
3. Click the Metric Options icon. The Metric Options dialog box opens.
4. From the Aggregation and Subtotal Behavior drop-down list, select Manual.
5. By default, the derived metric is aggregated at the level of the attributes on the visualization. To aggregate it at the level of its dataset, select the Aggregation From Base check box.
6. By default, the derived metric is subtotaled at the level of the attributes on the visualization. To subtotal it at the level of its dataset, select the Subtotals From Base check box.
7. Click OK to return to the Metric Editor.
8. Click Save to save your changes.
Related topics

- Adding a derived metric to a dashboard, page 319
- Editing or deleting derived metrics in a dashboard, page 343
- Creating a metric based on existing objects: Derived metrics, page 318
- Calculating data: Metrics, page 52

Providing statistical analysis from R analytics

You can perform statistical analysis in MicroStrategy Desktop using R analytics. Once an R analytic is deployed to MicroStrategy Desktop as a derived metric, the statistical analysis can be added to and analyzed on visualizations. An example of trend analysis is shown below.

MicroStrategy Desktop supports the deployment of R analytics from the R statistical environment as derived metrics. R is an open-source language and environment for statistical computing and graphics. The third-party R environment is freely available, as a separate download, from http://CRAN.R-project.org.

Prerequisites

- The MicroStrategy R Integration Pack must be installed and configured on the same machine as MicroStrategy Desktop:
To download the R Integration Pack, visit http://rintegrationpack.codeplex.com/.

For steps to install and configure the R Integration Pack, see the R Integration Pack User Guide, which can be downloaded from http://rintegrationpack.codeplex.com/documentation.

- A metric expression has been created for the R script using the deployR utility. For steps to use the deployR utility to create metric expressions for R scripts, see the R Integration Pack User Guide.

- The dashboard on which you create the derived metric for the R analytic must contain the metrics required to support the statistical analysis. For example, if an R analytic requires three inputs to define the target, trend, and season for a statistical analysis, the dashboard must include three metrics that can supply the data for those three inputs.

---

To provide statistical analysis from R analytics

1 From the File menu, select Open. Navigate to and select the dashboard to modify.

2 Hover your cursor over the top of the Datasets panel, click the arrow icon on the right, then select Insert New Metric. The Metric Formula Editor opens.

3 Type a name for the metric in the Metric Name field.

4 From the deployR utility of the R Integration Pack, copy the metric expression that describes the R script, then paste the metric expression into the Formula field.

5 Map all of the inputs for the metric expression, which are included in parentheses and separated by commas at the end of the metric expression, to metrics available in the dashboard. Each input must map to one metric in the dashboard.

6 When finished, click Save. The new metric is added to the dashboard. You can now add the derived metric to a visualization to begin analyzing the statistical analysis, as described in Adding, replacing, and removing data from visualizations, page 251.
Related topics

- Adding a derived metric to a dashboard, page 319
- Editing or deleting derived metrics in a dashboard, page 343
- Creating a metric based on existing objects: Derived metrics, page 318
- Calculating data: Metrics, page 52

Editing or deleting derived metrics in a dashboard

Once you have added a derived metric to a dashboard, you can quickly edit the definition of the metric, rename it, or delete it from the dashboard.

For background information on derived metrics, see Creating a metric based on existing objects: Derived metrics, page 318.

To rename a derived metric in a dashboard

1. From the File menu, select Open. Navigate to and select the dashboard to modify.
2. In the Datasets panel, right-click the derived metric, then select Rename.
   - If the Datasets panel is not displayed, from the View menu, select Datasets Panel.
3. Type a name for the derived metric and press ENTER. The metric is renamed and the new name is displayed in the Datasets panel, as well as in any visualizations that contain the metric.

To edit a derived metric in a dashboard

1. From the File menu, select Open. Navigate to and select the dashboard to modify.
2. In the Datasets panel, right-click the derived metric, then select Edit Derived Metric. The Metric Function Editor or Metric Formula Editor opens, based on the type of derived metric that you have chosen to edit.
• If the Datasets panel is not displayed, from the View menu, select Datasets Panel.

3 Select the appropriate options to define the metric, then click OK.

• For detailed steps describing the options in the Metric Function Editor, see To create a basic derived metric on the dashboard, page 321.

• For detailed steps describing the options in the Metric Formula Editor, see To create a derived metric from scratch, page 330.

To delete a derived metric from a dashboard

1 From the File menu, select Open. Navigate to and select the dashboard to modify.

2 In the Datasets panel, right-click the derived metric, and select Delete. The derived metric is deleted from the dashboard.

• If the Datasets panel is not displayed, from the View menu, select Datasets Panel.

Related topics

• Adding a derived metric to a dashboard, page 319

• Creating a metric based on existing objects: Derived metrics, page 318

• Calculating data: Metrics, page 52

Creating an attribute based on existing objects: Derived attributes

You can create and add derived attributes to a dashboard, based on dataset objects that already included in the dashboard. For example, you can combine the geographical region attribute with the state attribute to produce a result like Chicago, Illinois. (To do this, you would use the concatenation function.) A derived attribute works the same as any other attribute. You can add it to a visualization, drag it into a text field to display it as a label, or use it as a filter.
You can easily create a derived attribute that:

- Changes the data type of an existing attribute. The derived attribute can be a string, number, or date. The original attribute is not modified and remains on the dashboard. For steps, see *To change an attribute’s data type by creating a derived attribute, page 346.*

- Changes an existing metric to an attribute. Each value in the metric is displayed as a separate value in the attribute. The original metric is not modified and remains on the dashboard. For steps, see *To create a derived attribute based on a metric, page 165.*

- Creates additional date-related attributes, for any date attribute. This allows you to improve the depth of time-related information available for your data by generating attributes containing higher levels of time data based on an existing attribute in a dashboard. For example, if the attribute contains month data, the Year attribute, which contains the year of each month, can be generated. For steps, see *To create a derived attribute with additional time information, page 166.*

You can also create more complex derived attributes, using the functions available in the Attribute Editor. For example, your dashboard contains the Employee attribute, which contains separate attribute forms for the first name and last name of each company employee. (An attribute form is a descriptive category for any data that you save about any of its attributes.) You want to display the first initial and last name of each employee. You can create a derived attribute based on Employee, using the Concatenation function to combine the first letter of the first name and the last name. The derived attribute has the following definition:

\[
\text{Concat(Leftstr(Employee@FirstName,1), ".", Employee@LastName)}
\]

When the derived attribute is displayed in a visualization, it displays each employee by first initial and last name.

You can use a derived attribute to turn a Salary metric into a Salary Range attribute. Define the attribute’s values as salary bands, such as 20K and 50K. Create a derived attribute with the following definition:

\[
\text{Concat(LeftStr(toString(Salary), (Length(toString(Salary))-4)), "0", "K")}
\]

To display the salary bands in thousands, change the definition to the following:

\[
\text{Concat(LeftStr(toString(Salary), (Length(toString(Salary))-3)), "K")}
\]
By default, a derived attribute contains only the ID attribute form, but you can define additional attribute forms for the derived attribute. Any attribute forms besides the ID attribute form must be based on the value of the ID attribute form.

Sorting is one reason to create an additional form rather than another derived attribute. For example, your dataset contains a Date attribute in the format MM/DD/YY. You need to display the days of the week rather than the date. You can create a derived attribute that performs this transformation, returning values of Monday, Tuesday, and so on. If you sort these values alphabetically, Friday would display first. You want Sunday, the first day of the week, to display first, followed by Monday, and so on. You can create the derived attribute with these two forms:

- The ID form contains the default sorting order, defined as:
  \[ \text{DayOfWeek}(\text{Date@ID}) \]
- The Desc form contains the description, defined as:
  \[ \text{ToString<Pattern=ddd>}(\text{Date@ID}) \]

The derived attribute, when displayed in a visualization, sorts according to the ID form.

Steps to define attribute forms are included in *To create a derived attribute, page 347.*

---

**To change an attribute’s data type by creating a derived attribute**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. When you create a derived attribute, you can also add the derived attribute immediately to a specific visualization to be displayed. Do one of the following:
   - To create the attribute without adding it to a visualization, from the Datasets panel, right-click the attribute to use to create the derived attribute, point to **Data Type**, and select the data type.
   - To create the attribute and add it immediately to a specific visualization, from the visualization’s Editor panel, right-click the attribute to use to create the derived attribute, point to **Data Type**, and select the data type.
Your derived attribute is created and added to the dashboard.

To create a derived attribute

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. When you create a derived attribute, you can also add the derived attribute immediately to a specific visualization to be displayed. Do one of the following:
   - To create the attribute without adding it to a visualization, from the **Datasets** panel, right-click the dataset to add the attribute to, and select **New Attribute**.
   - To create the attribute and add it immediately to a specific visualization, from the visualization’s **Editor** panel, right-click the attribute to use to create the derived attribute, and select **New Attribute**.

The Attribute Editor opens.

3. You can type the definition of the derived attribute directly into the pane on the right. As you type, matching objects are displayed in a drop-down list. You can click an object or continue to type.

4. To add a function to the derived attribute’s definition, choose from the following in the **Functions** pane:
   - To add a function by selecting function arguments and being guided through the process, complete the following steps:
     a. Hover the cursor over the name of the function to use, then click **Edit**.
     b. Select each argument required for the function, then click **Add**.
     The function is added to the pane to the right, along with the selected arguments.
   - To add a function directly to the definition of the attribute, double-click the name of the function to add. The function is added to the pane to the right.
   - To view a short description of a function, click its name in the list. A description of the function, including its purpose, is shown at the bottom of the interface. Click **Details** to view more detailed information about the function and its arguments.
• To find a specific function, do one of the following:
  □ Type the name of a function in the search field.
  □ Browse for the function by selecting a function category from the drop-down list.

5 To add a dataset object to the derived attribute’s definition, double-click the object in the Objects pane. The selected object is added to the pane on the right. You can filter the list of dataset objects by doing one of the following:

• Type the name of an object in the search field.
• To display all dataset objects across all datasets in the dashboard, select All from the drop-down list.
• To display the dataset objects in a specific dataset, select the name of the dataset from the drop-down list.
• To display only metrics, select Metrics from the drop-down list.
• To display only attributes, select Attributes from the drop-down list.

6 After you finish defining the derived attribute, type its name in the Attribute Name field.

7 By default, a derived attribute contains only the ID attribute form, but you can define additional attribute forms for the derived attribute. Follow the steps below:

a Click the plus (+) tab above the pane on the right. A tab for a new attribute form is created and displayed.

b In the pane, define the attribute form using the same options that you used to define the ID attribute form, by typing a definition, adding functions, and so on, as described above. Any attribute forms besides the ID attribute form must be based on the value of the ID attribute form.

c To rename the attribute form, double-click its name on the tab. Type a new name and press ENTER to apply your changes.

d To delete an attribute form, click X on its tab.

8 Click Save to save your changes. Your derived attribute is created and added to the dashboard.
Grouping attribute values in a dashboard

An attribute is a business concept, such as Region or Category, that is reflected in the data in your data source. Attributes provide a context in which to report on and analyze business facts or calculations. Attributes are comprised of attribute elements, which are the values of the attribute. For example, the attribute Region includes the attribute elements North and South; January, February, and March are elements of the attribute Month. For more background information on attributes, see *Providing business context to data: Attributes*, page 50.

You can define groups by:

- Combining multiple attribute elements into a single element. This is referred to as an element group. The element group replaces the selected attribute elements in the visualization’s display.

- Combining multiple attribute elements with a calculation to create a new element. This is referred to as a calculated group. The calculated group displays on the visualization but does not replace the selected attribute elements.

Although the following examples use Grid visualizations to make it easier to see the data, you can create groups on other types of visualizations. For example, you can select multiple nodes on a Network visualization, and attribute elements or data points on a Graph visualization or Heat Map visualization.

You can group elements of an attribute imported from your data sources, or of a derived attribute that you created on the dashboard. For steps to create a derived attribute, and general information about them, see *Creating an attribute based on existing objects: Derived attributes*, page 344.

Replacing attribute elements with a group: Element groups

When you create an element group, you group attribute elements together to combine multiple elements into a single element. In a grid, a group combines
rows of data into one row; in a bar graph, a group combines multiple bar
risers into one bar riser; in a Network visualization, a group combines
multiple nodes into one node; and so on.

For example, if your grid displays revenue data from each month on separate
rows, you can group the months into seasons. Combine January, February,
and March into a group named Winter; group April, May, and June into
Spring; and so on. The image below shows this grid before the groups were
created:

<table>
<thead>
<tr>
<th>Region</th>
<th>Month</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>January</td>
<td>$54,654</td>
</tr>
<tr>
<td>North</td>
<td>February</td>
<td>$65,642</td>
</tr>
<tr>
<td>North</td>
<td>March</td>
<td>$56,593</td>
</tr>
<tr>
<td>North</td>
<td>April</td>
<td>$66,599</td>
</tr>
<tr>
<td>North</td>
<td>May</td>
<td>$52,313</td>
</tr>
<tr>
<td>North</td>
<td>June</td>
<td>$63,225</td>
</tr>
<tr>
<td>North</td>
<td>July</td>
<td>$42,563</td>
</tr>
<tr>
<td>North</td>
<td>August</td>
<td>$52,897</td>
</tr>
<tr>
<td>North</td>
<td>September</td>
<td>$64,549</td>
</tr>
<tr>
<td>North</td>
<td>October</td>
<td>$54,454</td>
</tr>
<tr>
<td>North</td>
<td>November</td>
<td>$26,554</td>
</tr>
<tr>
<td>North</td>
<td>December</td>
<td>$75,369</td>
</tr>
<tr>
<td>South</td>
<td>January</td>
<td>$33,225</td>
</tr>
<tr>
<td>South</td>
<td>February</td>
<td>$44,592</td>
</tr>
<tr>
<td>South</td>
<td>March</td>
<td>$55,969</td>
</tr>
<tr>
<td>South</td>
<td>April</td>
<td>$42,598</td>
</tr>
<tr>
<td>South</td>
<td>May</td>
<td>$51,234</td>
</tr>
<tr>
<td>South</td>
<td>June</td>
<td>$54,239</td>
</tr>
<tr>
<td>South</td>
<td>July</td>
<td>$68,715</td>
</tr>
<tr>
<td>South</td>
<td>August</td>
<td>$62,458</td>
</tr>
<tr>
<td>South</td>
<td>September</td>
<td>$52,347</td>
</tr>
<tr>
<td>South</td>
<td>October</td>
<td>$52,147</td>
</tr>
<tr>
<td>South</td>
<td>November</td>
<td>$65,214</td>
</tr>
<tr>
<td>South</td>
<td>December</td>
<td>$75,212</td>
</tr>
</tbody>
</table>
The same grid is displayed after the Seasons groups are created. The month elements have been replaced by the groups.

By default, the Month column is renamed to Month (Group) on the visualization to indicate that a group has been created on the Month attribute. In this example, the grouped attribute has been renamed to Seasons. (This is also referred to as the group’s display name.)

The grouped attribute (Seasons, in this case) replaces the attribute (in this case, Month) on the visualization’s Editor panel. The grouped attribute is added to the Datasets panel, but does not replace the attribute in the
Grouping attribute values in a dashboard. Grouped attributes are displayed on the Datasets panel and the Editor panel with this icon: ❔.

When you create a group, any attribute elements not used in the group are grouped together. By default, these elements are displayed individually, but you can choose to consolidate the remaining elements into a group.

In this example, all of the Month attribute’s elements are used in the Seasons groups, and the element groups replace the attribute elements, so there are
no unused elements. If you delete the Winter group, the months that made up the group are displayed on the grid, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Seasons</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>Spring</td>
<td>$181,137</td>
</tr>
<tr>
<td>North</td>
<td>Summer</td>
<td>$160,009</td>
</tr>
<tr>
<td>North</td>
<td>Fall</td>
<td>$156,377</td>
</tr>
<tr>
<td>North</td>
<td>January</td>
<td>$54,654</td>
</tr>
<tr>
<td>North</td>
<td>February</td>
<td>$65,642</td>
</tr>
<tr>
<td>North</td>
<td>March</td>
<td>$56,593</td>
</tr>
<tr>
<td>South</td>
<td>Spring</td>
<td>$148,071</td>
</tr>
<tr>
<td>South</td>
<td>Summer</td>
<td>$183,520</td>
</tr>
<tr>
<td>South</td>
<td>Fall</td>
<td>$192,573</td>
</tr>
<tr>
<td>South</td>
<td>January</td>
<td>$33,225</td>
</tr>
<tr>
<td>South</td>
<td>February</td>
<td>$44,592</td>
</tr>
<tr>
<td>South</td>
<td>March</td>
<td>$55,969</td>
</tr>
</tbody>
</table>

If you choose to display the unused elements as a consolidated group instead of individual items, a single row is displayed for the group. By default, the consolidated group is named All Others, as shown below, although you can change the name:

<table>
<thead>
<tr>
<th>Region</th>
<th>Seasons</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>Spring</td>
<td>$181,137</td>
</tr>
<tr>
<td>North</td>
<td>Summer</td>
<td>$160,009</td>
</tr>
<tr>
<td>North</td>
<td>Fall</td>
<td>$156,377</td>
</tr>
<tr>
<td>North</td>
<td>All Others</td>
<td>$176,889</td>
</tr>
<tr>
<td>South</td>
<td>Spring</td>
<td>$148,071</td>
</tr>
<tr>
<td>South</td>
<td>Summer</td>
<td>$183,520</td>
</tr>
<tr>
<td>South</td>
<td>Fall</td>
<td>$192,573</td>
</tr>
<tr>
<td>South</td>
<td>All Others</td>
<td>$133,786</td>
</tr>
</tbody>
</table>

For steps to create an element group, see *Replacing attribute elements with an element group, page 358*. For steps to consolidate unused elements into a group, see *Consolidating unused elements into a group, page 364*. For steps to modify a group, see *Renaming, rearranging, and removing groups, page 365*. 
Adding a new element by grouping attribute elements with a calculation: Calculated groups

You can also create groups that are defined with calculations, to create a new element (a new row in a grid, a new node in a Network visualization, and so on). A calculated group does not replace the selected attribute elements, but is added as a separate row. For example, using the grid with Region, Month, and Revenue from the previous example, you can display the averages for each season, as shown below. Notice that the individual months are still displayed, as well as the separate row for each season’s average. (Only the averages for South are shown, not all the months, to save space.)

<table>
<thead>
<tr>
<th>Region</th>
<th>Month</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>Winter Average</td>
<td>$58,963</td>
</tr>
<tr>
<td>North</td>
<td>Spring Average</td>
<td>$60,379</td>
</tr>
<tr>
<td>North</td>
<td>Summer Average</td>
<td>$53,336</td>
</tr>
<tr>
<td>North</td>
<td>Fall Average</td>
<td>$52,126</td>
</tr>
<tr>
<td>North</td>
<td>January</td>
<td>$54,654</td>
</tr>
<tr>
<td>North</td>
<td>February</td>
<td>$65,642</td>
</tr>
<tr>
<td>North</td>
<td>March</td>
<td>$56,593</td>
</tr>
<tr>
<td>North</td>
<td>April</td>
<td>$65,599</td>
</tr>
<tr>
<td>North</td>
<td>May</td>
<td>$52,313</td>
</tr>
<tr>
<td>North</td>
<td>June</td>
<td>$63,225</td>
</tr>
<tr>
<td>North</td>
<td>July</td>
<td>$42,563</td>
</tr>
<tr>
<td>North</td>
<td>August</td>
<td>$52,897</td>
</tr>
<tr>
<td>North</td>
<td>September</td>
<td>$64,549</td>
</tr>
<tr>
<td>North</td>
<td>October</td>
<td>$54,454</td>
</tr>
<tr>
<td>North</td>
<td>November</td>
<td>$26,554</td>
</tr>
<tr>
<td>North</td>
<td>December</td>
<td>$75,369</td>
</tr>
<tr>
<td>South</td>
<td>Winter Average</td>
<td>$44,595</td>
</tr>
<tr>
<td>South</td>
<td>Spring Average</td>
<td>$49,357</td>
</tr>
<tr>
<td>South</td>
<td>Summer Average</td>
<td>$61,173</td>
</tr>
<tr>
<td>South</td>
<td>Fall Average</td>
<td>$64,191</td>
</tr>
</tbody>
</table>
If this was a longer grid, you might not be able to see all the averages at once. You can show the data for all the winter averages, for example, as shown below:

![Show Data](image)

To do this, right-click the group element (Winter Average in the above example) and select **Show Data**. You can select multiple group elements at the same time, such as Winter Average and Spring Average in the example.

When you create a group, any attribute elements not used in the group are grouped together. By default, these elements are displayed individually, but you can choose to consolidate the remaining elements into a group.

Because a calculated group does not replace the attribute elements that the group contains, all the elements are considered unused. In the grid above, although the groups contain all the month elements, the months are still considered unused by the groups. If you choose to consolidate the unused elements into a group, the grid would look like the following:

![Consolidated Group](image)
By default, the consolidated group is named All Others, but you can change the name.

For steps to create a calculated group, see Replacing attribute elements with an element group, page 358. For steps to consolidate unused elements into a group, see Consolidating unused elements into a group, page 364. For steps to modify a group, see Renaming, rearranging, and removing groups, page 365.

**How groups are subtotaled**

When subtotals are calculated for a visualization that contains groups:

- An element group is included in subtotals, because the element group replaces attribute elements on the visualization.

- A calculated group is not included in subtotals, because the calculated group is added to the visualization, without replacing attribute elements. If the calculated group was included, the attribute elements in the group would be added to the subtotals twice.

Any elements that are not included in a group, whether it is an element group or a calculated group, are included in subtotals.

For example, three element groups are created for the Month attribute, to group the months into seasons. January, February, and March are not included in the groups. When the visualization is subtotaled by region, the
revenue for the groups and for the unused attribute elements are included in the totals, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Seasons</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>North</td>
<td>Spring</td>
<td>$181,137</td>
</tr>
<tr>
<td>North</td>
<td>Summer</td>
<td>$160,009</td>
</tr>
<tr>
<td>North</td>
<td>Fall</td>
<td>$156,377</td>
</tr>
<tr>
<td>North</td>
<td>January</td>
<td>$54,654</td>
</tr>
<tr>
<td>North</td>
<td>February</td>
<td>$65,642</td>
</tr>
<tr>
<td>North</td>
<td>March</td>
<td>$56,593</td>
</tr>
<tr>
<td>North</td>
<td>Total</td>
<td>$674,412</td>
</tr>
<tr>
<td>South</td>
<td>Spring</td>
<td>$148,071</td>
</tr>
<tr>
<td>South</td>
<td>Summer</td>
<td>$183,520</td>
</tr>
<tr>
<td>South</td>
<td>Fall</td>
<td>$192,573</td>
</tr>
<tr>
<td>South</td>
<td>January</td>
<td>$33,225</td>
</tr>
<tr>
<td>South</td>
<td>February</td>
<td>$44,592</td>
</tr>
<tr>
<td>South</td>
<td>March</td>
<td>$55,969</td>
</tr>
<tr>
<td>South</td>
<td>Total</td>
<td>$657,950</td>
</tr>
</tbody>
</table>

In the following example, three calculated groups are created for the Month attribute, to return the average revenue for each season. Because these are calculated groups, the groups are added to the visualization, and do not replace the attribute elements. The Spring Average group is the average of the April, May, and June revenue values. Notice that the total revenue for North is the same on this visualization as on the previous visualization, even though this visualization contains three extra rows for the groups. The
calculated groups are not included in the subtotal. All of the month elements are included in the subtotal, whether or not they are used in the groups.

![Table showing regional revenue data]

**Related topics**

- *Replacing attribute elements with an element group, page 358*
- *Grouping attribute elements with a calculation to create a new element, page 362*
- *Consolidating unused elements into a group, page 364*
- *Renaming, rearranging, and removing groups, page 365*

**Replacing attribute elements with an element group**

You can define a group by selecting attribute elements from a visualization, to combine multiple elements into one. In a Grid visualization, an element group combines rows of data into one row; in a bar graph, an element group combines multiple bars into one bar riser; in a Network visualization, an element group combines multiple nodes into one node; and so on. The selected elements are no longer displayed on the visualization.
For example, if your Graph visualization displays revenue data from each month in separate bar risers, you can group the months into seasons. Combine January, February, and March into a group named Winter; group April, May, and June into Spring; and so on. Bar risers for each month are no longer displayed; the visualization contains bar risers for the seasons instead.

For a more detailed example with sample images, see Grouping attribute values in a dashboard, page 349.

You can create multiple groups on the same attribute. If the Graph visualization also contains regions, you can create separate groups for the northern regions, southern regions, and central regions. You can create groups on different attributes, but each group can contain elements from only one attribute.

To define a single group, you can select attribute elements on a visualization and quickly create the group. For steps, see To quickly define a single group of attributes, page 359.

To define multiple groups at the same time, you can select an attribute on a visualization, and select the elements for each group using the Group Editor. For steps, see To define multiple attribute groups at the same time, page 360.

Once you have defined a group, you can change which elements are used in the group, rename the group, rename the grouped attribute, or delete the group. Once you have defined multiple groups, you can rearrange the order of the groups and choose whether to display elements not in the group as individual elements or a single consolidated group. For steps, see Renaming, rearranging, and removing groups, page 365.

Prerequisite

- The steps below assume that you have already created the visualization to add the group to. For steps, see Displaying a visual representation of your data: Visualizations, page 179.

To quickly define a single group of attributes

1. From the File menu, select Open. Navigate to and select the dashboard to modify.

2. Click the visualization to add the group to.
3 In the visualization, select each attribute element to add to the group.

4 Right-click the selected elements and select Group. The New Group dialog box opens.
   • If you point to Group and a Base On list opens, you have selected elements from multiple attributes (for example, by using a lasso on a Heat Map visualization). A group can contain elements from a single attribute. Select the attribute to group from the list. The New Group dialog box opens.

5 In the Name field, type a name for the group.

6 Click Save. The group is created and displayed in the visualization, replacing the attribute elements that you selected.

7 By default, the grouped attribute is renamed AttributeName (Group), where AttributeName is the attribute that you selected elements from. You can rename the grouped attribute by right-clicking it in the Editor panel, selecting Rename, and typing the new name.

You can continue to create groups by repeating these steps, if you want to group more elements in the attribute. Any attribute elements not used in the group are still displayed on the visualization. You can display the unused attribute elements as a group, by consolidating them. For steps, see Consolidating unused elements into a group, page 364.

---

To define multiple attribute groups at the same time

1 From the File menu, select Open. Navigate to and select the dashboard to modify.

2 Click the visualization to add the groups to.

3 In the visualization’s Editor panel, right-click the attribute to group and select Create Groups. The Group Editor opens.
   • If the Editor panel is not displayed, from the View menu, ensure that Editor Panel is selected. If the Editor panel is hidden behind another panel, click the Editor icon to display the Editor panel.

4 By default, the grouped attribute is renamed AttributeName (Group), where AttributeName is the selected attribute. To rename it, in the Attribute Name field, type a name for the group.
To create a group

5 In the field under Group, type a name for the new group. This name is displayed on the visualization.

6 Select the attribute elements to include in the group. From the Available list, double-click each attribute element to include.
   • To search for a specific attribute element, type its name in the search field.
   • To remove all attribute elements from the selected list, click Clear All.

7 Click the Apply icon to apply your changes. The new group is created and added to the list of groups.

8 To add another group, click the Add a Group, then repeat the previous steps, beginning at To create a group, page 361.

To save the groups

9 After you have added all the groups that you need, click Save. The groups are created and displayed in the visualization, replacing the attribute elements that you selected to create the groups.

Any attribute elements not used in the group are still displayed on the visualization. You can display the unused attribute elements as a group, by consolidating them. For steps, see Consolidating unused elements into a group, page 364. You can also modify the groups to rearrange the order that the groups are displayed, rename the group, delete the group, and so on. For steps, see Renaming, rearranging, and removing groups, page 365.

Related topics

• Grouping attribute values in a dashboard, page 349
• Consolidating unused elements into a group, page 364
• Renaming, rearranging, and removing groups, page 365
**Grouping attribute elements with a calculation to create a new element**

You can define a group by combining attribute elements with a calculation. A calculated group creates a new element; it does not replace the selected elements. In a Grid visualization, a calculated group adds a row of data; in a bar graph, it creates a new bar risers; in a Network visualization, it adds a node; and so on.

For example, your Grid visualization displays monthly revenue by region. You can select all the months and choose the calculation as Highest. This displays a new row in the Grid visualization with the highest monthly revenue in each region. The rows for each month are still displayed in the visualization.

For a more detailed example with sample images, see *Grouping attribute values in a dashboard, page 349.*

You can create multiple groups on the same attribute. For example, you can add a Lowest Revenue group, an Average Revenue group, subtract January’s revenue from February’s, subtract February’s revenue from March’s, and so on. Because the calculated group does not replace attribute elements, you can reuse attribute elements in these groups.

The available calculations are described below.

<table>
<thead>
<tr>
<th>If You Select...</th>
<th>The Available Calculations are...</th>
</tr>
</thead>
<tbody>
<tr>
<td>One element</td>
<td>Absolute</td>
</tr>
<tr>
<td>Two elements</td>
<td>• Add</td>
</tr>
<tr>
<td></td>
<td>• Average</td>
</tr>
<tr>
<td></td>
<td>• Greatest</td>
</tr>
<tr>
<td></td>
<td>• Least</td>
</tr>
<tr>
<td></td>
<td>• Element1 - Element2</td>
</tr>
<tr>
<td></td>
<td>• Element2 - Element1</td>
</tr>
<tr>
<td></td>
<td>• Element1/Element2</td>
</tr>
<tr>
<td></td>
<td>• Element2/Element1</td>
</tr>
<tr>
<td>Three or more elements</td>
<td>• Add</td>
</tr>
<tr>
<td></td>
<td>• Average</td>
</tr>
<tr>
<td></td>
<td>• Greatest</td>
</tr>
<tr>
<td></td>
<td>• Least</td>
</tr>
</tbody>
</table>
**Prerequisite**

- The steps below assume that you have already created the visualization to add the group to. For steps, see *Displaying a visual representation of your data: Visualizations, page 179.*

---

**To define a group with a calculation**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization to add the group to.

3. In the visualization, select each attribute element to use in the group.

4. Right-click the selected elements and point to **Calculation**, then select the type of calculation to create the derived element based on, such as **Add** or **Greatest**. Some calculations, such as **Element1-Element2**, are available if you have selected exactly two attribute elements. The New Calculation dialog box opens.

   - If you point to Calculation and a Base On list is displayed, you have selected elements from multiple attributes (for example, by using a lasso on a Heat Map visualization). A group can contain elements from a single attribute. Select the attribute to group from the **Base On** list, select the calculation, and click **OK**. The New Calculation dialog box opens.

5. In the **Name** field, type a name for the group.

6. Click **Save**. The group is created and added to the visualization.

7. By default, the grouped attribute is renamed **AttributeName (Group)**, where **AttributeName** is the attribute that you selected elements from. You can rename the grouped attribute by right-clicking it in the Editor panel, selecting **Rename**, and typing the new name.

All elements of the selected attribute are still displayed on the visualization, regardless of whether they are included in the calculated group. You can display the attribute elements as a group, by consolidating them. (The calculated group will not be included in the consolidated group and will still display separately.) For steps, see *Consolidating unused elements into a group, page 364.* You can also modify the groups to rearrange the order that the groups are displayed, rename the group, delete the group, and so on. For steps, see *Renaming, rearranging, and removing groups, page 365.*
Related topic

- *Grouping attribute values in a dashboard, page 349*

**Consolidating unused elements into a group**

When you create a group, any attribute elements not used in the group are grouped together. By default, these elements are displayed individually, but you can choose to consolidate the remaining elements into a group. The default name of the consolidated group is All Others.

- In an element group, the group replaces the attribute elements that make up the group. Any remaining elements are considered unused and placed in the All Others group.

- In a calculated group, the group does not replace the attribute elements that make up the group. All elements of the attribute used in the calculated group are considered unused and placed in the All Others group.

For examples of the consolidated group, see *Replacing attribute elements with an element group, page 358* and *Grouping attribute elements with a calculation to create a new element, page 362*.

**Prerequisite**

- The steps below assume you have already created at least one group. For steps, see *Replacing attribute elements with an element group, page 358* or *Grouping attribute elements with a calculation to create a new element, page 362*.

**To consolidate unused elements into a group**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization that contains the group.

3. In the visualization’s Editor panel, right-click the grouped attribute and select **Edit Groups**. The Group Editor opens.
From the **Display All Other Elements As** drop-down list, select **Consolidated Group**.

By default, the consolidated group is named All Others. To change the name, click the **All Others** group in the list of groups, and type the new name.

Click **Save**. The consolidated group is displayed on the visualization.

**Related topics**

- Grouping attribute values in a dashboard, page 349
- Replacing attribute elements with an element group, page 358
- Grouping attribute elements with a calculation to create a new element, page 362

**Renaming, rearranging, and removing groups**

After you create a group, you can modify the group:

- **To rename a group**, page 365
- **To rename a grouped attribute**, page 366 (the grouped attribute is the attribute whose elements have been added to the group)
- **To rearrange the display order of groups**, page 366
- **To change the attribute elements in an element group**, page 367
- **To change the calculation in a calculated group**, page 367
- **To consolidate unused elements into a group**, page 364
- **To delete a group**, page 366

**To rename a group**

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Click the visualization that contains the group.
3 On the visualization, right-click the group and select **Rename**.

4 Type a new name for the group, then click **Save** to apply your changes.

---

**To rename a grouped attribute**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 Click the visualization that contains the grouped attribute.

3 In the Editor panel of the visualization, right-click the grouped attribute, select **Rename**, and type the new name.

---

**To rearrange the display order of groups**

Even if an attribute contains only one group, you can rearrange the display order, because the unused attribute elements are considered a group. You can display the group above or below the unused elements.

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 Click the visualization that contains the group.

3 In the Editor panel of the visualization, right-click the grouped attribute, and select **Edit Groups**. The Group Editor opens.

4 To rearrange the order in which a group is displayed in the visualization, drag and drop the group to its new position in the list of groups.

5 Click **Save**.

---

**To delete a group**

1 From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2 Click the visualization that contains the group.

3 In the visualization, right-click the group, and select one of the following:
• **Ungroup** (displayed for an element group). The group is deleted, and each element within the group is displayed as a separate item in the visualization.

• **Remove Calculation** (displayed for a calculated group). The group is deleted.

**To change the attribute elements in an element group**

1. From the File menu, select Open. Navigate to and select the dashboard to modify.
2. Click the visualization that contains the group.
3. In the visualization, right-click the group, and select Edit Group. The Group Editor opens.
4. To add elements to the group, from the Available list, double-click each attribute element to include.
5. To remove elements from the group, from the Selected list, double-click each attribute element to remove.
   • To remove all attribute elements from the selected list, click Clear All.
6. Click the Apply icon to apply your changes to the group.
7. Click Save to return to the visualization.

**To change the calculation in a calculated group**

1. From the File menu, select Open. Navigate to and select the dashboard to modify.
2. Click the visualization that contains the group.
3. In the visualization, right-click the group, point to Edit Calculation, and select the calculation to apply to the attribute elements.

**Related topics**

• *Grouping attribute values in a dashboard, page 349*
• Replacing attribute elements with an element group, page 358
• Grouping attribute elements with a calculation to create a new element, page 362
LIMITING THE DATA DISPLAYED IN A DASHBOARD: FILTERS, SHEETS, AND PAGES

Introduction

A dashboard is an interactive display that you can create to showcase and explore business data. You can add visual representations of the data (called visualizations) to the dashboard to make your data easier to interpret, create new metrics and attributes, and add text labels and images.

If you have a lot of data in your dashboard or want to focus on a specific set of data, you can filter the data, to limit and customize what is displayed on the dashboard. For example, the graphs shown below are filtered to display only the South, Southeast, and Southwest customer regions. The filter, shown on
the left, displays the available regions and allows you to change what is displayed on the graphs.

A filter can limit the data in a specific sheet, a visualization, or another filter. A sheet is a layer of data that helps provide a logical flow to your dashboard. The dashboard above contains multiple sheets, shown as tabs at the bottom of the dashboard. The Profit and Revenue Data sheet is currently displayed. The Customer Region filter is applied to all the data in that sheet.

A dashboard can contain multiple sheets, each filtered in a specific way. You can also create layers of data that are filtered in the same way, by creating pages on a sheet.

For steps to create sheets and panels, see *Layering and organizing data for filtering, page 372*. 
Use the table below as a reference when choosing how to create a filter, to help you display the data that you want to analyze in your dashboard.

<table>
<thead>
<tr>
<th>To Filter…</th>
<th>Do This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>The data in visualizations and text on the dashboard in the same way</td>
<td>Create a sheet (tab) containing all the objects, and filter the sheet. For steps, see Adding, modifying, and deleting sheets, page 374 and Creating filters for a sheet of data, page 378.</td>
</tr>
<tr>
<td>The data in visualizations and text on the dashboard in different ways</td>
<td>Create a separate sheet (tab) for each set of objects to filter in the same way, then filter each sheet. For steps, see Adding, modifying, and deleting sheets, page 374 and Creating filters for a sheet of data, page 378.</td>
</tr>
<tr>
<td>The data in a specific visualization</td>
<td>Create a filter for the visualization. For steps, see Creating a filter for the data on a visualization, page 402. <strong>Note:</strong> The visualization is still filtered by any filters applied to the sheet.</td>
</tr>
<tr>
<td>The attribute values displayed in a filter that targets a sheet</td>
<td>Create the attribute filters for the sheet. Do one of the following: • Allow all attribute filters to filter the attribute filters displayed below them in the Filter panel. • For a specific attribute filter, select the attribute filters to filter. For steps, see Filtering the attribute values displayed in an filter for a sheet, page 395.</td>
</tr>
<tr>
<td>The objects displayed in a filter that targets a visualization</td>
<td>Create the first filter, that targets the visualization. Create another filter, that targets the visualization filter. For steps, see Filtering the objects displayed in a filter for a visualization, page 407.</td>
</tr>
<tr>
<td>The data in one visualization based on the data in another visualization</td>
<td>Create the two visualizations, the source (used as the filter) and the target (what is filtered). Create a filter using the source, to filter the target. For steps, see Using a visualization to filter the data displayed in another visualization, page 413.</td>
</tr>
</tbody>
</table>

For steps to use the filters after you create them, see the following:

- *Filtering data in a sheet, page 453*
- *Filtering data in a visualization, page 460*
- *Selecting data in one visualization to update the data displayed in another, page 464*
Layering and organizing data for filtering

You can create dashboards with multiple layers of organization to view and filter your data in more intuitive and useful ways. The dashboard shown below contains four sheets, each on its own tab. The Heat Map and Bubble sheet contains two pages, with the Heat Map page displayed.

The Heat Map page is filtered to display only the Northeast and Northwest customer geographical regions. When you switch to the Bubble Chart page,
note that the same filter is applied. All pages in a sheet are filtered in the same way.

When you switch to the Area Chart sheet, note that all the customer regions are included in the visualization. In addition, another filter has been added, for customer state.

Both sheets and pages can contain multiple visualizations and other dashboard objects such as text and images.
You can:

- Create layers of data that are filtered in different ways, by creating a separate sheet (tab) for each layer to be filtered. Each sheet has a separate set of filters. Each sheet is displayed on a separate tab in the dashboard; switch between sheets by clicking the tab of the sheet to display. For steps to create sheets, see *Adding, modifying, and deleting sheets, page 374*.

- Create layers of data that are filtered in the same way, by creating pages (or panels) on a sheet. Each sheet in a dashboard can contain multiple pages. When a sheet contains multiple pages, a row of circles or dots, each representing a page, is displayed at the bottom of the sheet. The current page is marked with a blue dot. To change the page that is displayed, click a different dot. For steps to create pages, see *Adding, modifying, and deleting pages, page 376*.

You can also create a new sheet or page when you copy or move a visualization. For steps, see *Duplicating visualizations, page 247* and *Moving visualizations, page 248*.

**Related topics**

- *Adding, modifying, and deleting sheets, page 374*
- *Adding, modifying, and deleting pages, page 376*
- *Creating filters for a sheet of data, page 378*
- *Filtering data in a dashboard, page 451*
- *Creating a dashboard, page 146*

**Adding, modifying, and deleting sheets**

You can create layers of data in a dashboard using sheets, to filter the data on each sheet independently of data on another sheet. For steps to create a filter on a sheet, see *Creating filters for a sheet of data, page 378*; for steps to filter the data on a sheet, see *Filtering data in a dashboard, page 451*.

You can add visualizations and other objects such as text to each sheet separately, without affecting the content on other sheets in the dashboard. You can create layers of data on the sheet, by creating pages. All pages on a single sheet are filtered in the same way. For steps to create a page, see *Adding, modifying, and deleting pages, page 376*. For examples of sheets and pages, see *Layering and organizing data for filtering, page 372*. 
To add a sheet

1. Open the dashboard to modify, by selecting **Open** from the **File** menu.
2. Click the **Add Sheet** tab. A new, empty sheet is added to the dashboard and displayed.

Now that you added the sheet, you can add objects and filter the sheet. For steps, see:
- Adding, modifying, and deleting pages, page 376
- Displaying a visual representation of your data: Visualizations, page 179
- Adding Text, Images, and Web Content, page 305
- Creating New Attributes, Metrics, and Groups, page 317
- Creating filters for a sheet of data, page 378

To rename, move, duplicate, or delete a sheet

1. Click the sheet’s tab, to open the sheet.
2. Click the arrow icon on the tab, and select one of the following:
   - To rename the sheet, select **Rename**, and then type a new name for the tab in the field. Press ENTER. The sheet is renamed.
   - To duplicate the sheet, select **Duplicate**. The sheet is duplicated and added to the right of the current sheet in the dashboard.
   - To delete the sheet, select **Delete**. The sheet is removed from the dashboard.
3. To move the sheet, click and drag the tab of the sheet to its new location in the list of tabs.

Related topics
- Adding, modifying, and deleting pages, page 376
Adding, modifying, and deleting pages

You can use pages (also referred to as panels) to create layers on a single dashboard sheet. The data on all the pages on a sheet is filtered in the same way.

You can use pages to separate objects that you want to display separately, but you want to filter the same way. For example, you can use pages to view the same data in different types of visualizations, such as regional sales data in a pie chart and in a line chart. The pie chart displays the contribution of selected geographical regions to the total, while the line chart shows the rate of increase of revenue for the selected regions. If you want to view the charts together, place them on the same page. To display each chart separately, place each chart on its own page. When you filter data in a sheet in the dashboard, the data is filtered across all pages on the sheet. For steps to filter data, see Filtering data in a dashboard, page 451.

When a sheet contains multiple pages, a row of circles or dots, each representing a page, is displayed at the bottom of the sheet. The current page is marked with a blue dot. To change the page that is displayed, click a different dot. The dashboard shown below contains four pages on Sheet 1, with Panel 3 displayed.

![Dashboard with multiple pages]

You can add visualizations and other objects such as text to each page separately, without affecting the content on other pages in the dashboard.

To add a page

1. Open the dashboard to modify, by selecting Open from the File menu.
2. Click the tab of the sheet to add a page to.
3 Hover the cursor over the sheet’s tab, then click the arrow icon in the tab.

4 Select **New Panel**. A new, empty page is added to the dashboard.

Now that you added the page, you can add objects to the page. For steps, see:

- *Displaying a visual representation of your data: Visualizations, page 179*
- *Adding Text, Images, and Web Content, page 305*
- *Creating New Attributes, Metrics, and Groups, page 317*

**To rename, move, duplicate, or delete a page**

1 Click the tab of the sheet that contains the page to update.

2 Display the page to update, by clicking its dot at the bottom of the sheet.

3 Click the arrow icon to the right of the page name, and select one of the following:

  - To rename the page, select **Rename**, and then type a new name for the page in the field. Press ENTER. The page is renamed.
  
  - To duplicate the page, select **Duplicate**. The new page is added after all the other pages in the sheet.
  
  - To delete a page, select **Delete**. The page is deleted from the dashboard.
  
  - To move the page one spot to the left in the list of pages, select **Move Left**.
  
  - To move the page one spot to the right in the list of pages, select **Move Right**.

**Related topics**

- *Adding, modifying, and deleting sheets, page 374*
- *Layering and organizing data for filtering, page 372*
- *Creating filters for a sheet of data, page 378*
Creating filters for a sheet of data

A sheet is a layer of data in a dashboard. The data on each sheet is filtered independently of the data on other sheets in the dashboard.

- If you want to filter the data in objects in the same way, place all the objects on a single sheet (or tab) and create a filter on the sheet.
- If you want to filter data in objects in different ways, create a separate sheet for each set of objects to filter in the same way. Create a filter on each sheet.

For example, a dashboard contains the following sets of data:

- Your revenue data broken out by geographical region and year, shown as a grid
- Your revenue data broken out by geographical region and year, displayed as a heat map
- Your revenue data broken out by geographical region and category, displayed as a bar graph

You want to select the regions to display in the grid and the heat map, but you want to select the range of revenue values to display in the bar graph. Create two sheets:

- Sheet 1 contains the grid and heat map. Create the region filter on this sheet.
- Sheet 2 contains the bar graph. Create the revenue filter on this sheet.

A filter on a sheet filters the data in all the visualizations and also in any dataset objects displayed in text fields on the sheet.

For example, the following sheet contains text and a graph. The text uses the customer region object combined with the static text “Revenue Data for”. As you select different regions to display in the sheet, the graph and the text change. In the example below, you selected Mid-Atlantic in the filter.
Revenue data for the states in the Mid-Atlantic region is displayed in the graph, and Mid-Atlantic is displayed in the text field.

For another example of filtered sheets, see *Layering and organizing data for filtering, page 372*.

You can filter data based on attribute values, metric values, or metric rank. For steps, see the following:

- *Creating an attribute filter for a sheet, page 381*
- *Creating a metric filter for a sheet, page 384*

A metric filter calculates the metric for the attributes in the sheet’s visualizations. If a grid contains geographical region and state data, the metrics are calculated for each state, not each region. You create a metric filter to display the top five profit values, and the profit values are calculated for each state. If you want to display the top five most profitable regions, create a metric filter that ranks the values of an attribute. For steps, see *Creating a metric filter that ranks the values of an attribute, page 389*. 
The Filter panel

A filter that targets the data in a sheet is displayed on the Filter panel, shown below:

You can change how filters are displayed in the Filter panel. For example, you can show or hide the Filter panel, collapse or expand all the filters in the panel, collapse or expand an individual filter, and move the Filter panel to a different location on the dashboard. For steps, see *Changing how filters are displayed on the Filter panel*, page 557.

To remove a filter from the sheet, hover the cursor over the name of the filter in the Filter panel, click the arrow icon displayed to the right of the name, and select **Remove**.

By default, as you make choices in the Filter panel, the data in the sheet is updated automatically. You can change this behavior so that you control when the update occurs, by disabling automatic apply. When automatic apply is disabled, you must click **Apply** in the Filter panel to update the sheet with the filter choices. Disabling automatic apply can be helpful when your sheet contains large amounts of data, so that the data is not updated for each change in a filter. Instead, the data can be updated after all the changes have been made. For steps, see *Applying filter changes individually or all at once*, page 394.
Creating an attribute filter for a sheet

You can select attribute values to filter the data that is displayed on a sheet, by creating an attribute filter. A filter on a sheet filters the data in all the visualizations and also in any dataset objects displayed in text fields on the sheet. (A sheet is a layer of data, filtered independently of other sheets on the dashboard; for background information, see Adding, modifying, and deleting sheets, page 374.)

For example, a sheet contains a grid that displays revenue and profit data by geographical region and employee. Create a filter on region. In the Filter panel, you can then select the region or regions to display. In the sample
below, the South, Southeast, and Southwest regions are selected in the Filter panel, so only employees in those regions are displayed in the grid.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>South</td>
<td>Corner</td>
<td>$1,650,742</td>
<td>$253,472</td>
</tr>
<tr>
<td>South</td>
<td>Nelson</td>
<td>$1,654,297</td>
<td>$251,519</td>
</tr>
<tr>
<td>South</td>
<td>Pierce</td>
<td>$2,084,241</td>
<td>$301,966</td>
</tr>
<tr>
<td>Southeast</td>
<td>Benner</td>
<td>$520,737</td>
<td>$79,664</td>
</tr>
<tr>
<td>Southeast</td>
<td>Lynch</td>
<td>$592,471</td>
<td>$88,639</td>
</tr>
<tr>
<td>Southeast</td>
<td>McClain</td>
<td>$531,371</td>
<td>$78,299</td>
</tr>
<tr>
<td>Southeast</td>
<td>Strome</td>
<td>$595,372</td>
<td>$99,074</td>
</tr>
<tr>
<td>Southwest</td>
<td>Bates</td>
<td>$1,068,907</td>
<td>$163,911</td>
</tr>
<tr>
<td>Southwest</td>
<td>Bell</td>
<td>$1,049,481</td>
<td>$157,039</td>
</tr>
<tr>
<td>Southwest</td>
<td>Hurt</td>
<td>$731,413</td>
<td>$111,779</td>
</tr>
<tr>
<td>Southwest</td>
<td>Johnson</td>
<td>$445,052</td>
<td>$66,831</td>
</tr>
<tr>
<td>Southwest</td>
<td>Schafer</td>
<td>$408,280</td>
<td>$61,772</td>
</tr>
</tbody>
</table>

The filter applies to the sheet that it was created on, and any pages that the sheet contains. The filter is not applied to any other sheets that the dashboard contains. If the sheet in the example above contained other visualizations, the attribute filter would filter those visualizations as well. For an example of a filter applied to multiple visualizations in the same sheet, see Adding, modifying, and deleting sheets, page 374.

To create an attribute filter

1. Open the dashboard to modify, by selecting Open from the File menu.
2. Click the tab of the sheet to filter.
3. From the Datasets panel, click the attribute to use to filter data, and drag it onto the Filter panel. You can place the attribute before or after any filters already displayed in the panel. The filter is added to the Filter panel and is automatically named for the selected attribute.

You can select and add more than one attribute to the Filter panel at a time. Press CTRL and click each attribute to select.

- If the Datasets panel is not displayed, from the View menu, select Dataset panel.
• If the Filter panel is not displayed, from the **View** menu, select **Filter Panel**. If the Filter panel is hidden behind another panel, click the **Filter** icon to display the Filter panel.

4 Select the style to use to display the filter. Hover the cursor over the name of the filter that you just added, click the arrow icon, point to **Display Style**, and select one of the following:

• **Check Boxes**: This style allows multiple selections.

• **Search Box**: This style is useful for a long list of items.

• **Slider**: This style is effective for browsing data in a graph.

• **Radio Buttons**: This style allows only a single selection.

• **Drop-down**: This style allows only a single selection.

• **Calendar**: This style is automatically selected for Date/Time values. It displays From and To boxes, to enter the date range.

5 You can include or exclude data using the attribute values selected in the filter. Hover the cursor over the name of the filter that you just added, click the arrow icon, and select one of the following:

• To display data only for selected values, select **Include** (default).

• To display data for all values except the values that are selected, select **Exclude**.

6 If the Filter panel contains multiple attribute filters, you can determine whether making selections in the filter affects the items displayed for other attribute filters in the Filter panel. For a more detailed description of how filtering attribute filters works, including examples and steps, see *Filtering the attribute values displayed in an filter for a sheet, page 395.*

7 By default, as you make choices in the Filter panel, data is updated automatically in the sheet. You can change this behavior so that you control when the update occurs, by disabling automatic apply. When automatic apply is disabled, you must click **Apply** in the Filter panel to update the sheet with the filter choices. For steps, see *Applying filter changes individually or all at once, page 394.*

**Related topics**

• *Creating filters for a sheet of data, page 378*

• *Adding, modifying, and deleting sheets, page 374*
Creating a metric filter for a sheet

You can use a metric to filter the data that is displayed on a sheet, by creating a metric filter. A filter on a sheet filters the data in all the visualizations and also in any dataset objects displayed in text fields on the sheet. (A sheet is a layer of data, filtered independently of other sheets on the dashboard; for background information, see Adding, modifying, and deleting sheets, page 374.)

You can filter data on a sheet by:

• Specifying a value to compare metric values to.
• Choosing values from a slider to compare metric values to.

For example, a sheet contains a grid that displays revenue and profit data by geographical region and employee. Create a metric filter that compares revenue values to a specific value, and another metric filter that displays the profit values for you to choose from.

• In the Filter panel, for the Revenue filter, you can then choose the operator (in this example, Greater than) and type the value to compare to (in this example, 1,000,000).

• In the Filter panel, for the Profit filter, you can move the endpoints of the slider to choose the range of values to display (in this example, 225,000 to 400,000).
In the grid, only employees with both revenue greater than $1,000,000 and profit between $225,000 and $400,000 are displayed.

You can choose to filter the metric based on:

- The metric values. For example, you can display data only for employees with revenue data greater than or equal to $1,000,000, as in the example above. For steps, see *To create a metric filter that filters on metric values, page 386.*

- The metric’s ranking. For example, you can display data only for the top five most profitable employees, as shown below. For steps, see *To create a metric filter that filters on metric rank, page 387.*

The metric filter applies to the sheet that it was created on, and any pages that the sheet contains. The filter is not applied to any other sheets that the dashboard contains. If the sheet in the example above contained other visualizations, the metric filter would filter those visualizations as well. For an example of a filter applied to multiple visualizations in the same sheet, see *Adding, modifying, and deleting sheets, page 374.*

A metric filter calculates the metric for the attributes in the sheet’s visualizations. The grid used in the examples above contains geographical region and employee data, so the metrics are calculated for each employee, not each region. The metric filter shown above displays the top five profit
values, calculated by employee. If you want to display the top five most profitable regions, create a metric filter that ranks the values of an attribute. For steps, see *Creating a metric filter that ranks the values of an attribute, page 389.*

---

**To create a metric filter that filters on metric values**

1. Open the dashboard to modify, by selecting **Open** from the **File** menu.

2. Click the tab of the sheet to filter.

3. From the **Datasets** panel, click the metric to use to filter data, and drag it onto the **Filter** panel. You can place the metric before or after any filters already displayed in the panel. The filter is added to the Filter panel and is automatically named for the selected metric.

   - If the Datasets panel is not displayed, from the **View** menu, select **Dataset Panel**.

   - If the Filter panel is not displayed, from the **View** menu, select **Filter Panel**. If the Filter panel is hidden behind another panel, click the **Filter** icon to display the Filter panel.

4. In the Filter panel, hover the cursor over the name of the filter that you just added, click the arrow icon, and select **Qualify on Value**. For example, you can display data only for stores with profit values greater than or equal to $100,000.

5. Select one of the following:

   - To filter data by comparing metric values to a number that you specify, complete the following steps. For example, you can display data only for stores with profits greater than or equal to $100,000.

     a. On the Filter panel, hover the cursor over the name of the filter that you just added, then click the arrow icon. Point to **Display Style** and select **Qualification**.

     b. Click **Greater than or equal to**. From the drop-down list, select the operator to use to compare data, such as **Less Than** or **Equals**. When you use the filter, you can change the operator to display a different set of data in the sheet.

     c. In the field, type the value to use to filter data, then press ENTER. When you use the filter, you can change the value to display a different set of data in the sheet.
To filter data by choosing values on a slider, complete the following steps. For example, you can display data for stores with profits between $50,000 and $100,000.

a On the Filter panel, hover the cursor over the name of the filter that you just added, then click the arrow icon. Point to Display Style and select Slider.

b Click and drag the endpoints of the slider to cover the range of values for which you want to filter data. When you use the filter, you can change the value range to display a different set of data in the sheet.

c You can choose to include or exclude data using the values selected in the slider. Hover the cursor over the filter name, click the arrow icon, and select one of the following:

- To display data for the metric values selected in the slider, select Include.
- To display data for all metric values except the values selected in the slider, select Exclude.

6 By default, as you make choices in the Filter panel, data is updated automatically in the sheet. You can change this behavior so that you control when the update occurs, by disabling automatic apply. When automatic apply is disabled, you click Apply in the Filter panel to update the sheet with the filter changes. For steps, see Applying filter changes individually or all at once, page 394.

---

To create a metric filter that filters on metric rank

1 Open the dashboard to modify, by selecting Open from the File menu.

2 Click the tab of the sheet to filter.

3 From the Datasets panel, click the metric to use to filter data, and drag it onto the Filter panel. You can place the metric before or after any filters already displayed in the panel. The filter is added to the Filter panel and is automatically named for the selected metric.

- If the Datasets panel is not displayed, from the View menu, select Dataset Panel.
• If the Filter panel is not displayed, from the View menu, select Filter Panel. If the Filter panel is hidden behind another panel, click the Filter icon to display the Filter panel.

4 In the Filter panel, hover the cursor over the name of the filter that you just added, click the arrow icon, and select Qualify on Rank.

5 From the drop-down list at the top of the filter, select one of the following:

• To assign a numeric rank to the metric values, where a rank of one is assigned to the highest metric value, and then filter by rank, select Highest. For example, you can display data for the ten employees with the longest tenure in years.

• To assign a numeric rank to the metric values, where a rank of one is assigned to the lowest metric value, and then filter by rank, select Lowest. For example, you can display data for the ten stores with the lowest costs.

• To filter by the top n% of metric values, select Highest %. For example, if eight items are displayed in a visualization, Rank % Highest = 25 displays the top two items.

• To filter by the bottom n% of metric values, select Lowest %. For example, if eight items are displayed in a visualization, Rank % Lowest = 25 displays the bottom two items.

6 Select one of the following:

• To filter data by comparing metric rank to a number that you specify, complete the following steps. For example, you can display data for the top 10 most profitable stores.
  a In the Filter panel, hover the cursor over the name of the filter that you just added, then click the arrow icon. Point to Display Style and select Qualification.
  b In the field, type the rank value to use to filter data, then press ENTER. When you use the filter, you can change the rank value to display a different set of data in the sheet.

• To filter data by choosing rank values on a slider, complete the following steps. For example, you can display data for stores with a profit rank between 10 and 25.
  a In the Filter panel, hover the cursor over the name of the filter that you just added, then click the arrow icon. Point to Display Style and select Slider.
b Click and drag the endpoints of the slider to cover the range of values for which you want to filter data. When you use the filter, you can change the range to display a different set of data in the sheet.

c You can choose to include or exclude data using the values selected in the slider. Hover the cursor over the filter name, click the arrow icon, and select one of the following:

- To display data for the metric values selected in the slider, select **Include**.
- To display data for all metric values except the values selected in the slider, select **Exclude**.

7 By default, as you make choices in the Filter panel, data is updated automatically in the sheet. You can change this behavior so that you control when the update occurs, by disabling automatic apply. When automatic apply is disabled, you click **Apply** in the Filter panel to update the sheet with the filter choices. For steps, see Applying filter changes individually or all at once, page 394.

**Related topics**

- Creating filters for a sheet of data, page 378
- Adding, modifying, and deleting sheets, page 374
- Filtering data in a sheet, page 453

**Creating a metric filter that ranks the values of an attribute**

When a filter uses a metric, the filter’s metric values are calculated for the attributes displayed on a visualization. You can instead select the attribute to calculate the metric values for.
For example, a sheet contains a grid that displays revenue and profit data by geographical region and state. The values on the grid are calculated for each state, not each region, as shown below:

<table>
<thead>
<tr>
<th>Visualization 1</th>
<th>Customer State</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Region</td>
<td>Arkansas</td>
<td>$261,561</td>
<td>$39,705</td>
</tr>
<tr>
<td>Central Region</td>
<td>Illinois</td>
<td>$2,189,123</td>
<td>$332,079</td>
</tr>
<tr>
<td>Central Region</td>
<td>Indiana</td>
<td>$589,266</td>
<td>$85,479</td>
</tr>
<tr>
<td>Central Region</td>
<td>Iowa</td>
<td>$448,843</td>
<td>$68,455</td>
</tr>
<tr>
<td>Central Region</td>
<td>Kansas</td>
<td>$219,525</td>
<td>$32,164</td>
</tr>
<tr>
<td>Central Region</td>
<td>Michigan</td>
<td>$1,052,462</td>
<td>$161,239</td>
</tr>
<tr>
<td>Central Region</td>
<td>Minnesota</td>
<td>$475,953</td>
<td>$70,886</td>
</tr>
<tr>
<td>Central Region</td>
<td>Missouri</td>
<td>$649,802</td>
<td>$96,885</td>
</tr>
<tr>
<td>Central Region</td>
<td>Nebraska</td>
<td>$140,785</td>
<td>$21,208</td>
</tr>
<tr>
<td>Central Region</td>
<td>North Dakota</td>
<td>$54,476</td>
<td>$8,503</td>
</tr>
<tr>
<td>Central Region</td>
<td>Ohio</td>
<td>$982,907</td>
<td>$148,980</td>
</tr>
<tr>
<td>Central Region</td>
<td>Oklahoma</td>
<td>$272,319</td>
<td>$42,216</td>
</tr>
<tr>
<td>Central Region</td>
<td>Wisconsin</td>
<td>$862,836</td>
<td>$131,308</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Delaware</td>
<td>$60,227</td>
<td>$9,105</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>District of Columbia</td>
<td>$653,702</td>
<td>$97,255</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Maryland</td>
<td>$912,823</td>
<td>$136,419</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>New Jersey</td>
<td>$1,919,528</td>
<td>$293,462</td>
</tr>
</tbody>
</table>

You want to display only the top two profit values, so you create a filter on the Profit metric’s values. The filter calculates the Profit metric values for the same attribute as the grid does, so the top two most profitable states are displayed, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>State</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>New York</td>
<td>$2,835,242</td>
<td>$430,699</td>
</tr>
<tr>
<td>Southwest</td>
<td>California</td>
<td>$3,843,737</td>
<td>$583,884</td>
</tr>
</tbody>
</table>

If you want to display the top two most profitable regions instead, create a top ranking filter, which allows you to specify the attribute to calculate the metric values for. A top ranking filter uses an attribute filter to specify the attribute for the metric calculation. To display the top two most profitable regions, create an attribute filter on region. Create a top rank filter, based on
the region filter, that selects the two most profitable regions for display. The result is shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>State</th>
<th>Revenue</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Arkansas</td>
<td>$261,661</td>
<td>$39,705</td>
</tr>
<tr>
<td>Central</td>
<td>Illinois</td>
<td>$2,189,123</td>
<td>$332,079</td>
</tr>
<tr>
<td>Central</td>
<td>Indiana</td>
<td>$509,266</td>
<td>$85,479</td>
</tr>
<tr>
<td>Central</td>
<td>Iowa</td>
<td>$448,843</td>
<td>$68,455</td>
</tr>
<tr>
<td>Central</td>
<td>Kansas</td>
<td>$219,625</td>
<td>$32,164</td>
</tr>
<tr>
<td>Central</td>
<td>Michigan</td>
<td>$1,052,462</td>
<td>$161,239</td>
</tr>
<tr>
<td>Central</td>
<td>Minnesota</td>
<td>$475,953</td>
<td>$70,886</td>
</tr>
<tr>
<td>Central</td>
<td>Missouri</td>
<td>$649,802</td>
<td>$96,855</td>
</tr>
<tr>
<td>Central</td>
<td>Nebraska</td>
<td>$140,785</td>
<td>$21,208</td>
</tr>
<tr>
<td>Central</td>
<td>North Dakota</td>
<td>$54,476</td>
<td>$8,503</td>
</tr>
<tr>
<td>Central</td>
<td>Ohio</td>
<td>$982,907</td>
<td>$148,980</td>
</tr>
<tr>
<td>Central</td>
<td>Oklahoma</td>
<td>$272,319</td>
<td>$42,216</td>
</tr>
<tr>
<td>Central</td>
<td>Wisconsin</td>
<td>$862,836</td>
<td>$131,308</td>
</tr>
<tr>
<td>Southwest</td>
<td>Arizona</td>
<td>$444,075</td>
<td>$64,675</td>
</tr>
<tr>
<td>Southwest</td>
<td>California</td>
<td>$3,843,737</td>
<td>$583,884</td>
</tr>
<tr>
<td>Southwest</td>
<td>Colorado</td>
<td>$505,886</td>
<td>$76,695</td>
</tr>
<tr>
<td>Southwest</td>
<td>Nevada</td>
<td>$221,427</td>
<td>$34,548</td>
</tr>
<tr>
<td>Southwest</td>
<td>New Mexico</td>
<td>$101,832</td>
<td>$15,576</td>
</tr>
<tr>
<td>Southwest</td>
<td>Texas</td>
<td>$2,198,669</td>
<td>$332,625</td>
</tr>
<tr>
<td>Southwest</td>
<td>Utah</td>
<td>$107,718</td>
<td>$16,280</td>
</tr>
</tbody>
</table>

An attribute filter uses selected attribute values to limit the sheet’s data. For an example, see *Creating an attribute filter for a sheet, page 381*. A sheet is a layer of data, filtered independently of other sheets on the dashboard; for background information, see *Adding, modifying, and deleting sheets, page 374*.

The filter applies to the sheet that it was created on, and any pages that the sheet contains. The filter is not applied to any other sheets that the dashboard contains. If the sheet in the example above contained other visualizations, the filter would filter those visualizations as well. For an example of a filter applied to multiple visualizations in the same sheet, see *Adding, modifying, and deleting sheets, page 374*.

**Prerequisite**

- The dashboard contains the attribute filter to base the metric rank filter on. For steps, see *Creating an attribute filter for a sheet, page 381*. 
To create a metric filter that ranks the values of an attribute

1. Open the dashboard to modify, by selecting **Open** from the **File** menu.

2. Click the tab of the sheet to filter.

3. On the Filter panel, hover the cursor over the name of the attribute filter to base the top ranking filter on, then click the arrow icon. Point to **Top N Rank**, then select the metric to use to rank each attribute value. Your top rank filter is added to the Filter panel and is automatically named **Metric by Attribute**, where **Metric** is the name of the metric used to rank the values of **Attribute**, the attribute in the selected filter.

   - If the Filter panel is not displayed, from the **View** menu, select **Filter Panel**. If the Filter panel is hidden behind another panel, click the **Filter** icon 🧵 to display the Filter panel.

4. From the drop-down list at the top of the filter, select one of the following:
   - To create a filter to display data for the top n values in the filter, select **Highest**. Type the appropriate value in the field and press ENTER to apply your changes. For example, to display data for the top 2 values, type 2.
   - To create a filter to display data for the bottom n values in the filter, select **Lowest**. Type the appropriate value in the field and press ENTER to apply your changes. For example, to display data for the bottom 5 values, type 5.
   - To create a filter to display data for the top n% of values in the filter, select **Highest %**. Type the appropriate value in the field and press ENTER to apply your changes. For example, to display data for the highest 10% of values, type 10.
   - To create a filter to display data for the bottom n% of values in the filter, select **Lowest %**. Type the appropriate value in the field and press ENTER to apply your changes. For example, to display data for bottom 30% of values, type 30.
5 Select one of the following:

- To filter data by comparing metric rank to a number that you specify, complete the following steps. For example, you can display data for the top 10 most profitable stores.
  
a  Hover the cursor over the name of the filter that you just added, then click the arrow icon. Point to Display Style and select Qualification.

  b  In the field, type the rank value to use to filter data, then press ENTER. When you use the filter, you can change the rank value to display a different set of data in the sheet.

- To filter data by choosing rank values on a slider, complete the following steps. For example, you can display data for stores with a profit rank between 10 and 25.
  
a  Hover the cursor over the name of the filter that you just added, then click the arrow icon. Point to Display Style and select Slider.

  b  On the Filter panel, click and drag the endpoints of the slider to cover the range of values for which you want to filter data.

  c  You can choose to include or exclude data using the values selected in the slider. Hover the cursor over the filter name, click the arrow icon, and select one of the following:

    •  To display data for the metric values selected in the slider, select Include.

    •  To display data for all metric values except the values selected in the slider, select Exclude.

6 By default, as you make choices in the Filter panel, data is updated automatically in the sheet. You can change this behavior so that you control when the update occurs, by disabling automatic apply. When automatic apply is disabled, you click Apply in the Filter panel to update the sheet with the filter choices. For steps, see Applying filter changes individually or all at once, page 394.

Related topics

- Creating filters for a sheet of data, page 378
- Adding, modifying, and deleting sheets, page 374
- Filtering data in a sheet, page 453
Applying filter changes individually or all at once

By default, when you make a change in a filter on a sheet, data in the sheet is updated automatically. The data is updated again when you make another change. You can change this behavior so that you control when the update occurs. Applying a number of filter changes all at once can be helpful when your sheet contains large amounts of data, so that you update the data once, after all the changes are made. Updating the data repeatedly takes longer than updating it once.

When filter changes are applied all at once, the Filter panel displays Reset and Apply buttons, as shown below. After you make choices in the filters in the Filter panel, click **Apply** to update the data on the sheet.

![Filter panel with Reset and Apply buttons](image)

This setting applies to all filters in the Filter panel, that is, all filters for the displayed sheet.

---

**To determine whether filter changes are applied individually or all at once**

1. Open the dashboard to modify, by selecting **Open** from the **File** menu.
2. Click the tab of the sheet to modify.
3. If the Filter panel is not displayed, from the **View** menu, select **Filter Panel**. If the Filter panel is hidden behind another panel, click the **Filter** icon to display the Filter panel.
4 Hover the cursor over the Filter panel, then click the arrow icon displayed in the top right of the panel. Do one of the following:

- To update data each time that you make a selection in a filter, select **Auto-apply Filters** (default).

- To update data when you click **Apply** in the Filter panel, clear **Auto-apply Filters**.

**Related topics**

- *Creating filters for a sheet of data, page 378*
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*
- *Filtering data in a sheet, page 453*

**Filtering the attribute values displayed in an filter for a sheet**

If you have created multiple filters on a sheet, you can determine whether or not the selections that you make in one attribute filter affect the choices displayed for other attribute filters. (In an attribute filter, you can select attribute values to filter the data that is displayed on a sheet; for background information, see *Creating an attribute filter for a sheet, page 381*. A sheet is a layer of data, filtered independently of other sheets on the dashboard; for background information, see *Adding, modifying, and deleting sheets, page 374*.)

By default, the selections that you make in a filter affect the visualizations on the sheet, and do not affect other filters.

- You can allow selections made in attribute filters to affect which items are displayed for other attribute filters displayed below them in the Filter panel. This setting applies to all attribute filters in the Filter panel. Selecting an item in a metric filter does not affect the items displayed in any other filter.

For example, a sheet contains attribute filters on product category, subcategory, and item, placed on the Filter panel in that order. If you select Electronics in the category filter, the items in the subcategory filter are restricted. Only product subcategories within Electronics, such as Audio Equipment and Cameras, are displayed in the subcategory filter. The item filter displays only electronic items.
For steps and a more detailed example, see *Attribute filters restricting items in all attribute filters below them, page 396.*

- You can specify which attribute filters are affected by selections made in another attribute filter. This allows certain filters to be unaffected by selections made in other filters, and allows an attribute filter to filter a filter placed above it in the Filter panel.

  For example, a sheet contains attribute filters on product category, subcategory, and item, placed on the Filter panel in that order. The subcategory filter filters the category and item filters. If you select Literature in the subcategory filter, only the Books category is displayed in the category filter, while the item filter displays only literature items.

  For steps and a more detailed example, see *An attribute filter restricting items in a specific filter, page 400.*

Displaying many attribute values in a filter can make it hard to find the values that you want. To help resolve this issue, you can use the Search Box display style for the filter, or you can create another filter to limit the values that are displayed in the first filter.

**Attribute filters restricting items in all attribute filters below them**

For example, a sheet contains attribute filters on product category, subcategory, and item, placed on the Filter panel in that order, as shown below. The number of attribute values for each filter is displayed next to the
filter's name: 4 categories, 32 subcategories, and 360 items. Notice also that all values are selected for all filters.

You can allow selections made in the attribute filters to filter (or target) the filters below it. That is, selections in the Category filter affect which subcategories are displayed in the Subcategory and Item filters. If you select Electronics in the Category filter, the items in the Subcategory filter are restricted, and only product subcategories within Electronics, such as Audio Equipment and Cameras, are displayed. The Item filter displays only
electronic items. The number of attribute values for each filter has changed: 1 category, 6 subcategories, and 90 items.

By default, selections made in attribute filters do not affect the items displayed in other filters. In this case, if you select Electronics in the Category filter, the items in the Subcategory filter are not updated. All subcategories, such as Literature (from the Books category) and Cameras (from the Electronics category), are displayed. All products are displayed in the Item filter. The number of attribute values for each filter remains the same as it
was before you selected Electronics in the Category filter: 4 categories, 32 subcategories, and 360 items.

Metric filters are not affected by any changes made to other filters in the sheet.

**Prerequisite**

- The sheet must contain at least two attribute filters. For steps, see *Creating an attribute filter for a sheet, page 381.*
To determine whether attribute filters restrict the items displayed in all attribute filters below them

1. Open the dashboard to modify, by selecting **Open** from the **File** menu.

2. Click the tab of the sheet to modify.

3. If the Filter panel is not displayed, from the **View** menu, select **Filter Panel**. If the Filter panel is hidden behind another panel, click the **Filter** icon to display the Filter panel.

4. Hover the cursor over the Filter panel, then click the arrow icon displayed in the top right of the panel. Select one of the following:
   - To allow selections in attribute filters to restrict the items in the following attribute filters, select **Target All Filters Below**.
   - To select items in attribute filters without affecting the items in other attribute filters, select **Clear All Targeting**. If an attribute filter has been defined to filter another filter, that filtering is also removed.

5. You can move a filter to rearrange the order in which it is displayed in the Filter panel. To do this, from the Filter panel, click and drag the header of the filter to a new location. You can move it to a position before or after any existing filter in the Filter panel.

An attribute filter restricting items in a specific filter

Rather than relying on the relative location of attribute filters in the Filter panel, you can specify which attribute filters are affected by selections made in another attribute filter. This allows certain filters to be unaffected by selections made in other filters, and an attribute filter to target a filter placed above it in the Filter panel.

For example, a sheet contains attribute filters on product category, subcategory, and item, placed on the Filter panel in that order. When you select a subcategory, you want to restrict the Category and Item filters to display all the items in the selected subcategory. You can specify that the Subcategory filter filters (or targets) the Category filter, which is positioned above it in the Filter panel, and the Item filter, positioned below it. In the Filter panel shown below, the Literature subcategory has been selected, indicated by the (1 of 32) displayed next to the Subcategory filter name. The
Category filter displays the category of the selected subcategory, and only 15 items are included in the Item filter.

If the Subcategory filter targeted only the Item filter, the Category filter would instead display all four categories even when the Literature subcategory was selected.

**Prerequisite**

- The sheet must contain at least two attribute filters. For steps, see *Creating an attribute filter for a sheet, page 381.*
To allow an attribute filter to restrict the items displayed in another attribute filter

1. Open the dashboard to modify, by selecting **Open** from the **File** menu.
2. Click the tab of the sheet to modify.
3. In the Filter panel, hover the cursor over the header of the attribute filter to modify, then click the arrow icon displayed to the right, and point to **Select Targets**. The names of all attribute filters in the Filter panel are displayed.
   - If the Filter panel is not displayed, from the **View** menu, select **Filter Panel**. If the Filter panel is hidden behind another panel, click the **Filter** icon to display the Filter panel.
4. Select the check box for each filter to target.
5. Click **Apply**.

**Related topics**

- *Creating an attribute filter for a sheet, page 381*
- *Creating filters for a sheet of data, page 378*
- *Filtering data in a sheet, page 453*

**Creating a filter for the data on a visualization**

You can filter the data within a specific visualization, to select what data is displayed on the visualization. For example, a bar graph displays data for all your geographical regions. You can select a single region to focus on the data for that region, or display the data for the top five most profitable regions.

Any filters applied to data in the sheet are also applied to the data in the visualization. (A sheet is a layer of data, filtered independently of other sheets on the dashboard; for background information, see *Adding, modifying, and deleting sheets, page 374* and *Creating filters for a sheet of data, page 378*.)
Use the table below as a reference when choosing how to create a filter for a visualization, to help you display the data that you want to analyze in your dashboard.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Example</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>To filter the data in your visualization based on attribute values that you select</td>
<td>In your Profits by Region graph, you can select a single geographical region to display data for that region only.</td>
<td>Create an attribute filter for the visualization. A filter displays all attribute values in the original visualization, not just those that you have selected, so that you can easily change your selection. For steps, see <em>Creating a filter on the data in a visualization or another filter</em>, page 409.</td>
</tr>
<tr>
<td>To filter the data in your visualization based on metric values or ranks</td>
<td>In your Profits by Region grid, you can choose to display the top five most profitable geographical regions.</td>
<td>Create a metric filter for the visualization. For a more detailed example, with images, see <em>A metric filter on the data in a visualization</em>, page 404. For steps, see <em>Creating a filter on the data in a visualization or another filter</em>, page 409.</td>
</tr>
<tr>
<td>To filter the data in your visualization based on multiple business attributes</td>
<td>The rectangles in your heat map represent year and geographical region. You can select several regional rectangles to focus on that data. You can select a larger year rectangle to display the data for all regions in that year.</td>
<td>Filter the visualization on the fly, by selecting objects to include or exclude from display. For steps, see <em>Filtering data in a visualization</em>, page 460.</td>
</tr>
</tbody>
</table>
A metric filter on the data in a visualization

For example, the Profit and Revenue Data sheet displays three sets of data:

- Your profit data broken out into the customer’s geographical regions, shown as a bar graph
- Your profit data broken out into customer income brackets, shown as a pie graph
- Your revenue data broken out into the customer’s states, shown as an area graph

The sheet is filtered by customer region (shown in the Filter panel on the left). The South, Southeast, and Southwest regions are selected in the filter.
This means that all three graphs display data for only those regions, as shown below:

You want the pie graph to focus on the income brackets that have the highest profit in the selected regions. Since you do not want to change the other two graphs, you cannot add the profit filter to the sheet’s filter, on the Filter panel. Instead, add a filter that targets only the pie graph. In the following image, the Profit filter has been added to the sheet, targeting only the Profit by Income Bracket graph. The two other graphs display the same metric.
values, regions, and states, but the pie graph is now split into only five sections, instead of ten. These are the five most profitable income brackets.

For steps to create a filter that targets the set of a data in a specific visualization, see *Creating a filter on the data in a visualization or another filter, page 409*.

**Related topics**

- *Creating a filter on the data in a visualization or another filter, page 409*
- *Filtering the objects displayed in a filter for a visualization, page 407*
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*
Filtering the objects displayed in a filter for a visualization

You can create a filter that restricts the objects displayed in a visualization filter. (A visualization filter updates the data displayed in a visualization; for background information, see Creating a filter for the data on a visualization, page 402.)

For example, the grid shown below displays revenue values for items. The filter on the left lists product subcategories. When you select a subcategory in the filter, only the items in the selected subcategory are displayed in the grid. Note the scrollbar in the filter—there are too many subcategories to display all of them in the filter at the same time.

To reduce the number of subcategories that have to be displayed in the filter, add a second filter, on product category, that targets the subcategory filter. When you select a category in the category filter, the grid is not affected, but only the subcategories in the selected category are displayed in the
subcategory filter. In the example below, Movies is selected in the category filter. Only movie subcategories are displayed in the subcategory filter.

<table>
<thead>
<tr>
<th>Subcategory</th>
<th>Item</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Small Soldiers</td>
<td>$44,267</td>
</tr>
<tr>
<td>Action</td>
<td>The Mask of Zorro</td>
<td>$47,581</td>
</tr>
<tr>
<td>Action</td>
<td>Vanishing Point</td>
<td>$33,045</td>
</tr>
<tr>
<td>Action</td>
<td>Godzilla</td>
<td>$32,121</td>
</tr>
<tr>
<td>Action</td>
<td>Apollo 13</td>
<td>$33,303</td>
</tr>
<tr>
<td>Action</td>
<td>Lethal Weapon 4</td>
<td>$37,471</td>
</tr>
<tr>
<td>Action</td>
<td>Le Mans</td>
<td>$33,379</td>
</tr>
<tr>
<td>Action</td>
<td>The Scarlet Pimpernel</td>
<td>$46,925</td>
</tr>
<tr>
<td>Action</td>
<td>The African Queen</td>
<td>$29,862</td>
</tr>
</tbody>
</table>

Notice that the titles of these two filters help describe how the filters work together.

For steps to create a filter that restricts the objects displayed in a filter that targets a visualization, see *Creating a filter on the data in a visualization or another filter*, page 409.

Related topics

- *Creating a filter on the data in a visualization or another filter*, page 409
- *Creating a filter for the data on a visualization*, page 402
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages*, page 369
- *Displaying a visual representation of your data: Visualizations*, page 179
- *Filtering data in a visualization*, page 460
Creating a filter on the data in a visualization or another filter

You can create a filter to filter:

- The data on a specific visualization on a sheet (referred to as a visualization filter). For an example, see Creating a filter for the data on a visualization, page 402.

- The objects displayed in a visualization filter. For an example, see Filtering the objects displayed in a filter for a visualization, page 407.

Steps to create both types of filter are included below.

You can also create a filter from an existing filter on the sheet. The sheet filter is removed from the Filter panel and displayed as a visualization filter. All visualizations in the sheet are targeted by this filter, although you can change the targets to remove visualizations and add other visualization filters. For an example of a filter on a sheet, see Creating filters for a sheet of data, page 378. To create a filter from an existing sheet filter, see To create a filter from an existing sheet filter, page 411.

Prerequisites

- If you are creating a filter for a visualization, the visualization must be added to the dashboard. For steps, see Displaying a visual representation of your data: Visualizations, page 179.

- If you are creating a filter to restrict the objects displayed in a visualization filter, the visualization filter must be created. Follow the steps below, selecting a visualization as the target.

To create a filter for a visualization or another filter

1. Open the dashboard to modify, by selecting Open from the File menu.

2. Click the tab of the sheet that contains the visualization or filter to be filtered.

3. From the toolbar, click the Insert icon, then click Filter. An empty filter is added to the dashboard and displayed.

4. If the Datasets panel is not displayed, from the View menu, select Dataset Panel.
5 From the Datasets panel, click the dataset object to filter on, and drag the object to the empty filter.

- If you drag an attribute, the attribute’s values are displayed as items in the filter. For example, if you drag the Region attribute onto a filter, the Northeast, Southeast, and Mid-Atlantic regions are displayed as items in the filter.

- If you drag a metric, the metric’s values are displayed on a slider or a metric qualification is displayed, which allows you to compare metric values to a specific number. For example, if you drag the Revenue metric onto a filter, the revenue values are displayed on a slider. If you use a metric qualification, you can select an operator such as Greater than or Equals, and then specify a number to compare the revenue value to.

6 In the filter, click **Select Target**. Click each visualization and/or filter to filter, then click **Apply**.

   **To select the filter’s display style and formatting**

7 From the drop-down list at the top of the Properties panel, choose **Filter**.

- If the Properties panel is not displayed, from the **View** menu, select **Properties Panel**. If the Properties panel is hidden behind another panel, click the **Properties** icon to display the Properties panel.

8 In the Properties panel, select the **Style** from the drop-down list.

- For an attribute filter, the styles are:
  - **Check Boxes**: This style allows multiple selections.
  - **Slider**: This style is effective for browsing data in a graph.
  - **Search Box**: This style is useful for a long list of items.
  - **Link Bar**: This style is useful to create tabs.
  - **Button Bar**: This style is useful to create tabs.
  - **Radio Buttons**: This style allows only a single selection.
  - **Drop-down**: This style allows only a single selection.
  - **List Box**: This style allows multiple selections.
  - **Calendar**: This style is automatically selected for Date/Time values. It displays From and To boxes, to enter the date range.
For a metric filter, the styles are:

- **Slider**: Filters data by choosing values on a slider.
- **Qualification**: Filters data by comparing metric values to a number that you specify.

9 For a metric filter, you can choose to filter the metric based on the metric values or the metric’s ranking. Select one of the following:

- To filter the metric based on values, hover the cursor over the filter, click the arrow icon, and select **Qualify on Value**. For example, you can display data only for stores with profit values greater than $100,000.

- To filter the metric based on rank, hover the cursor over the filter, click the arrow icon, and select **Rank**. For example, you can display data only for the top five most profitable employees.

10 If **Mode** is displayed in the Properties panel, select whether to include or exclude data using the filter selections. This option is available for metric filters that use the slider style and for attribute filters.

- To display data for the filter selections, select **Include**.
- To display data for everything except the filter selections, select **Exclude**.

11 You can select formatting options for a filter, such as whether to show the filter's title bar and the background color of the filter. For an attribute filter, you can also choose whether to allow multiple selections, to make all the items the same width, and to show an option to select all the items at the same time. For a description of the properties, see *Dashboard Editor: Filter properties, page 613*.

12 To move the filter, click and drag the filter to the appropriate location in the dashboard, so that an indicator line is displayed in the location to place the filter. The filter is moved to its new location and displayed.

---

**To create a filter from an existing sheet filter**

1 Open the dashboard to modify, by selecting **Open** from the **File** menu.

2 Click the tab of the sheet that contains the filter.
3 From the Filter panel, click and drag the filter directly onto the dashboard area, where it is displayed as a filter.

4 To change the filter's targets (the objects that the filter affects), complete the following steps:
   a Hover the cursor over the filter, click the arrow icon, and point to **Select Targets**.
   b All visualizations in the sheet are automatically targeted by the filter. To remove a visualization as a target, clear its check box.
   c To add a filter as a target, select its check box.
   d Click **Apply**.

5 You can select the style, mode, and formatting, just as with any other visualization filter. For steps, see *To select the filter's display style and formatting, page 410.*

---

**To delete a filter on a visualization**

1 Open the dashboard to modify, by selecting **Open** from the **File** menu.
2 Click the tab of the sheet that contains the filter.
3 Hover the cursor over the filter to delete, click the arrow icon, then select **Delete**. The filter is removed from the dashboard.

**Related topics**

- *Creating a filter for the data on a visualization, page 402*
- *Filtering the objects displayed in a filter for a visualization, page 407*
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*
- *Dashboard Editor: Filter properties, page 613*
- *Filtering data in a visualization, page 460*
Using a visualization to filter the data displayed in another visualization

Once you have added visualizations to a dashboard, you can filter, drill on, or select values in one visualization (the source) to update the data displayed in another visualization (the target) on the same page. (A page is a layer of data on a sheet. The data on all the pages on a sheet is filtered in the same way. For background information, see Adding, modifying, and deleting pages, page 376.)

For example, a page contains two visualizations, the Regional Revenue bar graph and the State Revenue and Profit grid. (Not all the states are shown in the sample to save space.)

![Regional Revenue and State Revenue and Profit](image)

When you click Mid-Atlantic in the Regional Revenue graph, the State Revenue and Profit grid is filtered to include only those states in the
Mid-Atlantic region, as shown below. Mid-Atlantic in the Regional Revenue graph is highlighted to indicate that it is selected.

![Regional Revenue vs State Revenue and Profit](image)

You can also select multiple attribute values in the source visualization. In the example below, both Northeast and Northwest are selected in the Regional Revenue visualization, so all the states belonging to those regions are displayed in the State Revenue and Profit visualization.

![Regional Revenue vs State Revenue and Profit](image)

You can:

- Filter data in the source visualization to update the data displayed in one or more target visualizations. For example, the source visualization contains a list of product categories. When you filter data in the source to
include only data for the Movies category, the data in the target is automatically updated to display only data for Movies. Filtering data in the target does not affect the data displayed in the source. You can:

- Filter data in the source to display only data for selected values
- Filter data in the source to display all data except the data for selected values
- Undo filtering in the source

For steps to add a filter on a visualization, see Creating a filter on the data in a visualization or another filter, page 409. For steps to filter a visualization, see Filtering data in a visualization, page 460.

- Drill on data in the source visualization to update the data displayed in one or more target visualizations. Drilling allows you to explore data at additional levels of detail beyond what is immediately visible in the visualization. For example, the source visualization contains a list of product categories. When you drill from Category to Subcategory in the source, the target will be updated to display data at the Subcategory level. You can undo drilling to return to the original display. Drilling on data in the target does not affect the data displayed in the source.

For steps to drill on a visualization, see Analyzing data in a visualization, page 424.

- Restrict the data displayed in one or more targets by selecting values in the source. For example, if the target displays revenue data across several months and you select January in the source, the data in the target is automatically updated to display revenue data for January only.

- Highlight the data displayed in one or more targets by selecting values in the source. For example, if the target is a heat map displaying delayed flights for several airports and you select BWI in the source, the rectangles for BWI will be highlighted in the heat map.

**Prerequisite**

- The steps below assume that you have already created a dashboard that contains two or more visualizations. Both the source and target visualizations must be added to the same page in the dashboard. For steps to add a visualization to a dashboard, see Displaying a visual representation of your data: Visualizations, page 179.
To enable a visualization to filter the data displayed in another visualization

1. Open the dashboard to modify, by selecting Open from the File menu.

2. Hover the cursor over the visualization to use as the source, then click the arrow icon in the top right. Select Use as Filter. The Filtering Options dialog box opens.

3. Under Use VisualizationName to filter the following targets, where VisualizationName is the name of the source visualization, select the check box next to each visualization to use as a target. (The source is the visualization that you filter or drill; the target is the visualization that is updated.)

4. Select one of the following from the drop-down list next to Data on selection:
   - To filter the data in the target by selecting values in the source, select Filter. Only the values selected in the source are displayed in the target.
   - To highlight the data in the target by selecting values in the source, select Highlight. The target still displays all the values; the values selected in the source are highlighted in the target.

5. If a second drop-down list is displayed next to the Data on selection option, the visualization was configured in a previous version to update the target when you filter or drill on a single, specific attribute in the source. Select one of the following:
   - To update data in the target when you filter or drill on the attribute already defined for the source, select For Attribute AttributeName, where AttributeName is the name of the attribute.
   - To update data in the target when you filter or drill on any data in the source, select For All Data.

6. If you selected Filter, you can clear your selections in the source visualization and display the data for all values at the same time in any target visualizations. For example, if the source is a grid that allows you to select regions to filter data in the target, you can click the Region header to display data for all regions at the same time in the target. Do one of the following:
   - To allow clearing your selections in the source, select the Allow users to clear all selections check box.
To disable clearing selections, clear the **Allow users to clear all selections** check box.

7 Click **OK** to apply your changes.

**Related topics**

- *Selecting data in one visualization to update the data displayed in another, page 464*
- *Displaying a visual representation of your data: Visualizations, page 179*
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*
Introduction

A dashboard is a quick-to-design, presentation-quality display that you can use to explore your business data.
You can easily interact with your data to identify trends, patterns, and details at a glance. For example, you can:

- Emphasize the data that you are most interested in by sorting information.
- Examine your data at different levels of detail by drilling on the data. For example, if you are examining sales data at a regional level, you can choose to drill down to view the same data at the level of individual franchise locations.
- Gain a different perspective on your data by switching the visualization used to display the data.

For steps to interact with the data on a dashboard and analyze data in a visualization, see the following sections:

- Running and viewing a dashboard, page 420
  - Viewing dashboards in Presentation Mode, page 422
- Analyzing data in a visualization, page 424
  - Examining the underlying data in a visualization, page 449
- Filtering data in a dashboard, page 451
  - Filtering data in a sheet, page 453
  - Filtering data in a visualization, page 460
  - Selecting data in one visualization to update the data displayed in another, page 464

**Running and viewing a dashboard**

A dashboard is an interactive display that you can create to showcase and explore business data. You can click on the name of a dashboard to view, or run, it. For steps to create a dashboard, see *Creating a dashboard, page 146.*

By default, dashboards are displayed as fully interactive dashboards, allowing you to display visual representations (called visualizations) of the data in the dashboard to make the data easier to interpret, sort and rearrange data in visualizations, perform manipulations on the data to display only the information that you are interested in, and so on.
You can also display dashboards in Presentation Mode, to minimize navigation features. For steps to switch to Presentation Mode, see *Viewing dashboards in Presentation Mode*, page 422.

**Layering and organizing data in dashboards**

If your dashboard contains multiple sheets, you can click a sheet’s tab to switch between pages of data in the visualization. If a sheet on your dashboard contains at least two pages, you can also switch between pages of content in the sheet. Click the dots at the bottom of the interface to select and display a different page.

Using pages and sheets helps you filter the dashboard. Each sheet can be filtered independently of other sheets in the dashboard. All pages on a sheet are filtered in the same way.

For a more detailed description of sheets and pages, including examples of how filtering works on them, and steps to create them, see *Layering and organizing data for filtering*, page 372.

**Manipulating data in a dashboard**

You can display your data in interactive visualizations, sort and pivot data in a visualization, filter your data by selecting attribute elements or metric values, quickly switch between different visualizations, and so on. For steps to perform a specific task, see *Analyzing data in a visualization*, page 424.

---

**To run and view a dashboard**

1. Do one of the following:
   - Double-click the `.mstr` file that contains the dashboard. The dashboard opens in MicroStrategy Desktop.
   - In MicroStrategy Desktop, from the **File** menu, select **Open**. Navigate to and click the saved dashboard, and click **Open**. The dashboard opens.

2. To switch to Presentation Mode, which maximizes the screen area by hiding various design options, see *Viewing dashboards in Presentation Mode*, page 422.
Viewing dashboards in Presentation Mode

You can view a dashboard without having to see all the navigation features, such as toolbars, menus, and panels, that are available in the default interface. This allows you to maximize the amount of data that you can view at one time, while still allowing you to interact with your data.

You can perform the following tasks on a visualization in Presentation Mode:

- Maximize and minimize the visualization.
- Limit the data displayed in the visualization, to display the subset of information that you need. For steps to filter a visualization, see \textit{Filtering data in a visualization, page 460}.
- Explore data at additional levels of detail beyond what is immediately visible in the visualization by drilling on the data in the visualization. Steps to drill on a visualization are included in the analyzing topic for each type of visualization.
- Organize how data is displayed on the visualization by sorting the data. Steps to sort a visualization are included in the analyzing topic for each type of visualization.
- View the underlying data in the visualization. You can then sort, move, export, and copy the data, as described in \textit{Examining the underlying data in a visualization, page 449}.
- Format the visualization. You can rename attributes or metrics, choose whether to display a visualization’s title bar, whether to apply banding to values in a grid, and so on. For a complete list, see \textit{General formatting for visualizations, page 265}. Besides these general formatting options, each type of visualization has specific formatting that can be applied to it, as described in \textit{Formatting specific visualization types, page 264}.
- Remove an object from a visualization.
- Create a new attribute or metric based on existing objects, to present your data in different ways. For steps and examples, see \textit{Creating an attribute...}
Based on existing objects: Derived attributes, page 344 and Creating a metric based on existing objects: Derived metrics, page 318.

- Group multiple attribute elements into a single item (called a derived element). For steps and examples, see Grouping attribute values in a dashboard, page 349.

- Export the visualization, as described in Exporting a visualization, page 178.

You can also:

- Switch between pages and sheets, as described in Layering and organizing data in dashboards, page 421. A sheet (tab) is a layer of data that is filtered in the same way; each sheet can contain multiple pages.

- Filter data for all the visualizations and text fields on a single sheet, as described in Filtering data in a dashboard, page 451.

---

To run and view a dashboard in Presentation Mode

1. Open the dashboard, by selecting Open from the File menu.

2. On the dashboard toolbar, click the Presentation Mode icon 🎨.
To exit Presentation Mode, press ESC or click the **Exit Presentation Mode** icon.

**Related topics**

- *Filtering data in a dashboard, page 451*
- *Analyzing data in a visualization, page 424*
- *Running and viewing a dashboard, page 420*

**Analyzing data in a visualization**

Dashboards display business data using a variety of visually striking, interactive data representations, called visualizations. You can use visualizations to form a picture of business trends at a glance, explore relationships between data, and quickly identify areas of improvement.

In the image below, data in a dashboard is displayed using a Grid visualization, which contains revenue, cost, and profit data for each Call Center in a Region. Total revenue, cost, and profit data is calculated and displayed for each region in the grid. Profit values of less than $300,000 are
displayed using a red background, while values greater than $800,000 are displayed in green.

You can analyze data by manipulating the information in a visualization in multiple ways. For example, you can:

- Organize how data is displayed on a visualization by sorting and pivoting the data.
- Choose to include or exclude data for specific objects on a visualization by filtering the data. A filter sifts the data in your visualization to display a subset of information that answers exactly what you require. For example, you can filter the visualization to display only selected regions, the top five most-profitable regions, or those regions with more than $1 million in revenue. For steps to filter a visualization, see Filtering data in a visualization, page 460.
In addition to filtering a single visualization, you can filter data for all visualizations on a single sheet. For steps, see *Filtering data in a dashboard, page 451.*

- Explore data at additional levels of detail beyond what is immediately visible in a visualization by drilling on the data in a visualization.

- View and save the underlying attribute and metric data within a visualization. For steps, see *Examining the underlying data in a visualization, page 449.*

For background information and steps to analyze data using a specific type of visualization, click the appropriate link below:

- **Graph visualization:** You can display your data in a graphical format and examine your data using a variety of different graph types, such as an area graphs, line graphs, or pie charts. For steps, see *Analyzing data in a graph, page 427.*

- **Grid visualization:** You can display your data in an interactive grid, allowing you to pivot, sort, move, drill, filter, and perform additional manipulations on the data displayed in the grid. You can also understand your data and prepare it for displaying on other types of visualizations by using the Grid visualization as an intermediate tool. For steps, see *Analyzing data in a grid, page 434.*

- **Heat Map visualization:** You can display your data as a combination of nested, colored rectangles. Each rectangle represents an attribute element, and is colored and sized according to the value of metrics in the visualization, allowing you to quickly grasp the state and impact of a large number of variables at one time. For steps, see *Analyzing data in a heat map, page 438.*

- **ESRI Map visualization:** You can display your data as locations on a map. Depending on the way that your visualization was designed, your data can be displayed as map markers, colored map areas, or a density map, as described below. For steps, see *Analyzing data in a map, page 441.*
  - If your map displays map markers, you can change the color, size, and display of markers based on the value of a metric, allowing you to quickly grasp relationships between different locations.
  - If your map is displayed as a density map, you display your data on an interactive map with color gradients displayed based on the concentration of locations of interest, allowing you to quickly understand patterns across a large amount of geographical data.
• If your map is displayed as an area map, you can change the color of regions based on the value of a metric, allowing you to quickly grasp the impact of different regions.

• **Network visualization**: You can display your data as a network of nodes, with lines between the nodes representing the relationships between attribute elements. For steps, see *Analyzing data in a Network visualization, page 445*.

Related topics

• *Running and viewing a dashboard, page 420*

• *Displaying a visual representation of your data: Visualizations, page 179*

• *Analyzing Data in Dashboards, page 419*

**Analyzing data in a graph**

A Graph visualization allows you to view your data in a graphical layout, such as a bar graph or scatter graph. You can select from a variety of graph styles to display the data. In the example below, the vertical bar graph style was chosen.

For example images of the graph styles available for graphs, see *Examples of graph styles, page 431*. 
If a graph displays multiple attributes either vertically or horizontally, you can use an attribute to separate (or slice) your data into separate rows or columns of graphs, or you can display all the attributes in a single set of graphs. For example, a bar graph contains revenue data for multiple years and regions. You can display a bar graph for each year and region combination. You can instead slice the data by year to display columns of bar graphs, with each column containing a set of bar graphs for a single year’s revenue data. For a more detailed description, including examples and steps to determine whether to display rows and columns of graphs or to display a single set of graphs, see *Splitting a graph into separate rows or columns with an attribute, page 190*.

Follow the steps in the table below to analyze data in a graph. You can also drill and filter a graph, and view the graph’s raw data:

- You can drill on a graph to view data at levels other than that displayed in the graph; for steps, see *Drilling on a graph, page 429*. For example, you can drill from Region to State, or Year to Month.

- You can filter a graph to limit and customize the data displayed on the graph; for steps, see *Filtering data in a visualization, page 460*. For example, you can filter a graph to display selected regions or the five most profitable regions. Instead of displaying the selected regions, you can exclude them and display all the unselected regions instead.

- You can display the visualization’s underlying attribute and metric data in a simple grid format. This allows you to review and examine the actual, raw data, which you can export or copy. For steps, see *Examining the underlying data in a visualization, page 449*.

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand or collapse the legend</td>
<td>Click the arrow icon at the top of the legend.</td>
</tr>
<tr>
<td>Move the legend</td>
<td>By default, the legend is displayed on the right side of the graph. To move the legend, click and drag it to its new location, so that a blue indicator line is displayed in the new position.</td>
</tr>
<tr>
<td>Display additional information about a graph element</td>
<td>Hover your cursor over the graph element to display a tooltip with the information.</td>
</tr>
<tr>
<td>Display additional information about a trend line</td>
<td>Hover your cursor over the trend line to display a tooltip with the information. Trend line information includes the metric the trend line is based on, the mathematical function used to display it, and its coefficient of determination.</td>
</tr>
<tr>
<td>To...</td>
<td>Do This...</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Swap the objects in the horizontal and vertical area</td>
<td>In the Editor panel, click the Swap icon (\text{Swap}). The objects in the Horizontal and Vertical areas are swapped.</td>
</tr>
</tbody>
</table>
| Sort data in the graph based on a single object | In the Editor panel, right-click the attribute or metric to sort, and select one of the following:                                                                                                          
  - To sort the values in the graph in ascending order (from A to Z), select Sort Ascending.                                                                                                               
  - To sort the values in the graph in descending order (from Z to A), select Sort Descending.                                                                                                           |
| Remove a sort from the graph              | In the Editor panel, right-click an object and select Clear Sort. You do not have to select the object that the graph is sorted on.                                                                            |
| Rename an object in the graph             | 1 In the Editor panel, right-click the object to rename, then select Rename. A field displaying the name of the object is displayed.                                                                          
  2 Type a new name for the object in the field, then press ENTER. The object is renamed.                                                                                                               |

**Drilling on a graph**

Drilling lets you view data at levels other than that displayed in the graph. You can drill down, up, or across attributes and some metrics displayed in a graph.

For example, if your graph displays categories, you can drill from a specific category to that category’s subcategories. If you drill down from the Electronics category, only the subcategories within Electronics, such as Audio Equipment and Cameras, are displayed.
You can drill on a graph in the following ways:

<table>
<thead>
<tr>
<th>Result</th>
<th>Available Graph Types</th>
<th>Example</th>
</tr>
</thead>
</table>
| Display data for selected graph items, breaking the data by a selected attribute | • Scatter graph  
• Bubble graph | A scatter graph contains profit data across several regions. If you select the bubbles for the Northeast and Central regions, and then drill to Call Center, profit data for each call center in the Northeast and Central regions is displayed. |
| Display data for selected graph items in a separate graph column for each attribute element on the horizontal axis | • Vertical line graph  
• Vertical bar graph  
• Vertical area graph  
• Grid graph | A vertical bar graph contains profit margin data across several years. If you select the bars for 2011 and 2012, and then drill to Category, profit margin data for each Category is displayed, and a graph is displayed in a separate column for 2011 and 2012. |
| Display data for selected graph items in a separate graph row for each attribute element on the vertical axis | • Horizontal line graph  
• Horizontal bar graph  
• Horizontal area graph | A horizontal bar graph contains profit margin data across several years. If you select the bars for 2011 and 2012, and then drill to Category, profit margin data for each Category is displayed, and a graph is displayed in a separate row for 2011 and 2012. |

To drill on an element in a graph

1. In the graph, do one of the following:
   - Click a graph element in the graph to select it. You can select multiple graph elements in the graph by pressing `CTRL`, then clicking additional elements to select them.
   - Click and drag over an area of the graph to choose all the graph elements in a selected area.

2. Right-click the selected graph elements, point to Drill, and then select the attribute to drill to. For example, to drill to the data at the Category level in a bubble chart, select Drill and then Category. Only the selected graph elements are displayed, and the selected attribute is used to group graph elements in the graph.
To undo drilling in a graph

1 Click the filter icon in the graph’s title bar. If the title bar is not displayed, hover the cursor over the top left of the graph to display the filter icon.

2 Choose from the following:
   - To remove all filtering and drilling from the graph at once, select Clear All. All filtering and drilling are removed, and are no longer used to filter data in the graph.
   - To remove a single drill, select the drill to remove.

Examples of graph styles

The table below contains example images of each graph style available for Graph visualizations.

<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Description</th>
<th>Example Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>You can display your data in a vertical or horizontal line graph, to view lines representing metric values for each element of an attribute.</td>
<td></td>
</tr>
<tr>
<td>Bar</td>
<td>You can display your data in a vertical or horizontal bar graph, to view bars representing metric values for each element of an attribute.</td>
<td></td>
</tr>
<tr>
<td>Graph Style</td>
<td>Description</td>
<td>Example Image</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Area</td>
<td>You can display your data in a vertical or horizontal area graph, to view an area representing metric values for each element of an attribute.</td>
<td><img src="image" alt="Area Graph Example" /></td>
</tr>
</tbody>
</table>
| Scatter     | You can display a scatter plot that allows you to visualize the trends of two different metrics for a set of attribute elements. In the scatter plot:  
- One bubble is displayed for each attribute element.  
- Each bubble’s position on the X-axis represents the value of the first metric.  
- Each bubble’s position on the Y-axis represents the value of the second metric. | ![Scatter Graph Example](image) |
| Bubble      | You can display a bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. In the bubble plot:  
- One bubble is displayed for each attribute element.  
- Each bubble’s position on the X-axis represents the value of the first metric.  
- Each bubble’s position on the Y-axis represents the value of the second metric.  
- The size of each bubble represents the value of the third metric. | ![Bubble Graph Example](image) |
<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Description</th>
<th>Example Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td>You can use the Grid style to identify trends across combinations of data. Each marker in the grid can be automatically sized or colored based on the value of a metric. For example, in the image to the right, a separate marker is displayed for each combination of publisher and quarter. Markers representing large revenue values are displayed in dark blue, and markers for smaller revenue values are displayed in light blue.</td>
<td></td>
</tr>
<tr>
<td>Pie or Ring</td>
<td>You can view the contribution of attribute elements or metrics to a total by displaying data in a pie or ring graph.</td>
<td></td>
</tr>
<tr>
<td>Combination</td>
<td>You can display the values of multiple metrics plotted on a graph, with each metric represented by a different graph type. For example, you can display cost using bar risers and display revenue as a line graph.</td>
<td></td>
</tr>
</tbody>
</table>

**Related topics**

- *Running and viewing a dashboard, page 420*
- *Filtering data in a visualization, page 460*
- *Analyzing Data in Dashboards, page 419*
- *Creating a Graph visualization, page 181*
- *Formatting a Graph visualization, page 283*
Analyzing data in a grid

You can use a Grid visualization to analyze data displayed in a tabular layout. You can sort, drill, choose to include or exclude data for specific rows in the grid, filter the data, and so on.

Follow the steps in the table below to analyze data in a grid. You can also drill and filter a grid:

- You can drill on a grid to view data at levels other than that displayed in the grid; for steps, see Drilling on a grid, page 437. For example, you can drill from Region to State, or Year to Month.

- You can filter a grid to limit and customize the data displayed on the grid; for steps, see Filtering data in a visualization, page 460. For example, you can filter a grid to display selected regions or the five most profitable
regions. Instead of displaying the selected regions, you can exclude them and display all the unselected regions instead.

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize the grid’s columns</td>
<td>In the grid, hover the cursor over the right edge of the column to resize until the cursor becomes directional arrows, then do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To resize the column manually, click and drag the column edge to the desired width.</td>
</tr>
<tr>
<td></td>
<td>• To have the column automatically sized to fit all of the column contents, double-click the column edge.</td>
</tr>
<tr>
<td>Move a row or column</td>
<td>1 To move an object to another position in the same area, click and drag the object to its new position in the Editor panel.</td>
</tr>
<tr>
<td></td>
<td>For example, State and Region are displayed in the grid’s rows, in that order. You want Region to be displayed before State. In the Rows area, click and drag Region to before State.</td>
</tr>
<tr>
<td></td>
<td>2 To move a row to a column, or a column to a row, in the Editor panel, click and drag the object from its current location in the Editor panel to the appropriate area in the Editor panel. You can move multiple objects from one area of the visualization to another at the same time. Press CTRL and click each object to select it, then drag the objects to their new location in the Editor panel.</td>
</tr>
<tr>
<td></td>
<td>For example, to move an attribute from the rows of a Grid visualization to the columns, click and drag the attribute from the Rows area to the Columns area.</td>
</tr>
<tr>
<td></td>
<td>3 To change whether the metrics are displayed on the rows or columns, drag and drop the Metric Names object to the Rows or Columns area of the Editor panel.</td>
</tr>
<tr>
<td>Swap the objects in the rows and columns</td>
<td>In the Editor panel, click the Swap icon. The objects in the Rows and Columns areas are swapped.</td>
</tr>
<tr>
<td>Sort data in the grid based on a single object</td>
<td>In the Editor panel, right-click the attribute or metric to sort, and select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To sort the values in the grid in ascending order (from A to Z), select Sort Ascending.</td>
</tr>
<tr>
<td></td>
<td>• To sort the values in the grid in descending order (from Z to A), select Sort Descending.</td>
</tr>
</tbody>
</table>
### To... | Do This...
---|---
Sort data in the grid using multiple objects | 1 In the Editor panel, right-click the attribute or metric to sort, and select **Advanced Sort**. The Advanced Sort dialog box opens.  
2 Do one of the following:  
   - To sort by data in the rows, click **Rows**.  
   - To sort by data in the columns, click **Columns**.  
3 Add an object to the sort, by completing the following steps:  
   a From the **Sort by** drop-down list, select the attribute or metric to sort.  
   b Select either **Ascending** to sort the data in ascending order (from A to Z) or **Descending** to sort the data in descending order (from Z to A).  
4 Repeat the previous step for each object to sort, placing the object in a new row.  
5 To delete a sort, click the **X** next to the object to delete.  
6 The number in the Order column determines the order in which each object is used to sort the data in the visualization. To reorder the sorted objects, click and drag a row to its new location in the list.  
7 Click **OK** to apply your changes and sort the data.

Remove a sort from the grid | In the Editor panel, right-click an object and select **Clear Sort**. You do not have to select the object that the grid is sorted on.

Display or hide subtotals | 1 In the grid, right-click the attribute to subtotal, then point to **Show Totals**. A list of subtotal functions is displayed.  
2 Do one of the following:  
   - To display a subtotal, select the check box next to the type of subtotal to display in the grid.  
   - To hide a subtotal, clear the check box next to the type of subtotal to remove from the grid.  
3 Repeat the step above for each subtotal to display or hide.  
4 Click **OK** to apply your changes to the grid.  
A subtotal is a total of a specific subset of metric data, totaled at a level that you select. Common subtotal functions include sum, count, minimum, maximum, average, mean, and median. Grand totals and subtotals are often collectively referred to as totals.  
For example, if your grid contains region and state attributes and a revenue metric, the grid displays revenue values for each state. You can obtain regional revenue values by displaying subtotals at the region level.

Rename an object in the grid | 1 In the Editor panel, right-click the name of the object to rename, then select **Rename**. A field displaying the name of the object is displayed.  
2 Type a new name for the object in the field, then press **ENTER**. The object is renamed.
**Drilling on a grid**

Drilling lets you view data at levels other than that displayed in the grid. You can drill down, up, or across attributes and some metrics displayed in a grid.

For example, if your grid displays categories, you can drill from a specific category to that category’s subcategories. If you drill down from the Electronics category, only the subcategories within Electronics, such as Audio Equipment and Cameras, are displayed.

**To drill on an attribute in a grid**

1. In the grid, right-click the attribute element to drill from, then point to **Drill**. (An attribute element is a value of an attribute. For example, January, February, and March are elements of the attribute Month.)

2. Select the object to drill to. For example, to drill to the data at the Category level, select **Drill to Category**.

   When you drill on an attribute value in a grid, you can only drill to objects within the dashboard’s dataset that are not included in the Editor panel. If all objects within the dataset are displayed in the dashboard, no drilling options are displayed.

**To undo drilling in a grid**

1. Click the filter icon in the grid’s title bar. If the title bar is not displayed, hover the cursor over the top left of the grid to display the filter icon.

2. Choose from the following:

   - To remove all filtering and drilling from the grid at once, select **Clear All**. All filtering and drilling are removed, and are no longer used to filter data in the grid.

   - To remove a single drill, select the drill to remove.

**Related topics**

- *Filtering data in a visualization, page 460*
- *Running and viewing a dashboard, page 420*
Analyzing data in a heat map

A Heat Map visualization is a combination of nested, colored rectangles, each representing an attribute element. A heat map allows you to quickly grasp the state and impact of a large number of variables at one time. Heat maps are often used in the financial services industry to review the status of a portfolio.

![Heat Map visualization](image-url)
The rectangles contain a wide variety and many shadings of colors, which emphasize the contribution of the various components. In a heat map:

- The size of each rectangle represents its relative weight.
- The color of each rectangle represents its relative value. For example, in the image above, larger values are green and smaller values are red.
- The large areas, such as the 2012 Q4 area of rectangles in the image above, represent different groups of data.
- The small rectangles, such as Northeast in the image above, represent individual attribute elements.

Follow the steps in the table below to analyze data in a heat map. You can also drill and filter a heat map, as well as view the heat map’s raw data:

- You can drill on a heat map to view data at levels other than that displayed in the heat map; for steps, see Drilling on the data in a heat map, page 440. For example, you can drill from Region to State, or Year to Month.
- You can filter a heat map to limit and customize the data displayed on the heat map; for steps, see Filtering data in a visualization, page 460. For example, you can filter a heat map to display selected regions or the five most profitable regions. Instead of displaying the selected regions, you can exclude them and display all the unselected regions instead.
- You can display the visualization’s underlying attribute and metric data in a simple grid format. This allows you to review and examine the actual, raw data, which you can export or copy. For steps, see Examining the underlying data in a visualization, page 449.

<table>
<thead>
<tr>
<th>To…</th>
<th>Do This…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand or collapse the legend</td>
<td>Click the arrow icon at the top of the legend. In the example above, the legend is collapsed.</td>
</tr>
<tr>
<td>Move the legend</td>
<td>By default, the legend is displayed on the right side of the heat map. To move the legend, click and drag it to its new location, so that a blue indicator line is displayed in the new position.</td>
</tr>
<tr>
<td>Display additional information about a rectangle</td>
<td>Hover your cursor over the rectangle to display a tooltip with the information.</td>
</tr>
</tbody>
</table>
Drilling on the data in a heat map

You can drill on a heat map to view data at levels other than that displayed in the grid. You can drill down, up, or across attributes and some metrics displayed in a grid.

For example, if your heat map displays categories, you can drill from a specific category to that category’s subcategories. If you drill down from the Electronics category, only the subcategories within Electronics, such as Audio Equipment and Cameras, are displayed.

To drill on a rectangle in a heat map

1. Select at least one rectangle in the heat map to drill on, by doing one of the following:
   - To select an individual rectangle, click the rectangle in the heat map.
   - To select multiple rectangles, press `CTRL`, then click each rectangle to work with.
   - To select all the rectangles in a lasso shape, click and drag over an area of the heat map to choose all the rectangles in the area.

2. Right-click the selected rectangles, point to **Drill**, and then select the attribute to drill to. Only the selected rectangles are displayed, and the

### To... | Do This...
---|---
Sort data in the heat map based on a single object | In the Editor panel, right-click the attribute or metric to sort, and select one of the following:
  - To sort the values in the heat map in ascending order (from A to Z), select **Sort Ascending**.
  - To sort the values in the heat map in descending order (from Z to A), select **Sort Descending**.

Remove a sort from the heat map | In the Editor panel, right-click an object and select **Clear Sort**. You do not have to select the object that the heat map is sorted on.

Rename an object | Right-click the object in the Editor panel, select **Rename**, and type the new name.
drill-to attribute that you selected is used to group rectangles in the heat map.

For example, to drill to the data at the Category level, point to Drill, and then select Category.

---

**To undo drilling in a heat map**

1. Click the filter icon in the heat map’s title bar. If the title bar is not displayed, hover the cursor over the top left of the heat map to display the filter icon.

2. Choose from the following:
   - To remove all filtering and drilling from the heat map at once, select Clear All. All filtering and drilling are removed, and are no longer used to filter data in the heat map.
   - To remove a single drill, select the drill to remove. The deleted drill is no longer used to filter data in the heat map.

**Related topics**

- Filtering data in a visualization, page 460
- Running and viewing a dashboard, page 420
- Analyzing Data in Dashboards, page 419
- Creating a Heat Map visualization, page 223
- Formatting a Heat Map visualization, page 296

---

**Analyzing data in a map**

Depending on the way that your visualization was designed, your data can be displayed as map markers, colored map areas, or a density map, as described below:

- If your map displays map markers, you can change the color, size, and display of markers based on the value of a metric, allowing you to quickly...
grasp relationships between different locations. Map markers can be displayed as static image markers or bubble markers:

- Image markers are fixed size images that mark locations on the map. You can color image markers or replace image markers in the map with a different image based on the value of a metric.

- Bubble markers provide two visual cues to help you analyze data displayed on a map: size and color. You can choose to size each bubble marker based on the value of a metric, with the largest bubbles being displayed for the largest metric values. You can have bubble markers colored based on the value of a metric. In the following example, the bubble markers are colored based on the percentage of revenue metric.

If your map is displayed as a density map, you display your data on an interactive map with color gradients displayed based on the concentration of locations of interest, allowing you to quickly understand patterns across a large amount of geographical data. For example, you
can display areas with a high number of stores in red, and areas with a low number of stores in blue, as shown below:

- If your map is displayed as an area map, you can change the color of different areas based on the value of a metric, allowing you to quickly grasp the impact of different areas. In the example below, the areas are the states of the United States, and they are colored based on the Percentage of Cost metric values.

Follow the steps in the table below to analyze data in a map. You can also filter a map, to limit and customize the data displayed on the map; for steps, see *Filtering data in a visualization, page 460*. For example, you can filter a
map to display selected geographical regions or the five most profitable regions. Instead of displaying the selected regions, you can exclude them and display all the unselected regions instead.

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the display theme of the map</td>
<td>In the map’s toolbar, from the <strong>Styles</strong> drop-down list, select the display theme to apply to the map, such as Street Map, Terrain Map, and so on.</td>
</tr>
<tr>
<td>Display additional information about a marker or location</td>
<td>Click the marker or location to display a tooltip with the information.</td>
</tr>
</tbody>
</table>
| Zoom in or out on the map                  | On the right side of the map, do one of the following:  
• To zoom in on the map, click the plus (+) icon.  
• To zoom out of the map, click the minus (-) icon. |
| View a different area of the map (pan)     | Click the map, then drag it in the direction of the area to view.  
If a selection tool is highlighted, click the icon to allow the cursor to pan the map rather than select locations. |
| Find a specific location                    | 1 In the map’s toolbar, type the location name in the **Find a place** box. |
| Select individual markers or locations in the map | 1 In the map’s toolbar, click the **Multiple Marker Selection tool** 🕊.  
2 Click the markers or locations to select.  
3 Click **Done**. |
| Select multiple markers or locations by drawing a rectangular lasso | 1 In the map’s toolbar, click the **Rectangular Selection tool** 🕊️.  
2 Click and drag on the map to enclose a set of markers/locations within a rectangle. All of the markers/locations within the rectangle are selected. |
| Select multiple markers or locations by drawing a circular lasso | 1 In the map’s toolbar, click the **Circular Selection tool** 🕊️.  
2 Click and drag on the map to enclose a set of markers/locations within a circle. All of the markers/locations within the circle are selected. |
| Select multiple markers or locations by drawing a freehand lasso | 1 In the map’s toolbar, click the **Freeform Selection tool** 🕊️.  
2 Click and drag on the map to enclose a set of markers/locations. All of the markers/locations within the shape are selected. |
| Clear all selections on the map            | 1 In the map’s toolbar, click the **Remove Selections** icon 🗑️.  
2 Click **OK**. |
| Rename an object                            | Right-click the object in the Editor panel, select **Rename**, and type the new name. |
For steps to change other options on the map, such as whether or not to cluster map markers or the color theme for a density map, see:

- *Formatting an ESRI Map visualization that displays map markers, page 299*
- *Formatting an ESRI Map visualization that displays a density map, page 300*
- *Formatting an ESRI Map visualization that displays areas, page 301*

**Related topics**

- *Filtering data in a visualization, page 460*
- *Running and viewing a dashboard, page 420*
- *Analyzing Data in Dashboards, page 419*
- *Creating an ESRI Map visualization that displays map markers, page 228*
- *Creating an ESRI Map visualization that displays a density map, page 233*
- *Creating an ESRI Map visualization that displays areas, page 239*

**Analyzing data in a Network visualization**

The Network visualization allows you to quickly view data about individual items and the relationships between them in a visual format. Business
attributes are represented by circular nodes, while the lines between the nodes (called edges) represent relationships between the nodes.

Follow the steps in the table below to analyze data in a Network visualization. You can also drill and filter a Network visualization, and examine the visualization’s raw data:

- You can drill on a Network visualization to view data at levels other than that displayed in the visualization; for steps, see Drilling on the data in a Network visualization, page 448. For example, you can drill from Region to State, or Year to Month.

- You can filter a Network visualization to limit and customize the data displayed on the visualization; for steps, see Filtering data in a visualization, page 460. For example, you can filter a Network visualization to display selected regions or the five most profitable regions. Instead of displaying the selected regions, you can exclude them and display all the unselected regions instead.

- You can display the visualization’s underlying attribute and metric data in a simple grid format. This allows you to review and examine the actual,
raw data, which you can export or copy. For steps, see *Examining the underlying data in a visualization, page 449.*

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand or collapse the legend</td>
<td>Click the arrow icon at the top of the legend. In the example above, the legend displays information on node size, edge size, edge color, and so on.</td>
</tr>
<tr>
<td>Move the legend</td>
<td>By default, the legend is displayed on the right side of the visualization. To move the legend, click and drag it to its new location, so that a blue indicator line is displayed in the new position.</td>
</tr>
<tr>
<td>Display attribute and metric values associated with an item</td>
<td>Hover your cursor over a node or an edge to display a tooltip with the information.</td>
</tr>
<tr>
<td>Rename an object</td>
<td>Right-click the object in the Editor panel, select Rename, and type the new name.</td>
</tr>
<tr>
<td>Zoom in or out on the visualization</td>
<td>Click and drag the thumb on the slider located in the top left of the visualization.</td>
</tr>
<tr>
<td>Size the visualization so that all nodes and edges are displayed in the visualization area</td>
<td>Click the <strong>Fit to Screen</strong> icon on the top of the slider.</td>
</tr>
<tr>
<td>Reposition a node</td>
<td>Click and drag the node to its new location.</td>
</tr>
<tr>
<td>Select multiple nodes</td>
<td>Click the <strong>Select</strong> icon , then click and drag over the nodes to select.</td>
</tr>
<tr>
<td>View a different area of the visualization (pan)</td>
<td>Click the <strong>Pan</strong> icon , then click and drag in the direction of the area to view.</td>
</tr>
<tr>
<td>Change the layout style used to display the nodes</td>
<td>Select the <strong>Force-directed Layout</strong> icon in the top right.</td>
</tr>
<tr>
<td>Display the nodes with edges of similar length, minimizing the number of times the edges cross each other</td>
<td>Select the <strong>Circular Layout</strong> icon in the top right. A circular layout makes it easy to identify clusters and relationships in the visualization.</td>
</tr>
<tr>
<td>Display the nodes in a circular layout</td>
<td>Select the <strong>Linear Layout</strong> icon in the top right. The linear layout makes it easy to see where edges begin and end (if the edges are displayed as arrows), as well as groups of closely related nodes.</td>
</tr>
</tbody>
</table>
Drilling on the data in a Network visualization

You can drill on a Network visualization to view data at levels other than that displayed in the visualization. You can drill down, up, or across attributes and some metrics displayed in a Network visualization.

For example, if your visualization displays categories, you can drill from a specific category to that category’s subcategories. If you drill down from the Electronics category, only the subcategories within Electronics, such as Audio Equipment and Cameras, are displayed.

To drill on a node in a Network visualization

1. In the visualization, select one or more nodes to drill on by doing one of the following:
   - To select nodes one at a time, press `CTRL`, then click each node to include.
   - To select all of the nodes in a rectangular lasso shape, click the Select icon, then click and drag over an area of the visualization to choose all the nodes in the area.

2. Right-click the selected nodes, point to Drill, and select the attribute to drill to. For example, to drill to the data at the Category level, select Drill to Category. Only the selected nodes are displayed, and the drill-to attribute that you selected is used to group nodes in the visualization.

To undo drilling in a Network visualization

1. Click the filter icon in the visualization’s title bar. If the title bar is not displayed, hover the cursor over the top left of the visualization to display the filter icon.

2. Choose from the following:
   - To remove all filtering and drilling from the visualization at once, select Clear All. All filtering and drilling are removed, and are no longer used to filter data in the visualization.
   - To remove a single drill, select the drill to remove.
Examining the underlying data in a visualization

You can examine the underlying attribute and metric data within a visualization in a simple grid format. Data from each attribute in the visualization is displayed in columns in the grid, followed by data from each metric in the visualization. You can:

- Add data from the visualization’s primary dataset to the grid.
- Sort and move data in the grid, and resize the columns.
- Export the data in the grid as an Excel, PDF, or CSV file.
- Copy the data in the grid to the clipboard.
- Create a new Grid visualization using the data in the grid. For background information, see *Creating a Grid visualization, page 220.*

To view the underlying data in a visualization

1. From the **File** menu, select **Open**. Navigate to and select the dashboard to modify.

2. Select the data to examine by doing one of the following:

   - To display all the underlying attribute and metric data in a visualization, hover the cursor over the visualization. Click the arrow icon displayed in the top right, then select **Show Data**.
   - To display underlying attribute and metric data only for selected elements in a visualization, select the elements to examine. Click the arrow icon displayed in the top right, then select **Show Data**.
Your data is automatically displayed in the Show Data dialog box.

The Show Data option is not available for visualizations created using the data in a dataset imported from a server.

3 You can display additional data from the visualization’s dataset, if the selected visualization has a primary dataset defined. For example, you can choose to display data from all attributes and metrics in the dataset, regardless of whether the attributes and metrics are displayed in the visualization. Choose from the following:

- To add data to the grid, click the plus icon (+), then select each object to display in the grid.
- To expand and collapse the lists of attributes and metrics, click the arrow icons next to the name of each list.

4 To sort data in the grid, hover over the header of the data to sort by, then click the arrow icon. Select one of the following:

- To sort the data in ascending order (from A to Z), select Sort Ascending.
- To sort the data in descending order (from Z to A), select Sort Descending.

5 To move data in the grid, hover the cursor over the header of the data that you want to move, then click the arrow icon.

- To move the column one space to the left, select Move Left
- To move the column one space to the right, select Move Right.

6 To copy data rows in the grid, click a row to select it. You can press CTRL and click specific rows to select them, or press SHIFT to select consecutive rows. Press CTRL + C to copy the data to the clipboard. You can then paste the copied rows into the text editing or spreadsheet software of your choice.

7 To resize columns, hover the cursor over the right edge of the column to resize. Click and drag the edge of the column to resize it, or double-click the edge of the column to have the column automatically sized to fit its contents.

8 To add the displayed data to the dashboard as a new Grid visualization, click Add as Grid. The Show Data dialog box closes, and the new Grid visualization in displayed.
To export the data in the grid to a file for offline viewing, click **Export Data**, and then select one of the following:

- To export the data as an Excel file, select **Excel**.
- To export the data as a PDF file, select **PDF**.
- To export the data as a comma-separated values (CSV) file, select **Data**.

Browse to the location to save the file in, then type a name for the file and click **Save** to save it.

When finished, click **Close** to return to the dashboard.

**Related topics**

- *Show Data dialog box, page 611*
- *Analyzing data in a visualization, page 424*
- *Running and viewing a dashboard, page 420*
- *Defining the primary dataset to use to display data in a visualization, page 263*
- *Creating a Grid visualization, page 220*
- *Analyzing data in a grid, page 434*

**Filtering data in a dashboard**

If you have a lot of data in your dashboard or want to focus on a specific set of data, you can filter the data, to limit and customize what is displayed on the dashboard. For example, the graphs shown below are filtered to display only the South, Southeast, and Southwest customer regions. The filter, shown on
the left, displays the available regions and allows you to change what is displayed on the graphs.

A filter can limit the data in a specific sheet, a visualization, or another filter. A sheet is layer of data that helps provide a logical flow to your dashboard. The dashboard above contains multiple sheets, shown as tabs at the bottom of the dashboard. The Profit and Revenue Data sheet is currently displayed. The Customer Region filter is applied to all the data in that sheet.

A dashboard can contain multiple sheets, each filtered in a specific way. Layers of data can be filtered in the same way, in separate pages on the same sheet.

- For steps to filter the data in a sheet, see Filtering data in a sheet, page 453.
- For steps to filter the data in a specific visualization, see Filtering data in a visualization, page 460.
Filtering data in a sheet

You can simultaneously filter all the data displayed in a sheet, to view only the information that you require. A sheet is a layer of data in a dashboard. The data on each sheet is filtered independently of the data on other sheets in the dashboard. When you select values in a filter, the data is updated in all the visualizations and also in any dataset objects displayed in text fields on the sheet. (A dataset object is an attribute or metric from a dataset.) Data is not updated on other sheets in the dashboard.

For example, Sheet1 contains the following sets of data:

- Your revenue data broken out by geographical region and year, shown as a grid
- Your revenue data broken out by geographical region and category, displayed as a bar graph

Sheet1 also contains text, which uses the region object combined with the static text “Revenue Data for”. Sheet2 contains your revenue data broken out by geographical region and year, displayed as a heat map.

A filter on Sheet1 allows you to select the regions to display. When you select Northeast, the grid and bar graph are updated to display revenue data for the Northeast region only. The text is updated to display “Revenue Data for Northeast”. The heat map, on Sheet2, is not updated and continues to display all the regions.

You can filter data in a sheet based on:

- The values of an attribute: You can filter based on a list of attribute values belonging to an attribute.

  For example, you can display income ranges only for the customers that you select.
• The value of a metric: You can filter data based on the values of a metric associated with a set of attributes.

For example, you can display sales numbers only for products whose current inventory count falls below a certain number.

• The rank of a metric: You can filter data based on the rank of a metric associated with a set of attributes.

For example, you can display profit and sales data only for the top five most profitable employees.

By default, the selections that you make in a filter affect the visualizations and text on the sheet, and do not affect other filters. If your sheet contains multiple filters, selections that you make in an attribute filter can affect the choices displayed for other attribute filters. Filters on metrics are not affected by any changes made to other filters in the sheet. For an example, see Filtering the attribute values displayed in an filter for a sheet, page 395.

To check whether a filter affects another filter, in the Filter panel, hover the cursor over the filter’s name, click the arrow icon displayed to the right, and point to Select Targets. Any filter selected in the list of targets is affected by the filter.

The following table provides steps to filter a sheet of data in different ways.

You can also filter data in a single visualization, without affecting the data displayed in any other visualization. For steps, see Filtering data in a visualization, page 460.

**Prerequisites**

• The sheet that you want to filter must have a filter. For steps to create filters for a sheet, see Creating filters for a sheet of data, page 378.

• If the Filter panel is not displayed, from the View menu, select Filter Panel. If the Filter panel is hidden behind another panel, click the Filter icon to display the Filter panel. To move the Filter panel, hover the cursor over the Filter tab, then click and drag the panel to its new location in the dashboard, so that an indicator line is displayed. You can change
the order of the panels, by dragging the Filter panel within the panel area, or move it off the panel area to the right or left side of the dashboard.

<table>
<thead>
<tr>
<th>To Filter a Sheet...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>By selecting attribute values</td>
<td>An example of this type of filter is shown below. Call Center is the attribute, and Atlanta, San Diego, and so on are the attribute values.</td>
</tr>
</tbody>
</table>

1 In the Filter panel, locate the filter that contains the attribute to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.

2 Select each value to display, or select All to choose all of the values at once.
   - If a search box is displayed, you can narrow the list of attribute values displayed as choices in the filter. Type a value in the search box to update the list of results.
   - If you are selecting items in a filter displayed using the Check Boxes style, you can clear all choices and select a single value. Hover the cursor over the value and click Only.

3 If the Apply button is displayed, click Apply to filter the data using your selections. You can make several changes before applying the filter.

If the dashboard is designed to automatically apply selections in the filter, the button is not displayed and your selections are automatically used to filter data.
<table>
<thead>
<tr>
<th>To Filter a Sheet...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>By searching for attribute values</td>
<td>An example of this type of filter is shown below. Subcategory is the attribute, and Business, Books - Miscellaneous, and so on are the attribute values.</td>
</tr>
</tbody>
</table>

1 In the Filter panel, locate the filter that contains the attribute to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter's name to expand it.
2 In the search field, type the name, or part of the name, of the attribute value to find.
3 From the list of results, select the name of the attribute value. The value is added to the list of values included in the filter.
4 Repeat the steps above to add additional values to the filter.
5 To remove a value from the filter, click X next to the value to remove.
6 If the Apply button is displayed, click **Apply** to filter the data using your selections. You can make several changes before applying the filter.

If the dashboard is designed to automatically apply selections in the filter, the button is not displayed and your selections are automatically used to filter data.
### To Filter a Sheet...

<table>
<thead>
<tr>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>By typing a date range</strong></td>
</tr>
</tbody>
</table>
| An example of this type of filter is shown below.  

![Date Filter Example]

1. In the Filter panel, locate the filter that contains the date attribute to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.
2. In the **From** field, type the beginning date of the date range or select it from the calendar by clicking the Calendar icon.
3. In the **To** field, type the end date of the date range or select it from the calendar by clicking the Calendar icon.
4. If the Apply button is displayed, click **Apply** to filter the data using your selections. You can make several changes before applying the filter.

If the dashboard is designed to automatically apply selections in the filter, the button is not displayed and your selections are automatically used to filter data.

---

| **By comparing metric values or ranks to a selected number** |
| An example of this type of filter is shown below:  

![Revenue Filter Example]

1. In the Filter panel, locate the filter that contains the metric to filter. If the filter is collapsed, click the arrow icon to the left of the name of the filter’s name to expand it.
2. From the drop-down list, select the operator, such as Greater than or Less than, to use to compare data. If the operators include Highest and Lowest, you are comparing the metric rank rather than value.
3. In the box, type the value to use to filter data, then press **ENTER**.
4. If the Apply button is displayed, click **Apply** to filter the data using your selections. You can make several changes before applying the filter.

If the dashboard is designed to automatically apply selections in the filter, the button is not displayed and your selections are automatically used to filter data.
### To Filter a Sheet...

<table>
<thead>
<tr>
<th>By choosing metric values or ranks from a slider</th>
<th>An example of this type of filter is shown below:</th>
</tr>
</thead>
</table>

1. In the Filter panel, locate the filter that contains the metric to filter. If the filter is collapsed, click the arrow icon to the left of the filter’s name to expand it.

2. If the filter contains a drop-down list of operators, you are filtering on rank. Select the operator, such as Highest or Lowest.

3. Do one of the following:
   - To filter the metric values by selecting a general range, click and drag the endpoints of the slider to cover the range of values to display. The selected value range is automatically highlighted in blue.
   - To filter the metric values by typing a specific range of values, hover your cursor over the endpoint of a slider. A dialog box is displayed. Type the value to use as the new endpoint of the value range, then press ENTER.

4. If the Apply button is displayed, click **Apply** to filter the data using your selections. You can make several changes before applying the filter.

If the dashboard is designed to automatically apply selections in the filter, the button is not displayed and your selections are automatically used to filter data.
### To Filter a Sheet...

<table>
<thead>
<tr>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>By comparing the ranked values of an attribute to a selected number</td>
</tr>
<tr>
<td>The attribute values are ranked by a metric.</td>
</tr>
<tr>
<td>An example of this type of filter is shown below:</td>
</tr>
<tr>
<td><img src="image.png" alt="Profit by Region" /></td>
</tr>
<tr>
<td>1 In the Filter panel, locate the filter that contains the metric to filter by an attribute. If the filter is collapsed, click the arrow icon to the left of the filter’s name to expand it.</td>
</tr>
<tr>
<td>2 From the drop-down list, select the operator, such as Highest or Lowest, to use to compare data.</td>
</tr>
<tr>
<td>3 In the box, type the value to use to filter data, then press ENTER.</td>
</tr>
<tr>
<td>4 If the Apply button is displayed, click Apply to filter the data using your selections. You can make several changes before applying the filter.</td>
</tr>
<tr>
<td>If the dashboard is designed to automatically apply selections in the filter, the button is not displayed and your selections are automatically used to filter data.</td>
</tr>
</tbody>
</table>

#### To clear all filter selections for a single filter, and display all the data for the filtered object

1 In the Filter panel, hover the cursor over the filter, then click the arrow icon displayed next to the filter name, and select Clear Selections. All the selections in the filter are cleared and all data for the attribute or metric that the filter is based on is displayed.

#### To clear all selections for all filters on the sheet

1 Hover the cursor over the Filter panel, then click the arrow icon displayed in the top right of the panel, and select Clear All Selections. All the selections in the Filter panel are cleared and all data is displayed.

### Related topics

- Filtering data in a dashboard, page 451
- Filtering data in a visualization, page 460
- Running and viewing a dashboard, page 420
- Creating filters for a sheet of data, page 378
Filtering data in a visualization

Filter a visualization to limit and customize the data displayed on the visualization. For example, you can filter the visualization to display only selected regions, the top five most-profitable regions, or those regions with more than $1 million in revenue. In these examples, region is the attribute; an attribute is a business concept, which provides a context for your numerical data. The values (or elements) of the Region attribute are Northeast, Northwest, South, and so on.

A filter can also affect the objects displayed in another filter. This can be helpful if a filter displays many values; filtering the values displayed in the filter allows you to more easily find the value to filter on. For an example, see Filtering the objects displayed in a filter for a visualization, page 407.

To check what visualizations and filters a filter affects, hover the cursor over the filter’s name, click the arrow icon displayed to the right, and point to Select Targets. Any visualization or filter selected in the list of targets is affected by the filter.

The following table provides steps to filter a visualization in different ways.

You can also filter all the visualizations on a sheet. For steps to filter a sheet, see Filtering data in a dashboard, page 451.

<table>
<thead>
<tr>
<th>To Filter a Visualization...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To display selected attribute values</td>
<td>Select the attribute values in the filter, or search for an attribute value in the filter. Examples of different styles of attribute filters are shown below:</td>
</tr>
</tbody>
</table>

To undo filtering, hover your cursor over the filter, click the arrow icon in the top right, and select Clear Selections.

If the dashboard does not contain an attribute filter, you can create it; for steps, see Creating a filter on the data in a visualization or another filter, page 409.
### To Filter a Visualization...

<table>
<thead>
<tr>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>By selecting a date range to display</strong></td>
</tr>
</tbody>
</table>
| 1 In the **From** field of the filter, type the beginning date of the date range or select it from the calendar by clicking the **Calendar** icon.  
2 In the **To** field, type the end date of the date range or select it from the calendar by clicking the **Calendar** icon. |  
| To undo filtering, hover your cursor over the filter, click the arrow icon in the top right, and select **Clear Selections**.  
If the dashboard does not contain a date filter, you can create it; for steps, see *Creating a filter on the data in a visualization or another filter, page 409*. |  
| **By comparing metric values or ranks to a selected number** |  
| 1 From the drop-down list in the filter, select the operator, such as Greater than or Less than, to use to compare data. If the operators include Highest and Lowest, you are comparing the metric rank rather than value.  
2 In the box, type the number to compare the metric's values or ranks to. |  
| To undo filtering, hover your cursor over the filter, click the arrow icon in the top right, and select **Clear Selections**.  
If the dashboard does not contain a metric filter, you can create it; for steps, see *Creating a filter on the data in a visualization or another filter, page 409*. |
By choosing metric values or ranks from a slider

<table>
<thead>
<tr>
<th>To Filter a Visualization...</th>
<th>Do This...</th>
</tr>
</thead>
</table>
| By choosing metric values or ranks from a slider | 1 If the filter contains a drop-down list of operators, you are filtering on rank. Select the operator, such as Highest or Lowest.  
2 In the filter, do one of the following:  
  • To filter the metric values by selecting a general range, click and drag the endpoints of the slider to cover the range of values to display. The selected value range is automatically highlighted in blue.  
  • To filter the metric values by typing a specific range of values, hover your cursor over the endpoint of a slider. A dialog box is displayed. Type the value to use as the new endpoint of the value range, then press **ENTER**. |

To undo filtering, hover your cursor over the filter, click the arrow icon in the top right, and select **Clear Selections**.

If the dashboard does not contain a metric filter, you can create it; for steps, see *Creating a filter on the data in a visualization or another filter, page 409*.

By choosing objects in another visualization

<table>
<thead>
<tr>
<th>To Filter a Visualization...</th>
<th>Do This...</th>
</tr>
</thead>
</table>
| By choosing objects in another visualization | 1 Select the objects in the source visualization (used as the filter). The data in the target visualization is then filtered or highlighted based on the selected objects.  
For an example, see *Selecting data in one visualization to update the data displayed in another, page 464*. If the visualizations are not defined to allow filtering and highlighting, follow the steps in *Using a visualization to filter the data displayed in another visualization, page 413*. |
## To Filter a Visualization...

<table>
<thead>
<tr>
<th>To display multiple attributes at the same time</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the visualization, select the attributes or attribute values to include in the visualization by pressing CTRL and clicking the objects to include.</td>
<td></td>
</tr>
<tr>
<td>- For a graph, select graph items, such as bars or bubbles. To choose all the graph items in an area, click and drag over an area of the graph.</td>
<td></td>
</tr>
<tr>
<td>- For a grid, select rows.</td>
<td></td>
</tr>
<tr>
<td>- For a heat map, select rectangles. To choose all the rectangles in a selected area, click and drag over an area of the heat map.</td>
<td></td>
</tr>
<tr>
<td>- For a map, select locations.</td>
<td></td>
</tr>
<tr>
<td>- For a network, select nodes. To choose all the nodes in a selected area, click the Select icon, then click and drag over an area of the visualization.</td>
<td></td>
</tr>
<tr>
<td>2 Right-click the selected data, and then select Keep Only. The data in the visualization is filtered and updated. The filter icon is displayed in the top left of the visualization, to indicate that the visualization has been filtered. You can also use it to remove the filtering, as described in To undo filtering on data in a visualization, page 464.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To exclude multiple attributes at the same time</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 In the visualization, select the attributes or attribute values to exclude from the visualization by pressing CTRL and clicking the objects to exclude.</td>
<td></td>
</tr>
<tr>
<td>- For a graph, select graph items, such as bars or bubbles. To choose all the graph items in an area, click and drag over an area of the graph.</td>
<td></td>
</tr>
<tr>
<td>- For a grid, select rows.</td>
<td></td>
</tr>
<tr>
<td>- For a heat map, select rectangles. To choose all the rectangles in a selected area, click and drag over an area of the heat map.</td>
<td></td>
</tr>
<tr>
<td>- For a map, select locations.</td>
<td></td>
</tr>
<tr>
<td>- For a network, select nodes. To choose all the nodes in a selected area, click the Select icon, then click and drag over an area of the visualization.</td>
<td></td>
</tr>
<tr>
<td>2 Right-click the selected data, and then select Exclude. The data in the visualization is filtered and updated. The filter icon is displayed in the top left of the visualization, to indicate that the visualization has been filtered. You can also use it to remove the filtering, as described in To undo filtering on data in a visualization, page 464.</td>
<td></td>
</tr>
</tbody>
</table>
To undo filtering on data in a visualization

Use these steps to undo filtering that displays or excludes multiple attributes. To undo filtering in an attribute or metric filter, hover your cursor over the filter, click the arrow icon in the top right, and select **Clear Selections**.

1. Click the filter icon in the visualization’s title bar. (If the filter icon is not displayed after you filter a visualization, you used an attribute or metric filter.)
   - If the title bar is not displayed, hover the cursor over the top left of the visualization to display the filter icon.

2. Choose from the following:
   - To remove all filtering and drilling from the visualization at once, select **Clear All**. All filtering and drilling are removed, and are no longer used to filter data in the visualization.
   - To remove a single filter update, select the filter to remove. The deleted filter is no longer used to filter data in the visualization.

Related topics

- *Filtering data in a dashboard, page 451*
- *Filtering data in a sheet, page 453*
- *Running and viewing a dashboard, page 420*
- *Creating a filter for the data on a visualization, page 402*

Selecting data in one visualization to update the data displayed in another

You can select data in one visualization (the source) to update the data displayed in another visualization (the target), depending on how your dashboard has been designed. The data in the target visualization is then filtered or highlighted based on the data that you selected in the source.
When you select an attribute value in the source visualization, the source highlights the data that is displayed or highlighted in the target. This allows you to clearly see what is included in the metric values shown on the target.

In the dashboard shown below, selections in the Source grid filter the Target grid. Nothing has been selected yet in the Source grid, so all values and all rows are displayed for both grids.

If you select Books in one row of the Source grid, all of the Books rows, regardless of region, are highlighted in the Source grid and displayed in the Target grid, as shown below. The revenue values for each region include only the Books revenue.

Clear the selections in the Source grid by clicking the Region header. (You can clear the selections by clicking any of the headers.) The Target grid once again calculates all the revenue for all regions and categories.

If you select North in the Source grid, all of the North rows, regardless of category, are highlighted in the Source grid and displayed in the Target grid, as shown below. The revenue value for North includes the revenue from all the categories in the North region.
Clear the selections in the Source grid by clicking the Region header.

If you select North and Books in the Source grid, all the North rows and all the Books rows are highlighted in the Source grid and displayed in the Target grid, as shown below. The revenue value for North includes the revenue from all the categories in the North region, while the revenue value for South includes only the Books category.

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Category</td>
</tr>
<tr>
<td>North</td>
<td>Books</td>
</tr>
<tr>
<td>North</td>
<td>Electronics</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
</tr>
<tr>
<td>South</td>
<td>Books</td>
</tr>
<tr>
<td>South</td>
<td>Electronics</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
</tr>
<tr>
<td>South</td>
<td>North</td>
</tr>
<tr>
<td>South</td>
<td>$543</td>
</tr>
</tbody>
</table>

Clear the selections in the Source grid by clicking the Region header.

If you select a metric value in a single row, such as revenue for the North and Books row, only that row is highlighted in the Source grid and displayed in the Target grid, as shown below. The revenue value includes only Books revenue in the North region.

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Region</td>
<td>Category</td>
</tr>
<tr>
<td>North</td>
<td>Books</td>
</tr>
<tr>
<td>North</td>
<td>Electronics</td>
</tr>
<tr>
<td>North</td>
<td>Movies</td>
</tr>
<tr>
<td>South</td>
<td>Books</td>
</tr>
<tr>
<td>South</td>
<td>Electronics</td>
</tr>
<tr>
<td>South</td>
<td>Movies</td>
</tr>
<tr>
<td>South</td>
<td>North</td>
</tr>
</tbody>
</table>

Follow the steps below to select data or clear your selections in one visualization, to update the data displayed in other visualizations.

**Prerequisites**

- A visualization is defined to update the data displayed in another visualization. For steps, see *Using a visualization to filter the data displayed in another visualization, page 413.*

- To clear selections in the source visualization and display data for all values in the target visualization, the source visualization must be designed to enable users to clear selections. For steps, see *Using a visualization to filter the data displayed in another visualization, page 413.*
To select data in one visualization to update the data displayed in another visualization

1. Select the data, as described below:
   - In a graph, click graph elements, such as bar risers or bubbles.
   - In a grid, click cells.
   - In a heat map, click rectangles.
   - In a map, click individual markers or locations, or draw a shape on the map to select multiple markers or locations, as described in Analyzing data in a map, page 441.
   - In a Network visualization, click nodes.

The target visualization is updated based on your selections.

To clear selections in one visualization and display data for all values in another visualization

If data in the target visualization is filtered (rather than highlighted) by selecting data in the source visualization, you can clear your selections in the source visualization and display data for all values at the same time in any target visualizations.

1. Depending on the source visualization’s display type, do the following:
   - For a graph or heat map, click an empty area in the visualization.
   - For a grid, click the header of a column in the grid.
   - For a map, click the Remove Selections icon \(\times\) in the map toolbar.
   - For a Network visualization, press \(\text{CTRL}\) and then click each selected node. This will clear all nodes.

The target visualization is automatically updated, and data for all values in the target visualization is displayed.

Related topics

- Using a visualization to filter the data displayed in another visualization, page 413
• *Filtering data in a dashboard, page 451*
• *Running and viewing a dashboard, page 420*
CONNECTING TO A SERVER TO ACCESS DATA AND DASHBOARDS

Introduction

A dashboard is an interactive display that you can create to showcase and explore business data. The main focus of a dashboard is the visualizations, which are visual representations of your data. To add data to a dashboard, you import data. You can import data from local files, a Google drive, or other data sources, but you can also connect to a MicroStrategy server to import data and dashboards. A MicroStrategy server is a location where dashboards and data are stored and accessed from MicroStrategy Web.

After you connect to a MicroStrategy server, you can:

• Open dashboards stored on the server and save dashboards on the server. This allows you to share MicroStrategy Desktop dashboards with other users and access the dashboards from another device. Connecting to a server also allows you to open dashboards saved in an existing MicroStrategy Enterprise project, make changes to the dashboards, and save the changed dashboards back to the MicroStrategy Enterprise environment. For steps, see Saving a dashboard onto a MicroStrategy server, page 474 and Opening a dashboard saved on a server, page 477.

• Import a dataset that is stored on the server. You can use the data in the dataset to create visualizations, filters, derived objects, and so on, just like
the data from any other dataset. For steps, see Importing a dataset from a server, page 481.

- Use data from a project on the server. The project’s objects are displayed in the All Objects panel in the Dashboard Datasets panel. You can use the objects to create visualizations, filters, derived objects, and so on, in the same way as using objects from a dataset. For steps, see Using data from a project on a server, page 483.

For steps to connect to a server, see Connecting a server to MicroStrategy Desktop, page 470.

Related topics
- About MicroStrategy Desktop, page 2
- Importing Data into MicroStrategy Desktop, page 55

Connecting a server to MicroStrategy Desktop

Before you can open or save dashboards on a server, import a dataset from a server, or use data from a project on the server, you must connect a MicroStrategy server to MicroStrategy Desktop. A MicroStrategy server is a location where dashboards and data are stored and accessed from MicroStrategy Web.

The user account that is used to log into the MicroStrategy server must have the Use MicroStrategy Desktop privilege. Additional privileges are required for different tasks, such as downloading dashboards. For a complete list, see User privileges for Desktop, page 472.

The user account that is used to log into the MicroStrategy server must have a Desktop license.

Prerequisites
- The MicroStrategy server must be a MicroStrategy Enterprise 10 server.
- You need the URL of the server. Complete the following steps in MicroStrategy Web. You can also use MicroStrategy Web Administrator
to obtain the URL. For details on working with MicroStrategy Web, see the *MicroStrategy Web Help*.


2. Click the **MicroStrategy** icon at the upper left of the page and select **Projects**. The project selection page is displayed.

   A project stores all the objects and information needed to create datasets and dashboards and analyze them. Conceptually, a project is the environment in which all related analysis is completed. Projects are often used to separate data into smaller sections of related data that fit user requirements. For example, you may have a project source separated into four different projects with analysis areas such as human resources, sales distribution, inventory, and customer satisfaction.

3. Click **URL to Connect to Server** in the project to connect to. The URL is generated and displayed in a dialog box.

4. Click **Copy Link**.

   - Ensure that your user account has the correct privileges, as described in *User privileges for Desktop*, page 472.
   - The user account has a Desktop license.

---

**To connect a server**

1. In MicroStrategy Desktop, do one of the following:
   - On a Windows machine, from the **File** menu of a dashboard, select **Preferences**.
   - On an Apple machine, from the **Desktop** menu of a dashboard, select **Preferences**.

   The Preferences dialog box opens.

2. Click **Server Connections**.

3. Click **+**.

4. Paste or type the URL of the MicroStrategy server into the **Server URL** field.
5 To view and edit the server connection information provided by the URL, click **Advanced**. The server connection information includes:

- Web Server Name
- Web Server Port
- Web Server Path
- Web Server Type
- Connection Type

6 Click **Test and Add**. If the test is successful, the server is added.

7 Click **OK** to return to Desktop.

### Related topics

- *User privileges for Desktop, page 472*
- *Saving a dashboard onto a MicroStrategy server, page 474*
- *Opening a dashboard saved on a server, page 477*
- *Importing a dataset from a server, page 481*
- *Using data from a project on a server, page 483*
- *Connecting to a Server to Access Data and Dashboards, page 469*

### User privileges for Desktop

Privileges give you access to specific Desktop functionality. For example, the Export MicroStrategy File privilege allows you to download dashboards and datasets from the server into Desktop, while the Import MicroStrategy File privilege allows you to upload dashboards from Desktop into the server.

The user account that is used to log into the MicroStrategy server must have the following privileges for the following tasks. When you are granted the
Use MicroStrategy Desktop privilege, all the other privileges listed below are automatically assigned as well.

<table>
<thead>
<tr>
<th>Task</th>
<th>Required Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect to a server from Desktop</td>
<td>• Use MicroStrategy Desktop</td>
</tr>
<tr>
<td>Save a dashboard onto a server</td>
<td>• Use MicroStrategy Desktop • Create and Edit Database Instances and Connections • Create Application Objects • Create Schema Objects • Import MicroStrategy File</td>
</tr>
<tr>
<td>Open a dashboard saved on a server</td>
<td>• Use MicroStrategy Desktop • Export MicroStrategy File • Use OLAP Services • Web Run Dashboard</td>
</tr>
<tr>
<td>Import a dataset from a server</td>
<td>• Use MicroStrategy Desktop • Export MicroStrategy File • Use OLAP Services • Web Publish Intelligent Cube</td>
</tr>
<tr>
<td>Share a dashboard</td>
<td>• Use MicroStrategy Desktop • Web Use Object Sharing Editor</td>
</tr>
<tr>
<td>Use data from a project on a server</td>
<td>• Use MicroStrategy Desktop • Web Modify Report List</td>
</tr>
</tbody>
</table>

Privileges are assigned in MicroStrategy Web or MicroStrategy Desktop; for steps, see the *MicroStrategy Web Help* or the *MicroStrategy System Administration Guide*.

**Related topics**

- *Connecting a server to MicroStrategy Desktop, page 470*
- *Saving a dashboard onto a MicroStrategy server, page 474*
- *Opening a dashboard saved on a server, page 477*
- *Importing a dataset from a server, page 481*
- *Using data from a project on a server, page 483*
Saving a dashboard onto a MicroStrategy server

You can save (or upload) a dashboard onto a MicroStrategy server, so that other MicroStrategy users can view and analyze the dashboard. A MicroStrategy server is a location where dashboards are stored and accessed from MicroStrategy Web.

How the data is accessed in MicroStrategy Web depends on the kind of data source used in the dashboard, as described below:

- If the data source uses in-memory data access, an in-memory cube is created from the data when the dashboard is saved to the MicroStrategy server. This cube is used whenever the dashboard is viewed in MicroStrategy Web. If the Web user refreshes the data, the MicroStrategy server connects directly to the data source to retrieve new data to repopulate the cube.

- If the data source uses direct data access, the saved dashboard does not contain data. When the dashboard is viewed in MicroStrategy Web, the server connects directly to the data source to obtain the data.

For a comparison of direct and in-memory data access, and steps to change how a dataset accesses data, see Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160.

Steps to save a dashboard onto a server follow.

Prerequisites

- You have created the dashboard, and the dashboard is open in MicroStrategy Desktop.

- You have connected the MicroStrategy server to MicroStrategy Desktop. For steps, see Connecting a server to MicroStrategy Desktop, page 470.

- The user account that you use to log into the MicroStrategy server must have the following privileges:
  - Use MicroStrategy Desktop
  - Create and Edit Database Instances and Connections
  - Create Application Objects
Create Schema Objects

Import MicroStrategy File

- If you will share the dashboard, the user account must have the Web Use Object Sharing Editor privilege. For steps to assign privileges, see User privileges for Desktop, page 472.

- The user account that is used to log into the MicroStrategy server must have a Desktop license.

---

To save a dashboard onto a MicroStrategy server


2. Some servers display the project list before you log in, while other servers require you to log in before the project list is displayed. From the first drop-down list, do one of the following:
   - If the project to save to is listed, select the project. (Projects are listed beneath the server that hosts them.)
   - If the server to save to is listed, but the project is not displayed, select the server.

3. To change the authentication mode, click Show Authentication Options. Select the authentication mode from the list. For descriptions of the authentication modes, see Selecting the authentication mode, page 480.

4. If you are prompted to log in, type your User Name and Password, then click Sign In. If the server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server.
   - If the Sign In to Application dialog box opens, complete the following steps to log in to the application server and then the MicroStrategy server:
     a. Type your User Name and Password for the application server, then click Sign In. If the application server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server. The Sign In dialog box is displayed.
     b. To change the authentication mode, click Show Authentication Options. Select the authentication mode from the list. For
Connecting to a Server to Access Data and Dashboards

MicroStrategy Desktop User Guide

8


descriptions of the authentication modes, see Selecting the authentication mode, page 480.

c Type your User Name and Password for the MicroStrategy server, then click Sign In. If the MicroStrategy server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server. The Upload to Server dialog box opens, indicating the server that you logged in to.

5 Select the Folder to save the dashboard in.

6 Type a Name for the dashboard and an optional Description.

7 Click Save. After the dashboard is successfully saved, a dialog box opens, displaying the link URL for the dashboard. Do one of the following:

• To view the dashboard, click View Dashboard. The dashboard is displayed in Desktop.

• To share the dashboard, click Share Dashboard. The Share dialog box opens. Continue with the To share the dashboard, page 476 steps below.

• If you do not want to share or view the dashboard, click OK. You are returned to Desktop, with a blank dashboard.

To share the dashboard

8 You can share the dashboard by:

• Emailing a link to the dashboard. Click Email Link to open your email editor. Complete the email and click Send to send the message and return to the Share dialog box.

• Copying the dashboard’s link URL. Complete the following steps:
  a Click Show Link.
  b Highlight the URL, then press CTRL + C to copy the link to the clipboard.

• Automatically generating HTML code containing the dashboard’s link URL. The link URL is displayed in an iFrame. Complete the following steps:
  a Click Show HTML.
  b To change the iFrame's width, type the width in the Width field.
  c To change the iFrame's height, type the height in the Height field.
The HTML code for the iFrame is displayed in the field. Highlight the code, then press CTRL + C to copy the link to the clipboard.

9 Click Close to return to Desktop.

Related topics
- Connecting a server to MicroStrategy Desktop, page 470
- Connecting to a Server to Access Data and Dashboards, page 469
- Saving a dashboard, page 175

Opening a dashboard saved on a server

You can open dashboards that are stored in a connected MicroStrategy server. A MicroStrategy server is a location where dashboards are stored and accessed from MicroStrategy Web. The dashboard is downloaded as a .mstr file and opened in Desktop. After you make changes, you can save the dashboard on the server or your computer.

You can open any MicroStrategy dashboard, even if it was created in a version of Visual Insight before MicroStrategy 10.

How the data is accessed when you open the file in Desktop depends on the kind of data source used to create the dashboard in MicroStrategy Web, as described below:

- If the data source uses in-memory data access, the data is included in the dashboard file during the download. This data is used when you open the dashboard. If you refresh the data, Desktop connects directly to the data source to retrieve new data. If that attempt is unsuccessful, Desktop connects to the MicroStrategy server, which connects to the data source and transfers the data back to Desktop.

- If the data source uses direct data access, the downloaded dashboard does not contain data. When you open the dashboard, Desktop connects directly to the data source to obtain the data. If that attempt is unsuccessful, Desktop connects to the MicroStrategy server, which connects to the data source and transfers the data back to Desktop.

- If the dashboard uses a large in-memory cube, the downloaded dashboard does not contain data. When you open the dashboard, Desktop connects to the MicroStrategy server to retrieve the data needed
for the dashboard; the entire cube is not transferred. If that attempt is unsuccessful, Desktop cannot display the dashboard.

For a comparison of direct and in-memory data access, see *Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160.*

**Prerequisites**

- You have connected the MicroStrategy server to MicroStrategy Desktop. For steps, see *Connecting a server to MicroStrategy Desktop, page 470.*
- The user account that you use to log into the MicroStrategy server must have the following privileges:
  - Use MicroStrategy Desktop
  - Export MicroStrategy File
  - Use OLAP Services
  - Web Run Dashboard
- The user account that is used to log into the MicroStrategy server must have a Desktop license.
- The dashboard to be downloaded does not contain any prompts that must be answered but do not have default answers. If a prompted dashboard contains default prompt answers or the prompts are optional, you can download the dashboard.

A prompt is a question presented to the user who runs the dashboard. Depending on the user’s answers, the dashboard displays different data from the data source. A default answer is a pre-selected answer for a prompt.

---

**To open a dashboard saved on a server**

1. In MicroStrategy Desktop, from the File menu, select **Download from Server.** The Download from Server dialog box opens.

2. Some servers display the project list before you log in, while other servers require you to log in before the project list is displayed. From the first drop-down list, do one of the following:
   - If the project to download from is listed, select the project. (Projects are listed beneath the server that hosts them.)
• If the server to download from is listed, but the project is not displayed, select the server.

3 To change the authentication mode, click **Show Authentication Options**. Select the authentication mode from the list. For descriptions of the authentication modes, see **Selecting the authentication mode, page 480**.

4 If you are prompted to log in, type your **User Name** and **Password**, then click **Login**. If the server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server.

• If the Sign In to Application dialog box opens, complete the following steps to log in to the application server and then the MicroStrategy server:
  
  a Type your **User Name** and **Password** for the application server, then click **Sign In**. If the application server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server. The Sign In dialog box is displayed.

  b To change the authentication mode, click **Show Authentication Options**. Select the authentication mode from the list. For descriptions of the authentication modes, see **Selecting the authentication mode, page 480**.

  c Type your **User Name** and **Password** for the MicroStrategy server, then click **Sign In**. If the MicroStrategy server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server. The Download from Server dialog box opens, indicating the server that you logged in to.

5 Navigate to the dashboard, and click **Open**. The dashboard is downloaded as a `.mstr` file and opened in Desktop.

• For steps to edit the dashboard, including adding new objects, see **Creating a dashboard, page 146**.

• For steps to interact with your data to identify trends, patterns, and details, see **Analyzing Data in Dashboards, page 419**.

**To save the dashboard**

6 After you make changes, save your dashboard:

• By saving it on the server. For steps, see **Saving a dashboard onto a MicroStrategy server, page 474**.
• By saving it on your computer. For steps, see *Saving a dashboard*, page 175.

Related topics

• *Connecting a server to MicroStrategy Desktop*, page 470
• *Saving a dashboard onto a MicroStrategy server*, page 474
• *Connecting to a Server to Access Data and Dashboards*, page 469

**Selecting the authentication mode**

Authentication is the process by which the system identifies the user. In most cases, a user provides a login ID and password which the system compares to a list of authorized logins and passwords. If they match, the user is able to access certain aspects of the system, according to the access rights and application privileges associated with the user.

The option to change the authentication mode is provided if the MicroStrategy server administrator provided you with one or more authentication user names and passwords to use for logging into MicroStrategy Web. For more information, contact your administrator.

The available authentication modes are:

• **Standard authentication**: MicroStrategy Intelligence Server is the authentication authority. This is the default authentication mode.

• **LDAP authentication**: An LDAP (lightweight directory access protocol) server is the authentication authority.

• **Database authentication**: The data warehouse database is the authentication authority.

• **Guest User**: Users log in as “Guest” and do not need to provide a password. This authentication mode may be required to enable other authentication modes, such as database warehouse or LDAP.

• **Single sign-on**: Single sign-on encompasses several different third-party authentication methods, including:
  
  • **Windows authentication**: Windows is the authentication authority.

  • **Integrated authentication**: A domain controller using Kerberos authentication is the authentication authority.
Trusted authentication request: A third-party single sign-on tool, such as IBM® Tivoli® Access Manager, CA SiteMinder®, or Oracle® Access Manager, is the authentication authority.

Related topics
- Saving a dashboard onto a MicroStrategy server, page 474
- Opening a dashboard saved on a server, page 477

Importing a dataset from a server

You can import an Intelligent Cube that is saved on a MicroStrategy server into Desktop, to use as a dataset for your dashboard.

- A dataset is a set of data that can be displayed in a dashboard. In Desktop, datasets provide the data to be displayed in a dashboard, in objects such as visualizations, filters, text fields, and so on.

- An Intelligent Cube is a multi-dimensional set of data saved on a MicroStrategy server. Intelligent Cubes can be shared as a single in-memory copy, to be used by many different dashboards created by multiple users in MicroStrategy Web and MicroStrategy Desktop. For background information on Intelligent Cubes, see the MicroStrategy In-memory Analytics Guide.

- A MicroStrategy server is a location where data is stored and accessed from MicroStrategy Web.

How the data in the dataset is accessed depends on how the dataset was created in MicroStrategy Web, as described below:

- If the dataset uses in-memory data access, the data is imported into the Desktop dashboard.

- If the dataset uses direct data access, the data is retrieved live from the server, not stored within the dashboard on your computer. You can perform most dataset management tasks, such as replacing and refreshing the dataset, with the following exceptions:
  - You cannot republish the dataset, although you can refresh the dashboard to retrieve the up-to-date information.
  - You cannot view the underlying data for a visualization that displays data from the dataset, by using the Show Data option.
For a comparison of direct and in-memory data access, see *Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160*. For a full list of dataset management tasks, see *Managing data in a dashboard, page 151*.

**Prerequisite**

- You have connected at least one server to MicroStrategy Desktop. For steps, see *Connecting a server to MicroStrategy Desktop, page 470*.
- The user account that you use to log into the MicroStrategy server must have the following privileges:
  - Use MicroStrategy Desktop
  - Export MicroStrategy File
  - Use OLAP Services
  - Web Publish Intelligent Cube
- The user account that is used to log into the MicroStrategy server must have a Desktop license.

---

**To import a dataset from a server**

1. In MicroStrategy Desktop, click the Add Data icon, and select Existing Dataset. The Select Intelligent Cube dialog box opens.

2. From the first drop-down list, select the project that contains the dataset. (Projects are listed beneath the server that hosts them.)

3. To change the authentication mode, click Change Authentication Options. Select the authentication mode from the list. For descriptions of the authentication modes, see *Selecting the authentication mode, page 480*.

4. Type the User Name and Password to access the MicroStrategy project, then click Login. If the server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server.

5. Navigate to and select the Intelligent Cube to use as a dataset.

6. Click Open. The dataset is displayed in your dashboard in the Datasets panel.
For steps to work with datasets on a dashboard, see *Managing data in a dashboard, page 151.*

For steps to create a dashboard, see *Creating a dashboard, page 146.*

**Related topic**

- *Connecting to a Server to Access Data and Dashboards, page 469*

### Using data from a project on a server

You can add dataset objects from a MicroStrategy project directly to your dashboard. Once you connect to a server, you can open the All Objects panel within the Datasets panel. This allows you to access the objects in the project, and use those objects in the same ways that you use objects from datasets, such as creating visualizations, filters, and derived objects. When you add a project object to the dashboard, MicroStrategy automatically creates a dataset to contain these objects and displays this dataset in the Datasets panel. The dataset is given the same name as the current project.

The project dataset is always in Direct Data Access mode, meaning that visualizations that contain data from this dataset are run directly against the data warehouse. For more information on Direct Data Access mode, see *Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160.*

You can:

- Remove the project dataset from the dashboard. For steps, see *Adding, replacing, and removing datasets in a dashboard, page 152.* If you remove the project dataset, then later add additional objects to the dashboard from the All Objects panel, MicroStrategy automatically creates and adds a new version of the dataset to the dashboard.

- Hide and rename objects, as described in *Modifying, renaming, showing, and hiding dataset objects in a dashboard, page 162.*

- Use the project's objects to create derived attributes and derived metrics, and groups of attribute elements. (You create derived objects from the Datasets panel or a visualization’s Editor panel, not the All Objects panel. You must add a project object to a visualization before you can use the object to create a derived object.) For steps, see *Creating New Attributes, Metrics, and Groups, page 317.*
• Use the project’s objects to create visualizations, text fields, and filters, as described in the steps below.

The project dataset does not support examining the underlying data in the dataset using the Show Data option.

**Prerequisite**

• You have connected at least one server to MicroStrategy Desktop. For steps, see *Connecting a server to MicroStrategy Desktop, page 470.*

• The user account that you use to log into the MicroStrategy server must have the following privileges:
  - Use MicroStrategy Desktop
  - Web Modify Report List

• The user account that is used to log into the MicroStrategy server must have a Desktop license.

---

**To add objects from a project directly to a dashboard**

1. In the dashboard, display the All Objects panel. To do this, from the bottom of the Datasets panel, click the arrow icon next to All Objects.
   - If the Datasets panel is not displayed, from the View menu, select **Dataset Panel**.
   - If this is the first time that you are accessing the All Objects panel, the Login screen is displayed. Select a project, and then type the user name and password to use to access the project. Click **Login**. If the server uses MicroStrategy Usher for security, you are instead asked for your Usher badge to connect to the server.

   The All Objects panel is displayed. For steps to navigate the All Objects panel, see *All Objects panel, page 554.*

2. To add project objects to the dashboard, click and drag the object to the appropriate area of your dashboard, as described below:
   - To add data to a visualization, click and drag an attribute or metric from the All Objects panel onto the appropriate area in the visualization’s Editor panel. The attribute or metric is added to the visualization and displayed. For an overview of visualizations and
steps to add data to a specific type of visualization, see Displaying a visual representation of your data: Visualizations, page 179.

• To display an object in a text field:
  a In the toolbar, click the **Insert** icon , then click **Text**. The text field is automatically added to the dashboard.
  b Drag and drop the object from the All Objects panel into the text field.

For more detailed steps to display text, including how to format the text, see Adding text, page 307.

• To add a filter for the sheet, from the All Objects panel, click the object to use to filter data, and drag it onto the Filters panel. For more detailed steps, including selecting the filter's display style and whether to use metric values or rank, see Creating filters for a sheet of data, page 378.

A sheet is a layer of data in a dashboard. The data on each sheet is filtered independently of the data on other sheets in the dashboard. For examples of sheets, see Layering and organizing data for filtering, page 372.

• To add a filter for a specific visualization:
  a In the toolbar, click the **Insert** icon , then click **Filter**. An empty filter is added to the dashboard and displayed.
  b Drag and drop the object from the All Objects panel into the filter.

For more detailed steps to create a filter on a visualization, including selecting the filter's target and display style, see Creating a filter for the data on a visualization, page 402.

**Related topics**

• Connecting to a Server to Access Data and Dashboards, page 469
• Managing data in a dashboard, page 151
• All Objects panel, page 554
Introduction

A dashboard is an interactive display that you can create to showcase and explore business data. The main focus of a dashboard is the visualizations, which are visual representations of your data. To add data to a dashboard, you import data from any of a variety of data sources.

When you import data from a database, you must establish communication between MicroStrategy and your data source. To establish communication, you create a database connection. A database connection specifies the connection information used to access the database that is your data source. The database connection enables MicroStrategy Desktop to retrieve data from your data source.

Some types of data sources allow you to connect directly to the data source during the data import process. This can streamline the process of importing data. To determine whether your data source is a type that supports direct connections, see Data source and ODBC driver support, page 504.

You can connect to a relational data source. For steps, see Creating a data source connection to a relational data source, page 488.
After you create a database connection, you can edit, delete, rename, or
duplicate it. For steps, see *Managing database connections, page 496*.

For the following data sources, you must define the OAuth parameters for
the connection:

- Dropbox
- Facebook
- Google Analytics
- Google BigQuery
- Google Drive
- Salesforce.com
- Twitter

For steps, see *Configuring OAuth parameters for a data source, page 498*.

**Related topics**

- *About MicroStrategy Desktop, page 2*
- *Importing Data into MicroStrategy Desktop, page 55*

---

**Creating a data source connection to a relational data source**

When you import data from a relational data source, you must establish
communication between MicroStrategy and your data source. To establish
communication, you create a database connection. A database connection
specifies the connection information used to access the database that is your
data source. The database connection enables MicroStrategy Desktop to
retrieve data from your data source.

**Prerequisites**

- Determine whether your data source is a certified or supported data
  source for use with MicroStrategy Desktop. For a list of certified and
supported data sources, see *Data source and ODBC driver support, page 504*.

- Determine whether you can connect directly to your data source during the data import process. For a list of data sources and connection types, see *Data source and ODBC driver support, page 504*.

- Depending on whether your data source supports direct connections during the data import process, do the following:

  - If direct connection is available:
    
    a. Gather the required configuration information for connecting to your data source. Commonly required items include:

    - **DBMS**: The version of the data source that you are connecting to.
    - **IP Address**: The IP address of the machine on which the data source resides.
    - **User**: The name of a valid user account for the data source.
    - **Password**: The password for the data source user account.
    - **Name**: A name to identify the data source configuration in MicroStrategy Desktop.

    Each database type requires specific information; see *Appendix B, Configuration Requirements for Data Sources* for the information that is required for your data source.

  - If direct connection is not available:

    a. Ensure that the required ODBC driver for your data source is installed on your machine. MicroStrategy certifies and supports a range of ODBC drivers for connecting to data sources. For a list of certified and supported ODBC drivers, see *Data source and ODBC driver support, page 504*.

    If the required ODBC driver is not installed on your machine, you must install the ODBC driver made available through the third-party (non-MicroStrategy) vendor of the driver. Refer to the vendor’s documentation for steps. After installing an ODBC driver, you must shut down and restart MicroStrategy Desktop. For steps, see *Opening MicroStrategy Desktop, page 16*.

    b. Create a DSN for your data source. For steps, see *Creating a DSN, page 492*. 
To create a new database connection to a relational data source

1. Open a dashboard.

2. From the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.

3. Do one of the following:
   - To import data from Google BigQuery, complete the following steps:
     a. Click Google BigQuery.
     b. If you are not logged into your Google account, sign in using your Google username and password.
     c. If a message is displayed asking you to allow MicroStrategy to access your Google BigQuery data, select Allow Access.
   - To import data from Hadoop, click Hadoop.
   - To import data from any available data source connection, click Database.

   The Select Import Options dialog box opens.

4. Select one of the following and click Next. The Import from Tables page opens.
   - To pick relational tables, select Pick Tables.
   - To build a SQL query, select Build a Query.
   - To type a Freeform query, select Type a Query.

5. On the Data Sources panel, click Add. The Data Source dialog box opens.

6. Select the type of connection to your database, as follows:
   - To connect directly to a data source, complete the following steps:
     a. Select DSN-less Connections.
     b. From the Select drop-down list, select the database connection type.
     c. From the DBMS drop-down list, select the version of the data source that you are connecting to.
d. Provide the remaining configuration information that is required for your data source type, as described in Appendix B, Configuration Requirements for Data Sources.

e. If you clear the **Show databases whose drivers were not found** check box, only databases that have an installed and configured driver are available for selection. You can connect to these databases by supplying the required connection information. If you select the **Show databases whose drivers were not found** check box, additional databases that do not have a configured driver are available for selection. For steps to connect to these databases, see *Creating a DSNLess database connection that supports a third-party driver, page 494*.

• To connect to a data source that requires a DSN, complete the following steps:

  a. Select **DSN Connections**.

  b. From the **DSN** drop-down list, select the DSN of the database to connect to.

  c. From the **DBMS** drop-down list, select the appropriate database management system (DBMS).

  d. Provide the login name and password to use to connect to the database.

  ![Image](image.png)
  You can create a new DSN. Click the **Create new DSN** icon. The Windows ODBC Data Source Administrator opens. For steps to create a DSN using the Windows ODBC Data Source Administrator, see *Creating a DSN, page 492*. Refresh the MicroStrategy Desktop browser page after you create the DSN to apply your changes.

  7 In the **Data Source Name** field, type a name for the database connection.

  8 Click **OK** to create the connection.

  9 Once you have created a connection to your data source, you can import data from your data source. For steps, see:

    • *Importing data from a database by picking relational tables, page 80*

    • *Importing data from a database by building a SQL query, page 67*

    • *Importing data from a database by typing a query, page 113*
Creating a DSN

To import data from a database or with a custom query (a Freeform script), you establish communication between MicroStrategy and your data source. You can connect directly to a variety of data sources during the data import process. If your data source is a type that does not support direct connections during the data import process, you must create a DSN (data source name) for your data source. After you create a DSN, you can connect to the data source and import your data.

A DSN is the name for a pointer that is used by a client application (in this case MicroStrategy) to find and connect to a database. The information obtained through a DSN generally includes the host computer name or IP address, instance name, and database name. The exact information varies depending on the type of database server.

To determine whether your data source requires you to create a DSN, see Data source and ODBC driver support, page 504.

A DSN uses an ODBC (Open Database Connectivity) driver to establish connectivity to a database. An ODBC driver is a type of software that translates MicroStrategy Intelligence Server requests into commands that the database understands. For a list of ODBC drivers that are certified or supported for use with MicroStrategy Desktop, see Data source and ODBC driver support, page 504.

The Microsoft ODBC Data Source Administrator manages database drivers and data sources on Windows. The utility is available from Microsoft and is usually included with the purchase of an ODBC driver. You can use the utility to create a DSN for a database. You can then use the DSN to establish a database connection, for use in importing data from a database or with a Freeform script.
The steps below show you how to create a DSN using the Microsoft ODBC Data Source Administrator.

**Prerequisites**

- Determine whether your data source requires a DSN to connect with MicroStrategy Desktop. For a list of data sources that require a DSN, see *Data source and ODBC driver support, page 504.*

- Review the list of certified and supported ODBC drivers for use with MicroStrategy Desktop in *Data source and ODBC driver support, page 504.* If the required ODBC driver is not installed on your machine, you must install the ODBC driver made available through the third-party (non-MicroStrategy) vendor of the driver. Refer to the vendor’s documentation for steps. After installing an ODBC driver, you must shut down and restart MicroStrategy Desktop. For steps, see *Opening MicroStrategy Desktop, page 16.*

- You must log on to the machine using a Windows user account with administrative privileges.

**To create a DSN using the Microsoft ODBC Data Source Administrator**

1. Log in to the machine as an administrator. This gives you the ability to create a system-wide DSN, rather than a user-specific DSN. You must create system DSNs to use them with MicroStrategy Desktop.

2. To access the ODBC Data Source Administrator, do the following:
   - If you are using a 32-bit version of Windows, the Microsoft ODBC Data Source Administrator can be accessed from the Control Panel. Refer to your third-party Microsoft documentation for steps to access the ODBC Data Source Administrator tool.
   - If you are using a 64-bit version of Windows, the Microsoft ODBC Data Source Administrator that is accessed from the Control Panel only displays 64-bit drivers. To create a system-wide DSN, you must use the 32-bit version of Microsoft ODBC Data Source Administrator. To access this version of the tool, locate the Windows SysWOW64 folder. Within this folder, double-click the `odbcad32.exe` file.

3. Click the **System DSN** tab. A list displays all the existing system data sources and their associated drivers.

   To view all the installed ODBC drivers, click the **Drivers** tab.
4 Click **Add**. The Create New Data Source dialog box opens.

5 Select the desired driver and click **Continue**. A driver setup dialog box is displayed.

6 Enter the information in the appropriate fields to create a data source for the selected database driver. The information to enter varies depending on the database platform that you selected. For specific details, refer to the vendor’s documentation.

7 Click **OK** to create a new DSN.

8 Click **OK** to close the ODBC Data Source Administrator.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by picking relational tables, page 80*
- *Importing data from a database by typing a query, page 113*
- *Importing data from Hadoop, page 112*

**Creating a DSNLess database connection that supports a third-party driver**

You can import data into MicroStrategy databases that are not packaged with a MicroStrategy-branded driver. One way to connect to these databases is to use an existing DSN for the database when you create a database connection. If a DSN is not available, you can create a direct connection to the database. When creating a direct connection to these types of databases, you must ensure that Desktop can locate the correct driver for the database.

The steps below show you how to provide the required configuration information and update the driver name to support connections to these databases.

**Prerequisite**

- The driver for your data source must be installed. Steps to install drivers for your data source are provided in the *MicroStrategy Installation and
Configuration Guide. For the steps below, you need the name of the driver that is installed for your data source.

To create a new database connection

1 Open a dashboard.

2 From the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.

3 Do one of the following:
   • To import data from Google BigQuery, complete the following steps:
     a Click Google BigQuery.
     b If you are not logged into your Google account, sign in using your Google username and password.
     c If a message is displayed asking you to allow MicroStrategy to access your Google BigQuery data, select Allow Access.
   • To import data from Hadoop, click Hadoop.
   • To import data from any available data source connection, click Database.

The Select Import Options dialog box opens.

4 Select one of the following and click Next. The Import from Tables page opens.
   • To pick relational tables, select Pick Tables.
   • To build a SQL query, select Build a Query.
   • To type a Freeform query, select Type a Query.

5 On the Data Sources panel, click Add. The Data Source dialog box opens.

6 Select DSNLess Connections.

7 Ensure that the Show databases whose drivers were not found check box is selected.
8 From the Database and Version drop-down lists, select your database and version. Configuration requirements for the selected database are displayed.

9 Click Show connection string.

- Type the value for each configuration requirement listed. Depending on the database that you are connecting to, this includes the server name, port number, and database name. For a detailed list of the information required for each database type, see Data source and ODBC driver support, page 504.

- Select the Edit connection string check box. You can now edit the connection string.

- Modify the Driver={DriverName} part of the connection string, where DriverName is the default name used for the driver. Replace the default DriverName with the name of the driver that your administrator installed for the database.

- If there were any optional configuration parameters that you chose not to define, modify the connection string to remove the parameters completely from the string. These parameters are listed with an equal sign (=) followed immediately by a semicolon (;), indicating no value is provided. For example, if the connection string includes AlternateServers=; remove this text from the connection string.

10 Type a user name and password with access to the database in the User and Password fields.

11 Type a name for the database connection in the Data Source Name field.

12 Click OK to create the connection.

Related topics

- Creating a data source connection to a relational data source, page 488
- Creating a data source connection to a relational data source, page 488

Managing database connections

You can edit, delete, rename, or duplicate an existing database connection.
Prerequisite

- The steps below assume that you have created the database connection that you want to modify. For steps to create a database connection, see *Connecting to a Data Source to Import Data, page 487*. 

To duplicate, edit, or rename a database connection

1. Open the dashboard.

2. From the toolbar, click the **Add Data** icon, and then select **External Data**. The Connect to Your Data page opens.

3. Select the type of data source. The Import from Tables page opens.

4. On the Data Sources panel on the left, hover the cursor over the name of the database connection to modify, then click the arrow icon. Select from the following:
   - To duplicate the database connection, click **Duplicate**. The duplicate connection is automatically created and displayed in the Database Connections panel.
   - To edit the database connection, click **Edit**. The Database Connection dialog box opens. Edit the database connection by providing the appropriate details for the type of connection that you want to define, such as the database management system (DBMS), and the login name and password to use to connect to the database. The information required may vary depending on the specific type of database connection that you want to edit. Click **OK** to save your changes. For descriptions of the fields, see *Creating a data source connection to a relational data source, page 488*.
   - To rename the database connection, click **Rename**. Type the new name in the **Please Enter Name** field, then click **OK**. The connection is renamed.

To delete a database connection

1. Open the dashboard.

2. From the toolbar, click the **Add Data** icon, and then select **External Data**. The Connect to Your Data page opens.
3 Select the type of data source. The Import from Tables page opens.

4 On the Data Sources panel on the left, hover the cursor over the name of the database connection to delete, click the arrow icon, and select **Delete**. A confirmation message is displayed.

5 Click **Yes**. The database connection is deleted.

**Related topic**

- *Connecting to a Data Source to Import Data, page 487*

**Configuring OAuth parameters for a data source**

You can import data from different data sources, such as an Excel file, a table in a database, the results of a Freeform SQL query, or other data sources with minimum project design requirements. The following data sources require you to configure an OAuth connection between your third-party data source and MicroStrategy Desktop:

- Dropbox
- Facebook
- Google Analytics
- Google BigQuery
- Google Drive
- Salesforce.com
- Twitter

You must create an OAuth connection between your third-party data source and Desktop to make these data sources available for import, as described in *Connecting to a Data Source to Import Data, page 487*. Next, you must define the OAuth parameters for the connection, as described in the steps below.
To configure OAuth parameters for a data source

1 Open the dashboard.

2 From the toolbar, click the Add Data icon, and then select External Data. The Connect to Your Data page opens.

3 Hover your cursor over the data source to configure OAuth parameters for, and then click Set OAuth Parameters. The Set OAuth Parameters dialog box is displayed.

4 Provide the following information:
   - **Client ID**: Type the Client ID acquired by configuring MicroStrategy Desktop as a remote access application in your data source.
   - **Client Secret**: Type the Client Secret acquired by configuring MicroStrategy Desktop as a remote access application in your data source.

5 To use the default Client ID and Client Secret provided by MicroStrategy, click Reset to Default.

6 Click OK to save the OAuth parameter changes.

7 Continue importing data, as described in the steps below:
   - Importing data from a Dropbox file, page 91
   - Importing data from Facebook, page 93
   - Importing data from Google Analytics, page 96
   - Importing data from Google BigQuery, page 99
   - Importing data from a file stored on Google Drive, page 105
   - Importing data from a Salesforce report, page 107
   - Importing data from Twitter, page 110

Related topics

- Connecting to a Data Source to Import Data, page 487
- Importing Data into MicroStrategy Desktop, page 55
SYSTEM REQUIREMENTS

Certified and supported software, hardware, and data source types

Introduction

This section lists software and hardware requirements to support MicroStrategy Desktop. It also lists the data source types and ODBC drivers that are certified or supported for MicroStrategy Desktop. See the following topics:

- Software requirements, page 501
- Hardware requirements and recommendations, page 503
- Data source and ODBC driver support, page 504

Software requirements

To install and support MicroStrategy Desktop, your machine must meet the following software requirements.

MicroStrategy Desktop and MicroStrategy Analytics Enterprise, with the exception of MicroStrategy Office, cannot concurrently be installed on the same machine.
Software requirements: Windows

<table>
<thead>
<tr>
<th>Software</th>
<th>Software Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td><strong>Certified:</strong></td>
</tr>
<tr>
<td></td>
<td>• Windows Vista Business Edition SP2 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Vista Enterprise Edition SP2 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows 7 Professional Edition SP1 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows 7 Enterprise Edition SP1 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows 8.1 all editions (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Standard Edition R2 SP1 (on x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Enterprise Edition R2 SP1 (on x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Standard Edition SP2 (on x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2008 Enterprise Edition SP2 (on x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012 Standard (on x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2012 Standard R2 (on x64)</td>
</tr>
<tr>
<td></td>
<td><strong>Supported:</strong></td>
</tr>
<tr>
<td></td>
<td>• Windows XP Professional Edition SP3 (on x86)</td>
</tr>
<tr>
<td></td>
<td>• Windows XP Professional Edition SP2 (on x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 Enterprise Edition SP2 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 Standard Edition SP2 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 Enterprise Edition R2 SP2 (on x86 or x64)</td>
</tr>
<tr>
<td></td>
<td>• Windows Server 2003 Standard Edition R2 SP2 (on x86 or x64)</td>
</tr>
<tr>
<td>Export application</td>
<td><strong>Certified:</strong></td>
</tr>
<tr>
<td></td>
<td>• Adobe Reader 10.x and 11.x</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Office 2003 SP3</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Office 2007 SP2</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Office 2010 SP1</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Office 2013</td>
</tr>
</tbody>
</table>

Software requirements: Mac

<table>
<thead>
<tr>
<th>Software</th>
<th>Software Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td><strong>Certified:</strong></td>
</tr>
<tr>
<td></td>
<td>• OS X 10.8.x</td>
</tr>
<tr>
<td></td>
<td>• OS X 10.9.x</td>
</tr>
</tbody>
</table>

Definition of certified versus supported

MicroStrategy uses the following terminology when listing support for components made by third-party (non-MicroStrategy) vendors:

- **Certified:** The third-party component has been actively tested with the current release. All tests were passed with no significant issues that would prevent the use of any applicable MicroStrategy features. MicroStrategy
expects any certified third-party component to be used successfully with any and all applicable MicroStrategy functionality.

- **Supported**: A third-party component that has been listed as supported is expected to be used successfully with any and all applicable MicroStrategy functionality. A third-party component that is supported rather than certified means that its testing meets one or more of any of the following conditions:
  
  - Testing of a given version of the third-party component has been lowered in priority to focus testing efforts on newer versions of the third-party component. Proper functionality is implied through the comprehensive testing executed during a relevant previous release of MicroStrategy, along with some basic coverage using the current release. This transition period provides a migration path to the newer versions of the component.
  
  - The third-party component was put through full certification testing, but an issue was found, which caused a significant loss of functionality or degradation in performance, for at least one applicable MicroStrategy feature or functionality set.

Related topics

- *Hardware requirements and recommendations, page 503*
- *Installing MicroStrategy Desktop, page 4*

# Hardware requirements and recommendations

MicroStrategy acknowledges that variables such as CPU speed, CPU type, operating system version, service upgrades, file space, and physical and swap memory are factors that play an important role in making your deployment of MicroStrategy Desktop a successful one. See below for the hardware requirements and recommendations for MicroStrategy Desktop.
Required Hardware: Windows

<table>
<thead>
<tr>
<th>Clock Speed</th>
<th>Processor</th>
<th>Memory</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 GHz</td>
<td>x86 or x64 compatible</td>
<td>4 GB</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

Recommended Hardware: Windows

<table>
<thead>
<tr>
<th>Clock Speed</th>
<th>Processor</th>
<th>Memory</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 GHz or higher</td>
<td>x86 or x64 compatible</td>
<td>4 GB</td>
<td>6 GB</td>
</tr>
</tbody>
</table>

Required Hardware: Mac

<table>
<thead>
<tr>
<th>Clock Speed</th>
<th>Processor</th>
<th>Memory</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 GHz</td>
<td>x86 compatible</td>
<td>4 GB</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

Recommended Hardware: Mac

<table>
<thead>
<tr>
<th>Clock Speed</th>
<th>Processor</th>
<th>Memory</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 GHz or higher</td>
<td>x86 compatible</td>
<td>4 GB</td>
<td>6 GB</td>
</tr>
</tbody>
</table>

Related topics

- Software requirements, page 501
- Installing MicroStrategy Desktop, page 4

Data source and ODBC driver support

The following table identifies the ODBC drivers that are certified or supported for MicroStrategy Desktop and different data source types. An ODBC (Open Database Connectivity) driver is a type of software that translates MicroStrategy requests into commands that the database understands. ODBC drivers are used to establish connectivity to a database.
MicroStrategy-branded ODBC drivers are installed with MicroStrategy Desktop.

For a definition of the terms “certified” and “supported,” see Definition of certified versus supported, page 502.

The configurations listed below that support direct (DSNless) connections allow you to create a connection directly to the data source during the data import process, without creating a DSN, as described in Connecting to a Data Source to Import Data, page 487. You can also connect to all of the certified and supported connections listed below by creating a DSN, as described in Creating a DSN, page 492.

MicroStrategy certifies 32-bit ODBC drivers for connection to data sources on Windows. Therefore, all ODBC driver support listed below is for the 32-bit version of the driver.

<table>
<thead>
<tr>
<th>Data source</th>
<th>Driver (32-bit only)</th>
<th>Status</th>
<th>Support direct (DSNless) connection during data import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actian Ingres 10S</td>
<td>Client Runtime with configuration defaulted for Vectorwise</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Actian Vectorwise:</td>
<td>Client Runtime with configuration defaulted for Vectorwise</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>• 2.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 3.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Amazon EMR Cloud (Hive 0.10)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Hive, page 519.</td>
</tr>
<tr>
<td>Amazon Redshift</td>
<td>PostgreSQL ODBC Driver version 8.04.00, Unicode version</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Apache Hadoop (for Apache Hive 0.11, 0.10, and 0.9)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Hive, page 519.</td>
</tr>
<tr>
<td>Aster Database 4.6.x</td>
<td>Aster Database ODBC Driver version 4.6.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Aster Database 5.x</td>
<td>Aster Database ODBC Driver version 5.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Aster Database 6.0.x</td>
<td>Aster Database ODBC Driver version 6.0.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Data source</td>
<td>Driver (32-bit only)</td>
<td>Status</td>
<td>Support direct (DSNless) connection during data import</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Calpont InfiniDB:</td>
<td>MySQL ODBC Driver version 5.2.5</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>• 2.2.x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 3.x</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cisco Composite 6.0.x</td>
<td>Composite ODBC version 6.0.0.03.06</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Cisco Composite 6.1.x</td>
<td>Composite ODBC version 6.1.0.01.09</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Cisco Composite 6.2.x</td>
<td>Composite ODBC version 6.02.00.00</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Cloudera CDH (for Apache Hive 0.11, 0.10, and 0.9)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see <em>Hive, page 519</em>.</td>
</tr>
<tr>
<td>Cloudera Impala 1.x</td>
<td>MicroStrategy ODBC driver for Impala Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see <em>Impala, page 519</em>.</td>
</tr>
<tr>
<td>Connection Cloud</td>
<td>Connection Cloud Driver version 1.4.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Denodo 5.0</td>
<td>PostgreSQL ODBC Driver version 9.1, Unicode version</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>EnterpriseDB Postgres Plus 9.0</td>
<td>EnterpriseDB 9.0 ODBC driver version 9.0.4.14</td>
<td>Supported</td>
<td>No</td>
</tr>
<tr>
<td>EnterpriseDB Postgres Plus 9.1</td>
<td>EnterpriseDB 9.1 ODBC driver version 9.1.2.2</td>
<td>Supported</td>
<td>No</td>
</tr>
<tr>
<td>EXASolution 4.1</td>
<td>EXASolution Driver version 4.1</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>EXASolution 4.2</td>
<td>EXASolution Driver version 4.2</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Google BigQuery</td>
<td>Simba BigQuery ODBC Driver version 1.0.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Greenplum 4.1.x</td>
<td>MicroStrategy ODBC Driver for Greenplum Wire Protocol</td>
<td>Supported</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see <em>Greenplum, page 517</em>.</td>
</tr>
<tr>
<td>Data source</td>
<td>Driver (32-bit only)</td>
<td>Status</td>
<td>Support direct (DSNless) connection during data import</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------</td>
<td>----------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>Greenplum 4.2.x</td>
<td>MicroStrategy ODBC Driver for Greenplum Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Greenplum, page 517.</td>
</tr>
<tr>
<td>Hortonworks HDP (for Apache Hive 0.11, 0.10, and 0.9)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Hive, page 519.</td>
</tr>
<tr>
<td>HP Vertica 5.1</td>
<td>Vertica ODBC driver version 5.01.xx.xx</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>HP Vertica 6.0</td>
<td>Vertica ODBC driver version 6.00.xx.xx</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>HP Vertica 6.1</td>
<td>Vertica ODBC driver version 6.01.xx.xx</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>IBM DB2:</td>
<td>MicroStrategy ODBC Driver for DB2 Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see DB2 Wire, page 515.</td>
</tr>
<tr>
<td>• 9.5 with Fix pack 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 9.7 with Fix pack 8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 10.1 with Fix pack 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 10.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM DB2 for i:</td>
<td>MicroStrategy ODBC Driver for DB2 Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see DB2 iSeries, page 514.</td>
</tr>
<tr>
<td>• 6.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 7.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM DB2 for z/OS</td>
<td>MicroStrategy ODBC Driver for DB2 Wire Protocol</td>
<td>Supported</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see DB2 z/OS, page 516.</td>
</tr>
<tr>
<td>• 9.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Informix IDS:</td>
<td>MicroStrategy ODBC Driver for Informix Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Informix Wire, page 521.</td>
</tr>
<tr>
<td>• 11.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Informix Ultimate Edition:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 11.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 12.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM Informix XPS 8.5</td>
<td>MicroStrategy ODBC Driver for Informix 8 with Informix Client SDK 3.50.TC5</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Informix XPS, page 522.</td>
</tr>
<tr>
<td>Data source</td>
<td>Driver (32-bit only)</td>
<td>Status</td>
<td>Support direct (DSNless) connection during data import</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------</td>
<td>--------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>IBM InfoSphere BigInsights 2.x</td>
<td>BigInsights ODBC Driver version 2.1</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>IBM Netezza 4.6.x</td>
<td>IBM Netezza ODBC Driver version 4.6.x</td>
<td>Supported</td>
<td>No</td>
</tr>
<tr>
<td>IBM Netezza 5.0.x</td>
<td>IBM Netezza ODBC Driver version 5.0.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>IBM Netezza 6.0.x</td>
<td>IBM Netezza ODBC Driver version 6.0.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>IBM Netezza 7.0.x</td>
<td>IBM Netezza ODBC Driver version 7.0.x</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>IBM Red Brick 6.3</td>
<td>IBM Red Brick Driver (6.30.TC12)</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Infobright 4.0.x</td>
<td>MicroStrategy ODBC Driver for MySQL Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Infobright, page 520.</td>
</tr>
<tr>
<td>Intel Distribution for Apache Hadoop (for Apache Hive 0.11, 0.10, and 0.9)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Hive, page 519.</td>
</tr>
<tr>
<td>Kognitio WX2 7.1.x</td>
<td>ODBC Driver for Kognitio WX2 version 7.1.2</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Kognitio WX2 7.2.x</td>
<td>ODBC Driver for Kognitio WX2 version 7.2</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>MapR (for Apache Hive 0.11, 0.10, and 0.9)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Hive, page 519.</td>
</tr>
<tr>
<td>MarkLogic 7.0</td>
<td>MarkLogic SQL ODBC Driver version 9.02.01.00</td>
<td>Supported</td>
<td>No</td>
</tr>
<tr>
<td>Maria DB 5.5.x</td>
<td>MySQL ODBC Driver version 5.2.5, Unicode version</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Data source</td>
<td>Driver (32-bit only)</td>
<td>Status</td>
<td>Support direct (DSNless) connection during data import</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft Access:</td>
<td>Microsoft Access Driver</td>
<td>Supported</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see MicroStrategy Access, page 523.</td>
</tr>
<tr>
<td>Microsoft Excel 2000 and 2003</td>
<td>Microsoft Excel Driver</td>
<td>Certified</td>
<td>No. You can also import data from an Excel spreadsheet as a file, as described in Importing data from a file, page 62.</td>
</tr>
<tr>
<td>Microsoft SQL Database</td>
<td>Microsoft SQL Server 2008 SP3 Native Client ODBC Driver</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Microsoft SQL Server:</td>
<td>SQL Server ODBC Driver (version number dependent on the certified operating system)</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see SQL Server, page 527.</td>
</tr>
<tr>
<td>2005 SP4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008 R2 SP1/SP2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2008 SP3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2012 SP1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft SQL Server Parallel Data Warehouse 2008 R2</td>
<td>Microsoft SQL Server 2008 R2 Parallel Data Warehouse ODBC Client 1.00.17.70</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>MongoDB 2.4</td>
<td>Simba MongoDB ODBC Driver version 0.04.x</td>
<td>Supported</td>
<td>No</td>
</tr>
<tr>
<td>MySQL Community Edition:</td>
<td>MySQL ODBC Driver version 5.2.5, Unicode version</td>
<td>Supported</td>
<td>No</td>
</tr>
<tr>
<td>5.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MySQL Enterprise Edition:</td>
<td>MySQL ODBC Driver version 5.2.5, Unicode version</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>5.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data source</td>
<td>Driver (32-bit only)</td>
<td>Status</td>
<td>Support direct (DSNless) connection during data import</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------------------------------------------------</td>
<td>-----------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td>MySQL Enterprise Edition:</td>
<td>MicroStrategy ODBC Driver for MySQL Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see MySQL, page 523.</td>
</tr>
<tr>
<td>Oracle:</td>
<td>MicroStrategy ODBC Driver for Oracle Wire Protocol</td>
<td>Supported</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Oracle, page 524.</td>
</tr>
<tr>
<td>ParAccel:</td>
<td>ODBC Driver for ParAccel version 2.0.1</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Pivotal HD (for Apache Hive 0.11, 0.10, and 0.9)</td>
<td>MicroStrategy ODBC Driver for Apache Hive Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Hive, page 519.</td>
</tr>
<tr>
<td>PostgreSQL:</td>
<td>MicroStrategy ODBC Driver for PostgreSQL Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see PostgreSQL, page 526.</td>
</tr>
<tr>
<td>Salesforce.com</td>
<td>MicroStrategy ODBC Driver for Salesforce</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see Salesforce, page 526.</td>
</tr>
<tr>
<td>SAND CDBMS 6.1</td>
<td>Nucleus ODBC Driver version 3.01.2067.00</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>SAND CDBMS 7.1</td>
<td>Nucleus ODBC Driver version 7.01.3327.00</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>SAP HANA:</td>
<td>HDBODC32 Driver version 1.00.56.49638</td>
<td>Certified</td>
<td>No</td>
</tr>
</tbody>
</table>
## Data source

<table>
<thead>
<tr>
<th>Data source</th>
<th>Driver (32-bit only)</th>
<th>Status</th>
<th>Support direct (DSNless) connection during data import</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA 1.0 SP6</td>
<td>SAP HANA Driver version 1.00.68</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>SAP Sybase ASE 15</td>
<td>MicroStrategy ODBC Driver for Sybase ASE Wire Protocol</td>
<td>Supported</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see <a href="#">Sybase ASE, page 528</a>.</td>
</tr>
<tr>
<td>SAP Sybase ASE:</td>
<td>MicroStrategy ODBC Driver for Sybase ASE Wire Protocol</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see <a href="#">Sybase ASE, page 528</a>.</td>
</tr>
<tr>
<td>• 15.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 15.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SAP Sybase IQ15.2</td>
<td>Sybase IQ ODBC Driver (15.2 IQ Network Client ESD #3)</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>SAP Sybase IQ 15.3</td>
<td>Sybase IQ ODBC Driver (15.3 IQ Network Client)</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>SAP Sybase IQ 15.4</td>
<td>Sybase IQ ODBC Driver (15.4 IQ Network Client ESD #3)</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>SAP Sybase IQ 16.0</td>
<td>Sybase IQ ODBC Driver (16.0 IQ Network Client SP #01)</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>Teradata:</td>
<td>Teradata ODBC Driver version 14.10.xx.xx</td>
<td>Certified</td>
<td>No</td>
</tr>
<tr>
<td>• V12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• V13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• V13.10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• V14.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• V14.10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Web services data sources</td>
<td>No driver required</td>
<td>Certified</td>
<td>Yes. To review a list of configuration information required for a DSNless connection to this data source, see <a href="#">Web services, page 529</a>.</td>
</tr>
</tbody>
</table>

### Related topics

- *Connecting to a Data Source to Import Data, page 487*
- *Managing database connections, page 496*
CONFIGURATION REQUIREMENTS FOR DATA SOURCES

Introduction

To import data from a database or with a custom database query (a Freeform script), you establish communication between MicroStrategy and your database by creating a database connection. You can connect directly to a variety of data sources during the data import process, without having to create a DSN. This can streamline the process of importing data from your data source. For a list of data sources that you can connect to without having to create a DSN, see the list of data sources that support direct (DSNless) connections in Data source and ODBC driver support, page 504.

You create a connection to a data source during the data import process. For steps, see Connecting to a Data Source to Import Data, page 487.

The configuration information required for your data source is described in the following sections:

- DB2 iSeries, page 514
- DB2 Wire, page 515
- DB2 z/OS, page 516
- Greenplum, page 517
For more information about importing data, see Importing data from a database by building a SQL query, page 67 and Importing data from Google Analytics, page 96.

**DB2 iSeries**

To connect to a DB2 iSeries data source, provide the following information:

- **DBMS**: The version of the DB2 iSeries data source you are connecting to. For a list of certified and supported data source versions, see Data source and ODBC driver support, page 504.

- **IP Address**: The IP address of the machine where the catalog tables are stored. This can be either a numeric address such as 123.456.789.98, or a host name. If you use a host name, it must be located in the HOSTS file of the machine or a DNS server.

- **Collection**: The name that identifies a logical group of database objects.

- **Location**: The DB2 iSeries location name, which is defined during the local DB2 installation.
• **Isolation Level**: The method by which locks are acquired and released by the system. Refer to your third-party DB2 iSeries documentation for information on the available isolation levels.

• **Package Owner (Optional)**: The package’s AuthID if you want to specify a fixed user to create and modify the packages on the database. The AuthID must have authority to execute all the SQL in the package.

• **TCP Port**: The DB2 DRDA listener process’s port number on the server host machine provided by your database administrator. The default port number is usually **446**. Check with your database administrator for the correct number.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.

• **Name**: A name to identify the DB2 iSeries data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

---

**DB2 Wire**

To connect to a DB2 Wire Protocol data source, provide the following information:

• **DBMS**: The version of the DB2 Wire Protocol data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

• **IP Address**: The IP address of the machine where the catalog tables are stored. You can use an IP address such as `123.456.78.90`, or a host name. If you use a host name, it must be located in the HOSTS file of the machine or a DNS server.

• **TCP Port**: The DB2 DRDA listener process’s port number on the server host machine provided by your database administrator. The default port
number is usually 50000. Check with your database administrator for the correct number.

- **Database Name**: The name of the database to connect to by default.
- **User**: The name of a valid user account for the data source.
- **Password**: The password for the data source user account provided above.
- **Name**: A name to identify the DB2 Wire Protocol data source configuration in MicroStrategy Desktop.

Related topics

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

**DB2 z/OS**

To connect to a DB2 z/OS data source, provide the following information:

- **DBMS**: The version of the DB2 z/OS data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

- **IP Address**: The IP address of the machine where the catalog tables are stored. This can be either a numeric address such as 123.456.789.98, or a host name. If you use a host name, it must be located in the HOSTS file of the machine or a DNS server.

- **Collection**: The name that identifies a logical group of database objects, which is also the current schema. On DB2 z/OS, the user ID should be used as the Collection.

- **Location**: The DB2 z/OS location name, which is defined during the local DB2 z/OS installation. To determine the DB2 location, you can run the command `DISPLAY DDF`.

- **Package Collection**: The collection or location name where bind packages are created and stored for searching purposes.
• **Package Owner (Optional):** The package’s AuthID if you want to specify a fixed user to create and modify the packages on the database. The AuthID must have authority to execute all the SQL in the package.

• **TCP Port:** The DB2 DRDA listener process’s port number on the server host machine provided by your database administrator. The default port number is usually 446.

• **User:** The name of a valid user account for the data source.

• **Password:** The password for the data source user account provided above.

• **Name:** A name to identify the DB2 z/OS data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

**Greenplum**

To connect to a Greenplum data source, provide the following information:

• **DBMS:** The version of the Greenplum data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504.*

• **Host Name:** The name or IP address of the machine on which the Greenplum data source resides.

• **Port Number:** The port number for the connection. The default port number for Greenplum is usually 5432. Check with your database administrator for the correct number.

• **Database Name:** The name of the database to connect to by default. The database administrator assigns the database name.

• **Alternate Servers:** A list of alternate database servers to enable connection failover for the driver. If the primary database server is unavailable, a connection to the servers in this list is attempted until a
connection can be established. You can list the servers in the following format:

HostName=Host:PortNumber=Port:Database=Database

In the syntax listed above:

- **Host**: Is the name or IP address of the machine on which the alternate Greenplum data source resides.
- **Port**: The port number for the alternate connection.
- **Database**: The name of the database to connect to by default for the alternate Greenplum data source.

To provide multiple alternate servers for failover, each HostName, PortNumber, and Database combination must be separated by commas, as shown in the example below:

HostName=GreenplumServer1:PortNumber=5432:Database=Database1,
HostName=GreenplumServer2:PortNumber=5432:Database=Database2

- **User**: The name of a valid user account for the data source.
- **Password**: The password for the data source user account provided above.
- **Name**: A name to identify the Greenplum data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*
Hive

To connect to a Hive data source, provide the following information:

- **DBMS**: The version of the Hive data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

- **Host Name**: The name or IP address of the machine on which the Hive data source resides. The system administrator or database administrator assigns the host name.

- **Database Name**: The name of the database to connect to by default. If no database name is provided, the default database is used for the connection. The database administrator assigns the database name.

- **Port Number**: The port number for the connection. The default port number for Hive is usually **10000**. Check with your database administrator for the correct number.

- **User**: The name of a valid user account for the data source.

- **Password**: The password for the data source user account provided above.

- **Name**: A name to identify the Hive data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*

- *Importing data from a database by building a SQL query, page 67*

- *Importing data from Google Analytics, page 96*

Impala

To connect to an Impala data source, provide the following information:

- **DBMS**: The version of the Impala data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.
- **Server Name**: The name or IP address of the machine on which the Impala data source resides. The system administrator or database administrator assigns the host name.

- **Port Number**: The port number for the connection. The default port number for Impala is usually **21050**. Check with your database administrator for the correct number.

- **User**: The name of a valid user account for the data source.

- **Password**: The password for the data source user account provided above.

- **Name**: A name to identify the Impala data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

**Infobright**

To connect to an Infobright data source, provide the following information:

- **DBMS**: The version of the Infobright data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

- **Host Name**: The name or IP address of the machine on which the Infobright data source resides. The system administrator or database administrator assigns the host name.

- **Port Number**: The port number for the connection. Check with your database administrator for the correct number.

- **Database Name**: The name of the database to connect to by default. The database administrator assigns the database name.

- **User**: The name of a valid user account for the data source.

- **Password**: The password for the data source user account provided above.
• **Name**: A name to identify the Infobright data source configuration in MicroStrategy Desktop.

**Related topics**

• *Connecting to a Data Source to Import Data, page 487*
• *Importing data from a database by building a SQL query, page 67*
• *Importing data from Google Analytics, page 96*

### Informix Wire

To connect to an Informix Wire Protocol data source, provide the following information:

• **DBMS**: The version of the Informix Wire Protocol data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

• **Server Name**: The client connection string designating the server and database to be accessed.

• **Host Name**: The name of the machine on which the Informix server resides. The system administrator or database administrator assigns the host name.

• **Port Number**: The Informix server listener’s port number. The default port number for Informix is commonly **1526**. Check with your database administrator for the correct number.

• **Database Name**: The name of the database to connect to by default, which is assigned by the database administrator.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.

• **Name**: A name to identify the Informix Wire Protocol data source configuration in MicroStrategy Desktop.
Informix XPS

To connect to an Informix XPS (eXtended Parallel Server) data source, provide the following information:

• **DBMS**: The version of the Informix XPS data source you are connecting to. For a list of certified and supported data source versions, see Data source and ODBC driver support, page 504.

• **Database**: The name of the database to connect to by default, which is assigned by the database administrator.

• **Server Name**: The client connection string designating the server and Informix XPS database to be accessed.

• **Host Name**: The name of the machine on which the Informix XPS server resides.

• **Service Name**: The service name, as it exists on the host machine. The system administrator assigns the service name.

• **Protocol Type**: The protocol used to communicate with the server.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.

• **Name**: A name to identify the Informix XPS data source configuration in MicroStrategy Desktop.

Related topics

• Connecting to a Data Source to Import Data, page 487

• Importing data from a database by building a SQL query, page 67

• Importing data from Google Analytics, page 96
Microsoft Access

To connect to a Microsoft Access data source, provide the following information:

- **DBMS**: The version of the Microsoft Access data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.
- **File Path**: The directory where the Microsoft Access database file is stored.
- **User**: The name of a valid user account for the data source.
- **Password**: The password for the data source user account provided above.
- **Name**: A name to identify the Microsoft Access data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

MySQL

To connect to a MySQL data source, provide the following information:

- **DBMS**: The version of the MySQL data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.
- **Host Name**: The name or IP address of the machine on which the MySQL data source resides. The system administrator or database administrator assigns the host name.
- **Database Name**: The name of the database to connect to by default. The database administrator assigns the database name.
• **Port Number**: The port number for the connection. The default port number for MySQL is usually 3306. Check with your database administrator for the correct number.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.

• **Name**: A name to identify the MySQL data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

**Oracle**

To connect to an Oracle data source, provide the following information:

• **DBMS**: The version of the Oracle data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

• **Standard Connection**: A standard connection is configured with the following connection parameters:

  □ **Host Name**: The name of the Oracle server to be accessed. This can be a server name such as Oracle-1 or an IP address such as 123.456.789.98.

  □ **Port Number**: The Oracle listener port number provided by your database administrator. The default port number is usually 1521.

  □ One of the following parameters; which one you choose is up to your personal preference:

    - **SID**: The Oracle System Identifier for the instance of Oracle running on the server. The default SID is usually ORCL.

    - **Service Name**: The global database name, which includes the database name and the domain name. For example, if your
database name is finance and its domain is business.com, the service name is finance.business.com.

- **Alternate Servers:** A list of alternate database servers to enable connection failover for the driver. If the primary database server entered as the SID or service name is unavailable, a connection to the servers in this list is attempted until a connection can be established. You can list the servers in SID or service name format, as shown in the following examples:
  - Using an SID: (HostName=DB_server_name:PortNumber=1526:SID=ORCL)
  - Using a Service Name: (HostName=DB_server_name:PortNumber=1526:ServiceName=service.name.com)

- **TNSNames Connection:** A TNSNames connection uses a TNSNAMES.ORA file to retrieve host, port number, and SID information from a server (alias or Oracle net service name) listed in the TNSNAMES.ORA file. A TNSNames connection requires the following parameters:
  - **Server Name:** A server name, which is included in a TNSNAMES.ORA file included in the TNSNames File text box described below.
  - **TNSNames File:** The location of your TNSNAMES.ORA file. Make sure to enter the entire path to the TNSNAMES.ORA file, including the file name itself. You can specify multiple TNSNAMES.ORA files.
  - **User:** The name of a valid user account for the data source.
  - **Password:** The password for the data source user account provided above.
  - **Name:** A name to identify the Oracle data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*
PostgreSQL

To connect to a PostgreSQL data source, provide the following information:

- **DBMS**: The version of the PostgreSQL data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*.

- **Host Name**: The name or IP address of the machine on which the PostgreSQL data source resides. The system administrator or database administrator assigns the host name.

- **Port Number**: The port number for the connection. The default port number for PostgreSQL is usually **5432**. Check with your database administrator for the correct number.

- **Database Name**: The name of the database to connect to by default. The database administrator assigns the database name.

- **User**: The name of a valid user account for the data source.

- **Password**: The password for the data source user account provided above.

- **Name**: A name to identify the PostgreSQL data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*

- *Importing data from a database by building a SQL query, page 67*

- *Importing data from Google Analytics, page 96*

Salesforce

To connect to a Salesforce data source, provide the following information:

- **DBMS**: The version of the Salesforce data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504*. 
- **Host Name**: The URL used to log in to the Salesforce.com system. You can keep the default of login.salesforce.com to connect to the production instance. However, you can also connect to other systems such as test.salesforce.com if you are connecting to testing environments.

- **User**: The name of a valid user account for the data source.

- **Password**: The password for the data source user account provided above.

- **Name**: A name to identify the Salesforce data source configuration in MicroStrategy Desktop.

**Related topics**

- Connecting to a Data Source to Import Data, page 487
- Importing data from a database by building a SQL query, page 67
- Importing data from Google Analytics, page 96

**SQL Server**

To connect to a SQL Server data source, provide the following information:

- **DBMS**: The version of the SQL Server data source you are connecting to. For a list of certified and supported data source versions, see Data source and ODBC driver support, page 504.

- **Server, Port**: The name of a SQL Server on your network, in the format `ServerName_or_IPAddress,PortNumber`. For example, if your network supports named servers, you can specify an address such as SQLServer-1,1433. You can also specify the IP address such as 123.45.678.998,1433.

  Additionally, if you use named instances to distinguish SQL Server databases, you can include the named instance along with either the server name or IP address using the format `ServerName\NamedInstance or IPAddress\NamedInstance`. The following are examples of providing the server name for your SQL Server database:

  - SQLServer-1\Instance1,1433
  - 123.45.678.998\Instance1,1433
• **Database Name**: The name of the database to connect to by default. The database administrator assigns the database name.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.

• **Name**: A name to identify the SQL Server data source configuration in MicroStrategy Desktop.

**Related topics**

• *Connecting to a Data Source to Import Data, page 487*

• *Importing data from a database by building a SQL query, page 67*

• *Importing data from Google Analytics, page 96*

**Sybase ASE**

To connect to a Sybase ASE (Adaptive Server Enterprise) data source, provide the following information:

• **DBMS**: The version of the Sybase ASE data source you are connecting to. For a list of certified and supported data source versions, see *Data source and ODBC driver support, page 504.*

• **Network Address**: The network address of the machine on which the Sybase ASE data source resides, in the format `ServerName_or_IPAddress, PortNumber`. For example, if your network supports named servers, you can specify an address such as `SybaseASE-1,5000`. You can also specify the IP address such as `123.456.789.98,5000`. Contact your system administrator for the server name or IP address.

• **Database Name**: The name of the database to connect to by default. The database administrator assigns the database name.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.
• **Name**: A name to identify the Sybase ASE data source configuration in MicroStrategy Desktop.

**Related topics**

- *Connecting to a Data Source to Import Data, page 487*
- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google Analytics, page 96*

---

**Web services**

To connect to a web services data source, provide the following information:

• **DBMS**: The type of web services data source you are connecting to. You have the following options:

  ▪ **XQuery**: Provides connection to a web services data source by using XQuery statements to retrieve data. XQuery is a language for processing XML data. Any web service that uses the REST architecture or SOAP protocol can be accessed using MicroStrategy Desktop. Refer to your third-party XQuery documentation for information on how to create XQuery statements. For steps to connect to a specific web services data source and retrieve data through the use of XQuery statements, see *Importing data from Google Analytics, page 96*.

  ▪ **Salesforce SOQL**: Provides connection to a Salesforce data source by using Salesforce Object Query Language (SOQL) statements to retrieve data. SOQL is a language for processing data from Salesforce data sources. Refer to your third-party Salesforce documentation for information on how to create SOQL statements. For steps to connect to a specific Salesforce data source and retrieve data through the use of SOQL statements, see *Importing data from Google Analytics, page 96*.

    You can also connect to Salesforce data sources and retrieve data by including tables and columns of data. For information on connecting to Salesforce data sources in this way, see *Salesforce, page 526*.

• **User**: The name of a valid user account for the data source.

• **Password**: The password for the data source user account provided above.
• **Name**: A name to identify the web services data source configuration in MicroStrategy Desktop.

**Related topics**

• *Connecting to a Data Source to Import Data, page 487*
• *Importing data from a database by building a SQL query, page 67*
• *Importing data from Google Analytics, page 96*
Interfaces for Data Import, Dashboard Creation, and Preferences

Introduction

For descriptions of the dialog boxes and other user interfaces in MicroStrategy Desktop, see the following sections:

- Interfaces for importing data, page 531
- Interfaces for creating dashboards, page 548
- Interfaces for formatting dashboard objects, page 575
- Preferences dialog box, page 618

Interfaces for importing data

You import data directly into MicroStrategy Desktop, for use in creating dashboards. You can import data from many different data sources, such as an Excel file or a database, or by using the results of a custom database query. You can import data into a new dataset or add the data to an existing dataset. You can select multiple tables to create a single, multi-table dataset.
The Connect to Your Data page lists the available data sources.

- The data sources are displayed in a grid by default. You can change the view to a list of the data sources and databases, by clicking the **List** icon. To return to the grid view, click the **Grid** icon.

- You can display only the data sources that access data directly, by clicking **Connect Live**. To display all data sources, whether they access data directly or from memory, click **All**. For more details about the difference, and steps to change how a dataset accesses data, see *Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160*.

For steps to import data from various data sources, see the appropriate topic below:

- *Importing data from a file, page 62*. The file can be in a selected folder, URL, or file URI scheme.

- *Importing data from a database by picking relational tables, page 80*.

- *Importing data from a database by building a SQL query, page 67*.

- *Importing data from a database by typing a query, page 113*.

- *Importing data from Hadoop, page 112*.

- *Importing data from a Salesforce report, page 107*.

- *Importing data from Google Analytics, page 96*.

- *Importing data from Google BigQuery, page 99*.

- *Importing data from a file stored on Google Drive, page 105*.

- *Importing data from a Dropbox file, page 91*.

- *Importing custom data by typing or pasting values, page 83*.

- *Importing data from a BI tool, page 85*. BI tools include SAP Business Objects Universe (BO), Oracle Business Intelligence Enterprise Edition (OBIEE), and IBM Cognos Framework Manager.

- *Importing data from Facebook, page 93*.

- *Importing data from Twitter, page 110*.

- *Importing data from a sample file, page 109*.

- *Suggesting a data source for data import, page 120*. 
After you import the data from the data source, you can modify and refine the data, using the interfaces listed below, before adding it as a dataset to your dashboard. You can use the same interfaces to make changes to your data after it has been imported.

- **Preview page, page 534**, displays a preview of the data before it is imported and allows you to further define the data. For example, you can designate a data column as an attribute or a metric, assign a geo role to a data column to generate additional geographical data, use data columns as attribute forms to define a new multiform attribute, and so on. You can view the objects in each table.

- **Parse Your Data page, page 538**, which allows you to select whether to import your data in a tabular or cross-tabbed layout. You can also insert column headers into the data, if the file does not provide them.

- **Wrangle Your Data page, page 540**, which allows you to explore your data to evaluate its quality and usability, and then improve its quality before importing. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on.

- **All Objects View page, page 536**, displays all the objects in all of the tables. You can define the data, as in the Preview page, and can also improve performance by partitioning a very large dataset and creating search indexes for attributes.

**Related topics**

- **Importing Data into MicroStrategy Desktop, page 55**
- **Best practices: Importing data into MicroStrategy Desktop, page 59**

**Select Import Options dialog box**

When you import from a database, Hadoop, or Google BigQuery, you can select how to import the data. The options are:

- **Pick Tables**: An intuitive visual interface makes it easy to build to import your data by dragging and dropping relational tables. For steps, see **Importing data from a database by picking relational tables, page 80** or **Importing data from Google BigQuery, page 99**.

- **Build a Query**: An intuitive visual interface makes it easy to build the SQL query that imports your data by dragging and dropping tables,
selecting columns, defining joins, and specifying filter conditions. For steps, see *Importing data from a database by building a SQL query*, page 67.

- **Type a Query**: A Freeform script, or query, allows you to write your own database queries to retrieve data from a relational database, giving you full control over accessing your data. For steps, see *Importing data from a database by typing a query*, page 113.

### Related topics

- *Importing Data into MicroStrategy Desktop*, page 55
- *Interfaces for importing data*, page 531

### Preview page

When you import data into MicroStrategy Desktop, a preview of your data is displayed. You can select options to modify your data before it is imported, or make changes to your data after it has been imported.

For example, MicroStrategy Desktop automatically designates data columns in your file as attributes or metrics based on the values contained in each data column, with attributes displayed in blue with an attribute icon 🌟 and metrics displayed in orange with a metric icon 🍃. You can manually designate data columns as attributes or metrics before the dataset is saved.

You can:

- Preview your data before it is imported
- Select the worksheet of data to import, if you are importing the data from an Excel workbook with more than one worksheet
- Designate a data column of data as an attribute or a metric
- Automatically generate additional time-related information based on the contents of a data column
- Assign a geo role to a data column, to generate additional geographical data and to allow for easier integration with map-based visualizations
The Preview page contains the following areas and options:

- **Tables**: Displays the tables to be imported. If you selected multiple files to create a multi-table dataset, you can change which file is previewed by clicking a different table. To define import options for a table, hover the cursor over the table name in the Tables area, then click the icon. The following list of options is displayed:
  - **Refresh Data**: Refreshes the data from its source, after you’ve made changes.
  - **Rename**: Renames the table.
  - **Delete**: Deletes the table before it is imported.
  - **Define Relationships**: Allows you to define how tables and columns are joined and used, and which tables are related to other tables. For steps, see *Defining relationships between attributes, page 138*.
  - **Show All Attribute Forms**: Displays all available attribute forms for all attributes in the table.
  - **Show All Columns**: Allows you to select the columns to display.

- **Preview**: Displays a preview of the data that will be imported. To define a data column, hover the cursor over the column name in the Preview area, then click the arrow icon. The following list of options is displayed:
  - **Change Data Type**: Changes the data type of the data column.
  - **Convert to Attribute**: Defines the data column as an attribute.
  - **Convert to Metric**: Defines the data column as a metric.
  - **Create Geo Attributes**: Assigns a geo role to the data column to generate additional geographical data for easier integration with map-based visualizations. For a more detailed description of the interface, see *Geo Attribute dialog box, page 544*.
  - **Do Not Import**: Removes this data column from the import process.
  - **Rename**: Renames the data column.

You can hide the preview by clearing the **Show Preview** check box. If you hide the preview, you can still define data columns. In the Tables area, right-click the data column. The same options listed above, such as Change Data Type, are displayed.

- **All Objects View**: Click to display all the objects in all of the tables on the same interface. You can define the data, using the same options listed in Preview above. Additionally, you can also partition the dataset and create
search indexes. For detailed descriptions of the options, see *All Objects View page, page 536*.

- **Parse**: Click to select whether to import your data in a tabular or cross-tabbed layout. You can also insert column headers into the data, if the file does not provide them. For detailed descriptions of the options, see *Parse Your Data page, page 538*.

  The Parse Data option is not available if you are importing data from a database.

- **Wrangle**: Click to evaluate your data’s quality and usability, and then refine your data to improve its quality before you import it into MicroStrategy Desktop. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on. For a more detailed description of the interface, see *Wrangle Your Data page, page 540*.

  The Wrangle Your Data option is available for selected data sources.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Managing data in a dashboard, page 151*

**All Objects View page**

The All Objects View page is displayed as part of the data import process. Use the All Objects View page to:

- View, search, and define objects across all tables that are being imported. For a description of the available options, see *Defining data, page 537*.

- Divide very large datasets into multiple segments, called partitions. For an overview of this process, and the available options, see *Partitioning data, page 538*. 
Defining data

Use the All Objects View page to display all the objects in all the tables that you are importing. If you want to view the objects in a single table, or preview the data in the table, use the Preview page, page 534.

You can:

- Search for objects in all the tables.
- Sort attributes or metrics. To do so, hover the cursor over the Attributes or Metrics header, then click the arrow icon, and select Sort Ascending or Sort Descending.
- Quickly convert an attribute to a metric, or a metric to an attribute, by dragging the object from one column to another.
- Quickly convert multiple objects at once. Press the Shift key while selecting the objects, and then drag them while holding down the Shift key.

To define an object, you can hover the cursor over the object, then click the arrow icon, and select one of the following:

- To exclude the object when importing your data, select Do Not Import.
- To define the object as an attribute, select Convert to Attribute.
- To define the object as a metric, select Convert to Metric.
- To assign a geo role or shape key to the data column for easier data integration with map-based visualizations, select one of the following:
  - To assign a geo role to the data column, point to Define Geography, then select the geo role to assign, such as City, State, or Latitude. Select the check box next to each attribute to have automatically generated based on the data column, then click OK.
  - To define the data column without assigning it a geo role, point to Define Geography, select None, then click OK.

For background information about geo roles, see Preparing your data to display on maps: Geo roles, page 135.

The Define Geography option is not available for data imported from Hadoop.

- To change the data type of the column, point to Change Data Type, and select the data type to use.
• To rename the data column, select Rename. Type a name in the field and press ENTER.

**Partitioning data**

If you are importing very large datasets into MicroStrategy Desktop, you can divide the dataset into multiple segments, called partitions. The data in the partitions is processed simultaneously, improving the performance of your dashboard. If you will create filters that use a search box, you can improve the performance of the search by creating a search index for the attributes in your dataset. For recommendations when you create partitions and search indexes, see *Improving performance: Partitioning large datasets and creating search indexes, page 127*.

The partitioning options on the All Objects View page include:

- **Partition Attribute**: The attribute ID of the attribute used to split the dataset.
- **Number of Partitions**: Number of segments to split your dataset into.
- **Search Index**: Enables the search index for the attribute.

**Related topics**

- *Improving performance: Partitioning large datasets and creating search indexes, page 127*
- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Managing data in a dashboard, page 151*

**Parse Your Data page**

By default, MicroStrategy Desktop assumes that your data is stored in a simple tabular layout, with each column in the table containing a separate attribute or metric. You can also import data stored in a cross-tabbed layout, with attributes and metrics stored in both table rows and columns. Select one of the following options:

- To import data from a simple tabular layout, select **Tabular**. By default, MicroStrategy Desktop uses the first row of data as headers for the
imported data columns. These column headers are then displayed as the names of the attributes and metrics that you define.

If the data in the imported file does not provide column headers for the data columns, you can specify the column headers manually by doing the following:

a  Select the **Insert new column headers** check box. A default column header is automatically inserted for each data column.

b  To specify a name for a column header, hover the cursor over a column, then click the arrow icon in the top right. Select **Rename**, then type a name for the header in the field and press ENTER.

- To import data from a cross-tabbed layout, select **Crosstab**. A preview of your data is displayed, with cells of data that contain metric data, attribute data, and metric header names each displayed in separate colors. The legend in the top right lists the colors in which each type of data is displayed. Perform the following steps:

  a  Click and drag the edges of the **Metric Data area** to highlight each cell that contains metric data.

  b  Specify which cells contain metric header information by doing one of the following:

    ▪  If no metric headers are contained in the file, select the **No Metric Headers** check box.

    ▪  If metric headers are included in the file, clear the **No Metric Headers** check box. Click and drag the **Metric Header Block area** to highlight the cells that contain metric header data.

For examples of tabular and cross-tabbed layouts, see *Previewing your data and specifying data import options, page 121.*

- The Parse Data option is not available if you are importing data from a database.

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Best practices: Importing data into MicroStrategy Desktop, page 59*
- *Previewing your data and specifying data import options, page 121*
Wrangle Your Data page

The Wrangle Your Data page allows you to explore your data to evaluate its quality and usability. You can then prepare your data to improve its quality before you import it into MicroStrategy Desktop. For example, you can remove white space, filter your data, delete duplicate rows or cells, find and replace data, concatenate columns, and so on.

You work with sample data (a subset of your actual data) to build a script that will clean and prepare your data, also known as data wrangling. The completed script is applied to your data when you publish the cube.

The Wrangle Your Data page is displayed after you import data from the following data sources:

- Files imported from your computer or network, or uploaded from a URL
- Custom data typed or pasted directly into MicroStrategy Desktop
- Dropbox
- Google Analytics
- Google Drive
- Salesforce
- Sample files

The Wrangle Your Data page contains the following areas:

- **Functions**: Allows you to select a function to apply to the selected data.
  - For a function that needs no further input, like facet, the function is automatically applied to your data.
  - If the function needs parameters, define the parameters, then click **Apply** to apply the function to your data.

- **Suggestions**: Displays a list of suggested functions to apply to the selected data column. The suggestions are based on the sample data that you select.

- **History Script**: Lists your functions. Allows you to redo and undo applying functions. The history script is saved with the dataset and therefore in the dashboard. You can also export the script, to save the functions in order. You can then import the saved script to apply to another set of data. Steps for both are included in *Refining your data quality before importing*, page 129.
Refining your data quality before importing.

Data Preview: Displays a sample of the whole dataset.

- Select a data column or part of a cell to apply a function to.
- After you apply a function, the sample data is updated to preview the effect of the function.

Facet: Displayed when a facet (filter) function is selected. Allows you to filter your data in a variety of ways, so that you can focus on a smaller amount of information during the data wrangling process. Rows are not deleted when you use a facet function.

When you have completed refining and cleaning your data, click OK to apply the script to your actual data.

For detailed steps to refine your data, and a full list of functions, see Refining your data quality before importing, page 129.

Related topics

- Importing Data into MicroStrategy Desktop, page 55
- Refining your data quality before importing, page 129
- Preview page, page 534

Valid date and time forms for wrangling your data

During the data wrangling process, you can change a column’s data type to date, displayed in yyyy-MM-dd format. You provide the date format of your data in the Input Date Format field, using the characters listed in the following table. For background information on the data wrangling process, and steps to wrangle or refine your data, see Refining your data quality before importing, page 129.

For example, if your data displays 01022014 for January 2, 2014, type the date format MMddyyyy in the field. For the same date, if your data displays 2014.01.02, type yyyy.MM.dd in the date format field. If your data displays Thu Jan 2, 14, type EEE MMM d, yy. After the data is converted to a date, the dates are displayed in yyyy-MM-dd format. That is, January 2, 2014 displays as 2014-01-02.
Some symbols denote different formats depending on the capitalization. For example, a lowercase w displays the week number of the year, while an uppercase W displays the week number of the month.

<table>
<thead>
<tr>
<th>Date Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G</td>
<td>Era designator, such as AD or BC.</td>
</tr>
<tr>
<td>y</td>
<td>Year, such as 96 or 1996.</td>
</tr>
<tr>
<td>M</td>
<td>Month in year, such as 01, Jan, or January.</td>
</tr>
<tr>
<td>w</td>
<td>Week number in year. The 27th week of the year is displayed as 27.</td>
</tr>
<tr>
<td>W</td>
<td>Week number in month. The second week of February is displayed as 2.</td>
</tr>
<tr>
<td>D</td>
<td>Day number in year. The 189th day of the year is displayed as 189.</td>
</tr>
<tr>
<td>d</td>
<td>Day number in month, such as 10.</td>
</tr>
<tr>
<td>F</td>
<td>Day of week in month, such as 2.</td>
</tr>
<tr>
<td>E</td>
<td>Day name, such as Sun or Sunday.</td>
</tr>
<tr>
<td>a</td>
<td>AM or PM marker, to display time using a 12-hour clock.</td>
</tr>
<tr>
<td>H</td>
<td>Hour, based on a 24-hour clock, from 0 to 23.</td>
</tr>
<tr>
<td>k</td>
<td>Hour, based on a 24-hour clock, from 1 to 24.</td>
</tr>
<tr>
<td>K</td>
<td>Hour in AM or PM, from 0 to 11.</td>
</tr>
<tr>
<td>h</td>
<td>Hour in AM or PM, from 1 to 12.</td>
</tr>
<tr>
<td>m</td>
<td>Minute.</td>
</tr>
<tr>
<td>s</td>
<td>Second.</td>
</tr>
<tr>
<td>S</td>
<td>Millisecond.</td>
</tr>
<tr>
<td>z</td>
<td>Time zone, such as GMT-08:00, PST, or Pacific Standard Time.</td>
</tr>
<tr>
<td>Z</td>
<td>Time zone using the RFC 822 four-digit time zone, such as -0800.</td>
</tr>
</tbody>
</table>

**Create Multiform Attribute dialog box**

When you import data, each column in a table will be imported as a separate attribute. If your data contains different attribute forms of the same attribute saved in separate columns, you can create a multiform attribute to combine the forms into a single attribute.

For example, the LU_CALL_CENTER TABLE contains two columns, Call Ctr ID and Call Center Name, which will be imported as two attributes. You
can create a single Call Center attribute that uses the columns as attribute forms.

Steps are below to create a new multiform attribute during data import.

**Prerequisites**

- This procedure assumes that you have already begun importing data. The Preview page is displayed after you select a data source to import from, select the data to import, and click **Prepare Data**. For a list of the data sources that you can import from, and links to steps to import data, see *Importing Data into MicroStrategy Desktop, page 55.*

---

### To create a multiform attribute

1. On the Preview page, select the columns to use as attribute forms by holding the Shift key while selecting them.

2. Right-click the selected columns and select **Create Multiform Attribute**. The Create Multiform Attribute dialog box opens.

3. Type the name to use for the new attribute in the **New Attribute Name** field.

4. For each attribute form, select the correct **Form Category**, such as ID or Description, from the drop-down list.

5. For each attribute form, determine whether or not the form is displayed, as described below:
   - To display the attribute form, select the **Display Form** check box.
   - To hide the attribute form, clear the **Display Form** check box.

6. Click **Submit** to create the new multiform attribute and return to the Preview page. The multiform attribute replaces the columns that were used to create it.

---

**Related topics**

- *Importing Data into MicroStrategy Desktop, page 55*
- *Previewing your data and specifying data import options, page 121*
Geo Attribute dialog box

You can improve the depth of the geographic information available for your data by having MicroStrategy automatically generate attributes containing higher levels of geographic data based on an existing attribute in a dashboard. For example, if the attribute contains city data, you can have MicroStrategy automatically generate the State attribute, which contains the state that each city is located in.

You can create geo roles when:

- You are previewing data before importing it. For steps, see Assigning geo roles, page 137.
- You are working in a dashboard. For steps, see Modifying, renaming, showing, and hiding dataset objects in a dashboard, page 162.

For background information on how and when to use geo roles, see Preparing your data to display on maps: Geo roles, page 135.

For detailed information about which attributes can be generated based on the type of geographic information the attribute contains (called the geo role), see the Creating and Configuring a Project chapter of the Project Design Guide.

Related topic

- Preparing your data to display on maps: Geo roles, page 135
- Creating an ESRI Map visualization that displays map markers, page 228
- Creating an ESRI Map visualization that displays a density map, page 233
- Creating an ESRI Map visualization that displays areas, page 239
- Importing Data into MicroStrategy Desktop, page 55
Expression dialog box

When you are importing data by building a SQL query, you can define an expression based on a column to select the data that you want to import. To define an expression, type the expression into the Expression pane in the middle of the Expression dialog box.

The following options are available:

- **Insert**: Click this icon to select a MicroStrategy function to insert into the expression.

- **Syntax validation**: Click this icon to check your expression for valid syntax. If the expression is valid, a message appears in the bottom of the Expression pane to inform you that your syntax is valid. If the expression is not valid, the message explains the syntax problem.

- **Clear**: Click this icon to clear the contents of the Expression pane.

Related topics

- *Importing data from a database by building a SQL query, page 67*
- *Importing data from Google BigQuery, page 99*
- *Importing data from Hadoop, page 112*

New Condition dialog box

When you are importing data from a database, you can define a condition to select the data that you want to import. To define a condition, type the condition into the Expression pane in the middle of the New Condition dialog box.

The following options are available:

- **Insert**: Click this icon to select a MicroStrategy function to insert into the condition.

- **Syntax validation**: Click this icon to check your condition for valid syntax. If the condition is valid, a message appears in the bottom of the Expression pane to inform you that your syntax is valid. If the condition is not valid, the message explains the syntax problem.

- **Clear**: Click this icon to clear the contents of the Expression pane.
Prerequisite

- The steps below assume that you are importing data from a database and have added at least one database table to the Editor pane.

To select data to import based on a condition

1. From the toolbar, click the Filters icon. The Filters dialog box opens.
2. In the Expression pane, type the condition that you want to define. You can insert functions into the condition by doing the following:
   a. Click the Insert icon. A pop-up menu is displayed.
   b. To select a function, choose the name of the function from the list. The Function Arguments dialog box opens.
   c. Select the appropriate options to provide arguments for the function and click OK. Your function is displayed in the Expression pane.
3. To check your condition for valid syntax, click the Syntax validation icon. If the condition is valid, a message is displayed in the bottom of the Expression pane to inform you that your syntax is valid. If the condition is not valid, the message explains the syntax problem.
4. To clear the contents of the Expression pane, click Clear.
5. Repeat the steps above as appropriate to define your condition.
6. When you are finished editing your condition, click Save to apply your changes and save the condition.

Related topics

- Importing data from a database by building a SQL query, page 67
- Importing data from Google BigQuery, page 99
- Importing data from Hadoop, page 112
- Creating and managing filters to determine which data to import from a database, page 75
Link Attributes Editor

By default, when you import a new dataset directly into a dashboard that contains at least one dataset, the new dataset is automatically linked to attributes that already exist in the dashboard. MicroStrategy attempts to link attributes that share the same name. You can also manually link the data when importing the data or editing the dashboard.

Linking attributes allows you to:

- Display data from multiple datasets in the same visualization.
- Use a visualization based on one dataset as a filter to update the data displayed in a visualization based on another dataset.
- Group data from one dataset based on an attribute that exists in another dataset.

Right-click the attribute to link, in either the Datasets panel while viewing a dashboard or in the Tables area on the Preview page during data import, and select **Link To Other Datasets**. The Link Attributes Editor is displayed, with the following options:

- **Links to**: The attribute to link the selected attribute to. You can type the name of an attribute in the field to narrow the list of choices.

- **Show Attribute Forms**: The attribute forms to base the link on.

  At least one of the attribute forms that you link must be the ID attribute form.

- **Add a Link**: Links additional pairs of attributes.

Related topic

- **Linking data shared across multiple datasets, page 259**

Function Arguments dialog box

You can select the appropriate arguments to provide data for a function using the Function Arguments dialog box. A description of the function, a description of the arguments required for the function, and a preview of the function’s formula are displayed in the Function Arguments dialog box. Select the appropriate options to define each argument required for the function.
Click OK to apply your changes.

**Related topics**

- *Creating and managing filters to determine which data to import from a database, page 75*
- *Importing data from a database by building a SQL query, page 67*
- For additional information and descriptions of the functions available, see the *Functions Reference*.

**Interfaces for creating dashboards**

Refer to the sections below for an explanation of the interfaces that you can use to create dashboards:

- *Dashboard Editor, page 549*
  - *Dashboard Editor: Dashboard Datasets panel, page 551*
  - *Dashboard Editor: Filter panel, page 555*
  - *Dashboard Editor: Editor panel, page 557*
  - *Dashboard Editor: Visualization Gallery, page 568*
- *Attribute Editor, page 570*
- *Filtering Options dialog box, page 572*
- *Replace Objects dialog box, page 574*
Dashboard Editor

The image below shows the Dashboard Editor:

The Dashboard Editor contains the following features and functionality:

- **Visualization area**: Displays the data that has been added to the dashboard, including interactive visualizations and text fields. In this sample, the visualization area displays a Line visualization and a Bubble visualization on separate pages.

- **Toolbar**: Provides the most commonly used tools, including undo and redo.

  You can undo or redo almost any actions in a dashboard, including inserting a blank visualization, adding and removing dataset objects from visualizations, filtering data, changing a visualization’s type, drilling, and switching between sheets. From the toolbar, click the **Undo** or **Redo** icons.

- **Datasets panel**: Lists the dashboard’s datasets, and the attributes and metrics in each dataset. You can drag and drop objects from the Datasets panel to add them to a visualization, filter a visualization based on an
attribute or metric, and so on. Display the Datasets panel by selecting **Datasets Panel** from the **View** menu.

For a detailed explanation of the Datasets panel, see *Dashboard Editor: Dashboard Datasets panel, page 551*.

- **Editor panel**: Displays the objects that have been added to the current visualization. Drag and drop objects from the Datasets panel to the Editor panel to add them to the current visualization. For steps to create and display data in visualizations, see *Displaying a visual representation of your data: Visualizations, page 179*. Display the Editor panel by selecting **Editor Panel** from the **View** menu.

For a detailed explanation of the Editor panel, see *Dashboard Editor: Editor panel, page 557*.

- **Filter panel**: Displays the filtering options for the current sheet. To filter the sheet to refine the data displayed in it, select and change the filtering options. For steps to create filters, see *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*. For steps to use the filter, see *Filtering data in a sheet, page 453*. Display the Filter panel by selecting **Filter Panel** from the **View** menu.

For a detailed explanation of the Filter panel, see *Dashboard Editor: Filter panel, page 555*.

- **Properties panel**: Displays the formatting options for the selected object (visualization, text, image, and so on). You can select formatting options to specify the type of graph elements to display in a Graph visualization, banding options for a Grid visualization, whether to allow rectangles to be deleted in a Heat Map visualization, format the title of a filter, size an image, and so on. For descriptions of the various options, see *Interfaces for formatting dashboard objects, page 575*. Display the Properties panel by selecting **Properties Panel** from the **View** menu.

- **Visualization Gallery**: Changes the visualization used to display your data, and allows you to quickly view data requirements to display visualizations. Display the Visualization Gallery by selecting **Visualization Gallery** from the **View** menu.

For a detailed explanation of the Visualization Gallery, see *Dashboard Editor: Visualization Gallery, page 568*.

- **Sheets**: A tab is displayed for each sheet in the dashboard. Sheets organize data into multiple tabs to provide a logical flow to your dashboard. Each sheet can be filtered independently of data on another sheet. Use the tabs to switch between sheets, rename a sheet, duplicate a sheet, move a sheet, and add a page to the current sheet. For steps, see *Adding, modifying, and deleting sheets, page 374*. 
The Editor panel, Filter panel, and Properties panel are stacked or docked in one panel by default, but you can view each panel separately (as shown in the example above). To undock a panel, drag its panel tab off the docked panel.

**Dashboard Editor: Dashboard Datasets panel**

The Dashboard Datasets panel displays all of the datasets in the dashboard, and the attributes and metrics in each dataset. The attributes and metrics can be displayed as data on a dashboard. The Datasets panel is also referred to as simply the Datasets panel. To display the Dashboard Datasets panel while viewing a dashboard, from the View menu, select **Datasets Panel**.

The Datasets panel shows the dataset objects from each dataset in the dashboard, organized by the dataset that they belong to. If your dashboard contains more than one dataset, you can expand or collapse the list for each dataset. You can also expand or collapse all the datasets at once. To do this, hover the cursor over the name of the Datasets panel, then click the arrow icon. Select one of the following:

- To expand and display all datasets in the Datasets panel, select **Expand All Datasets**.
- To collapse all datasets in the Datasets panel, displaying only their headers, select **Collapse All Datasets**.

You can narrow the list of objects displayed in the Datasets panel. From the drop-down list at the top of the panel, select one of the following:

- To view all dataset objects in all datasets added to the dashboard, select **All**.
- To view only the dataset objects from a selected dataset, select the name of the dataset to view.
- To view a specific type of dataset object, select the object type:
  - To display attributes only, select **Attributes**.
  - To display metrics only, select **Metrics**.

If your dashboard contains multi-table cubes as datasets, you can choose between displaying dataset objects in a single list, or organized by dataset.

- To display all dataset objects in a single list, select **Flat View**.
• To display dataset objects listed under the name of the dataset that they belong to, select **Table View**.

You can also search for the name of a dataset object by typing it in the search field.

![DATASETS](image)

You can:

• **Add or remove datasets from the dashboard.** For steps, see *Adding a dataset to a dashboard, page 153* and *Removing a dataset from a dashboard, page 157*.

• **Replace a dataset with another dataset.** The replacement can be an existing dataset in the dashboard or imported data. For steps, see *Replacing datasets in a dashboard, page 154*.

• **You can update your imported data by republishing or refreshing a dataset.** For steps, see *Refreshing and updating your imported data: Republishing datasets, page 141*.

• **You can select how a dataset accesses its data, either directly or from memory.** Direct data access means that Desktop connects to the data source. If the in-memory data access is used, Desktop retrieves the dataset results from the data sources and stores them in memory. For more details about the difference, and steps to change how a dataset accesses data, see *Selecting how a dataset accesses its data: Direct data access vs. in-memory, page 160*.

• **You can edit the data in a dataset, by adding new data columns, renaming columns, changing data types, and so on.** For more details and steps, see *Editing imported data, page 140*. 
- Link attributes that are shared in common across multiple datasets. Linking attributes across multiple datasets allows you to display data from multiple datasets in the same visualization and to manipulate data from one dataset based on the data in another dataset. For more details and steps to link attributes, see Linking data shared across multiple datasets, page 259.

- Create derived attributes based on attributes already included in the dashboard. For steps, see Creating an attribute based on existing objects: Derived attributes, page 344.

- Create derived metrics based on the metrics already included in the dashboard. For steps, see Creating a metric based on existing objects: Derived metrics, page 318.

- Create derived elements to group and display your data. For steps, see Creating a metric based on existing objects: Derived metrics, page 318.

- Define the geo role for an attribute. A geo role associates geographical information, such as city or longitude, with a data column, allowing you to integrate your data with the Map, Density Map, or Map with Areas visualizations. For steps, see To define the geo role for an attribute, page 165.

- Create an attribute from a metric, or a metric from an attribute. For steps, see To create a derived attribute based on a metric, page 165 and To create a derived metric based on an attribute, page 164.

You can add, replace, or remove data from a visualization, as follows:

- To add data to the visualization, click and drag an attribute or metric from the Datasets panel onto the appropriate area in the visualization’s Editor panel, so that a green indicator line is displayed in the location in which you want to place the attribute or metric. The attribute or metric is added to the visualization and displayed.

- To replace an attribute or metric that has already been added to the visualization, click the name of the object on the visualization’s Editor panel, then select the item to replace the object with. The data is replaced in the visualization and displayed.

- To remove an attribute or metric from the visualization, in the visualization’s Editor panel, hover the cursor over the object’s name, then click X.

You can add or remove filters from the dashboard, as follows:

- To add a filter, from the Datasets panel, click and drag the attribute or metric that you want to use to create the filter onto the Filter panel. If the
Filter panel is not displayed, you can hover the cursor over the attribute or metric in the Datasets panel, click the arrow icon, and select **Add to Filters**.

- To remove a filter, click and drag the name of the filter from the Filter panel onto the Datasets panel.

### All Objects panel

If you are connected to a server, you can open the All Objects panel within the Datasets panel. This allows you to access the objects in the project, and use those objects in the same ways that you use objects from datasets, such as creating visualizations, filters, and derived objects.

### Prerequisite

- Before you can access the All Objects panel, you must be connected to a server. For steps, see *Connecting a server to MicroStrategy Desktop, page 470*.

To display the All Objects panel, from the bottom of the Datasets panel, click the arrow icon next to **All Objects**. If this is the first time that you are accessing the All Objects panel, the Login screen is displayed. Select a project, and then type the user name and password to use to access the project. Click **Login**. The All Objects panel is displayed.

The following options are available on the All Objects panel:

- You can quickly navigate to a specific folder location using the drop-down list at the top of the panel. The list at the bottom of the panel is updated to display the contents of the selected folder, including dataset objects and other folders. To expand the contents of a folder, click the folder’s name. The contents of the folder are displayed.

- You can search for a dataset object by typing its name in the search field at the top of the panel. To search within a selected folder, select the name of the folder from the list.

When you add objects from the All Objects panel to the dashboard, a dataset containing each object is automatically added to the dashboard and displayed in the Datasets panel. The dashboard is given the same name as the project whose dataset objects it contains. For a general overview of creating, editing, and deleting datasets in a dashboard, see *Managing data in a dashboard, page 151*. 
Dashboard Editor: Filter panel

The Filter panel displays a list of all the filters for the displayed sheet. When you make selections in the Filter panel, your selections are used to filter the data displayed in every visualization on the sheet currently displayed in the dashboard. A filter on a sheet also filters the data in any dataset objects (that is, an attribute or metric from a dataset) displayed in text fields on the sheet.

For example, a dashboard contains a grid and a heat map, which both display sales data for a series of product categories. Each visualization is placed on a separate page. The pages are located on the Sales sheet, which is displayed in the dashboard. If you make selections to display data in the grid for only the Books and Electronics categories, both the grid and the heat map visualization will be updated to only include data for Books and Electronics.
One of the pages also displays text, which uses the category dataset object combined with the static text “Revenue Data for”. As you select different categories to display in the sheet, the text changes. If you select Books, the text displays as “Revenue Data for Books”.

To display the Filter panel while viewing a dashboard, from the View menu, select Filter Panel. If the Filter panel is hidden behind another panel, click the Filter icon to display the Filter panel.

You can:

• Add filters to the sheet. To add a filter to a dashboard, click and drag the attribute or metric to create the filter from the Datasets panel onto the Filter panel, so that a green plus (+) icon is displayed next to the cursor. The filter is added to the Filter panel and displayed. For detailed steps to add filters, including steps to determine the display style to use when creating a filter, see Creating filters for a sheet of data, page 378.

• Remove filters from the sheet. To remove a filter, hover the cursor over the name of the filter in the Filter panel, click the arrow icon displayed to the right of the name, and select Remove.

• Filter the data in the sheet, using the filters displayed in the Filter panel. For steps, see Filtering data in a sheet, page 453.

• Allow selections in attribute filters to restrict the items displayed in other attribute filter. For steps, see Filtering the attribute values displayed in an filter for a sheet, page 395.

• Modify how filters are displayed on the Filter panel. For example, you can collapse or expand all the filters in the panel, collapse or expand an individual filter, and move the Filter panel to a different position on the dashboard. For steps, see Changing how filters are displayed on the Filter panel, page 557.

• If the Filter panel displays Reset and Apply buttons, the sheet is not updated automatically with each change to a filter; click Apply to update the sheet. By default, each change is applied individually. When you control when the update occurs, you can apply a number of changes all at once, which usually takes less time than applying each change. For steps to determine the update behavior, see Applying filter changes individually or all at once, page 394.
Changing how filters are displayed on the Filter panel

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This...</th>
</tr>
</thead>
</table>
| Expand or collapse the display of all filters in the Filter panel | Hover the cursor over the Filter panel, then click the arrow icon displayed in the top right of the panel. Do one of the following:  
  • To expand and display all filters in the Filter panel, select **Expand All**.  
  • To collapse all filters in the Filter panel, displaying only their headers, select **Collapse All**. |
| Expand or collapse an individual filter in the Filter panel | Click the arrow next to the name of the filter to collapse it. Click the arrow again to expand the filter. |
| Move the Filter panel                      | Hover the cursor over the Filter tab, then click and drag the panel to its new location in the dashboard, so that an indicator line is displayed. You can change the order of the panels, by dragging the Filter panel within the panel area, or move it off the panel area to the right or left side of the dashboard. |

Related topics

- *Dashboard Editor, page 549*
- *Dashboard Editor: Dashboard Datasets panel, page 551*
- *Dashboard Editor: Editor panel, page 557*
- *Creating a dashboard, page 146*
- *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*
- *Filtering data in a dashboard, page 451*

Dashboard Editor: Editor panel

The Editor panel contains a list of all the attributes and metrics that are displayed as data in the selected visualization. To display the Editor panel, from the View menu, select **Editor Panel**. If the Editor panel is hidden behind another panel, click the Editor icon 📝 to display the Editor panel. To
view the dataset objects for a specific visualization, click the visualization in the dashboard.

You can add, remove, and reposition data on the visualization, as described below:

- Add data to the visualization. From the Datasets panel, click and drag attributes or metrics onto the Editor panel, so that a green indicator line is displayed in the location to add the attribute or metric to. You can select multiple dataset objects at the same time by pressing CTRL and clicking each dataset object to select it. The dataset objects are added to the visualization and displayed. In the image above, the Call Center attribute has been added to the Grouping area of a visualization.

- To replace the data displayed in a visualization, click and drag an object from the Datasets panel onto the object on the Editor panel to replace, so that a blue arrow icon is displayed next to the cursor. The data is replaced in the visualization and displayed.

- Remove an attribute or metric from the visualization. Right-click the object in the Editor panel, and select Remove.

- Remove all of the attributes and metrics in a visualization at once. Click the Clear All icon. All objects in the visualization are removed.

- Display or hide subtotals for a grid. Click Show Totals icon. If the subtotals are displayed, they are hidden; if the subtotals are hidden, they are displayed.
• Swap the objects in the rows and columns of the visualization. Click the **Swap** icon.

• Move or pivot data from one area of the visualization to another. Click and drag an object from its current location in the Editor panel to the appropriate area in the Editor panel. You can move multiple objects from one area of the visualization to another at the same time. Press **CTRL** and click each object to select it, then drag the objects to their new location in the Editor panel.

For example, to move an attribute from the rows of a Grid visualization to the columns, click and drag the attribute from the Rows area to the Columns area.

Different areas, such as Grouping, Rows, and Columns, are displayed in the Editor depending on the type of visualization that you selected, as described below:

- **Dashboard Editor: Graph, page 560**
- **Dashboard Editor: Grid, page 562**
- **Dashboard Editor: Heat Map, page 563**
- **Dashboard Editor: ESRI Map, page 565**
- **Dashboard Editor: Network, page 567**

You can also use the Editor panel to:

- Sort and pivot data in a visualization. For steps, see *Analyzing data in a visualization, page 424*.
- Display subtotals in a visualization. For steps, see *Formatting visualizations, page 264*.
- Change the number format used to display data in a visualization. For steps, see *Formatting numeric values in a visualization, page 271*.
- Change the number formatting applied to a metric. For steps, see *Formatting numeric values in a visualization, page 271*.
- Change the attribute forms displayed for an attribute. For steps, see *Selecting which attribute forms to display in a visualization, page 269*.
- Rename dataset objects in a visualization. For steps, see *Formatting visualizations, page 264*.
- Create new metrics based on metrics in the dashboard. For steps, see *Creating a metric based on existing objects: Derived metrics, page 318*. 
• Create new attributes based on attributes in the dashboards. For steps, see "Creating an attribute based on existing objects: Derived attributes, page 344."

• Group and display data in the visualization using derived elements. For steps, see "Grouping attribute values in a dashboard, page 349."

• Select elements in one visualization to filter the data displayed in another visualization. For steps, see "Using a visualization to filter the data displayed in another visualization, page 413."

• Apply thresholds to highlight metric data in a visualization when the data meets a specific condition. For steps, see "Adding or removing a threshold in a visualization, page 273."

• Rename the visualization. The name is displayed in the title bar of the visualization. Click the arrow icon at the top of the Editor panel, and select Rename. Type the new name.

• Create a filter on the displayed sheet. On the Editor panel, right-click the object to base the filter on, and select Add to Filter. For detailed steps, see "Creating filters for a sheet of data, page 378."

**Related topics**

• "Displaying a visual representation of your data: Visualizations, page 179"

• "Dashboard Editor, page 549"

• "Dashboard Editor: Dashboard Datasets panel, page 551"

• "Dashboard Editor: Filter panel, page 555"

• "Creating a dashboard, page 146"

**Dashboard Editor: Graph**

The Editor panel for a Graph visualization contains a list of all the attributes and metrics that are displayed as data in the visualization.

For detailed steps to create a Graph visualization, see the appropriate link below:

• For steps to create an area, bar, or line graph, see "Creating area, bar, or line graphs, page 192."
• For steps to create a bubble or scatter graph, see *Creating a bubble or scatter graph, page 196.*

• For steps to create a graph with graph markers displayed in a grid layout, see *Creating a graph with graph markers displayed in a grid layout, page 200.*

• For steps to create a pie or ring graph, see *Creating a graph with pies or rings, page 202.*

• For steps to create a combination graph, see *Creating a combination graph, page 209.*

• For steps to create a dual-axis graph, see *Creating a dual-axis graph, page 215.*

To add data to the visualization, from the **Datasets** panel, click and drag an attribute or metric onto the Vertical or Horizontal areas on the **Editor** panel. As you place dataset objects on the Vertical or Horizontal areas, an icon is displayed next to each dataset object, indicating the location in which the object is displayed:

• **Left Axis**  
  The dataset object is displayed on the left vertical axis.

• **Right Axis**  
  The dataset object is displayed on the right vertical axis.

• **Top Axis**  
  The dataset object is displayed on the top horizontal axis.

• **Bottom Axis**  
  The dataset object is displayed on the bottom horizontal axis.

• **Top Column** (available for attributes): The attribute is used to slice the data into columns of graphs. A separate column is displayed for each element in the attribute.

• **Left Row** (available for attributes): The attribute is used to slice the data into rows of graphs. A separate row is displayed for each element in the attribute.

You can place metrics on the top, bottom, left, or right axes of a graph visualization. Metrics can be added to up to two different axes at one time. These can be adjacent axes, in the case of scatter and bubble graphs, or opposite axes, in the case of dual-axis graphs.

Attributes can be placed on the left vertical axis or the bottom horizontal axis (also called the traditional graph axes).

If you place more than one attribute on either the Vertical area or the Horizontal area, the attributes at the top of the area are used to slice your
data into rows or columns of graphs. To display attributes on the vertical or horizontal graph axis instead, right-click the name of the attribute in the Editor panel and select **Left Row**.

- If the attribute is in the Vertical area, select **Left Row**.
- If the attribute is in the Horizontal area, select **Top Column**.

To remove an attribute or metric from the visualization, right-click the object in the Editor panel and select **Remove**. You can remove all of the attributes and metrics in a visualization at once. To do this, from the Editor panel’s toolbar, click the **Clear All** icon. All objects in the visualization are removed.

To swap the horizontal and vertical areas of the grid, click the **Swap** icon on the Editor panel’s toolbar. Objects in the horizontal area are moved to the vertical area, and objects in the vertical area are moved to the horizontal area.

**Related topics**

- *Creating a Graph visualization, page 181*
- *Formatting a Graph visualization, page 283*
- *Formatting visualizations, page 264*
- *Adding or removing a threshold in a visualization, page 273*
- *Analyzing data in a graph, page 427*

**Dashboard Editor: Grid**

The Editor panel for a Grid visualization contains a list of all the attributes and metrics that are displayed as data in the visualization.

For detailed steps to create a Grid visualization, see *Creating a Grid visualization, page 220*.

To add data to the visualization, from the **Datasets** panel, click and drag an attribute or metric onto the **Editor** panel, so that a green indicator line is displayed in the location to add the attribute or metric to, as follows:

- **Rows**: To add an attribute to the rows of the grid, drag the attribute onto the **Rows** area.
• **Columns**: To add an attribute to the columns of the grid, drag the attribute onto the **Columns** area.

• **Metrics**: To add a metric to the visualization, drag the metric onto the **Metrics** area. The Metric Names object, an attribute created by MicroStrategy Desktop, is automatically added to the Editor panel. To change whether the metrics are displayed on the rows or columns of the grid, drag and drop the Metric Names object onto the Rows or Columns area of the Editor panel.

To remove an attribute or metric from the visualization, right-click the object in the Editor panel and select **Remove**. You can remove all of the attributes and metrics in a visualization at once. To do this, from the Editor panel’s toolbar, click the **Clear All** icon . All objects in the visualization are removed.

To swap the rows and columns of the grid, click the **Swap** icon on the Editor panel’s toolbar. Objects in the rows are moved to the columns, and objects in the columns are moved to the rows.

**Related topics**

- *Creating a Grid visualization, page 220*
- *Formatting a Grid visualization, page 293*
- *Formatting visualizations, page 264*
- *Adding or removing a threshold in a visualization, page 273*
- *Analyzing data in a grid, page 434*

**Dashboard Editor: Heat Map**

The Editor panel for a Heat Map visualization contains a list of all the attributes and metrics that are displayed as data in the visualization.

For detailed steps to create a Heat Map visualization, see *Creating a Heat Map visualization, page 223*.

To add data to the visualization, from the **Datasets** panel, click and drag an attribute or metric onto the **Editor** panel, so that a green indicator line is displayed in the location to add the attribute or metric to, as follows:
• **Grouping**: To display rectangles in the Heat Map, click and drag at least one attribute onto the **Grouping** area. For example, if the attribute is Year, a rectangle for each year is displayed in the visualization.

You can drag additional attributes onto the Grouping area to group the rectangles in the visualization into larger areas. For example, the Region attribute contains the element Northeast and the State attribute contains the elements New York and New Jersey. If Region is placed above State in the Grouping area, an area called Northeast is displayed in the visualization, with the rectangles New York and New Jersey inside. You can add additional attributes to further group the rectangles in the Heat Map.

• **Size By**: To size each rectangle based on the value of a metric, click and drag the metric onto the **Size By** area. This metric is used to determine the size of each rectangle, with rectangles for larger metric values displayed as larger than rectangles for small metric values.

• **Color By**: To have the rectangles colored automatically based on the elements in an attribute or based on the value of a metric, click and drag the attribute or metric onto the **Color By** area.

• **Tooltip**: To display additional metric values in a tooltip when you hover the cursor over a rectangle, click and drag the metrics that you want to display onto the **Tooltip** area.

To remove an attribute or metric from the visualization, right-click the object in the Editor panel and select **Remove**. You can remove all of the attributes and metrics in a visualization at once. To do this, from the Editor panel’s toolbar, click the **Clear All** icon. All objects in the visualization are removed.

**Related topics**

• *Creating a Heat Map visualization, page 223*

• *Formatting a Heat Map visualization, page 296*

• *Formatting visualizations, page 264*

• *Adding or removing a threshold in a visualization, page 273*

• *Analyzing data in a heat map, page 438*
Dashboard Editor: ESRI Map

The Editor panel for an ESRI Map visualization contains a list of all the attributes and metrics that are displayed as data in the visualization. An ESRI Map visualization allows you to display your data as markers, density maps, or areas on an interactive map.

To display map markers or a density map, you must provide latitude and longitude information for each map marker. You can do this with a single attribute that has been assigned a geo role or with separate latitude and longitude attributes. To display areas in the visualization, you must provide an attribute whose values include the names of each area to display. For more details on these data requirements, see the following:

- Creating an ESRI Map visualization that displays map markers, page 228
- Creating an ESRI Map visualization that displays a density map, page 233
- Creating an ESRI Map visualization that displays areas, page 239

The options displayed on the Editor panel differ depending on what kind of ESRI Map visualization you have selected on the Properties panel. To add data to the visualization, from the Datasets panel, click and drag an attribute or metric onto the Editor panel, so that a green indicator line is displayed in the location to add the attribute or metric to, as follows:

- **Geo Attribute**: You can provide locations in the map using one attribute assigned a geo role for which MicroStrategy automatically adds the latitude and longitude information, click and drag the attribute containing the latitude and longitude information to the Geo Attribute area. MicroStrategy Desktop automatically detects the latitude and longitude attribute forms and displays their names in the Latitude and Longitude areas.

  Available for all types of ESRI Map visualizations.

- **Latitude**: To provide locations in the map using separate attributes for latitude and longitude, click and drag the attribute that contains the latitude information to the Latitude area. If you provided a geo attribute, this area is populated automatically.

  Available for map markers and density maps.

- **Longitude**: To provide locations in the map using separate attributes for latitude and longitude, click and drag the attribute that contains the
longitude information to the **Longitude** area. If you provided a geo attribute, this area is populated automatically.

Available for map markers and density maps.

- **Color By**: To display map markers or areas in different colors based on the value of a metric, click and drag the metric to the **Color By** area.

  Available for map markers and area maps.

- **Size By**: To size bubble markers based on the value of a metric, with the largest bubbles being displayed for the largest metric values, click and drag the metric to the **Size By** area.

  Available for map markers.

- **Tooltip**: To display additional metric or attribute information in a tooltip when you click an area in the visualization, click and drag the metrics or attributes that you want to display to the **Tooltip** area.

  Available for all types of ESRI Map visualizations.

To remove an attribute or metric from the visualization, right-click the object in the Editor panel and select **Remove**. You can remove all of the attributes and metrics in a visualization at once. To do this, from the Editor panel’s toolbar, click the **Clear All** icon. All objects in the visualization are removed.

**Related topics**

- *Creating an ESRI Map visualization that displays map markers*, page 228
- *Creating an ESRI Map visualization that displays a density map*, page 233
- *Creating an ESRI Map visualization that displays areas*, page 239
- *Formatting an ESRI Map visualization that displays map markers*, page 299
- *Formatting an ESRI Map visualization that displays a density map*, page 300
- *Formatting an ESRI Map visualization that displays areas*, page 301
- *Formatting visualizations*, page 264
- *Adding or removing a threshold in a visualization*, page 273
Dashboard Editor: Network

The Editor panel for a Network visualization contains a list of all the attributes and metrics that are displayed as data in the visualization.

For detailed steps to create a Network visualization, see Creating a Network visualization, page 243.

To add data to the visualization, from the Datasets panel, click and drag an attribute or metric onto the Editor panel, so that a green indicator line is displayed in the location to add the attribute or metric to, as follows:

- **From Item**: To display each node at which an edge in the visualization begins, click and drag the attribute that contains the name of each node onto the From Item area.

- **To Item**: To display each node at which an edge in the visualization ends, click and drag the attribute that contains the name of each node onto the To Item area.

- **Edge Color**: To have each edge colored automatically based on the value of a metric, drag the metric onto the Edge Color area.

- **Edge Size**: To size each edge based on the value of a metric, with edges for larger metric values displayed as thicker than edges for smaller metric values, drag the metric onto the Edge Size area.

- **Item Size**: To size each node based on the value of a metric, with nodes for larger metric values displayed as larger than nodes for smaller metric values, drag the metric onto the Item Size area.

To remove an attribute or metric from the visualization, right-click the object in the Editor panel and select Remove. You can remove all of the attributes and metrics in a visualization at once. To do this, from the Editor panel’s...
toolbar, click the Clear All icon. All objects in the visualization are removed.

**Related topics**

- *Creating a Network visualization, page 243*
- *Formatting a Network visualization, page 302*
- *Formatting visualizations, page 264*
- *Adding or removing a threshold in a visualization, page 273*
- *Analyzing data in a Network visualization, page 445*

**Dashboard Editor: Visualization Gallery**

Use the Visualization Gallery to quickly select the visualization used to display your data in a dashboard. You can also quickly view data requirements to display visualizations.

To display the Visualization Gallery, from the View menu, select **Visualization Gallery**.

Use the Visualization Gallery to:

- Change a visualization's type: Click the visualization in the dashboard. In the Visualization Gallery, click the icon of the visualization to display.

- View the visualization's name and data requirements: Hover the cursor over the icon of a visualization.

  For example, a Heat Map visualization requires a minimum of one attribute and one metric to display correctly. Your Grid visualization contains only a single attribute, so an additional metric is required to properly display the visualization as a Heat Map visualization.

  The table below contains a list of the visualization types that you can use to display your data, as well as a link to a help topic with additional information
on the visualization, such as detailed steps to create the visualization and example images.

<table>
<thead>
<tr>
<th>Visualization Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>You can display your data using area graphs and select from a variety of graph styles, including absolute and stacked percent graphs. For steps, see <em>Creating a Graph visualization, page 181</em>.</td>
</tr>
<tr>
<td>Bar</td>
<td>You can display your data using bar graphs and select from a variety of graph styles, including stacked and clustered bar graphs. For steps, see <em>Creating a Graph visualization, page 181</em>.</td>
</tr>
<tr>
<td>Bubble</td>
<td>You can display a bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. For steps, see <em>Creating a bubble or scatter graph, page 196</em>.</td>
</tr>
<tr>
<td>Combo</td>
<td>You can display your data in a graph that combines multiple types of graph elements, such as a bar and area graph. For steps, see <em>Creating a dual-axis graph, page 215</em>.</td>
</tr>
</tbody>
</table>
| ESRI Map           | You can display your data as colored regions or map markers overlaid on a map, as follows:  
  • Map: You can display your data as markers on a map, then change the color, size, and display of markers based on the value of a metric, allowing you to quickly grasp relationships between different locations. You can enable map items to be clustered together and displayed as a circle when a large number of map markers must be displayed in the same map area. For steps, see *Creating an ESRI Map visualization that displays map markers, page 228*.  
  • Density Map: You can display your data as color gradients on a map, with colored shading displayed based on the concentration of locations of interest, allowing you to understand patterns in large amounts of geographical data. For steps, see *Creating an ESRI Map visualization that displays a density map, page 233*.  
  • Map with Areas: You can display your data as two-dimensional regions on a map, then change the color of regions based on the value of a metric, allowing you to quickly grasp the impact of different locations. For steps, see *Creating an ESRI Map visualization that displays areas, page 239*. |
Attribute Editor

You can create and add derived attributes to a dashboard, based on dataset objects that already included in the dashboard. To do so, you define the derived attribute using the Attribute Editor. Once the derived attribute is defined, it works the same as any other attribute. For example, you can add it to a visualization.

Derived attributes created in a dashboard are saved with the dashboard’s definition and cannot be used in other dashboards.
The following options are available in the Attribute Editor:

- **Functions**: You can add functions to the definition of the derived attribute. You can filter the list of functions displayed by typing the name of a function in the search field, or by selecting a function category from the drop-down list.
  - To display a short description of a function, click its name in the list. A description of the function is displayed at the bottom of the dialog box. Click **Details** to view more detailed information about the function and its arguments.

- **Objects**: You can add dataset objects, such as attributes and metrics, to the definition of the derived attribute. You can filter the list of dataset objects displayed by typing the name of the object in the search field, or by selecting a specific category of dataset object from the drop-down list.

- **Attribute Name**: In the field, type the name of the derived attribute.

If desired, you can type the definition of the derived attribute directly into the editor pane on the right. As you type, matching objects are displayed in a drop-down list. You can click an object or continue to type.

By default, the derived attribute contains the ID attribute form. You can define additional attribute forms for the derived attribute, by clicking the plus (+) icon above the editor pane. A tab for the attribute form is created and displayed. In the editor pane, define the attribute form using the same options you used to define the ID attribute form, as described above. Any attribute forms besides the ID attribute form must be based on the value of the ID attribute form.

- To edit an attribute form, click the tab of the attribute form to switch to it, then define the attribute form as described above.

- To rename the attribute form, double-click its name on the tab. Type a new name and press **ENTER** to apply your changes.

- To delete an attribute form, click **X** on its tab.

**Related topics**

- *Creating an attribute based on existing objects: Derived attributes, page 344*

- *Creating a dashboard, page 146*

- *Providing business context to data: Attributes, page 50*
Dashboard Properties dialog box

You can specify whether and how frequently your dashboard data is refreshed, and how to join attributes across datasets.

Refreshing your data

By default, data in your dashboard is not automatically refreshed. You can specify that data from direct access datasets is automatically refreshed, and set how frequently that data is refreshed. The auto refresh buttons are available in Presentation Mode.

Joining unrelated attributes across datasets

You can choose to allow joins across datasets based on unrelated common attributes.

To access the Dashboard Properties dialog box

1 In a dashboard, from the File menu, select Dashboard Properties.

Filtering Options dialog box

You can filter, drill, or select data in one visualization (the source) to update the data displayed in one or more additional visualizations (the targets) on the panel. For example, when you filter data in the source to include only data for the Movies category, the data in the target is automatically updated to display only data for Movies. You can do the following:

- Filter the data displayed in the target by filtering or drilling on data in the source.
- Filter the data displayed in the target by selecting elements in the source.
- Highlight the data displayed in the target by selecting elements in the source.

The following options are available:
• **Use VisualizationName to filter the following targets**: Select the check box next to each target visualization to update when users filter or drill on data in the source visualization.

• **Data on selection**: Once you have selected at least one target visualization to apply filtering to, you can allow users to filter or highlight data in the target by selecting elements in the source visualization. Select one of the following:
  - To enable users to filter the data in the target by selecting elements in the source, select **Filter**.
  - To enable users to highlight the data in the target by selecting elements in the source, select **Highlight**.

• If a drop-down list is displayed next to the Data on Selection option, the visualization has already been configured to allow users to update data in the target by filtering or drilling on a single, specific attribute in the source. The options are:
  - **For Attribute AttributeName** (where AttributeName is the name of the attribute): Continue allowing users to update data in the target by filtering or drilling based on the attribute already defined for the source.
  - **For All Data**: Allow users to update data in the target by filtering or drilling on any data in the source.

• **Allow users to clear all selections**: If you enable users to filter the data in the target by selecting elements in the source, you can enable users to undo their filtering selection. Select this option to allow users to clear their selection in the source visualization and display the data for all elements at once in any target visualizations. For example, if the source is a Grid visualization that allows users to select from elements of Year to filter data in the target, the user can click the Year header to display data for all years at once in the target. For other types of visualizations, users can clear their selections by clicking on empty space in the source visualization.

**Related topics**

• *Using a visualization to filter the data displayed in another visualization*, page 413

• *Creating a Graph visualization*, page 181
Replace Objects dialog box

When you replace one or more datasets in a dashboard, you can determine how to replace dataset objects that belong to the datasets being replaced. For example, a visualization displays sales data for physical store locations. If you replace the data in the dashboard with sales data for Internet sales only, you can choose to replace Physical Store Revenue with Internet Revenue, Physical Store Sell-Through with Internet Sell-Through, and so on, so that the visualization displays the corresponding sales data, updated for Internet sales only.

The following options are available:

- **Clear object alias and number format on dashboard**: Determines whether to keep or discard any name changes and number formatting that you applied to dataset objects in the datasets being replaced in a visualization.

- **Current Objects**: Lists the dataset objects in the dataset being replaced.

- **New Objects**: Lists the dataset objects in the replacement datasets.

  - For each attribute in the Current Objects list, you can:
    - Replace the attribute with an attribute from the new dataset, by selecting the replacement from the New Objects drop-down list.
    - Remove the attribute from the dashboard, by selecting Remove From Dashboard.

  - For each derived attribute in the Current Objects list, you can:
    - Replace the derived attribute with an attribute from the new dataset, by selecting the replacement from the New Objects drop-down list.
    - Keep the derived attribute and its existing definition as part of the new dataset, by selecting Keep Existing Definition.
    - Remove the derived attribute from the dashboard, by selecting Remove From Dashboard.

  - For each metric, you can:
    - Replace the metric with a metric from the new dataset, by selecting the replacement from the New Objects drop-down list.
    - Remove the metric from the dashboard, by selecting Remove From Dashboard.
For each derived metric that you created in the dashboard (not as part of a dataset), you can:

- Keep the derived metric and its existing definition as part of the new dataset, by selecting **Keep Existing Definition**.
- Remove the derived metric from the dashboard, by selecting **Remove From Dashboard**.

**Related topics**

- *Replacing datasets in a dashboard, page 154*
- *Managing data in a dashboard, page 151*

**Interfaces for formatting dashboard objects**

Refer to the sections below for an explanation of the interfaces you can use to format dashboards:

- Interfaces for formatting visualizations:
  - *Dashboard Editor: Graph: Properties, page 576*
  - *Dashboard Editor: Grid: Properties, page 590*
  - *Dashboard Editor: Heat Map: Properties, page 595*
  - *Dashboard Editor: ESRI Map: Properties, page 599*
  - *Dashboard Editor: Network: Properties, page 601*
  - *More Options dialog box, page 604*
  - *Advanced Sort Editor, page 607*
  - *Thresholds Editor, page 608*
  - *Advanced Thresholds Editor, page 610*
  - *Show Data dialog box, page 611*

- Interfaces for formatting other dashboard objects:
  - *Dashboard Editor: HTML container properties, page 612*
  - *Dashboard Editor: Image properties, page 612*
Dashboard Editor: Graph: Properties

You can select formatting options for a Graph visualization, such as whether to display trend or reference lines, whether to display data labels, and font and color options for text in a graph. From the drop-down list at the top of the panel, determine what part of the graph to format. See the appropriate section below for formatting options:

- **Data Exploration options, page 576**
  The Data Exploration options contain general graph formatting options to determine how to display graph axes, whether to display labels for graph items, and so on.
- **Trend Lines options, page 579**
- **Reference Lines options, page 582**
- **Title and Container options, page 583**
- **Legend options, page 584**
- **Axis options, page 585**
- **Rows and Columns options, page 587**
- **Shapes options, page 588**

If you are formatting the visualization in Formatting Mode, you can also click an area of the graph to format it. The appropriate formatting options are automatically displayed in the Properties panel. For background information on Formatting Mode, see *Using Formatting Mode for visualizations, page 267.*

**Data Exploration options**

The Data Exploration options contain general graph formatting options to determine how to display graph axes, whether to display labels for graph items, and so on. The following options are available:

- **Axis Scale For:** From the drop-down list, select the metrics to specify axis formatting options for, as follows:
- **All Metrics**: Format options for all metrics in the visualization.

- **Metric Name**: Format the specific metric.

  - **Set To**: To determine how to display the axes for the metrics selected in the Axis Scale For drop-down list above, select one of the following:
    - **Global** (default): Display each of the selected metrics on axes with the same minimum and maximum values.
    - **Per row/column**: Display the selected metrics using the same minimum and maximum Y-axis values across each column of graphs, and the same X-axis values across each row of graphs.
    - **Per Cell**: Allow MicroStrategy to display the selected metrics using the axis values best suited to display the metric data.
    - **Custom**: Define specific minimum and maximum values to use to display the selected metrics. In the Min and Max fields, type the minimum and maximum axis values. For example, if you selected Profit in the Axis Scale For drop-down list, and you want to display the Profit metric on an axis that includes values from 0 to 5 million, type 0 in the Min field and 5000000 in the Max field. A preview of your changes is displayed in the scale below. The numbers above the scale represent the minimum and maximum axis values that you have defined. The numbers below the scale represent the minimum and maximum values in the data being displayed.

  - **Log Scale**: Determine whether to display the graph using a logarithmic scale. This can improve the display of data that follows a logarithmic trend.

  - **Axis Origin**: Define a custom axis origin value for any metric. For example, you can use this option to display a scatter plot on an axis that divides the graph into four quadrants. From the drop-down list, select one of the following:
    - **All Metrics**: Select this option to format all metrics at once.
    - **X Axis**: Select this option to format all metrics on the X-axis. (Available if all metrics in the graph are displayed on the X-axis.)
    - **Y Axis**: Select this option to format all metrics on the Y-axis. (Available if all metrics in the graph are displayed on the Y-axis.)
    - **Metric Name**: Select this option to format a specific metric.

Clear the check box and type the numeric value at which to begin displaying the axis values. The default is 0.
• **Max Size**: Specify how MicroStrategy determines the maximum size of graph items in the visualization. By default, MicroStrategy attempts to automatically size graph items in the visualization to optimize the graph display. For example, in a bubble graph, MicroStrategy attempts to display large bubbles for large metric values and small bubbles for small metric values, without hiding smaller bubbles under large ones if they overlap. From the drop-down list, select one of the following:

  - **Automatic** (default): Allow MicroStrategy to automatically size graph items to optimize the graph display.
  - **Manual**: Manually select the size of graph items. In the field, type the maximum size of the graph items as a ratio between .01 and 1. For example, type 1 to display the largest bubble markers at the maximum size at which the visualization can display graph items. If all graph items in the visualization are the same size (there is no metric in the Size By area), this value determines the size of all items displayed in the visualization. If the graph items are automatically sized based on the value of a metric (there is a metric in the Size By area), this value is the size of the largest graph item displayed in the visualization.

• **Min Size**: Specify how MicroStrategy determines the minimum size of graph items in the visualization. From the drop-down list, select one of the following: (Available if there is a metric in the Size By area.)

  - **Automatic** (default): Allow MicroStrategy to automatically size graph items to optimize the graph display.
  - **Proportional**: Automatically size graph items as proportional to the largest values displayed in the visualization.
  - **Manual**: Manually size graph items. In the field, type a percentage. The graph item for the smallest metric value in the visualization will be displayed as a percentage of the size of the largest item. For example, to display the smallest value using a graph item 20 percent of the size of the largest graph item in the visualization, type .2.

• **Legend**: Display or hide the legend in the visualization. From the drop-down list, select either Show (default) or Hide.

• **Fit To**: Determine how to size the visualization. From the drop-down list, select one of the following:

  - **Content**: Size the visualization so that all graph items are displayed at once.
  - **Panel** (default): Size the visualization to take up all available space on the visualization’s panel.
• **Banding on Rows**: Apply color banding to alternating rows in the visualization. Banding rows can make reading multiple rows of data easier for the user.

• **Data Labels**: Show or hide data labels for graph items in the visualization. For example, if your visualization contains a vertical bar graph, with the number of delayed flights for several airlines each displayed as a separate bar, you can display text showing the number of delayed flights for each airline over the corresponding bar in the visualization. Data labels allow you to display pertinent values or text for each item in the visualization without having to hover the cursor over each item in the visualization to view a tooltip. Select one of the following:
  - **Text**: Show data labels using the attribute values associated with each graph item. In the example above, the name of the airline would be displayed over each bar in the visualization. This option is only available if you have added an attribute to the Break By area.
  - **Values**: Show data labels using the metric values associated with each graph item. In the example above, the number of delayed flights would be displayed over each bar in the visualization. To display data labels for all metrics, select the All Metrics check box. To display data labels for specific metrics, select the check box next to the name of each metric to display data labels for.
  - **None** (default): Do not display data labels.

You can define additional formatting options, such as how to display the attribute form names and how null and zero metric values are hidden. To access these options, click **More Options**. For detailed descriptions of these options, see *More Options dialog box, page 604.*

**Trend Lines options**

Trend lines are not available for stacked or clustered graphs for which there is more than one metric series displayed in the graph, or for percent graphs. At least one axis must have numeric values displayed on it.

The Select a Metric option below is available for the following types of graphs:

• Each metric is plotted on its own axis.

• For graphs in which there is more than one metric series displayed in each graph (more than one metric on a single axis, or if there is an object in the Break By area), the graph must be in absolute mode.
• Attributes on one axis and metrics on another, or metrics on both axes.

The following options are available to format the trend lines in a Graph visualization:

• **Trend Lines**: Use the following options to display a trend line based on a metric:
  
  - From the drop-down list, select the metric to use to display the trend line, then select one of the following: (Available for non scatter and bubble graphs.)
    - To display a trend line for the selected metric, click **Enable**.
    - To display the metric without a trend line, click **Disable** (default).
  
  - From the **Line** color palette, select the color to use to display the trend line.
  
  - From the **Line** drop-down list, select the line style to use to display the trend line. The default is **Thin**.

• **Trend Line Parameters**:
  
  - **Model**: Select the type of trend line to display. The options are:
    - **Best-fit**: Display the trend line that best fits the data, defined as the trend line with the highest r-squared value.
    - **Linear**: Display a linear trend line, which is a best-fit straight line that is used with simple linear data sets. Your data is linear if the pattern in its data points resembles a line. A linear trend line represents data that is increasing or decreasing at a steady rate.
    - **Logarithmic**: Display a logarithmic trend line, which is a best-fit curved line that is most useful when the rate of change in the data increases or decreases quickly and then levels out. Available if the graph values are positive.
    - **Exponential**: Display an exponential trend line, which is a curved line that is most useful when data values rise or fall at increasingly higher rates.
    - **Power**: Display a power trend line, which is a curved line that is best used with data sets that compare measurements that increase at a specific rate.
    - **Polynomial**: Display a polynomial trend line, which is a curved line that is used when data fluctuates. For example, you can use a polynomial trend line to analyze gains and losses over a large data
The order of the polynomial corresponds to the number of upward and downward fluctuations in the data. Your data fluctuates if the pattern in its data points resembles a line with hills and valleys. Generally speaking, an order 2 polynomial has up to one hill or valley, an order 3 polynomial has up to two hills or valleys, and so on. In the field, type the degree of the polynomial, from 2 to 6.

- **Level**: Determine whether to display a single trend line across each graph in the visualization, or use the same trend line across each row, column, or individual graph.
  - **Per cell**: Display a separate trend line for each chart in the visualization.
  - **Per row**: Display a separate trend line for each row of charts in the visualization.
  - **Per column**: Display a separate trend line for each column of charts in the visualization.
  - **Entire table**: Each chart shares the same trend line.

- **Include break-by attributes**: Displays a separate trend line for each attribute in the Break By area. This option is selected by default. (Available for graphs other than Scatter or Bubble that have metrics displayed on only one axis.)

- **Seasons**: Select this option to display additional periods in the graph based on seasons. (Available for time-based attributes Quarter, Month, and Day.)

- **Forecasting**:
  - The following options are available if there are metrics on only one axis on the graph:
    - **Extrapolate values by adjusting the horizontal axis**: Select this option to display the trend line past the data available.
    - **Forward**: To display additional periods to the right of the graph, select the number of periods.
    - **Backward**: To display additional periods to the left of the graph, select the number of periods.
  - The following options are available if there are metrics on both axes on the graph:
- **Extrapolate values**: Select this option to display the trend line past the data available. From the drop-down list, select the metric to display the trend line for.

- **Min**: Type the minimum value at which to display the trend line. This value must be less than the minimum value available in the data.

- **Max**: Type the maximum value at which to display the trend line. This value must be greater than the maximum value available in the data.

### Reference Lines options

The following options are available to format the reference lines in a Graph visualization. The options below are available if there is a metric on the X or Y axis. Reference lines are not available for 100% stacked graphs.

- **Metric**: Select the metric to display the reference line based on. If multiple metrics share the same axis and the metrics are displayed in a stacked graph, this option is not available and the reference line is calculated based on the sum of the metric values.

- **Type**: Lists all reference lines that have already been added to the selected metric. To add a new reference line based on the selected metric, click **Add**. To remove a reference line, click **X** next to the name of the reference line to delete. Determine the height at which to display the reference line. The options are:
  - **Maximum**: Display a reference line at the highest point in the graph.
  - **Minimum**: Display a reference line at the lowest point in the graph.
  - **Average**: Use the average of all data points in the graph.
  - **Median**: Use the median value of all data points in the graph.
  - **First**: Use the height of the first data point plotted in the graph.
  - **Last**: Use the height of the last data point plotted in the graph.
  - **Constant**: Type the height at which to display the reference line as a number in the field and click **OK**.

- **Level**: Determine the level at which to display each reference line. The options are: (Available for all reference line types except Constant.)
- **Per cell**: Display a separate reference line for each chart in the visualization.
- **Per row**: Display a separate reference line for each row of charts in the visualization.
- **Per column**: Display a separate reference line for each column of charts in the visualization.
- **Entire table**: Each chart shares the same reference line.

- **Show label**: Select this option to show a label for the reference line. Select one of the following:
  - **Type**: Display the type of reference line shown in the visualization, such as Maximum or Average.
  - **Metric**: Display the name of the metric used to create the reference line.
  - **Value**: Display the value of the reference line.

- **Font**: Use the following options to format the label text:
  - Select the font type from the first drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.

**Title and Container options**

The following options are available to format the title, background, and borders in a Graph visualization:

- **Title**: Use the following options to display and format the graph title:
  - **Show Titlebar**: Select to display the graph title.
  - Select the font type from the **Font** drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.
• **Fill Color**: Select the background color of the title from the color palette.

• **Outer Border**: Use the following options to format the border line displayed around the Graph visualization:
  - From the **Line** color palette, select the color to use to display the border.
  - From the drop-down list, select the line style to use to display the border. The default is Thin.

• **Background**: Select options to format the background in the Graph visualization.
  - From the first drop-down list, select the area of the visualization to format the background for, as follows:
    - **All** (default): Select this option to format the background for the entire visualization.
    - **Rows**: Select this option to format the background for the row headers.
    - **Columns**: Select this option to format the background for the column headers.
  - **Fill**: Determine the color of the background. In the field, type the opacity of the background as a percentage, with higher values displayed as more opaque.

• **All Visualization Text**: Use the following options to format the text in the Graph visualization:
  - Select the font type from the **Font** drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.

**Legend options**

The following options are available to format the legend in a Graph visualization. (Available if the visualization contains a legend.)

• **Show Legend**: Determine whether to display or hide the graph legend.
• **Text:** Use the following options to format the text displayed in the graph legend.
  - Select the font type from the **Text** drop-down list.
  - Determine whether to apply **Bold, Italic, Underline,** or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.

• **Fill:** Select the background color for the legend from the color palette. In the field, type the opacity of the background as a percentage, with higher values displayed as more opaque.

**Axis options**

The following options are available to format the graph axes in a Graph visualization.

• **Axis Labels:** Select options to format the axis labels in the visualization.
  - From the first drop-down list, select the axis to format:
    - **X and Y Axes**
    - **X Axis**
    - **Y Axis**
  - **Show Labels:** Determine whether or not to show axis labels.
  - **Font:** Use the following options to format the axis label text:
    - Select the font type from the **Font** drop-down list.
    - Determine whether to apply **Bold, Italic, Underline,** or **Strikethrough** formatting to the text, by clicking the appropriate icon.
    - Select the font size from the drop-down list.
    - Select the font color from the color palette.
  - **Rotation:** Determine whether to display the axis labels as **Automatic** (default), **Vertical,** or **Horizontal.** (Available if you are formatting the X-axis.)

• **Axis Lines:** Select options to format the axis lines in the visualization.
From the first drop-down list, select the axis lines to format:

- All Lines
- X and Y Axes
- X Axis
- Y Axis
- Axis Origin

**Line:** From the color palette, select the color to use to display the axis lines. From the drop-down list, select the line style to use to display the axis lines. The default is **Thin**.

**Axis Titles:** Select options to format the axis titles in the visualization.

- From the first drop-down list, select the axis titles to format:
  - X and Y Axes
  - X Axis
  - Y Axis

- **Show Axis Titles:** Determine whether or not to show axis titles.

- **Font:** Use the following options to format the axis title text:
  - Select the font type from the **Font** drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.

**Grid Lines:** Select options to format the grid lines shown on individual graphs in the visualization.

- From the first drop-down list, select the grid lines to display:
  - **Hide** (default): No grid lines are displayed.
  - **Show Major and Minor**: Show all grid lines in the visualization.
  - **Show Major Only**: Show only major grid lines in the visualization, minimizing the display of grid lines overall.
  - **Automatic**: MicroStrategy determines which grid lines to display
From the color palette, select the color to use to display the grid lines.

From the drop-down list, select the line style to use to display the grid lines. The default is Thin.

**Rows and Columns options**

The following options are available to format the rows and columns of graphs in a Graph visualization.

- **Text**
  - **Selection**: Determine the part of the visualization to format:
    - All rows and columns in the visualization
    - Row Text
    - Column Text
    - Row Headers
    - Column Headers
    - Row Values
    - Column Values
  - **Text**: Determine whether to Show or Hide the selected row or column text.
  - **Font**: Use the following options to format the selected rows or columns:
    - Select the font type from the Font drop-down list.
    - Determine whether to apply Bold, Italic, Underline, or Strikethrough formatting to the text, by clicking the appropriate icon.
    - Select the font size from the drop-down list.
    - Select the font color from the color palette.
  - **Align**: Use the following options to format the text alignment for the selected rows or columns:
    - Determine whether to display column text using Left, Center, or Right horizontal alignment.
Determine whether to display row text using Top, Middle, or Bottom vertical alignment.

- **Background**
  - **Selection**: Determine whether to format the background of Rows or Columns.
  - **Fill**: Select the background color from the color palette. In the field, type the opacity of the background as a percentage, with higher values displayed as more opaque.

- **Matrix Lines**: Determine how the horizontal and vertical boundary lines between each graph in the visualization are displayed.
  - From the drop-down list, select one of the following:
    - **All Matrix Lines**: Display all boundary lines. (Default)
    - **Horizontal Matrix Lines**: Display only horizontal boundary lines.
    - **Vertical Matrix Lines**: Display only vertical boundary lines.
  - **Line**: From the color palette, select the color of the matrix lines. From the drop-down list, select the line style to use to display the grid lines. The default is Thin.

**Shapes options**

The following options are available to format the graph items, such as graph markers and data labels, in a Graph visualization.

- **Color**: Select options to format the color of graph items.
  - **Shape**: Click **Select color ranges** to determine the fill color to use to display graph items. The Thresholds dialog box opens. Select the set of colors to apply, how to calculate the ranges (for example, select Value to base the colors on the value of the metric), and the bands. For steps to create a threshold, see Creating a threshold, page 274. (Available for graphs with markers displayed as bars, areas, circles, squares, or pies.)
  - **Border**: Determine the border color to use to display graph items. (Available for graphs with markers displayed as bars, areas, circles, squares, or pies.)

- **Style and Effects**: Select options to format the graph items.
  - From the first drop-down list, select the graph items to format:
- **All** metrics in the graphs
- **Metric Name**
- **Attribute Element**
  - **Opacity**: In the field, type the opacity of the graph items, with higher values displayed as more opaque.
  - **Border**: From the drop-down list, select the line style of the border. The default is **Thin**.

- **Data Labels**: Show or hide data labels for graph items in the visualization. For example, if your visualization contains a vertical bar graph, with the number of delayed flights for several airlines each displayed as a separate bar, you can display text showing the number of delayed flights for each airline over the corresponding bar in the visualization. Data labels allow you to display pertinent values or text for each item in the visualization without having to hover the cursor over each item in the visualization to view a tooltip.
  - Select one of the following:
    - **None** (default): Do not display data labels.
    - **Values**: Show data labels using the metric values associated with each graph item. In the example above, the number of delayed flights would be displayed over each bar in the visualization. To display data labels for all metrics, select the All Metrics check box. To display data labels for specific metrics, select the check box next to the name of each metric to display data labels for.
    - **Text**: Show data labels using the attribute values associated with each graph item. In the example above, the name of the airline would be displayed over each bar in the visualization. This option is only available if you have added an attribute to the Break By area.
  - **Font**: Use the following options to format the data labels:
    - Select the font type from the **Font** drop-down list.
    - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
    - Select the font size from the drop-down list.
    - Select the font color from the color palette.
Dashboard Editor: Grid: Properties

You can format a Grid visualization, to determine whether to show banding in rows in the grid, whether to merge row and column headers, and so on.

From the drop-down list at the top of the panel, determine what part of the grid to format. See the appropriate section below for formatting options:

- General Settings options, page 590
- Column Header Area options, page 591
- Row Header Area options, page 592
- Value Area options, page 593
- Container options, page 594
- Title options, page 594

General Settings options

The following general formatting options are available to format rows, columns, and data cells in the Grid visualization:

- **Show Banding**: Determine whether or not to apply color banding to rows in the visualization. If this option is selected, rows in the grid are displayed using alternating colors. (Cleared by default)

- **Padding**: Determine whether to display a small, medium, or large amount of padding between values in the grid and each data cell.

- **Columns**: Select one of the following column width options:
  - **Auto Fit to Window** (default): The grid’s columns stretch to fit the size of the available space in the grid container.
- **Auto Fit to Contents**: The width of the grid's columns is sized to fit the data in the column. All extra space in the grid is removed.

- **Fixed**: Each column is displayed using a fixed width. If you select this option, from the drop-down list, select the column to adjust, then type the width of the column in pixels. You can also select All Columns from the drop-down list, then type the column width for every column in the grid.

- **Rows**: Select one of the following row height options:
  - **Auto Fit to Contents** (default): The height of the grid's rows is sized to fit the data in the row. All extra space in the grid is removed.
  - **Fixed**: Each row is displayed using a fixed height. If you select this option, in the Row Height field, type the height of the row in pixels.

You can define additional formatting options, such as showing, merging, and locking the row or column headers; how to display the attribute form names; and determine how null and zero metric values are hidden. To access these options, click **More Options**. For detailed descriptions of these options, see *More Options dialog box, page 604*.

### Column Header Area options

The following options are available to format the column headers in the Grid visualization:

- **Font**
  - Select the font type from the first drop-down list.
  - Apply **Bold, Italic, Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.

- **Fill Color**: Select the background color to use to display the column header.

- **Horizontal Lines**
  - **Border Style**: Select the line style to use to display the horizontal borders of the column header.
Border Color: Select the line color to use to display the horizontal borders of the column header.

Vertical Lines

Border Style: Select the line style to use to display the vertical borders of the column header.

Border Color: Select the line color to use to display the vertical borders of the column header.

Alignment

Select the vertical alignment to use to display the header text. The options are Top, Middle, and Bottom.

Select the horizontal alignment to use to display the header text. The options are Left, Center, Right, and Justify.

Wrap Text: Determine whether or not to wrap the header text, by selecting or clearing the check box. Wrapped text displays on multiple lines instead of a single line.

Row Header Area options

The following options are available to format the row headers in the Grid visualization.

Font

Select the font type from the first drop-down list.

Apply Bold, Italic, Underline, or Strikethrough formatting to the text, by clicking the appropriate icon.

Select the font size from the drop-down list.

Select the font color from the color palette.

Fill Color: Select the background color to use to display the row header.

Horizontal Lines

Border Style: Select the line style to use to display the horizontal borders of the row header.

Border Color: Select the line color to use to display the horizontal borders of the row header.
• **Vertical Lines**
  - **Border Style**: Select the line style to use to display the vertical borders of the row header.
  - **Border Color**: Select the line color to use to display the vertical borders of the row header.

• **Alignment**
  - Select the vertical alignment to use to display the header text. The options are **Top**, **Middle**, and **Bottom**.
  - Select the horizontal alignment to use to display the header text. The options are **Left**, **Center**, **Right**, and **Justify**.
  - **Wrap Text**: Determine whether or not to wrap the header text, by selecting or clearing the check box. Wrapped text displays on multiple lines instead of a single line.

**Value Area options**

The following options are available to format the data cells in the Grid visualization:

• **Font**
  - Select the font type from the first drop-down list.
  - Apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.

• **Fill Color**: Select the background color to use to display the values.

• **Horizontal Lines**
  - **Border Style**: Select the line style to use to display the horizontal borders of the values area.
  - **Border Color**: Select the line color to use to display the horizontal borders of the values area.

• **Vertical Lines**
• **Border Style**: Select the line style to use to display the vertical borders of the values area.

• **Border Color**: Select the line color to use to display the vertical borders of the values area.

• **Alignment**
  
  Select the vertical alignment to use to display the values. The options are *Top*, *Middle*, and *Bottom*.

  Select the horizontal alignment to use to display the values. The options are *Left*, *Center*, *Right*, and *Justify*.

• **Wrap Text**: Determine whether or not to wrap the values, by selecting or clearing the check box. Wrapped text displays on multiple lines instead of a single line.

### Container options

The following options are available to format the display of the container in which the Grid visualization is displayed:

• **Fill Color**: Select the background color to use to display the grid container.

• **Border Style**: Select the line style to use to display the borders of the grid container.

• **Border Color**: Select the line color to use to display the borders of the grid container.

### Title options

The following options are available to format the title bar of the Grid visualization:

• **Font**
  
  Select the font type from the first drop-down list.

  Apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.

  Select the font size from the drop-down list.

  Select the font color from the color palette.
• **Fill Color**: Select the background color to use to display the title.

**Grid Resizing options**

**Related topics**

- *Creating a Grid visualization, page 220*
- *Formatting a Grid visualization, page 293*
- *Dashboard Editor: Grid, page 562*
- *More Options dialog box, page 604*

**Dashboard Editor: Heat Map: Properties**

You can format a Heat Map visualization, to enable rectangles to be deleted from the visualization, to select the algorithm used to size and position rectangles in the visualization, and so on.

From the drop-down list at the top of the panel, determine what part of the heat map to format. See the appropriate section below for formatting options:

- *Data Exploration options, page 596*
  
  The Data Exploration options contain general formatting options to determine how to display rectangles, whether to display labels for rectangles, and so on.

- *Title and Container options, page 597*

- *Legend options, page 598*
Data Exploration options

The Data Exploration options contain general formatting options to determine how to display rectangles, whether to display labels for rectangles, and so on. The following options are available:

- **Layout**: Determine how rectangles in the visualization are sized and positioned. The options are:
  - **Keep readability, not element order** (default): Size the rectangles in the Heat Map visualization to make them as easy to read as possible.
  - **Balance readability and element order**: Size and position the rectangles to make them as easy to read as possible, while still attempting to display them in the same order in which they appear in the Editor panel.
  - **Keep element order, not readability**: Position the rectangles in the Heat Map visualization in the same order in which they appear in the Editor panel.

- **Headers**: You can determine where the rectangles’ headers are displayed. From the drop-down list, select one of the following options:
  - **In Center** (default): Display the header in the center of the rectangle.
  - **On Top**: Display the header at the top of the rectangle.

- **Labels**: You can choose whether to label each rectangle with the name of the attribute element that it represents. From the drop-down list, select one of the following options:
  - **On** (default): Show the rectangle labels.
  - **Off**: Hide the rectangle labels.
  - **Proportional**: Display the rectangle labels with the size of each label reflecting the size of the rectangle. Rectangles that contain large values will be displayed with larger labels than rectangles that contain small values.

- **Show Metric Values**: Select this option to display the metric values for each rectangle in the visualization. For example, if you add Region, Profit, and Revenue to the Heat Map visualization, with rectangles displayed for each customer region, you can select the Show metric values check box to display the profit and revenue data for the Mid-Atlantic region in the Mid-Atlantic rectangle, the profit and revenue data for the Northeast region in the Northeast rectangle, and so on.
- **Shape Color**: If the heat map’s rectangles are colored by attribute values, Desktop automatically selects the colors for each attribute value. You can instead select the color for any or all attribute values. For each attribute value to change, select it in the **Shape Color** drop-down list. From the color palette in the next drop-down list, select the color to use to display the attribute value, and then the opacity in the next drop-down list. To restore an attribute value to its default color, in the color palette, select **Automatic**.

  - To color rectangles by attribute values, place the attribute in the Color By area in the Editor panel. For more details, see *Creating a Heat Map visualization, page 223*.

- **Text**: To format text in the visualization, perform the following steps:

  a. From the drop-down list, determine the text to format. The options are **All**, **Headers**, or **Labels**. (Available if the Header Position is set to **On Top**).

  b. Click the plus (+) icon to increase the size of text in the visualization, or click the minus (-) icon to decrease the size of text in the visualization.

  c. From the drop-down list, select the font type to use to display the text.

You can define additional formatting options, such as how to display the attribute form names and how null and zero metric values are hidden. To access these options, click **More Options**. For detailed descriptions of these options, see *More Options dialog box, page 604*.

**Title and Container options**

The following options are available to format the title, background, and rectangle headers in a Heat Map visualization:

- **Title**: Use the following options to display and format the visualization’s title:

  - **Show Titlebar**: Select to display the visualization’s title.

  - Select the font type from the **Font** drop-down list.

  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.

  - Select the font size from the drop-down list.

  - Select the font color from the color palette.
- **Fill Color**: Select the background color of the title from the color palette.

- **Background**: To format the background of the visualization, perform the following steps:
  a. From the color palette, select the background color for the visualization.
  b. Type a number to specify the opacity of the background color, with higher percentage values being more opaque.

- **Header Color**: To format rectangle headers in the visualization, perform the following steps:
  a. From the color palette, select the color to use to display the headers.
  b. Type a number to specify the opacity of the rectangle headers, with higher percentage values being more opaque.

  Header Color is available when the headers are positioned at the top of the rectangles. If the headers are positioned in the middle of the rectangles, the headers do not use a separate background color.

### Legend options

Use the following options to display and format the visualization’s legend:

- **Show Legend**: Select to display a legend in the visualization.
- Select the font type from the **Font** drop-down list.
- Determine whether to apply **Bold, Italic, Underline, or Strikethrough** formatting to the text, by clicking the appropriate icon.
- Select the font size from the drop-down list.
- Select the font color from the color palette.

### Related topics

- *Creating a Heat Map visualization, page 223*
- *Formatting a Heat Map visualization, page 296*
- *Dashboard Editor: Heat Map, page 563*
Dashboard Editor: ESRI Map: Properties

You can format an ESRI Map visualization to determine whether markers on the map are clustered together in the visualization, or change the background map theme, such as a street map or satellite map.

The following options are available:

- **Title**: Use the following options to format the title's font:
  - Select the font type from the first drop-down list.
  - Apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the second drop-down list.
  - Select the font color from the color palette.

- **Fill Color**: Select the title’s background color.

- **Container**: Use the following options to format the display of the container in which the ESRI Map visualization is displayed:
  - **Border Style**: Select the line style to use to display the borders of the container.
  - **Border Color**: Select the line color to use to display the borders of the container.

- **Map Options**: Use the following options to format the display of the map:
  - **Map Style**: Select the display theme to use when showing the map, such as **World Street Map** or **Terrain Map**.
  - **Map Type**: Select the type of map to display. The options are:
    - **Marker**: Displays a map with bubble or image markers.
    - **Area**: Displays a map with colored areas representing geographic regions, such as countries, states, and counties.
    - **Density**: Displays a density map.
  - **Clustering**: Enable map markers to be clustered together and displayed as a circle when a large number of map markers must be...
displayed in the same map area. You can double-click a cluster to zoom in on the area and display individual map markers. The options are: (Available for marker maps)

- **Automatic**: Allow MicroStrategy to determine whether to cluster map markers.
- **On**: Display markers on the map as clustered.
- **Off** (default): Display markers on the map without clustering.

- **Marker Type**: Select the type of map marker to display on the map, such as **Bubbles** or **Pins**. (Available for map markers)

- **Boundaries**: Select the base map to use to display areas in the visualization, such as **US States** or **World Admin Divisions**. The base map is a map that contains the shape of each area that can be displayed in the visualization. For example, you can display data for both states and provinces by displaying your data on the World Admin Divisions base map, or display data only for states by displaying your data on the U.S. States base map. The base maps available vary automatically depending on the type of geographic data that you have added to the map. For example, if you add state data to the visualization, the US States and State Abbreviations base maps are available. (Available for area maps)

- **Color Bands**: Select the color theme to use to show locations on the map. For example, to display areas with a low density of locations of interest as blue and areas with a high density as red, select the color theme that changes from blue to red. (Available for density maps)

- **Zoom behavior on filtering**: Determine whether to refit the map area displayed in the visualization when the user selects map locations.

  - **Keep current zoom level** (default): Select this option to keep the current level of magnification when locations are selected on the map.

  - **Dynamically change zoom level**: Select this option to zoom in on and refit the contents of the visualization to best display the selected locations on the map.

- **Show Legend**: Determine whether or not a legend is displayed for the map. The legend shows the relationship between the color of each marker and the metric value for that location. By default, the check box is cleared, meaning that the legend is hidden.
Related topics

- Creating an ESRI Map visualization that displays map markers, page 228
- Formatting an ESRI Map visualization that displays map markers, page 299
- Dashboard Editor: ESRI Map, page 565
- Creating an ESRI Map visualization that displays a density map, page 233
- Formatting an ESRI Map visualization that displays a density map, page 300
- Dashboard Editor: ESRI Map, page 565
- Creating an ESRI Map visualization that displays areas, page 239
- Formatting an ESRI Map visualization that displays areas, page 301
- Dashboard Editor: ESRI Map, page 565

Dashboard Editor: Network: Properties

Once you create a Network visualization, you can customize the display of the visualization, such as the size of the font used to show labels for nodes in the visualization, or whether to display an animation when switching between node layout styles.

From the drop-down list at the top of the panel, determine what part of the visualization to format. See the appropriate section below for formatting options:

- Data Exploration options, page 602
  
  The Data Exploration options contain general formatting options to format node labels, node edges, the display theme for the visualization, and so on.
- Title and Container options, page 603
- Legend options, page 603
Data Exploration options

The Data Exploration options contain general formatting options to format node labels, node edges, the display theme for the visualization, and so on. The following options are available:

- **Show Node Label**: Show descriptive labels for nodes in the visualization.
- **Show Edge Direction**: Display edges in the visualization as arrows to show the node at which each edge starts and ends.
- **Show Animation Transition**: Show an animation when you change the layout style used to display nodes in the visualization.
- **Node Size Aggregation**: Select the function used to aggregate the metric values used to determine node size in the visualization.
- **Theme**: Determine whether to display the visualization using a **Dark** or **Light** (default) display theme.
- **Item Fill**: Use the following options to format the color of the nodes in the visualization:
  - From the drop-down list, select the opacity of the nodes, with higher percentage values being more opaque.
  - From the color palette, select the color to use to display the nodes.
- **Item Border**: Use the following options to format the border of each node in the visualization:
  - From the color palette, select the color of the node borders.
  - From the drop-down list, select the line style of the node borders. The default is **Thin**.
- **Background**: Use the following options to format the visualization’s background:
  - From the drop-down list, select the opacity of the visualization’s background, with higher percentage values being more opaque.
  - From the color palette, select the background color for the visualization.

You can define additional formatting options, such as how to display the attribute form names and determine how null and zero metric values are
hidden. To access these options, click **More Options**. For detailed descriptions of these options, see *More Options dialog box, page 604*.

**Title and Container options**

The following options are available to format the title and background in a Heat Map visualization:

- **Title**: Use the following options to display and format the visualization’s title:
  - **Show Titlebar**: Select to display the visualization’s title.
  - Select the font type from the **Font** drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
  - Select the font color from the color palette.
  - **Fill Color**: Select the background color of the title from the color palette.

- **Fill**: Use the following options to format the visualization’s background:
  - From the color palette, select the color to use to display the background.
  - Type the opacity of the background color as a percentage in the field. Higher percentage values are displayed as more opaque than lower percentage values. Press ENTER to apply your changes.

**Legend options**

The following options are available to format the legend:

- **Show Legend**: Determine whether to display or hide the visualization legend.

- **Text**: Use the following options to format the legend text:
  - From the first drop-down list, select the font type.
  - Apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
From the second drop-down list, select the font size.

From the color palette, select the font color.

- **Fill**: Use the following options to format the legend's background:
  - From the color palette, select the color to use to display the legend's background.
  - Type the opacity of the background color as a percentage in the field. Higher percentage values are displayed as more opaque than lower percentage values. Press ENTER to apply your changes.

**Related topics**

- *Creating a Network visualization, page 243*
- *Formatting a Network visualization, page 302*
- *Dashboard Editor: Network, page 567*
- *More Options dialog box, page 604*

**More Options dialog box**

You can select additional formatting options for a Graph, Grid, Heat Map, or Network visualization in a dashboard using the More Options dialog box. You can also define how attributes and metrics are joined within the visualization.

The following options are available:

- **Headers** (Available for Grid visualizations)
  - **Rows**: Determine whether to **Show**, **Merge**, and/or **Lock** the row headers in a grid.
  - **Columns**: Determine whether to **Show**, **Merge**, and/or **Lock** the column headers in a grid.

If a header is locked, it cannot be realigned or shifted.

- **Display**
  - **Remove Extra Column**: Determine whether the word "Metrics" is displayed on the grid. (Available for Grid visualizations)
Show Attribute Form Names: Determine how headers for attributes and attribute forms are displayed in a visualization. For example, you can choose to have a header containing the attribute form name automatically displayed above each attribute form shown in the visualization, or have a single header automatically displayed for each attribute in the visualization, with each header containing only the attribute name. The following options are available:

- Off (default): Select this option to have the attribute name automatically displayed in the header of each attribute. No attribute form names are included.
- On: Select this option to have a header automatically displayed for each attribute form, with each header consisting of the attribute name followed by the attribute form name.
- Form name only: Select this option to have a header automatically displayed for each attribute form, with each header consisting of only the attribute form name.
- Show attribute name once: Select this option to have a header automatically displayed for each attribute form and have the attribute name included only in the header for the first attribute form for each attribute. The remaining attribute forms are displayed using the attribute form name only.
- Automatic: Select this option to automatically display either headers for each attribute or each attribute form depending on the number of attribute forms visible in the visualization for each attribute. If only one attribute form is shown for an attribute, the attribute is displayed with a header containing the attribute's name. If more than one of the attribute's forms are visible in the visualization, each attribute form is displayed with a header containing the attribute name followed by the attribute form name.

Hide null/zero: Select this option to determine how MicroStrategy hides null and zero metric values in a visualization. From the drop-down list, select one of the following:

- Hide Nulls or Zeros (default): Select this option to hide rows and columns that consist only of null or zero metric values.
- Hide Nulls Only: Select this option to hide rows and columns that consist only of null metric values.
- Hide Zeros Only: Select this option to hide rows and columns that consist only of zero metric values.
• **Filtering:** Determine how filtering data through other visualizations works.
  
  - **All Selections** (default): All the filtering selections are applied.
  
  - **Last Selection Only:** Only the last filtering selection is applied.

• **Join Behavior:** You can define how all attributes are joined within the visualization. You can also define how each metric in the visualization is joined.
  
  - For each metric, select one of the following join types:
    
    - **Inner Join:** Data is displayed only for the metric values that have corresponding attribute values.
      
      For example, to show sales and budget data for all regions, an inner join on the sales and budget metrics will yield a visualization showing only those regions that have both sales and budget information.
      
      An inner join is more commonly used for metric joins than outer joins. Inner joins provide effective results when you know the metrics are closely related to each other and when your data source contains relatively complete metric data, without empty values. They also require less processing time.
    
    - **Outer Join:** All metric values are displayed, even if other metrics in the visualization are missing values. Allows you to see all the data that is available for the metric.
      
      For example, to show sales and budget information for all regions, if the sales has an outer join and the budget metric has an inner join, the combination will yield all those regions that have both sales and budget data, and will also include all data for sales.
      
      An outer join is effective if your data source contains empty values for some metrics. Outer joins are useful for rank metrics, because an attribute element will have a rank applied whether it has values or not. You want to see all ranked elements in the results, not just those elements that have values.

When finished, click **Save** to apply your changes.

**Related topics**

• *Formatting a Graph visualization, page 283*
Advanced Sort Editor

You can sort data in a visualization based on multiple dataset objects at the same time, using the Advanced Sort dialog box.

You can determine whether to sort based on data added to the rows or the columns of the visualization, by clicking Rows or Columns.

To sort a dataset object, select the object from the Sort By drop-down list, then choose whether to sort the values in Ascending (from A to Z) or Descending order (from Z to A). Do the same for each dataset object that you want to sort.

The Order column determines the order that the objects are sorted in. After you define multiple sorts, you can reorder them, by clicking and dragging a sort to its new location in the list.

To delete a sort, click the X next to the object to delete.

You can sort the metric values hierarchically, by selecting the Sort metric hierarchically check box. Hierarchical sorting, or multiple-key sorting, sorts data according to multiple sorting criteria in a hierarchical manner. This means that the first criterion is the initial basis for sorting. Any ties are resolved using the second criterion, any remaining ties are resolved using the third criterion, and so on. If a tie remains after all the criteria are used, the default sort order is used as the tiebreaker. In a simple example using the Worldwide Emissions sample dashboard, you can sort by ascending population, then ascending emissions. If two countries have the same population, their emissions are compared to sort them. You can, of course, create more complex multiple-key sorting.

When finished, click OK to apply changes and sort the data.
Thresholds Editor

You can highlight metric data in a visualization by applying formatting to the visualization when data fulfills a specific condition. This formatting is called a threshold. For example, a Grid visualization displays revenue data for different geographical regions. You can use thresholds to display revenue values less than $500,000 in red, or replace values greater than $5,000,000 with a company logo.

The following options are available:

- **Thresholds Type**: Select the type of formatting to apply to metric values that meet the threshold condition, as follows:
  - **Color-based**: Creates a threshold that changes the color used to display metric values.
    - **Color**: The set of colors to apply to the values.
  - **Image-based**: Creates a threshold that replaces metric values with an image.
    - **Image**: The set of images to replace values with.
    
    The **Image-based** option is shown for visualizations that support replacing metric values with images.
  - **Reversed**: If selected, the set of color or images is reversed in the threshold display. For example, a threshold color progresses from dark red to light red; if it is reversed, it progresses from light red to dark red.
  - **Based on**: The metric used to determine the threshold condition.
  - The next drop-down list determines the how to calculate the metric to determine the condition:
    - **Value**: Creates a threshold based on the value of the metric.
    - **Highest**: Creates a threshold based on the top n metric values.
    - **Lowest**: Creates a threshold based on the bottom n metric values.
- **Highest %**: Creates a threshold based on the top n percent of metric values.
- **Lowest %**: Creates a threshold based on the bottom n percent of metric values.
- **Break By**: The attribute level at which to restart counting rank or percent values for the metric. To continue counting without restarting, select **None**. This option is only available for thresholds that are based on rank or percent values.

Each band displayed in the threshold slider represents a different range of metric values. The color or image displayed above the band represents the formatting used to display values that fall within its range. You can:

- Modify the range covered by a band:
  - To increase or decrease the range of values covered by the band, click and drag a thumb left or right along the slider.
  - To change the end of a band to a specific value, double-click the thumb at the end of the band, then type the value and press ENTER. The bands are updated.
- You can add or edit bands for thresholds that use colors rather than images:
  - To change the color applied to the range of values covered by a band, double-click the band, then select the new color from the palette.
  - To create a new band, hover over an empty section at the bottom of one of the threshold bands, so that the cursor has a plus displayed next to it. Click the band to divide it into two separate bands. You can change the range of the band, as described above.
  - To delete a band, click the band, then press DELETE. The band is deleted.
  - To delete a thumb, click the thumb to select it and press DELETE. The thumb is deleted.

To preview your changes in the visualization, click **Apply**. To create the threshold, click **OK**.

To create multiple thresholds, including thresholds with multiple conditions that can be based on attributes as well as metrics, click **Advanced Thresholds Editor**. For a description of the Advanced Thresholds Editor, see *Advanced Thresholds Editor, page 610*. 
Advanced Thresholds Editor

You can format data in a visualization based on multiple attribute or metric qualifications. To do this, you define thresholds using the Advanced Thresholds Editor.

The Advanced Thresholds Editor displays a list of all thresholds currently defined for the visualization. The number to the left of each threshold displays the order in which the thresholds are evaluated. To the right of each threshold is a preview of the formatting used to display data that meets the threshold’s condition.

- To add a new threshold, click **New Threshold**.
- To delete a threshold, click X to the right of the threshold. The threshold is deleted.
- To edit a threshold, click the threshold.
- To change the formatting of a threshold, click the formatting preview displayed to the right of the threshold.
- To change the order that a threshold is evaluated, click the arrow icon to the right of the threshold, and select either **Move Up** or **Move Down**.
- To determine whether to apply the threshold formatting to metric values, metric subtotal values, or both, click the arrow icon to the right of the threshold. Point to **Apply to**, then select one of the following:
  - To apply formatting only to the metric values that meet the threshold conditions, select **Metric only**.
  - To apply formatting only to metric subtotal values that meet the threshold conditions, select **Subtotals only**.
  - To apply formatting to both metric values and subtotals that meet the threshold conditions, select **Metric and subtotals only**.

For complete steps for all these actions, see *Creating a threshold using multiple qualifications, page 278*. 
Related topic

- Creating a threshold using multiple qualifications, page 278
- Adding or removing a threshold in a visualization, page 273

Show Data dialog box

You can examine the underlying attribute and metric data of a visualization in a simple grid format, using the Show Data dialog box. You can:

- Add data from the visualization’s primary dataset to the grid.
- Sort and move data in the grid, and resize the columns
- Export the data in the grid as an Excel, PDF, or CSV file
- Copy the data in the grid to the clipboard
- Create a new Grid visualization using the data in the grid

For steps to view and work with the underlying data in a visualization, see Examining the underlying data in a visualization, page 449.

You can also use this option to display a group’s data. For example, a group called Winter Average is displayed for many regions on a Grid visualization. You can view all the winter averages for each region in the Show Data dialog box. To do this, right-click the group and select Show Data.

The Show Data dialog box is not available for visualizations created using the data in a dataset imported from a server.

Related topics

- Examining the underlying data in a visualization, page 449
- Defining the primary dataset to use to display data in a visualization, page 263
- Creating a Grid visualization, page 220
- Grouping attribute values in a dashboard, page 349
Dashboard Editor: HTML container properties

Once you create an HTML container, you can specify the HTML or URL to use, and then format its background color and border. The following options are available:

- Select one of the following to determine how to specify the HTML container:
  - **iFrame**: Displays the contents of a web page in an iFrame. In the field, type the URL of the web page.
  - **HTML**: Uses HTML to display content. In the field, type the HTML to add to the dashboard.
- **FillColor**: The background color of the HTML container.
- **BorderStyle**: The type of border to draw around the HTML container. (Default is no border.)
- **BorderColor**: The border’s color. (This option is displayed after you select a type of border)

Related topic

- *Adding web content, page 314*

Dashboard Editor: Image properties

Once you create an image, you can resize it, format its background color and border, and enable it as a link to a URL. The following options are available:

- **Size**: Size the image using specific sizing options. The options are:
  - **Fixed To**: Displays the image with a specific width and height. Type the width of the image, in pixels, in the X field. Type the height of the image, in pixels, in the Y field.
  - **Fit to Container**: Sizes the image so that its width and height fit inside its container. If the space available to display the image does not match the image’s original aspect ratio, blank space is displayed.
  - **Fill Container**: Sizes the image so that it fills its container. If the space available to display the image does not match the image’s original aspect ratio, blank space is displayed.
aspect ratio, a portion of the image is cropped to fit the size of the available space.

- **Stretch**: Stretches the image so that it fills all space available in its container.

- **Lock Aspect Ratio**: Determines whether or not to keep the image’s original aspect ratio when the image is resized.
  - To maintain the image's aspect ratio when the image is resized, select the **Lock Aspect Ratio** check box.
  - To resize the image without maintaining the aspect ratio, clear the **Lock Aspect Ratio** check box.

- **Restore to Original Size**: Restores the image to its original size.

- **Fill Color**: The background color of the image’s container.

- **Border Style**: The type of border to draw around the image. (Default is no border.)

- **Border Color**: The border’s color. (This option is displayed after you select a type of border.)

- **Link**: Determines whether the image opens a URL when you click the image. The options are:
  - **Disabled**: The image is not a link. (Default)
  - **Navigate to URL**: The image is used as a link to the URL that you type in the field.

- **Tooltip**: Text to display when you hover the cursor over the image. (Available if link is enabled)

**Related topic**

- *Adding an image, page 312*

**Dashboard Editor: Filter properties**

Once you create a filter for a visualization, you can customize the display of the filter, such as whether to display a title, the title’s font, and the display style of the filter (slider or qualification for a metric filter, check boxes or radio buttons for an attribute filter). This type of filter filters the data within a specific visualization, to select what data is displayed on the visualization.
You can also use this type of filter to filter the objects displayed in a filter that targets a visualization. For examples and more detailed descriptions, including steps to create the filters, see Creating a filter for the data on a visualization, page 402.

From the drop-down list at the top of the panel, determine what part of the filter to format. See the appropriate section below for formatting options:

- *Filter options, page 614*
- *Title and Container options, page 615*

**Filter options**

The following options are available to format the filter:

- **Style**: The options vary depending on the type of filter.
  - For an attribute filter, the styles are:
    - **Check Boxes**: This style allows multiple selections.
    - **Slider**: This style is effective for browsing data in a Graph visualization.
    - **Search Box**: This style is useful for a long element list.
    - **Link Bar**: This style is useful to create tabs.
    - **Button Bar**: This style is useful to create tabs.
    - **Radio Buttons**: This style allows only a single selection.
    - **Drop-down**: This style allows only a single selection.
    - **List Box**: This style allows multiple selections.
  - For a metric filter, the styles are:
    - **Slider**: Filters data by choosing values on a slider.
    - **Qualification**: Filters data by comparing metric values to a number that you specify.

- **Font**: Use the following options to format the display of the filter’s text:
  - Select the font type from the Font drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
- Select the font size from the drop-down list.
- Select the font color from the color palette.
- **Alignment**: How the filter’s items are displayed: *Automatic*, *Horizontal*, or *Vertical*.

- **Mode**: Whether to include or exclude data using the filter selections. Available for metric filters that use the slider style and for attribute filters.
  - To display data for the filter selections, select **Include**.
  - To display data for everything except the filter selections, select **Exclude**.

- Use the following options to format the display of an attribute filter:
  - **Allow multiple selections**: Determines whether you can select multiple items in the filter, allowing the target visualization to display data for several items at once. To allow only a single selection, clear this check box.
  - **Make all items the same width**: Determines whether each item in the filter is displayed using the same width or proportionally, which means that the width of each item is proportional to the length of the text inside the item.
  - **Show option for all**: Determines whether or not the filter shows the All option, which displays all the objects in the target.
  - **Alias**: By default, the All option is displayed in the filter as (All). To replace it with your own text, type the text in this field. (Available if **Show option for All** is selected.)

**Title and Container options**

The following options are available to format the title and container of a filter:

- **Title**: Use the following options to display and format the filter’s title:
  - **Show Titlebar**: Select to display the filter’s title.
  - Select the font type from the **Font** drop-down list.
  - Determine whether to apply **Bold**, **Italic**, **Underline**, or **Strikethrough** formatting to the text, by clicking the appropriate icon.
  - Select the font size from the drop-down list.
- Select the font color from the color palette.
- **Fill Color**: Select the background color of the title from the color palette.
- **Alignment**: The alignment of the text: Left, Center, or Right.

- **Container**: Use the following options to format the display of the filter’s container. The container holds the filter, including the title bar and the filter items.
  - **Fill Color**: Select the background color to use to display the container.
  - **Outer Border Style**: Select the line style to use to display the borders of the container.
  - **Outer Border Color**: Select the line color to use to display the borders of the container.

**Related topic**

- *Creating a filter for the data on a visualization, page 402*

**Dashboard Editor: Text properties**

Once you add text to a dashboard, you can format the text, such as selecting the font color and size, whether to bold or italicize text. You can also use the text as a link to an URL.

The following options are available:

- **Text**: The font to apply to the text.
- **Bold**: Whether or not to apply bold formatting to the text.
- **Italic**: Whether or not to italicize the text.
- **Underline**: Whether or not to underline the text.
- **Strikethrough**: Whether or not to strike through the text.
- **Font Size**: The font size to apply to the text.
- **Font Color**: The font color of the text.
- **Text Alignment**: The alignment of the text: Left, Center, Right, or Justified.
• **Wrap Text:** Whether or not to wrap lines of text that are too long to be displayed in the text field.

• **Direction:** The direction that the text is displayed in:
  - **Horizontal** (default): Display the text horizontally.
  - **90 degrees:** Display the text rotated 90 degrees clockwise. The text reads from the top of the text field to the bottom.
  - **-90 degrees:** Display the text rotated 90 degrees counterclockwise. The text reads from the bottom of the text field to the top.

• **Overflow:** Determine how to display text that exceeds the size of its text field:
  - **Clip** (default): Display only the text that can fit within the size of the text field.
  - **Scroll:** Display a scroll bar to allow a user to view all of the text.

• **Fill Color:** Select the background color of the text field.

• **Border Style:** Select the type of border to draw around the text field.

• **Border Color:** Select the border's color.

• **Link:** Determine whether or not use the text as a link to a specific URL when you click the text:
  - **Disabled** (default): Display the text without adding a link.
  - **Navigate to URL:** Use the text as a link. In the field, type the URL to link to.

• **Tooltip:** Type additional text to display when you hover the cursor over the text.

**Related topic**

• *Limiting the Data Displayed in a Dashboard: Filters, Sheets, and Pages, page 369*
Preferences dialog box

The Preferences dialog box contains the following sections:

- **General**
  - Specify the language to use on Desktop. See *Specifying the display language preferences, page 618*.
  - Check for updates to Desktop. See *Upgrading and updating MicroStrategy Desktop, page 6*.
  - Determine whether or not Desktop automatically checks for updates. For steps, see *To prevent Desktop from automatically checking for updates, page 10* or *To allow Desktop to automatically check for updates, page 10*.

- **Network**
  - Select the network proxy. For steps, see *Selecting the network proxy, page 619*.

- **Server Connections**
  - Connect a server. For steps, see *Connecting a server to MicroStrategy Desktop, page 470*.

**Specifying the display language preferences**

The Preferences dialog box lets you personalize your MicroStrategy Desktop language settings. You can select the language that pages are displayed in and the language that numbers and dates are displayed in.

---

**To set language preferences**

1. Do one of the following:
   - On a Windows machine, from the **File** menu of a dashboard, select **Preferences**.
   - On an Apple machine, from the **Desktop** menu of a dashboard, select **Preferences**.

   The Preferences dialog box opens.
2 Click **General**.

3 From the **Language** drop-down list, select the language to display MicroStrategy Desktop pages in.

4 From the **Number and Date Format** drop-down, select the language to display numbers and dates in.

Using this setting along with a custom number format can create a dynamic currency format that changes according to the locale’s default currency symbol.

5 Click **OK** to save your preferences.

6 Close and reopen Desktop to apply the language preferences.

**Related topic**

- *Preferences dialog box, page 618*

---

**Selecting the network proxy**

The network proxy setting determines how MicroStrategy Desktop connects to the Internet.

---

**To select the network proxy**

1 In MicroStrategy Desktop, do one of the following:

- On a Windows machine, from the **File** menu of a dashboard, select **Preferences**.

- On an Apple machine, from the **Desktop** menu of a dashboard, select **Preferences**.

   The Preferences dialog box opens.

2 Click **Network**.

3 Select one of the following:

   - **Use computer’s proxy configuration**.
• Use proxy configuration file, then provide the URL for the file.

• Manual proxy configuration, then provide the HTTP Proxy and Port. If a password is required, select the Proxy server requires password check box, and provide the Username and Password.

4 Click OK to return to Desktop.

Related topic

• Preferences dialog box, page 618
ADDITIONAL RESOURCES

Introduction

MicroStrategy provides a variety of resources to complete tasks using MicroStrategy products. These resources include manuals, integrated help systems, online forums, and so on. For details, see the following:

- For background information and steps to access the MicroStrategy Desktop Discussion Forum, see Discussion Forum, page 621.
- For details about the reporting capabilities of the full MicroStrategy product suite, and a description of the manuals that support the full product suite, see Resources, page 622.

Discussion Forum

The MicroStrategy Desktop Discussion Forum is an extension of the MicroStrategy Support Site. It allows you and other members of the MicroStrategy user community to exchange information about your experiences with the MicroStrategy platform. You can ask questions, share best practices, comment about MicroStrategy products and related technologies, and so on. To access the MicroStrategy Desktop Discussion Forum, visit http://community.microstrategy.com/t5/MicroStrategy-Analytics-Desktop/bd-p/383
Resources

This section provides details on how to access books and online help.

Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

• **Manuals**: In general, MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started

The steps to access the manuals are described in *Accessing manuals and other documentation sources, page 628*.

Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.

• **Help**: In general, MicroStrategy help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

Additional formats

MicroStrategy manuals are available as electronic publications, downloadable on the Apple iBooks Store or Google Play, and can be read on your iOS or Android device respectively. To download a book, search for the book’s title in the iBookstore or Google Play. To view a list of manuals that are currently available, scan the following QR codes using your device’s camera:
• For iOS devices, scan the following QR code:

![QR Code for iOS]

• For Android devices, scan the following QR code:

![QR Code for Android]

For new MicroStrategy releases, it may take several days for the latest manuals to be available on the iBookstore or Google Play.

**Translations**

For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

**Finding information**

You can search all MicroStrategy books and Help for a word or phrase, with a simple Google™ search at [http://www.google.com](http://www.google.com). For example, type “MicroStrategy derived metric” or “MicroStrategy logical table” into a Google search. As described above, books typically describe general concepts and examples; Help typically provides detailed steps and screen options. To limit your search to MicroStrategy books, on Google’s main page you can click **More**, then select **Books**.
Manuals for MicroStrategy overview and evaluation

• *Introduction to MicroStrategy: Evaluation Guide*

Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide includes a walkthrough of MicroStrategy features so you can perform reporting with the MicroStrategy Tutorial project and its sample business data.

• *MicroStrategy Evaluation Edition Quick Start Guide*

Overview of the installation and evaluation process, and additional resources.

Resources for security

• *Usher Help*

Steps to perform mobile identity validation using the Usher mobile security network to issue electronic badges for identifying users.

Manuals for query, reporting, and analysis

• *MicroStrategy Installation and Configuration Guide*

Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, and basic maintenance guidelines.

• *MicroStrategy Upgrade Guide*

Steps to upgrade existing MicroStrategy products.

• *MicroStrategy Project Design Guide*

Information to create and modify MicroStrategy projects, and create the objects that present your organization’s data, such as facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.

• *MicroStrategy Basic Reporting Guide*

Steps to get started with MicroStrategy Web, and how to analyze and format data in a report. Includes the basics for creating reports, metrics, filters, and prompts.
• MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application

Steps to create Freeform SQL reports, Query Builder reports, complex filters and metrics, use Data Mining Services, and create custom groups, consolidations, and complex prompts.

• Document and Dashboard Analysis Guide

Steps to execute, analyze, and format a dashboard in MicroStrategy Web.

• MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents

Steps to create Report Services documents, add objects, and format the document and its objects.

• MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for Your Data

Steps to create MicroStrategy Report Services dashboards and add interactive visualizations.

• MicroStrategy In-memory Analytics Guide

Information to use MicroStrategy OLAP Services features, including Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

• MicroStrategy Office User Guide

Instructions for using MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, and Word, to analyze, format, and distribute business data.

• MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile

Steps to use MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

• MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence

Information and instructions to install and configure MicroStrategy Mobile, as well as steps for a designer working in MicroStrategy Developer or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.
• **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting Your MicroStrategy Business Intelligence System**

Steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

Steps for administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

• **MicroStrategy MDX Cube Reporting Guide**

Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.

• **MicroStrategy Operations Manager Guide**

Instructions for managing, monitoring, and setting alerts for all of your MicroStrategy systems from one console. This guide also includes steps for setting up and using Enterprise Manager to analyze your MicroStrategy system usage.

**Manual for the Human Resources Analytics Module**

• **Human Resources Analytics Module Reference**

**Software Development Kits**

• **MicroStrategy Developer Library (MSDL)**

Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.
• **MicroStrategy Web SDK**

The Web SDK is available in the MicroStrategy Developer Library, which is part of the MicroStrategy SDK.

**Documentation for MicroStrategy Portlets**

• **Enterprise Portal Integration Help**

Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

This resource is available from http://www.microstrategy.com/producthelp.

**Documentation for MicroStrategy GIS Connectors**

• **GIS Integration Help**

Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

This resource is available from http://www.microstrategy.com/producthelp.

**Help**

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

• Help button: Use the Help button or ? (question mark) icon on most software windows to see help for that window.
• Help menu: From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

• F1 key: Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

  For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.

### Accessing manuals and other documentation sources

The manuals are available from http://www.microstrategy.com/producthelp.

Adobe Reader is required to view these manuals. If you do not have Adobe Reader installed on your computer, you can download it from http://get.adobe.com/reader/.

The best place for all users to begin is with the *MicroStrategy Basic Reporting Guide*.

To access the manuals and other documentation sources, visit http://www.microstrategy.com/producthelp.

### Documentation standards

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| bold | • Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions  
Example: Click **Select Warehouse**. |
<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>italic</em></td>
<td>• Names of other product manuals and documentation resources&lt;br&gt;• When part of a command syntax, indicates variable information to be replaced by the user&lt;br&gt;Example: Type <code>copy c:\filename d:\foldername\filename</code></td>
</tr>
<tr>
<td><strong>Courier font</strong></td>
<td>• Calculations&lt;br&gt;• Code samples&lt;br&gt;• Registry keys&lt;br&gt;• Path and file names&lt;br&gt;• URLs&lt;br&gt;• Messages displayed in the screen&lt;br&gt;• Text to be entered by the user&lt;br&gt;Example: <code>Sum(revenue)/number of months.</code>&lt;br&gt;Example: Type <code>cmdmgr -f scriptfile.scp</code> and press Enter.</td>
</tr>
<tr>
<td>+</td>
<td>A keyboard command that calls for the use of more than one key (for example, <code>SHIFT+F1</code>).</td>
</tr>
<tr>
<td>⚠</td>
<td>A note icon indicates helpful information for specific situations.</td>
</tr>
<tr>
<td>⚠</td>
<td>A warning icon alerts you to important information such as potential security risks; these should be read before continuing.</td>
</tr>
</tbody>
</table>
User Guide

Version 10

To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in the “About MicroStrategy...” menu of your software. To view the version number of your software, click the MicroStrategy Desktop icon in the Windows task bar, then select About.

Document number: 09611000

Copyright © 2015 by MicroStrategy Incorporated. All rights reserved.

Legal notices

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor (any such agreement, a “Separate Agreement”), the following terms apply:

This software and documentation are the proprietary and confidential information of MicroStrategy Incorporated and may not be provided to any other person. Copyright © 2001-2015 by MicroStrategy Incorporated. All rights reserved. THIS SOFTWARE AND DOCUMENTATION ARE PROVIDED “AS IS” AND WITHOUT EXPRESS OR LIMITED WARRANTY OF ANY KIND BY EITHER MICROSTRATEGY INCORPORATED OR ANYONE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, GOOD TITLE AND NONINFRINGEMENT, QUALITY OR ACCURACY. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE OR DOCUMENTATION PROVE DEFECTIVE, YOU (AND NOT MICROSTRATEGY, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.
In no event will MicroStrategy, Incorporated, or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract warranty, negligence, strict liability for the negligence of indemnity or contribution, the failure of any remedy to achieve its essential purpose, or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy, shall not exceed, at the option of MicroStrategy, Inc., either a full refund of the price paid, or replacement of the Software. No oral or written information given out expands the liability of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U.S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at FAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at FAR 52.227-19, as applicable. Contractor is MicroStrategy, Incorporated., 1850 Towers Crescent Plaza, Tysons Corner, VA  22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.

The following terms and notices apply regardless of whether you have executed a Separate Agreement:

Trademark Information


Other product and company names mentioned herein may be the trademarks of their respective owners.

Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or commitments concerning the availability of future products or versions that may be planned or under development.

Patent Information
This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 5,321,520, 5,416,602, 5,748,560, 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,393, 6,279,033, 6,501,832, 6,567,796, 6,587,547, 6,606,596, 6,658,093, 6,658,432, 6,662,195, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,707,889, 6,741,980, 6,765,997, 6,768,788, 6,772,137, 6,788,768, 6,792,086, 6,798,867, 6,801,910, 6,820,073, 6,829,334, 6,836,537, 6,850,603, 6,859,798, 6,873,693, 6,885,734, 6,888,929, 6,895,084, 6,940,953, 6,964,012, 6,977,992, 6,996,568, 6,996,569, 7,003,512, 7,010,518, 7,016,480, 7,020,251, 7,039,165, 7,082,422, 7,113,474, 7,113,993, 7,127,403, 7,174,349, 7,181,417, 7,194,457, 7,197,461, 7,228,303, 7,260,577, 7,266,181, 7,272,212, 7,302,639, 7,324,942, 7,330,847, 7,340,040, 7,356,758, 7,356,840, 7,415,438, 7,428,302, 7,430,562, 7,440,898, 7,457,397, 7,486,780, 7,509,671, 7,516,181, 7,559,048, 7,574,376, 7,617,201, 7,725,811, 7,801,967, 7,836,178, 7,861,161, 7,861,253, 7,881,443, 7,925,516, 7,945,584, 7,970,782, 8,005,870, 8,035,382, 8,051,168, 8,051,369, 8,094,788, 8,130,918, 8,296,287, 8,321,411, 8,452,755, 8,521,733, 8,522,192, 8,577,902, 8,606,813, 8,607,138, 8,645,313, 8,761,659, 8,775,807, 8,782,083, 8,812,490, 8,832,588, 8,943,044, and 8,943,187. Other patent applications are pending.

Third Party Software
Various MicroStrategy products contain the copyrighted technology or software of third parties ("Third Party Software"). A list of Third Party Software, as well as links to any terms and conditions associated with such Third Party Software ("Third Party Terms"), can be found at www.microstrategy.com/third-party-notices. Your use of MicroStrategy products is subject to all applicable Third Party Terms.
INDEX

**A**

Advanced Sort Editor 607
attribute defined on 50
  define data column as 124
element 51
form 51
multiform 125
attribute element group 349
attribute filter 381
attribute relationship 138
attribute value, changing the color of
  graph 283
  heat map 297
authentication mode to log in to MicroStrategy Web 480

**B**

BI tool, importing data from 85

**C**

calculated group 349, 354
  All Others group 355
  changing the calculation 367
  creating 362
  unused attribute elements 355
certified defined on 502
color palette for a dashboard 169
  applying 172
  creating 171
  deleting 172
  editing 172
color-coding based on a metric. See threshold.
  connecting to a database 488
  creating your first dashboard. See dashboard - creating your first 17
  CSV file, exporting a visualization to 178
  customizing a SQL query during data import 74

**D**

dashboard 2
  color palette 169, 172
  creating 146
  creating your first dashboard. See dashboard - creating your first 17
display theme 167
downloading from a server 477
exporting 176
Index

filtering 451
formatting 167, 173
layer. See page and sheet. page 376
Presentation Mode 422
running 421
saved on a server 477
saving 175
saving to a server 474
sheet 374
uploading to a server 474
viewing 421
dashboard - creating your first 17
analyzing data 41
creating a dashboard 18, 24
drilling on a Heat Map visualization 45
exporting a dashboard 48
filtering 41
adding 34
Heat Map visualization 45
using a metric 36
using an attribute 36
visualization with another visualization 38
Heat Map visualization defined on 49, 151
creating from scratch 328
database configuration requirements 513
creating from scratch 328
database 
connecting to 488
importing data from 67
importing data 19
Dashboard Editor 549
data access 160
data file, exporting a visualization to 178
data source, configuring OAuth parameters for 498
data wrangling 129
database
configuration requirements 513
connecting to 488
importing data from 67
supported types 504
database connection
creating 488
deleting 496
DSNless connection 487
duplicating 496
editing 496
supported data sources 504
dataset
data access 160
direct data access 160
data file
exporting a visualization to 178
data source, configuring OAuth parameters for 498
data source
connecting to 488
data wrangling 129
database
configuration requirements 513
connecting to 488
importing data from 67
importing data 19
Dashboard Editor 549
data access 160
data file, exporting a visualization to 178
data source, configuring OAuth parameters for 498
importing data 19
Dashboard Editor 549
data access 160
data file, exporting a visualization to 178
data source, configuring OAuth parameters for 498
data source
connecting to 488
data wrangling 129
DB2 iSeries 514
DB2 Wire 515
DB2 z/OS 516
derived attribute 344
derived metric 318, 319
aggregation function 325
based on an arithmetic calculation 322, 323
basic 319
combining the values of multiple metrics 322
creating from scratch 328
deleting 344
deploying R analytics 341
editing 343
from an attribute 327
renaming 343
shortcut metric 320
Desktop license 470
Desktop. See MicroStrategy Desktop.
display theme for a dashboard 167
Dropbox file, importing data using 91
DSN, creating a 492

E
editing imported data 140
element group 349
   All Others group 353
   changing the attribute elements 367
   creating 358
      multiple groups 360
      single group 359
   unused attribute elements 353
ESRI Map visualization
   analyzing 441
   areas 239
      creating 241
      formatting 301
      geographical data for 240
   density map 233
      creating 236
      formatting 300
      geographical data for 234
   importing data for 135
   map markers 228
      creating 230
      formatting 299
      geographical data for 228
   threshold 275
Excel, exporting a visualization to 178
exporting
dashboard 176
history script for data wrangling 135
visualization 178
Expression dialog box 545

F
Facebook, importing data from 93
file URI scheme, importing data from 62
file, importing data from 62
filter 369
   using. See filtering.
sheet 378
      applying changes all at once 394
      applying changes individually 394
      attribute filter 381
      automatically applying 394
      creating 378
      deleting 380
      display 557
Filter panel. See also Filter panel. 380
   filtering items displayed in a
      filter 395
      metric filter 384
      moving 400
      top ranking filter 389
visualization 402
   creating 409
   deleting 412
   filtering items displayed in a
      filter 407
   formatting 613
   moving 411
   visualization with another
      visualization 413
Filter panel 380
   collapsing a filter 557
   collapsing all filters 557
   expanding a filter 557
   expanding all filters 557
   hiding 556
   moving 557
<table>
<thead>
<tr>
<th>Showing</th>
<th>Filter</th>
<th>Drilling</th>
</tr>
</thead>
<tbody>
<tr>
<td>556</td>
<td>437</td>
<td>437</td>
</tr>
<tr>
<td>Forecasting</td>
<td>Formatting</td>
<td>Undoing</td>
</tr>
<tr>
<td>290</td>
<td>293</td>
<td>437</td>
</tr>
<tr>
<td>Grouping</td>
<td>Grouped attribute</td>
<td>Consolidating unused elements</td>
</tr>
<tr>
<td>349</td>
<td>351</td>
<td>364</td>
</tr>
<tr>
<td>Grouped attribute</td>
<td>Adding a new element with</td>
<td>Calculated</td>
</tr>
<tr>
<td>349, 354, 362</td>
<td>353, 355</td>
<td>364</td>
</tr>
<tr>
<td>Grouped attribute</td>
<td>Replacing attribute elements with</td>
<td>Subtotals and subtotals</td>
</tr>
<tr>
<td>349</td>
<td>356</td>
<td>366</td>
</tr>
<tr>
<td>G</td>
<td>G</td>
<td>H</td>
</tr>
<tr>
<td>Geo roles</td>
<td>Geo roles</td>
<td>Hardware requirements</td>
</tr>
<tr>
<td>135</td>
<td>163</td>
<td>503</td>
</tr>
<tr>
<td>Google Analytics, importing data using</td>
<td>Google Analytics, importing data using</td>
<td>Google Analytics, importing data using</td>
</tr>
<tr>
<td>96</td>
<td>Google Analytics, importing data using</td>
<td>Google Analytics, importing data using</td>
</tr>
<tr>
<td>Google BigQuery, importing data from</td>
<td>Google BigQuery, importing data from</td>
<td>Google BigQuery, importing data from</td>
</tr>
<tr>
<td>99</td>
<td>Google BigQuery, importing data from</td>
<td>Google BigQuery, importing data from</td>
</tr>
<tr>
<td>Heat Map visualization</td>
<td>Heat Map visualization</td>
<td>Heat Map visualization</td>
</tr>
<tr>
<td>223</td>
<td>427</td>
<td>223</td>
</tr>
<tr>
<td>Attribute value</td>
<td>Attribute value</td>
<td>Attribute value</td>
</tr>
<tr>
<td>283</td>
<td>283</td>
<td>283</td>
</tr>
<tr>
<td>Reference line</td>
<td>Reference line</td>
<td>Threshold</td>
</tr>
<tr>
<td>284</td>
<td>284</td>
<td>284, 289</td>
</tr>
<tr>
<td>Trend line</td>
<td>Trend line</td>
<td>Trend line</td>
</tr>
<tr>
<td>284, 289</td>
<td>284, 289</td>
<td>284, 289</td>
</tr>
<tr>
<td>Hive</td>
<td>Hive</td>
<td>Hive</td>
</tr>
<tr>
<td>517</td>
<td>517</td>
<td>517</td>
</tr>
<tr>
<td>HTML container</td>
<td>HTML container</td>
<td>HTML container</td>
</tr>
<tr>
<td>314</td>
<td>314</td>
<td>314</td>
</tr>
<tr>
<td>Freeform query, importing data using</td>
<td>Freeform query, importing data using</td>
<td>Freeform query, importing data using</td>
</tr>
<tr>
<td>113</td>
<td>113</td>
<td>113</td>
</tr>
<tr>
<td>Function Arguments dialog box</td>
<td>Function Arguments dialog box</td>
<td>Function Arguments dialog box</td>
</tr>
<tr>
<td>547</td>
<td>547</td>
<td>547</td>
</tr>
</tbody>
</table>

© 2015 MicroStrategy, Inc.
adding 315
deleting 316
moving 316

I
image 312
  adding 312
  deleting 314
  moving 313
  sizing 313
image file, exporting a dashboard to 176
Impala 519
importing data 55, 531
  based on an expression 545
  best practices 59
BI tool 85
  configuring OAuth parameters 498
custom data 83
Dropbox file 91
editing 140
Facebook 93
from a database. See also importing
data from a database 67
from a file 62
  best practices 59
geo roles 135
Google Analytics 96
Google BigQuery 99
  customizing your query 117
  joining tables 102
Google Drive 105
Hadoop 112
MicroStrategy sample file 109
previewing 121
refining data quality 129
Salesforce report 107
scraping a web page 65
suggesting a data source 120
Twitter 110
  updating 141
  wrangling 129
importing data from a database
  based on a filter 75
  best practices 61
  by building a SQL query 67
  by picking relational tables 80
  customizing a SQL query 74
  joining database table columns 78
  query 113
Infobright 520
Informix Wire 521
Informix XPS 522
installing 4
  automatically 11
  hardware requirements 503
internationalization 618

J
joining attributes 138
  unrelated attributes 572

L
license
  Desktop 470
license for Desktop 4, 475

M
map-based visualization. See also ESRI
  Map visualization.
  areas 239
  density map 233
  map markers 228
metric defined on 52
  define data column as 124
formatting 271
Metric Editor 319
metric filter 384
Microsoft Access 523
MicroStrategy Desktop 1
  automatically installing 11
  checking for updates to 6, 8, 9
  connecting a server to 469, 470
  deploying R analytics 341
  hardware requirements 503
  installing 4
  ODBC driver support 504
  opening 16
  software requirements 501
  supported data sources 504
  updating 6
  upgrading 6
MicroStrategy file, exporting 176
MicroStrategy sample file, importing data from 109
multiform attribute 125
MySQL 523

N
network proxy 619
Network visualization 243
  analyzing 445
  drilling 448
  undoing 448
  formatting 302
  threshold 275
New Condition dialog box 545

O
OAuth parameter configuration 498
ODBC driver 504
Oracle 524

P
page 376
  adding 376
  deleting 377
  duplicating 377
  rearranging 377
  renaming 377
partitioning 127
PDF
  exporting a dashboard to 176
  exporting a visualization to 178
PostgreSQL 526
preferences
  language settings 618
  network proxy 619
Presentation Mode 422
Preview page 534
previewing imported data 121
primary dataset 158
privilege 472
project, using objects from 483
public data
  importing data from 65
  public data, importing from 65

Q
query, importing data using 113

R
R (analytics) integration with MicroStrategy Desktop 341
reconciliation during dataset replacement 154
reference line in a Graph visualization 284
refreshing data 141
  automatically 572
relational tables, importing data by
picking 80
republishing data 141
running a dashboard 421

S
Salesforce 526
Salesforce report, importing data from 107
saving a dashboard 175
search index 127
secondary dataset 158
Select Import Options dialog box 533
server
  authentication mode 480
  connecting to Desktop 469, 470
downloading a dashboard from 477
importing a dataset from 481
opening a dashboard saved on 477
saving a dashboard to 474
uploading a dashboard to 474
using objects from a project 483
sheet 374
  adding 375
  creating a filter for 378
    applying changes all at once 394
    applying changes individually 394
    attribute 381
    automatically applying 394
    deleting 380
    metric 384
deleting 375
duplicating 375
filtering 453
  top ranking 389
moving 375
rearranging 375
nenaming 375
shortcut metric 320
Show Data dialog box 611
software requirements 501
SQL Server 527
subtotals and groups 356
supported defined on 503
Sybase ASE 528

T
text field 307
  adding 310
deleting 312
  editing 312
  moving 312
  sizing 312
threshold 273
  creating 275
  ESRI Map visualization 275
  Graph visualization 275
  Heat Map visualization 275
  Network visualization 275
  removing all thresholds defined with a specific metric 278
top ranking filter 389
trend line 289
trend line in a Graph visualization 284
Twitter, importing data from 110
typing data to import 83

U
uninstalling automatically 11
updating imported data 141
updating MicroStrategy Desktop 6
upgrading MicroStrategy Desktop 6
  automatic 11
URL, importing data from 62, 65
user preferences
  language settings 618
network proxy 619
user privilege 472

V

viewing a dashboard 421
Presentation Mode 422
visualization 179
derived metric 319
display type 246
ESRI Map
areas 239
density map 233
map markers 228
Graph 181
Grid 220
Heat Map 223
Network 243
object requirements 183
tasks. See visualization - tasks.
threshold 273
title bar 266
visualization - tasks
adding data to 251
creating 179
defining primary dataset for 263
deleting 250
duplicating 247
examining underlying data 449
exporting 178
filter 402
creating 409
deleting 412
formatting 613
undoing 464
using 460
visualization with another visualization 413, 464
formatting 264
numeric values 271

maximizing 266
moving to another page 249
moving to another sheet 250
renaming an attribute or a metric 265
restoring to default size 266
sizing 266
Visualization Gallery 568

W

web content, displaying in a dashboard 314
web page, importing data from 65
web services 529
wrangling data 129
exporting a history script 135
history script 129
importing a history script 132